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요   약   문

Ⅰ. 제 목

농·식품 이동형 방사능 측정 장비 및 신속분석법 개발에 관한 연구

Ⅱ. 연구성과 목표 대비 실적

구분
특허 소프트웨어

등록

논문

출원 등록 비SCI SCI

목표 2 1 1 8 5

달성 8 2 5 5

구분 상품화 정책자료 교육지도 언론홍보

목표 3 2 5 3

달성 3 2 9 5

* 고려사항 : 본 연구는 장비 개발이 주를 이루는 과제로, 상품화 및 실용화 여부가 중요한 연구 성과

지표임. 따라서 출원, 상품화, 소프트웨어 등록 등이 매우 중요하고, 특허 등록은 2016년도에 다수 이루

어 질 것으로 판단됨. 개발된 장비 및 신속분석법은 즉시 적용할 수 있도록 주간부처에 정책 제안을 하

였음.

Ⅲ. 연구개발의 목적 및 필요성

우리나라는 후쿠시마 원전사고 당시 편서풍의 영향으로 방사능 검출시기가 늦었고 그 양도

극히 미량이었으나 오히려 다른 국가들에 비해 더 많은 국가적 혼란을 겪은 바 있으며 현재까

지도 대다수의 국민들이 방사능 공포에 시달리고 있으며 특히 먹거리에 대한 우려가 높다. 이

에 따라 일본 후쿠시마 원전사고 이후 일본 등 수입산 농·식품 주요 품목에 대한 방사능 검사

가 강화되었으나, 농식품의 품목이 다양하고 물리·화학적 특성이 달라 전처리 과정부터 방사능

측정과 분석 평가 단계에 이르기까지 신뢰성 높은 검사 시스템 구축이 필수적이다. 또한 향후

주변국가 또는 국내에서 일어날 수 있는 이와 유사한 방사능 누출 사고 발생에 대비하여, 국민
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들의 건강과 먹거리 안전성 확보를 위한 검사방법의 확립과 효율적인 검사관리 체계의 구축이

시급하다. 게다가 현재 농식품 방사능 분석 장비는 전량 수입되고 있으며 예기치 못한 방사능

재난사고 시 수요 증가로 공급이 부족하거나 가격 폭등으로 장비 확보가 어려울 수 있으므로

방사능 분석 장비의 국산화 및 신속검사에 적합한 장비의 개발이 필수적이라고 할 수 있다. 따

라서 본 연구에서는 농식품 특성에 맞는 신속 분석법과 신속 검사체계를 확립하고 현장에 적

합한 방사능 분석 장치를 개발하는데 그 목적이 있다. 그리고 분석결과의 신뢰성 확보를 위해

서 국내에서 유통되는 농·축·수산물을 이용한 기준물질과 인증표준물질을 개발이 반드시 필요

하다. 더불어 원전사고와 같은 재난사고 발생 시 국민들의 식품안전에 대한 불안감 확산 및 유

관기관의 신뢰도 하락을 방지하기 위해 국내 방사능검사체계의 개선방향을 제시하고 유관기관

관계자와 관련 전문가들, 소비자 등 이해관계자 상호간의 지속적이고 효과적인 쌍방향 리스크

커뮤니케이션 방안 마련이 반드시 필요하다.

Ⅳ. 연구개발 내용 및 범위

후쿠시마 사고 후 많은 필요성이 제기된 현장 신속 분석용 이동형 장비 2 종류를 개발하였다.

개발된 장비는 크게 NaI 검출기 기반 신속 분석 장치와 HPGe 검출기 기반 이동형 분석 장치

인데, 특히 HPGe 기반 현장 이동형 분석 장치의 경우 최초로 개발하였다. 장비는 검출기, 백

그라운드 저감용 차폐체, 이동장치 및 운영 프로그램으로 구성되며, 개발된 장비는 수입산 장

비와 기준물질(RM) 및 실제 시료를 비교·분석함으로써 성능이 우수함을 확인하였다.

기존 실험실 정밀분석 방법 개선 및 신속분석법과의 연계기술을 도출함으로써 농·축·수산물

중 방사능 신속분석법을 확립하였으며 분석법의 현장평가 등을 통해 신속검사 매뉴얼을 개발

하였다. 개발된 신속 분석용 이동형 장비와 신속 검사 매뉴얼을 통해서 비상시 신속 분석할 수

있는 기반을 확립하였다. 국내․외 방사능 관리체계와 현황을 조사하고, 각 국가별 방사능 분

석방법을 비교․검토함으로써 현행 유관기관과 관련 업체들의 식품 중 방사능 관리 체계의 문

제점을 파악하고 개선안을 마련하였다. 또한 방사능 및 식품안전과 관련한 국내외 정보 수집,

인식 조사, 전문가 자문 및 세미나 등을 통해 올바른 정보제공 및 쌍방향 커뮤니케이션 방안을

제시하였다.

또한 농·축·수산물을 이용한 기준물질(RM) 또는 인증표준물질(CRM) 36개를 국내 최초로

개발하여 실험자의 불확도를 줄이고 결과값의 신뢰성을 확보하였다.

Ⅴ. 연구개발결과

1. 농식품 중 방사능 신속분석법 확립 및 국내 방사능 검사관리 체계 개선

농·축·수산물 중 MDA에 따른 분석시간 결정 및 정량한계를 설정하고 실험실 정밀분석 방법

개선 및 신속분석법과의 연계기술을 도출함으로써 농·축·수산물 중 방사능의 정성 및 정량 분

석법을 확립하였다. 또한 개발된 감마선 검출기 및 분석프로그램에 대한 분석 절차서를 개발하

였고 농·축·수산물 검역 장소에서 개발 장비 및 분석법의 현장평가 등을 통해 신속검사 매뉴얼

을 개발하였다. 국내․외 방사능 관리체계와 현황을 조사하고, 각 국가별 방사능 분석방법을

비교․검토함으로써 현행 관리 체계의 문제점을 파악하고 개선안을 마련하였다. 또한 방사능
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및 식품안전과 관련한 국내외 정보 수집, 인식 조사, 전문가 자문 및 세미나 등을 통해 올바른

정보제공 및 쌍방향 커뮤니케이션 방안을 제시하였다.

2. 이동형 방사능 분석장비 개발

농식품 중 방사능 신속분석에 적합한 이동형 방사능 분석장비 두 종류, NaI(Tl) 및 HPGe

검출기를 개발하였다. 본 장비는 이동이 가능하고, 현장에서 신속하게 분석할 수 있는 장점이

있다. 특히 하나의 다중파고분석기(NeoMCA)를 이용하여 두 검출기에 동시 적용이 가능하고,

외부 전원 없이 내부 전원만으로 장시간 분석이 가능한 장비이다. 또한 방사능 분석용 농식

품 시료에 대한 정보를 종합적으로 관리할 수 있는 식품분석 DB 프로그램 개발하였다. 농식

품 중 방사능 핵종식별, 방사능 산출 등이 가능한 한글프로그램(NeoGMA)을 국내 최초 개발

하였다. 기존에는 영문프로그램으로 복잡하고 전문가에 적합하였으나, 개발 운영 프로그램은

초보자에게도 쉽게 분석할 수 있도록 한글이면서 순차적으로 실행할 수 있도록 하였다.

검증을 위해서 기존 상용장비(Canberra Lynx MCA & Genie2K 프로그램) 및 교정용 인증표

준물질(CRM), 한국표준연구원 제작 RM 시료 등을 이용한 다양한 비교평가를 통해 본 연구

에서 개발한 이동형 방사능 측정 장비의 신뢰성을 확보하였다. 국립농산물품질관리원과 삼성

웰스토리에서의 현장측정을 통해 본 연구에서 개발한 이동형 방사능 측정장비가 현장 활용

가능성을 평가하였다.

3. 농·축·수산물에 대한 표준인증물질 개발

국내·외에서 처음으로 농·축·수산물인 밀가루, 멸치, 닭고기를 이용하여 인증표준물질(CRM)을

개발하였다. 이는 국내 및 국제 비교시험물질로 사용할 예정이며 나아가 방사능측정기관에 보

급하여 방사능측정 품질관리에 활용함으로써 측정 데이터의 신뢰성 향상에 기여할 것으로 판

단된다. 또한 이 연구에서 개발된 농·축·수산물 기준물질들은 과제 참여기관의 숙련도시험 및

개발된 이동형 장비의 비교평가에 활용됨으로써 방사능측정의 품질관리에 기여하였다.

Ⅵ. 연구성과 및 성과활용 계획

1. 연구성과

농·축·수산물에 대해 현장에서 적용 가능한 신속분석법을 확립하고 이에 대한 절차서 및 매뉴

얼을 개발하였다. 또한 현장에서 방사능 측정 및 분석이 가능한 이동형 NaI 및 HPGe

장비 2종을 개발하였으며 수입 장비와 비교하여 MDA를 만족함을 확인하였다. 장비 개발과 더

불어 독립형 다중파고분석기를 개발하고 상용제품 수준의 신뢰성을 확인하였으며 식품분석

DB 프로그램 및 일반사용자용 감마핵종 분석 한글프로그램을 국내 최초 개발하였다. 또한 국

내·외 최초 농·축·수산물을 이용한 인증표준물질 및 기준물질 36종을 개발함으로써 방사능 측

정 결과에 대한 신뢰성 향상에 기여하였다.
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2. 활용계획

○ 확립된 신속분석법을 기반으로 현장적용 및 검사체계 개선을 통해 예기치 못한 방사능 사

고시 소비자에게 안전한 농식품을 공급하고 사회·경제적 피해를 최소화한다.

○ 농식품 중 방사능 검사용 국산장비를 개발함으로써 원천기술을 확보하고 수입장비 대체로 예산을

절감한다.

○ 개발된 기준물질 및 인증표준물질을 활용함으로써 분석결과의 신뢰성을 제고한다.

○ 수집된 자료를 바탕으로 국내 방사능 관련 관리 체계의 문제점을 파악하고 개선을 위한

정책 자료로 활용한다.

○ 국민인식조사 및 쌍방향 리스크 커뮤니케이션 방안을 활용하여 소비자의 불안을 해소한다.
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SUMMARY

Ⅰ. Project Title

Development of Rapid Analytical Method and Equipment for the Radionuclide of

Agricultural Food in Field

Ⅱ. Achievements against the Objectives of the Project

Classification
Patent Software

Registration

Paper

Application Registration Non-SCI SCI

Objective 2 1 1 8 5

Achievement 8 2 5 5

Classification Product Policy Proposal Education Public Relations

Objective 3 2 5 3

Achievement 3 2 9 5

Ⅲ. Objectives and Importance of the Project

When the Fukushima accident was happened, although, a very small amount of

radioactivity was lately detected in Korea because of the prevailing westerlies, we

experienced more confused than the other countries. A majority of the people were haunted

by the fear of radioactivity and the people highly have concerned about food so far.

Therefore, the radioactivity inspection for imported agricultural food was strengthened after

the Fukushima accident. But, because the items of the agricultural foods are various and

they have different physicochemical properties, it is necessary to develop the reliable

inspection system from pre-treatment procedure to radioactivity detection, analysis and

assessment stage. Also, to prepare the radioactivity leakage accident happened in domestic

or neighboring countries, it is important to develop the analytical method and efficient

management system for health of the people and the safety of the foods. Because we
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import all radioactivity analysis equipment for agricultural foods, when the radioactivity

accident happened, it may be difficult to secure the equipment due to demand increase or

price rise. Therefore, it is necessary to localize the radioactivity analysis equipment for

agricultural foods and to develop the suitable system for rapid inspection. In this research,

we developed the rapid analytical method and rapid inspection system for radionuclide in

agricultural foods. Also we developed the radioactivity analysis equipment for field

inspection and RM and CRM for reliability management for analysis result using the

agricultural, livestock and marine products in domestic circulation. We improved the

reliability of the data and developed equipment by proficiency test for related organization

using the RM and CRM developed in this research. In addition to, we proposed the

improvement direction for the domestic radioactivity inspection system and developed the

continuous and efficient bilateral risk communication way to avoid the spreading anxiety

for food safety and reliability decrease for related organizations in radioactivity accident.

Ⅳ. Contents and Scope of the Project

We developed the rapid analytical method for agricultural foods by improvements of the

laboratory analysis and deduction of the linkage technique. The rapid inspection manuals

for radionuclide of agriculture foods were developed by the field assessment. We

apprehended the problems in the radioactivity management system of the related

organizations and companies and prepared the improvement way by investigating the

current state in domestic and overseas and comparing the radioactivity analysis method.

Also, we suggested the method of suitable information offering and bilateral risk

communication by information collection, awareness investigation, expert consultation and

seminars for radioactivity and food safety.

We developed the system hardware, shielding container for the detector, movement

system and analysis program to make the portable radioactivity analysis equipment for

rapid inspection in field. Also, we assessed the performance of the developed system by

analysing the RM and real sample and comparing with the result of the imported system.

We developed the thirty six of the RM or CRM using the agricultural, livestock and

marine products to decrease the experiment error and secure the reliability.

Ⅴ. Result of the Project

1. Development of the rapid analytical method for agricultural products and

improvements of the radioactivity inspection management system

We developed the qualitative and quantitative radioactivity analytical method for

agricultural foods by decision of the analysis time according to the MDA, setting of

the LOQ, improvements of the laboratory analysis and deduction of the linkage
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technique with rapid analytical method. Also, we developed the analysis procedure for

developed system and analysis program, and made the rapid inspection manual by

field assessment for developed equipment and analysis method. We apprehended the

problems in the radioactivity management system of the related organizations and

companies and prepared the improvement way by investigating the current state in

our own and other lands and comparing the radioactivity analysis method. Also, we

suggested the method of suitable information offering and bilateral risk communication

by information collection, awareness investigation, expert consultation and seminars

for radioactivity and food safety.

2. Development of the portable radioactivity analysis system for agricultural

products

We developed the standard of the portable radioactivity analysis equipment by

understanding of the current technology state and the patent trend. Also we

developed the separable Pb shielding and transportation cart suitable for lower MDA

value (NaI(Tl) : 20 Bq/kg, HPGe : 3 Bq/kg). The developed multi channel

analyser(NeOMCA) can be used for both NaI(Tl) and HPGe detector, and it is

possible to measure radioactivity for long-time using the inner battery. It enable to

secure the reliability level of the developed equipment as the existing commercial

products. We developed the food analysis DB program to manage the informations of

the agricultural product samples totally. And we developed nation’s first the

Korean-language program(NeoGMA) of gamma radionuclide analysis for general-user

group with functions of gamma radiation measurement, radionuclide distinction,

radioactivity computation and MDA assessment. According to the comparison

assessment using the commercial products(Canberra Lynx MCA & Genie2K program),

CRM and developed RM by KRISS, we secured the reliability of the developed

equipment. Also we confirmed superiority for field utilization by field measurement in

NAQS(National Agricultural Products Quality Management System) and Samsung

Well Story.

3. Development of the CRM for the agricultural, livestock and marine products

For the first time, at home and abroad, we developed CRM using the wheat flour,

anchovy and chicken as the agricultural, livestock and marine products. We have a

plan to use the CRM as abroad comparison test substance and to supply the CRM to

radioactivity measurement organizations. These enable to raise the reliability of the

measurement data by utilizing for the quality management of the radioactivity

measurements. Also developed RM and CRM were contributed the quality

management of radioactivity measurements by utilizing for proficiency test and
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comparison assessment for developed portable equipment.

Ⅵ. Accomplishment of the Project and their Applications

1. Accomplishment of the Project

We developed the rapid analytical method for agricultural foods in field and the

manual. Also we developed the portable NaI and HPGe system for radioactivity

measurement and analysis in field. These equipments satisfied the MDA compared with

the commercial products. In addition to, we developed the independent multi channel

analyzer and confirmed the reliability level as commercial products. For the first time,

the food analysis DB program and the Korean-language gamma radionuclide analysis

program for general user group were developed in Korea. We developed the thirty six

of the RM or CRM using the agricultural, livestock and marine products to secure the

reliability for measurement data.

2. Applications

○ To minimize the social·economical damage and supply the safe agricultural foods to

people by improvements of the inspection system and field application based on the

developed rapid analytical method

○ To reduce the budget by replacement for the imported equipment and to secure the

original technology by development domestic radioactivity inspection equipment for

agricultural products

○ To raise the reliability of the analysis results by utilizing the developed RM and

CRM

○ To utilize the policy proposal for improvements measures by understanding the

problems for domestic radioactivity management system based on the collecting

information

○ To resolve the consumer’s apprehension by utilizing the awareness investigation and

bilateral risk communication measures
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제 1 장  연구개발과제의 개요

제 1 절 연구개발의 목표와 필요성

1. 연구개발의 목적 및 필요성

□ 1986년 4월 26일 체르노빌 원전사고에 이어 2011년 3월 11일 일본 후쿠시마 원전 사고가

발생하자 전 세계적으로 원전의 안전성과 농·축·수산물의 방사능 오염 등 먹거리 안전 문

제에 대한 관심이 높아지고 있다. 이에 각국에서는 원전사고 발생 국가에서 수입되는 식

품에 대한 방사능 검사, 수입금지, 자국 식품도 주기적 점검하는 등의 방법으로 식품안전

관리를 강화하고 있다. 우리나라는 일본 원전사고 이후 식품의약품안전처에서 일본에서

수입되는 농․임산물, 가공식품, 식품첨가물, 건강기능식품에 대해 2011년 3월 19일 이후

부터 방사능 검사를 실시하고 있으며, 2014년 7월 15일 현재까지 수입이 잠정적으로 중단

된 농산물은 후쿠시마, 도치기, 이바라키, 지바, 시즈오카 등 13개 현(縣)에서 생산된 엽채

류, 순무, 죽순, 버섯류, 차(茶) 등 27개 품목이다. 하지만 농축수산물의 품종이 다양하여

물리화학적 성질이 다르기 때문에 전처리 과정에서 방사능 측정과 분석 평가 단계에 이르

기까지 신뢰성이 높은 검사 시스템을 시급히 마련해야 한다.

□ 우리나라와 인접한 국가(중국 동부지역 가동 중인 원전, 중국 전역에 건설 진행 또는 계획

중인 원전과 일본 큐수 지역 원전, 북핵 원전)의 방사능 누출사고 발생 시에는 단시간 내

에 한반도 전역에 걸친 방사능 오염이 발생할 수 있다. 현재 농식품 방사능 분석 장비는

전량 수입되고 있으며, 이러한 예기치 못한 방사능 재난사고 시 수요 증가로 공급이 부족

하거나 가격 폭등으로 장비 확보가 어려울 수 있다. 또한 방사능 분석방법, 핵종별 기준

마련 및 신속 분석체계 확립과 관련하여 농식품 중 방사능 검사관리 체계는 전반적으로

미흡한 실정이다. 따라서 예기치 못한 재난사고 발생 시 안전한 먹거리의 확보를 위해서

는 정확하고 신속한 검사가 가능한 기기의 개발, 시료 종류별 검사법, 기기의 특성과 검사

법의 신뢰성을 평가할 수 있는 기준물질의 개발, 그리고 비상 검역검사체계의 구축이 필

요하다.

□ 일본 원전사고 이후, 정부 유관기관들과 관련 업체들은 식품 중 방사능 오염 여부 확인을

위해 많은 인력, 장비, 시간과 노력을 투여하고 있다. 그러나 방사능 시험검사 실무자의

대부분이 비전공자여서 전문적인 지식이 부족해 관련 기관 또는 업체를 대상으로 한 지속

적이고 주기적인 실태관리와 교육이 필요하다. 또한, 결과값의 오차를 줄이고 실험자의 숙

련도를 평가하기 위해서는 국내․외에서 개발되고 있는 기준물질(RM) 및 인증표준물질

(CRM)을 이용한 결과의 신뢰성 제고도 해결되어야 할 과제이다.

□ 현재 국내의 환경시료를 시용한 숙련도시험물질 개발은 한국표준과학연구원(KRISS)에서

2007년부터 지하수, 토양, 쌀 등 다양한 시료를 이용하여 숙련도 시험 물질을 제작 보급하

고 있으며, 한국원자력안전기술원(KINS)에서도 국제원자력기구(IAEA)와 마찬가지로 교차

분석에 사용될 토양시료를 직접 제작하여 보급하고 있으나 식품이나 해수, 해양퇴적물과

같은 환경시료들의 개발은 전무한 실정이며 농·축·수산물을 이용한 교차분석은 한 번도
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시행되지 못하였다. 특히 식품에서 저준위 방사능 측정은 측정값에 대한 불확도가 높아

측정기술과 데이터 품질관리 및 신뢰성 향상이 절대적으로 필요하다. 따라서 본 연구에서

는 국내에서 일반적으로 유통되는 농·축·수산물을 이용하여 기준물질을 제조하고 숙련도

시험을 실시하여 농·축·수산물 중 방사능데이터 결과에 대한 신뢰성을 보증하고자 하였다.

□ 또한 본 연구에서는 농·축·수산물의 방사능 모니터링 뿐 만 아니라, 현장 신속검사 및 검

사방법 표준화를 위한 국내외 최신 분석법 및 연구개발 현황을 파악하고 비교하여 실험실

기반의 수입 장비를 활용하는 농산물 중심의 현행 방사능 분석법에 대한 문제점과 개선점

을 도출하고자 하였다. 또한 기준물질(RM) 및 인증표준물질(CRM)을 이용한 정성 및 정

량 분석을 통하여 이동형 장비의 성능을 검증하고, 비상시 현장에서 농식품 중 방사능 오

염 여부를 즉시 판별 할 수 있는 신속분석법을 확립하고자 하였다.

□ 아울러 동 연구에서는 일본의 원전사고 이후 우리나라 국민들의 방사능에 대한 인식은 어

떠한지, 방사능과 관련하여 어떠한 정보를 요구하는지, 정보제공을 위하여 어떠한 매체가

가장 효과적인지 등에 대한 정확한 인식조사를 실시하고, 이를 토대로 올바른 쌍방향 커

뮤니케이션 방안 마련을 위한 기초자료를 수집하고자 한다.

2. 연구개발의 범위

□ 주요 농·축·수산물 중 방사능의 정성 및 정량 분석법을 확립한다. 농·축·수산물 중 MDA

에 따른 분석시간 결정 및 정량한계를 설정하고 실험실 정밀분석 방법 개선 및 신속분석

법과의 연계기술을 도출한다.

□ 국내․외 방사능 관리체계와 현황을 조사하고, 각 국가별 방사능 분석방법을 비교․검토

하여 효과적이고 정확한 신속분석법 확립을 위한 기초 정보로 활용한다. 또한 유관기관과

관련 업체들의 식품 중 방사능 관리 체계와 현황을 조사하여 현행 관리 체계의 문제점을

파악하고 보완․개선점을 찾고자한다.

□ 후쿠시마 원전사고와 방사능 관련 국민 인식조사를 실시하여 방사선 및 방사능에 대한 기

본 지식정도와 일본 원전사고의 영향에 대한 국민들의 우려 정도, 관련 정보를 습득하는

정보창구와 정보원의 신뢰도, 요구되는 정보 등을 파악하여 올바른 정보제공 및 쌍방향

커뮤니케이션 방안 마련의 기초자료로 활용하고자 한다.

□ 장비하드웨어, 검출기를 위한 차폐용기, 아동장치 및 분석프로그램 등을 개발하여 농식품

용 방사능 현장 검사 장비를 개발한다. 수입 장비와 개발 장비의 성능을 비교하고 현장

적용실험 및 실험실 교차분석에 활용한다.

□ 감마선 검출기 및 분석프로그램을 이용한 분석 절차서를 개발하고 농·축·수산물 검역 장

소에서 분석법 현장평가를 통해 현장 신속검사 매뉴얼을 개발한다. 기존 수입 장비와 새

로 개발된 이동형 방사능 측정 장비를 활용하여 국내에서 유통되고 있는 국산 또는 수입

농식품의 방사능 오염 여부를 모니터링하고 이들 결과를 비교․검토하여 개발 장비의 성

능을 평가하고 현장에서의 방사능 오염 여부 측정 시 사용될 신속분석법을 개발하고 기존

의 분석법과 비교한다.



16

□ 농·축·수산물에 대한 기준물질(RM) 또는 인증표준물질(CRM)을 개발하여 실험자의 실험

오차를 줄이고 숙련도를 확인하는 방법으로 사용한다. 또한 식품은 종류에 따라 밀도가

다르므로 표준선원과 측정시료 사이의 오차를 줄이기 위해 유사한 물성의 식품 기준물질

(RM) 또는 인증표준물질(CRM)을 활용하여 밀도에 의한 오차를 줄여 결과값의 신뢰성을

제고한다.
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3. 연구개발의 목표 및 연구개발 수행내용

□ 제1세부

과제별
구분
(연도)

연구개발목표 연구개발 수행내용

1

세부

과제

(한국

원자력

연구원)

1차년도

(2013)

Ÿ 실험실 정밀 분석법 개선 및 신속

분석법과의 연계기술 도출

Ÿ 시중에 유통중인 휴대용 검출기 현

황 및 문제점 도출

Ÿ 실험실 정밀 분석법 개선을 위한

교정선원 summing effect 효과 보

정기술 개발

Ÿ 실험실 정밀 분석법 개선을 위한

밀도보정 기술 개발

Ÿ 신속분석법과의 연계도출을 위한

교정 선원 이용 밀도 및 summing

효과 동시 보정기술 개발

Ÿ 실험실 간 교차분석

Ÿ 수입 장비 현장 신속검사와 실험실

정밀분석

Ÿ 수산물 시료 10개 품목 20 개 이상

시료 분석

Ÿ 자문회의 및 진도점검회의 개최

Ÿ 업계, 학계, 정부, 연구계를 포함한

자문회의 개최 및 의견 청취를 통

한 과제 점검 및 일부 내용 추가

연구

Ÿ 주관 및 협동과제 모두 참석하는

진도점검회의 3회 이상 개최, 각

협동 과제간 수시 진도 점검회의

및 실험실간 교차분석 수행 일정

조절

Ÿ 방사능 분석관련 워크숍 2회 개최

2차년도

(2014)

Ÿ 방사능검출하한치에 따른 분석시간

결정과 정량한계 설정, 불확도 요

인 산출

Ÿ 검출하한치에 따른 분석시간 최적

결정

- 목표 MDA기준을 설정하고 이에

따른 측정시간 결정

Ÿ 정량한계 설정

- 정확성과 정밀도가 포함되어 있

으며 LOD로부터 3배 또는 3.3배로

인위적으로 정함

Ÿ 불확도 요인 산출

- 계측에 의한 불확도가 크나

Cs-134와 같이 동시합성이 일어나

는 경우 이에 의한 불확도가 가장

큰 영향을 줄 수 있음

Ÿ 직접법을 이용한 전처리법 절차화

및 RM 이용 교차분석

Ÿ 전처리법 절차서 구축

- 비상시 현장에서 적용가능한 직

접법 절차서 구축

Ÿ 제2협동에서 개발된 RM 이용 실험

실간 교차분석

- HPGe를 이용한 정밀분석과 개발

장비(NaI)를 이용한 분석 및 비교

평가

Ÿ 수산물 시료 방사능 분석
Ÿ 실험실 정밀분석을 이용한 수산물

10개 품목 20개 시료 분석

Ÿ 기술자문위원회 및 과제 진도관리
Ÿ 년2회 이상 자문회의 개최 및 3회

이상 과제 진도 관리
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과제별
구분
(연도)

연구개발목표 연구개발 수행내용

1

세부

과제

(한국

원자력

연구원)

3차년도

(2015)

Ÿ 주요 농·축·수산물 중 방사능의 정

성 및 정량 분석법 확립

Ÿ 방사성요오드(131I)와 방사성 세슘

(134Cs, 137Cs)의 규제치 초과 여부

를 신속하게 현장에서 검사·분석할

수 있는 정성·정량 분석법 확립

Ÿ 평상시 및 비상시 동시 사용 가능

한 검출 장비의 운용방법 확립

Ÿ 농식품 중 방사능 실험실 확인검사

연계 현장 신속검사 매뉴얼 개발

(시료채취, 분석 및 평가절차서 포

함)

Ÿ 농·축·수산물 검역 장소에서 분석

법 현장평가

Ÿ 기준물질과 실제 농식품 중 방사능

비교 분석

Ÿ 수산물 중 방사능 검사법 현장적용

및 신뢰성 확인

Ÿ 수산물 중 방사능 신속 검사법의

현장 적용 실험

Ÿ 수산물 시료 10개 품목 20개 이상

시료 분석

Ÿ 국내외 농식품 중 방사능 검사관리

현황 조사를 통한 개선방안 마련

Ÿ 국내 및 국외분석 방법, 규제방법,

검사현황 등을 통한 개선안 마련

Ÿ 외산 장비 및 국산 장비를 활용한

정성·정량 분석법 확립

Ÿ 자문회의 및 진도점검회의 개최

Ÿ 산업계, 학계, 정부, 연구계를 포함

한 자문회의 개최 및 의견 청취를

통한 과제 점검(년 2회 이상)
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□ 제1협동

과제별
구분
(연도)

연구개발목표 연구개발 수행내용

1

협동

과제

(네오

시스

코리아)

1차년도

(2013)

Ÿ 방사능 분석장비 전자부 및 차폐체

설계 및 분석프로그램 개발

Ÿ 식품 방사능 현장 분석장비 자료

조사

- 국내 기술현황 및 특허 분석

- 국외 기술현황 및 특허 분석

Ÿ 이동형 방사능 분석장비 설계

- NaI(Tl) 및 HPGe 검출기 겸용

- 이동형 차폐체 및 카트 설계

- MCA 및 운용프로그램 설계

Ÿ 식품분석 DB 프로그램 개발

- DB 프로그램 설계

- DB 프로그램 제작 및 운용평가

2차년도

(2014)

Ÿ NaI(Tl) 검출기형 분석장비

Prototype 제작 및 성능 검증

Ÿ 이동형 차폐체 및 카트 제작

- 차폐체 및 카트 안전해석

- 차폐체 및 카트 Prototype 제작

- 차폐체 MDA 평가

Ÿ NaI(Tl) 검출기형 분석장비 개발

- 일체형 프리앰프 개발

- NaI(Tl)용 MCA 개발

- 시험용 운용 프로그램 제작

- NaI(Tl)용 Prototype 제작

- CRM 및 RM 시료를 이용한 성

능검증 및 보완

Ÿ 방사능 분석장비 분석 프로그램 설

계

Ÿ 상용 방사능 핵종분석 프로그램 분석

- 상용프로그램(IAEA, Genie2K,

GammaVision 등) 분석

- 핵종분석 알고리즘 정립

Ÿ 핵종분석 프로그램 설계

- 핵종분석 프로그램 개념 설계 및

플로우 차트 작성

- 프로그램 세부 메뉴 결정

- 프로토콜 및 데이터 포맷 정립

- 분석보고서 포맷 정립

- 식품분석 DB 프로그램과 연동

Ÿ HPGe 검출기형 분석장비 설계

Ÿ NeoGMA MCA 설계

- NaI(Tl) 및 HPGe 검출기 겸용

- 디지털형 MCA 설계

Ÿ HPGe 검출기형 분석장비 설계
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과제별
구분
(연도)

연구개발목표 연구개발 수행내용

1

협동

과제

(네오

시스

코리아)

3차년도

(2015)

Ÿ HPGe 검출기형 분석장비 시제품

제작 및 성능 검증

Ÿ NeoGMA MCA 개발

- 계측 및 신호처리용 DPP 개발

- Li-ion 내장 배터리 적용 : 최장

8시간 독립 사용

- NaI(Tl) 및 HPGe 검출기 겸용

일체형 MCA 개발

- 상용제품과의 성능 비교평가

Ÿ NeoGMA 프로그램 제작

- 감마핵종분석 한글프로그램

- 장비제어, 측정, 교정, 핵종분석,

저장, 보고서 출력 등 기능 구현

- 식품분석 DB 프로그램과 연동

- 프로그램 매뉴얼 작성

Ÿ HPGe용 Prototype 제작

- HPGe 검출기형 분석장비

Prototype 제작

- CRM 시료를 이용한 성능 평가

Ÿ 시제품 제작

- 차폐체 및 카트 시제품 제작

- NaI(Tl) 및 HPGe 검출기 겸용

이동형 방사능 분석장치 시제품

제작

- CRM 및 RM 시료를 이용한

성능 검증

- 한국표준과학연구원 제작 RM

시료 측정 및 비교평가

Ÿ 현장적용 실험

- 국립농산물품질관리원

- 삼성웰스토리

Ÿ 방사능 검사장비 시제품 제작 및

특허 출원

Ÿ 특허출원 : 2건

Ÿ 대한방사선방어학회 2015년 추계학술

대회 전시
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□ 제2협동

과제별
구분
(연도)

연구개발목표 연구개발 수행내용

2

협동

과제

(한국

표준

과학

연구원)

1차년도

(2013)

Ÿ 농·축·수산물 생체시료를 이용한

기준물질(RM) 개발(I)

Ÿ 세슘-137 등 감마핵종을 포함한

농, 수, 축산물 기준물질제조

Ÿ 농산물(쌀) 기준물질 (고/저준위 1

품목, 총 2종)

Ÿ 축산물(쇠고기) 기준물질 (고/저준

위 1품목, 총 2종)

Ÿ 수산물(대구) 기준물질 (고/저준위

1품목, 총 2종)

Ÿ 숙련도시험실시

2차년도

(2014)

Ÿ 농·축·수산물 생체시료를 이용

RM (II)

Ÿ 세슘-137 등 감마핵종을 포함한

농, 수, 축산물 기준물질제조

Ÿ 농산물(밀가루) 기준물질 (고/저준

위 1품목, 총 2종)

Ÿ 축산물(분유)기준물질 (고/저준위

1품목, 총 2종)

Ÿ 수산물(굴) 기준물질 (고/저준위 1

품목, 총 2종)

Ÿ 숙련도시험실시

Ÿ 농산물건조시료를 이용 CRM 의

개발

Ÿ 농산물(밀가루) 인증표준물질

(CRM) 제조, 1 품목

3차년도

(2015)

Ÿ 농·축·수산물 생체시료를 이용

RM (III)

Ÿ 세슘-137 등 감마핵종을 포함한

농, 수, 축산물 기준물질제조

Ÿ 농산물(옥수수) 기준물질 (고/저준

위 1품목, 총 2종)

Ÿ 축산물(계란)기준물질 (고/저준위

1품목, 총 2종)

Ÿ 수산물(해초류) 기준물질 (고/저준

위 1품목, 총 2종)

Ÿ 숙련도시험실시

Ÿ 축산물건조시료를 이용 CRM 의

개발

Ÿ 축산물(닭고기) 인증표준물질

(CRM) 제조, 1 품목

Ÿ 수산물건조시료를 이용 CRM 의

개발

Ÿ 수산물(멸치) 인증표준물질(CRM)

제조, 1 품목
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□ 제3협동

과제별
구분
(연도)

연구개발목표 연구개발 수행내용

3

협동

과제

(방사선

보건원)

1차년도

(2013)

Ÿ 기존 수입 장비를 이용한 축산물중

방사능 신속분석법의 적용성 검증

Ÿ 기준물질 정성분석 및 정량분석 4종
완료

Ÿ 수입 및 국내 축산물에 대한 정성분
석 및 정량분석 : 10개 품목 30개 시
료 완료(4 협동과제 공동)

Ÿ 기존 장비를 이용한 현행 검사방법
및 신속분석법 비교 분석: 완료

Ÿ 국내·외 방사능 검사관리 현황조사
Ÿ 국내·외 방사능검사 유관 기관의 검
사관리 현황 조사 및 문제점 파악:
보고서 반영

2차년도

(2014)

Ÿ 축산물 중 방사능 신속분석법 확립

Ÿ 수입 장비 및 국내 개발 장비(NaI)를
이용한 축산물 방사능 비교 분석 :
기준물질 5종 완료

Ÿ 국내/수입 축산물 및 농림수산물 시
료에 대한 HPGe 분석 : 10개 품목
30개 시료 분석 완료(4 협동과제 공
동)

Ÿ 동일한 시료에 대하여 NaI 분석하고
방보원에 맞게 매뉴얼을 작성함으로
써 현장 활용을 위한 기반 마련

Ÿ 가축 근육부위를 구분(전지, 후지, 배
최장근 등)하여 핵종 주요 침착부위
분석 기반자료 확보

Ÿ 실험실간 교차분석을 통한 방사능 신
속분석법 확립: 완료

Ÿ 안정적 핵종분석을 위한 신형 말리넬
리 보정용기 개발(국내 특허출원)

Ÿ K-40농도를 이용한 천일염 생산년도
감별법 개발(국내 특허출원)

Ÿ 원전사고 지역 국가의 방사능검사 관

리 현황조사

­ 원전사고 지역(일본)의 방사능 검사법,
문제점 및 신속 대응체계 등 조사(학
술계): 보고서 반영

3차년도

(2015)

Ÿ 방사능 실험실 확인검사 연계 현장

신속검사 매뉴얼 검증

Ÿ 수입 장비 및 국내 개발 장비(HPGe)
를 이용한 축산물 중 방사능 비교 분
석 : 기준물질 5종 분석 완료

Ÿ 국내/수입 축산물 중 방사능분석 :
11개 품목, 156종 시료 완료(누적)

Ÿ 방사능 현장 신속검사 및 실험실 확
인 검사결과 비교 분석 : 교차분석
완료

Ÿ 시료채취, 전처리 및 분석방법, 검사
기관간 역할 및 체계, 절차 등 표준
화 완료

Ÿ 안정적 핵종분석을 위한 신형 말리넬
리 보정용기 개발(국제 특허출원)

Ÿ 안정적 핵종분석을 위한 신형 말리넬
리 및 소형 측정병 겸용 보정용기 개
발(국내 및 국제 특허출원)

Ÿ K-40농도를 이용한 천일염 생산년도
감별법 개발(국제 특허출원)

Ÿ 방사능 재난사고 대비 농식품 검사기

관의 신속검사 대응 매뉴얼 마련

Ÿ 신속검사법 위기대응 매뉴얼 마련:
매뉴얼 확립 및 정책제안 자료 제공
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□ 제4협동

과제별
구분
(연도)

연구개발목표 연구개발 수행내용

4

협동

과제

(한국

소비자

원)

1차년도

(2013)

Ÿ 기존 실험실 장비를 이용한 농산물

중 방사능 신속분석법의 검증 및

이동형 장비를 이용한 농산물 중 방

사능 비교 분석 : 기준물질 및 인증

표준물질(8종)

Ÿ 2협동 과제에서 개발한 농,수,축산

물 RM(고준위 및 저준위) 6종에

대한 결과값 비교분석

- 기존 국내외에서 개발된 인증표준물

질 2종(쌀CRM, 현미CRM)에 대한

결과값 비교분석

Ÿ 시중 유통 중인 수입 및 국산 농식

품 방사능 모니터링 결과, 검출된

제품을 대상으로 결과값 상호 비교

분석

Ÿ 국내 및 수입 농산물 중 방사능 분

석 : 10개 품목 30개 시료

Ÿ 수입 및 국내 유통되는 차류 10개

품목 30개 시료 분석

Ÿ 국민 다소비 농식품인 커피, 버섯, 배

추, 소금 및 원전주변 토양 시료 등에

대한 추가 모니터링 : 92개 품목 192

개 시료 (계획서 외 추가 목표)

Ÿ 검출제품을 대상으로 장비, 분석시간

별 MDA 비교분석

Ÿ 원전사고 지역(국외)의 방사능 검사

법, 문제점 및 신속 대응체계 등 조

사

Ÿ 일본 후생노동성, 소비자청, 방사선의

학총합연구소와 간담회 및 세미나 개

최 (3혐동과 공동수행)

Ÿ 국내 방사능검사 민간기관의 검사관

리 현황조사 및 문제점 파악

Ÿ 방사능분석 유관기관에 대한 실태점

검 및 인증표준물질 교차분석

2차년도

(2014)

Ÿ 기존 실험실 장비를 이용한 농산물

중 방사능 신속분석법의 검증 및

이동형 장비를 이용한 농산물 중 방

사능 비교 분석 : 기준물질 및 인증

표준물질(6종)

Ÿ 현행 실험실기반 방사능 측정장비

와 외산 이동형 장비를 이용한 농

산물 중 방사능 측정 결과값 비교

분석

Ÿ 2협동 과제에서 개발한 농,수,축산

물 RM(고준위 및 저준위) 6종에

대한 결과값 비교분석

Ÿ 국내 및 수입 농산물 중 방사능 분

석 : 10개 품목 30개 시료

Ÿ 국내 유통 중인 일본 수입 주류(청

주) 10개 품목 30개 시료

Ÿ 국민 다소비 농식품인 현미, 맥주, 소

스류, 어묵 및 화장품 등에 대한 추가

모니터링 : 71개 품목 141개 시료 (계

획서 외 추가 목표)

Ÿ 국외(미국)의 방사능 검사법, 문제

점 및 신속 대응체계 등 조사

Ÿ 미국 방사능 검사법 및 신속대응체

계 등 조사

Ÿ 수도권 거주 소비자(300명 이상)를 대

상으로 원자력 및 방사능 안전 관련 소

비자 인식조사

Ÿ 방사능 안전과 관련한 올바른 정보제

공 및 쌍방향 커뮤니케이션 방안제

시를 위한 기초자료 수집(설문조사

등)
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과제별
구분
(연도)

연구개발목표 연구개발 수행내용

4

협동

과제

(한국

소비자

원)

3차년도

(2015)

Ÿ 수입 장비 및 국내 개발 장비(NaI,

HPGe)를 이용한 농산물 중 방사능 비

교 분석 : 기준물질 및 인증표준물질(6

종)

Ÿ 이동형 방사능측정 외산장비(Food-

screen)와 국내개발 이동형 장비(NaI)

를 이용한 농산물 중 방사능 측정 결

과값 비교분석

Ÿ 2협동 과제에서 개발한 농,수,축산물

RM(고준위 및 저준위) 종에 대한 결

과값 비교분석

Ÿ 국내 및 수입 농산물 중 방사능 분석

: 10개 품목 30개 시료

Ÿ 수입 및 국내 유통되는 농산물 10

개 품목 30개 시료

Ÿ 검출제품을 대상으로 장비, 분석시간

별 MDA 비교분석

Ÿ 국민 다소비 농식품인 버섯과 수입 식

품(메밀국수, 훈제연어 등) 및 화장품

등에 대한 추가 모니터링 : 46개 품목

94개 시료 (계획서 외 추가 목표)

Ÿ 기준물질 교차분석 수행(2 협동과

제 주관)

Ÿ 수산물(제1세부과제), 축산물(제3협동과

제) 시료의 신속분석법 교차 검증

Ÿ 방사능분석 유관기관에 대한 실태점

검 및 검출시료, 인증표준물질 교차분

석

Ÿ 국내 개발 장비(NaI, HPGe)를 이용한

농산물의 방사능 신속분석법 개발

Ÿ 비상시 신속․정확하게 분석 가능한

분석법 개발

Ÿ 방사능 안전과 관련한 올바른 정보제

공 및 쌍방향 커뮤니케이션 방안 강

구

Ÿ 2차년도 설문조사 결과를 바탕으로

리스크커뮤니케이션 방안 강구

Ÿ 전문가 자문회의 및 포럼 등 개최
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제 2 장  국내·외 기술개발 현황

제 1 절 국내·외 관련 기술현황

1. 방사능 분석법 관련 기술 현황

현재 우리나라의 경우 식품공전 상에 식품 중 유해물질 시험법(방사능)에 따라 식품 중 감마

선 방출 방사성 핵종 확인 및 방사능 시험을 실시하고 있다. 분석은 다중파고분석기 또는 고순

도 게르마늄 검출기(HPGe)로 측정된 표준선원의 방사능 에너지 피크에 대응하는 동위원소를

검체의 방사능 피크에너지와 대조하여 동위원소표로부터 방사성 핵종을 확인한 후 각 핵종에

대한 방사능을 측정하는 방법으로 시료의 전처리(직접법, 건조법, 회화법) 측정용기(1L 마리넬

리비이커)에 넣고 측정시간을 최소 10,000초로 하여 감마선 방사성 핵종(131I, 134Cs, 137Cs)을 분

석하도록 하고 있다. 미국의 경우 우리나라와 마찬가지로 고순도 게르마늄 분광기를 사용하여

식품 중 감마선 방출 방사성 핵종을 확인하고 있다. 분석은 식품의 가식부 최소 400 mL를 시

료로 하여 사용하도록 하며, 혼합 감마 표준물질을 사용하여 핵종별 에너지와 효율 보정하여

사용하도록 하고 있다.

원전사고가 발생했던 일본의 경우도 비가식부를 제거한 나머지를 검체로 하여 고순도 게르

마늄 검출기(HPGe)를 사용하도록 규정하고 있다는 점에서 우리나라의 검사법과 유사하다. 하

지만 후쿠시마 원전사고 이후 일본은 자국에서 생산․출하 되는 다양한 종류의 농·축·수산물에

대한 신속한 방사능 측정이 요구되어 고순도 게르마늄 검출기를 통한 정밀 분석 이전에 먼저

NaI 검출기를 사용하여 비교적 짧은 분석시간 동안 시료의 방사능 오염 여부를 스크리닝 하였

다. 이때 방사능 측정치가 현행 일본 식품 방사능 기준치(방사성 세슘) 100 Bq/kg의 1/5인 20

Bq/kg 아래인 경우 해당 식품을 시중에 유통 시키고, 20 Bq/kg 이상인 경우 HPGe 검출기로

정밀 측정 후 방사능 오염 정도와 시장 유통 여부를 결정하도록 하였다.

2. 농식품 현장 방사능 측정장비 관련 기술 현황

가. 국내외 관련특허 현황

NaI(Tl) 검출기와 HPGe 검출기를 호환하여 사용할 수 있는 이동형 방사능 측정장비 및 분

리형 차폐체 기술에 대하여 KIPRIS/WIPS 특허 DB에 등록된 특허 중 2013. 9. 30.까지 공개된

4개국(한국, 미국, 일본, 유럽연합) 특허를 분석하였다. 분석 결과, 방사능 측정장비의 경우 주

요 연관 특허는 한국 1건, 미국 17건, 유럽 4건 및 일본 1건으로 조사되었으며, 이 중 유사성이

있다고 판단이 되는 특허는 2건이었다. 또한 분리형 차폐체 기술의 경우 한국 1건, 미국은 1건,

유럽 0건 및 일본 1건으로 조사되었으며, 이 중 유사성이 있다고 판단이 되는 특허는 2건이었

다.
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분야
등록번호

(등록일)
발명의 명칭 기술요약 관련성

이동형 방사능

측정장비

10-0372755

(2001.09.15.)

다기능 방사성

감마핵종분석기

및 측정장치

한국수력원자력

주식회사,

한국전력공사

관련없음

10-0925560

(2001.09.15.)

3차원 이동 가능

한 검출기를 구

비하는 방사선

측정 장치

한국수력원자력

주식회사,

한국원자력연구

원

관련없음

분리형 차폐체

기술

10-0889286

(2009.03.11)

보론 및 납이 함

유된 폴리에틸렌

방사선 차폐제

및 그 제조방법

한국원자력연구

원
관련없음

10-0395886

(2003.08.13)

감마핵종분석기

의 방사선 차폐

체

한국수력원자력

주식회사,

한국전력공사

관련없음

표 2.1. 관련 특허 분석 결과

국내외 특허분석 결과, 방사능 분석 관련 특허는 다수 존재하나 농식품 전용 이동형 방사능

측정장비 관련 특허가 거의 없으며 특히 HPGe 검출기를 이용한 이동형 신속 검사장비는 전무

한 것으로 파악되었다.

나. 국내외 관련제품 현황

현재 국제적으로 판매되고 있는 이동형 방사능 식품오염 신속검사장비는 Canberra사의 Foo

dScreen(http://www.canberra.com/products/radiochemistry_lab/pdf/FoodScreen-SS-C39444.pd

f)과 Ortec사의 FoodGurard(http://www.ortec-online.com/Solutions/Food-Water-Environmenta

l-Monitoring.aspx)가 대표적이다. 이들 분석장비는 NaI(Tl) 검출기 기반의 방사능 검사장비에

이동형 카트를 적용한 것에 불과하며 장비 무게의 대부분을 차지하는 차폐체가 160∼200 kg

정도의 일체형으로 제작되어 개인의 이동 및 현장분석이 사실상 불가능하다.
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회사/제품명 주요 특징

(미국) Canberra/FoodScreen

Ÿ 검출기: 2” × 2” NaI detector

Ÿ MDA : 20 Bq/L @ Cs-137 (4분)

Ÿ 측정범위 : 40 ∼ 3000 keV

Ÿ 차폐방식/두께: 납/38∼ 42 mm

Ÿ 전원공급 방식: 배터리 구동방식

Ÿ 무게 : 약 200 kg

Ÿ 가격 : 6,000만원/대

(미국) Ortec/FoodGuard

Ÿ 검출방법: 3” × 3” NaI detector

Ÿ MDA : 15 Bq/L @ Cs-137 (10분)

Ÿ 측정범위 : 40 ∼ 3000 keV

Ÿ 차폐방식/두께: 납/30 mm

Ÿ 전원공급 방식: 배터리 구동방식

Ÿ 무게 : 약 160 kg

Ÿ 가격 : 4,500 만원/대

표 2.2. 현재 판매중인 이동형 방사능 식품오염 신속검사장비

이와는 별도로 탁상용 식품오염검사기는 전 세계적으로 10개 정도 제품이 판매 중이나, 거의

대부분이 NaI(Tl) 검출기 전용 장비이며 비표준 시료 용기의 사용 및 얇은 차폐체 두께 등으

로 인해 이동형 방사능 식품오염 신속검사에는 적합하지 않은 실정이다. 후쿠시마 사고 후 국

내에 일부 회사에는 NaI 기반 장비를 판매하고 있으나, 식약처 식품 공전에서 HPGe 장비를

공식적으로 제시하고 있기 때문에 제도 개선도 동시에 병행 되어야 사용할 수 있는 실정이다.

특히 판매되는 제품들에 대한 신뢰성 확보를 위한 농식품 인증 물질들이 개발되어 있지 않아

서 식품 분석용으로 국내에 사용되는데 제한이 있는 실정이다.
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제조사 모델명 제품사진 검출기 비고

Kromek

(영국)
Quant for GR1

Conventional

scintillator

큐세이프

(한국)
QSF803-A

NaI(Tl)

45 mm

킴스유비큐

(한국)
TN100B-15

NaI(Tl)

Ø25x25mm

Shanghi BESEN

Instrument

(중국)

BS9711
NaI(Tl)

(크기 확인 불가)
핵종분석 불가

Berthold

(독일)
LB200

NaI(Tl)

Ø25x25mm

Radiansa

(영국)

Bio-Scout detects

Radioactivity in

Foods

NaI(Tl)

Ø50x50mm
납 차폐체 없음

Mirion

(미국)
SPIR-Quanta

NaI(Tl)

Ø75x75mm

SEA

(독일)

EL 25 Foodstuff

Counter

NaI(Tl)

Ø25x25mm

ATOMTEX

(벨라루스)
AT1135

NaI(Tl)

Ø25x40mm

HIDEX

(핀란드)

TRIATHLER

BECQUEREL

FINDER

NaI(Tl)

Ø50x50mm

표 2.3. 현재 판매중인 탁상형 식품오염검사기
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3. 농식품 기준물질 및 인증표준물질 관련 기술 현황

국제 무역에서 각 나라에서의 시험 및 교정결과에 대한 신뢰성을 보증하기 위하여 국제표준

기구(ISO)는 국제적으로 통용될 수 있는 교정 및 시험 결과의 상호 인정제도를 실시하고자 노

력하고 있다. 따라서 이러한 문제를 해결하기 위하여 1990년 ISO/IEC Guide 25를 발간하였고,

품질보증 분야의 발전이 거듭되면서, ISO/IEC Guide 25를 수정한 ISO/IEC Guide 17025를 발

간하였으며 이 가이드는 규정된 요건에 의거하여 운영하고 있음을 입증할 수 있는 시험 및 교

정기관의 신뢰성을 높여주는데 큰 역할을 하고 있다. 이러한 목적을 달성하기 위한 방편으로

시험 및 교정기관들과 다른 기관간의 협력을 활성화하고, 정보 및 경험의 교류, 규격 및 절차

의 조화에 도움을 줄 것으로 예상하고 있으며 숙련도 시험을 수행하여 국가표준체계의 확립상

황을 점검하고 국내 측정기관의 능력을 향상하기 위하여 숙련도 시험은 필수적으로 수행하여

야 한다. 2011년 초의 후쿠시마 원전 사고로 인해 지구촌이 방사능의 재앙으로부터 자유로울

수 없게 된 이후 국내에 유통되는 농·축·수산물 중 방사능에 대한 국민들과 관심과 우려가 몹

시 크다. 따라서 농·축·수산물 중에 포함된 방사성동위원소에 대한 정기적인 측정 및 분석을

통한 감시가 정기적으로 여러 연구기관에서 수행되고 있다. 그러나 발표된 결과물에 대한 신뢰

논란이 끊이지 않고 있으며, 신뢰성 결여로 국내 수입되는 농·축·수산물에 대한 시민단체 및 국

민의 불신감이 상존한다.

방사능분석과 측정에 대한 검사기관의 분석능력, 결과에 대한 품질시험은 1998년 이후 한국원자

력안전기술원의 국내교차프로그램으로 진행되고 있으나 정도 관리에 필요한 방사능측정용 표준물질

개발 및 보급이 제때 이루어지지 못하고 있는 실정이다. 환경시료(토양, 퇴적물, 해수, 어류)들을 이

용한 방사성동위원소분석용 인증표준물질의 개발은 일찍이 선진국(NIST, NPL)과 국제기구(IAEA,

IRMM)등에서 시작되었고, 국내에는 대부분 이들 국가 및 기구로부터 제작된 표준물질을 구매하여

직접 이용하거나 Running Standard Material을 만들어서 구입한 표준물질을 이용하여 정량하여 사

용하고 있다.

현재, 국내의 환경시료를 이용한 숙련도시험물질 개발은 한국표준과학연구원(KRISS)에서 2007년

부터 지하수, 토양, 쌀 등 다양한 시료를 이용하여 숙련도시험 물질을 제작 보급하고 있으며, 한

국원자력안전기술원(KINS)에서도 국제원자력기구(IAEA)와 마찬가지로 교차분석에 사용될 토양시

료를 직접 제작하여 보급하고 있으나 식품이나 해수, 해양퇴적물과 같은 환경시료들의 개발은 전무

한 실정이며 농축수산물을 이용한 교차분석은 한 번도 시행되지 못하였다.

방사능분석용 기준물질들은 다양한 물질들이 흔히 사용되고 있으며 이들 시료 표준물질의 갖추어

야 할 조건은 먼저 화학분석 대상 환경시료의 매질과 동일하거나 물리․화학적으로 동일 또는 유사

한 구조를 가진 것, 둘째 표준물질로 사용하기 위하여 채취된 물질이 균질화 되어 있어야 할 것이

다. 일반적으로 농·축·수산물에 존재하는 자연 및 인공방사성 핵종은 극미량으로 존재하므로 방사능

농도는 아주 낮고, 시료의 종류에 따라서 농도범위도 서로 다르다. 특히 식품에서 저준위 방사능측

정은 측정값에 대한 불확도가 높아 측정기술과 데이터 품질관리 및 신뢰성 향상이 절대적으로 필

요하다. 따라서 본 연구에서는 국내에서 일반적으로 유통되는 농·축·수산물을 이용하여 기준물질을

제조하고 숙련도시험을 실시하여 농·축·수산물 중 측정된 방사능데이터의 결과에 대한 신뢰성을 보

증하고자 한다. 본 과업을 통하여 제조된 감마방사성 동위원소 측정용 농·축·수산물 기준물질

은 동 과제에서 개발하고자 하는 신속측정방법과 측정 장비를 이용한 방사성동위원소 측정

에 있어서 데이터의 결과에 대한 신뢰성을 보증하고 분석기관간의 교차분석 및 정도관리에 활용되
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어 방사능 유해성분 시험/분석기관의 신뢰성 있는 과학적 결과 제시를 통한 국민의 막연한 불안

감 해소 크게 도움이 될 것으로 사료된다.

4. 리스크 커뮤니케이션 관련 기술 현황

리스크 커뮤니케이션은 위해정보 교류과정을 뜻하며 위험이 발생하였을 경우 그 규모와 미

치는 영향, 중요도, 관리방안에 대한 정보를 교환하고 인식하는 과정을 통해 문제에 대한 해결

책을 제공하는 일련의 과정을 말한다. 기존 연구들에서는 원활한 소통을 위해서는 대중별 인식

을 고려하여 정보를 전달해야하고 관련 전문가와 일반 대중과의 관점 차이와 인식의 차이를

이해하도록 노력해야하며, 일반 대중의 위험에 대한 인식과 요구되는 정보를 바탕으로 지속적

인 최적화의 중요성을 강조하였다. 또한, 리스크 커뮤니케이션의 활성화를 위해서는 이해 당사

자(국민, 소비자)들이 직접 참여할 수 있도록 관심을 파악하고, 지속적인 조사와 연구를 통한

안정적인 정보매체 확보를 위해 노력해야한다고 하였다. 선행 연구에서는 특히 식품, 의약품과

관련한 위해 문제가 발생하였을 때 이와 관련하여 국민과의 위해정보교류를 위해서는 우선 국

민들의 인식을 정확하게 파악․분석하고, 용어 사용시 표준화된 언어를 사용하도록 하며, 주요

정보 전달 매체가 언론인 점을 감안하여 정보 제공에 있어 각 언론은 정확한 정보 전달의 역

할에 충실해야함과 더불어 관련 정보들은 국민들이 쉽게 이해할 수 있는 수준의 정보로 제공

되어야 한다고 제시하였다.
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제 2 절 현행 방법 문제점과 개선 방향

1. 식품 방사능 분석의 한계점과 문제점 분석 및 개선 방향

현재 우리나라의 식품 중 방사능 물질의 오염 여부를 판단하는 식품 방사능 분석법은 주변

국가 또는 국내 원전사고 등으로 인한 방사능 관련 비상 상황이 발생하였을 경우 그대로 적용

하는데 한계가 있다. 현행 식품 방사능 분석법에 따라 검사시 시료당 측정시간이 길고, 정밀분

석이 필요한 경우 실험실로 시료를 운반하여 측정을 하기 때문에 실제로 하루에 측정할 수 있

는 시료의 수가 매우 제한적이다. 또한, 현재 국내에서 식품 중 방사성 핵종 분석에 사용되는

고순도 게르마늄 검출기가 장착된 장비들은 대부분 고가의 수입 제품이고, 차폐체의 무게로 인

해 사고 현장으로 이동이 불가능하다. 이는 단시간에 많은 양의 시료를 현장에서 모니터링해야

한다는 점에서 비상시 사용가능 한 분석법으로 어려움이 있을 것으로 판단된다. 따라서 주변

국가 또는 국내 원전사고와 같은 비상상황이 발생할 경우 국민들의 먹거리 안전성 확보를 위

해서는 신속하게 방사능 오염여부를 판단할 수 있는 방사능 신속분석법과 현장에서 직접 측정

이 국내 기술의 장비가 개발되어야 할 것이다. 특히 식품 공전에서는 HPGe 기반 반도체 검출

기만을 이용하여 분석할 수 있도록 되어 있으나, 일본의 경우 비상시 NaI 검출기를 스크린 용

으로 사용하고 있다. 따라서 우리도 비상시와 신속 분석이 필요한 경우 NaI 검출기를 이용할

수 있는 제도적 기반 마련이 시급하다.

2. 농식품 현장 방사능 측정장비 관련 기술개발 문제점 분석 및 개선방향

현재 판매되고 있는 대부분의 방사능 식품오염 검사장비는 NaI(Tl) 검출기 기반의 고정형

(또는 탁상형) 방사능 검사장비에 이동형 카트를 적용한 것에 불과하며 장비 무게의 대부분을

차지하는 차폐체가 160∼200 kg 정도의 일체형으로 제작되어 개인의 이동 및 현장분석이 사실

상 불가능하다. 농식품 현장 방사능 측정장비 개발을 위한 기존제품의 문제점 및 개선방향을

아래 표에 정리하였다.
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순번 문제점 개선방향

1
NaI(Tl) 검출기를 사용하여 정확한 핵종분

석이 어려움

Ÿ NaI(Tl) 및 HPGe 검출기의 겸용 사용

이 가능한 분석장비 개발

Ÿ 검출기의 교체 및 LN2 충전이 쉬운 장

비 설계

2
160∼200 kg 정도의 일체형 납차폐체로 인

한 이동 사용 불가

Ÿ 납차폐체를 여러 조각으로 나누고 각

조각당 무게를 10 kg 이하로 하여 이동

편의성 확보

Ÿ 납차폐체의 두께를 최대한 늘려 핵종분

석을 위한 낮은 최소검출농도(MDA)달

성

3
이동 사용이 편리한 별도의 운반장비가 존

재하지 않음

Ÿ NaI(Tl) 및 HPGe 검출기의 겸용 사용

기 가능한 이동형 카드 제작

Ÿ 납차폐체 및 검출기 등의 보관 및 이동

을 위한 보관함 제작

4
비표준형의 시료용기가 사용되어 즉각적인

교차분석이 어려움

Ÿ 시료용기를 1L 표준 마리넬리 비이커

사용

Ÿ 차폐체의 최소 내경을 1L 표준 마리넬

리 비이커로 고정

5
영문으로 되어있는 운영프로그램으로 관련

전문가만이 사용 가능

Ÿ 한글 운영 프로그램 개발

Ÿ 일반인의 사용이 가능하도록 측정 및

분석 메뉴를 시각화

Ÿ 한글 매뉴얼 및 절차서 작성

6 분석 시료 증가에 따른 정보관리가 어려움
Ÿ 식품분석 DB 프로그램 개발

Ÿ 핵종분석 프로그램과 연동

7 가격 Ÿ 외국 제품 대비 70% 수준

표 2.4. 농식품 현장 방사능 측정장비 관련 문제점 및 개선방향

3. 농식품 기준물질 및 인증표준물질개발 관련 문제점 분석 및 개선방향

국내외적으로 농식품을 이용한 방사능 측정용 기준물질 및 인증표준물질 개발 건수는 극히

제한적이다. 이는 Cs-137 등 인공방사성동위원소 측정에 유의한 농도를 함유한 농식품 재료를

쉽게 구할 수 없는 것이 주된 요인으로 작용한다. 실제로 IAEA등에서 개발한 RM의 경우 영

국의 핵재처리공장이 있는 영국의 셀라필드지역에서 채취한 시료를 이용한 RM(IAEA-381 해

수시료, IAEA 134 어류, IAEA 434 어류)들이 대부분이며, 최근 들어 EU IRMM에서 체르노빌

핵발전소영향을 받은 지역에서 채취한 열매를 이용한 인증표준물질 등이 보고되었다. 사실
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spiking 등을 통해 인위적으로 방사성동위원소등을 첨가하여 RM을 개발할 수 있으나

homogeneity 문제 등에 있어서 어려움을 겪고 있는 실정이다,

이러한 문제점과 관련하여 본 과제를 통하여 인공 방사성동위원소의 인위적인 첨가를 통한

인증표준물질 제작이 세계 최초로 이루어짐과 더불어 이에 따른 인증표준물질 제작기술 축적

은 본 과제를 통하여 얻어진 결과로서 상당한 의미를 부여할 수 있을 것으로 사료된다. 특히

제작된 시료의 균질성(homogeneity)시험에서 모든 시료의 균질도가 3%이내로 나와 ISO의 균

질도 자격조건을 만족시킨 것은 고무적인 결과로 볼 수 있으며, 국제학회발표에서 다수의 국가

들이 국내에서 개발된 인증표준물질에 대한 관심을 표명하였다. 추후 개발될 인증표준물질은

국제비교시험물질로 제공될 예정이며 이 또한 본 과제의 연구성과로 나타날 것이다. 그러나 이

러한 연구성과에도 불구하고, 인증표준물질제작기간이 1년 내외로 극히 짧아 제작된 인증표준

물질의 양과 개수가 적은 문제는 추후 우리가 고려해야할 사항임은 분명하다. 인증표준물질개

발에 소요되는 예산과 인력을 고려할 때 보다 장기적인 투자를 통하여 충분한 양을 확보하여

장기적인 수요에 대처하는 것이 바람직할 것으로 사료된다.

4. 국내 식품 안전 리스크 커뮤니케이션 문제점 분석 및 개선 방향

식품 안전과 관련하여 국민들은 자신의 건강과 직결된 문제로 매우 민감하게 받아들이고 있

으며, 뿐만 아니라 방사능 오염의 경우 장기간 위험에 노출될 수 있다는 불안감 때문에 특히

방사능과 식품안전 관련 리스크 커뮤니케이션 방안 마련이 어려운 것은 사실이다. 원전 관련

큰 사고들로 1986년 4월 체르노빌, 1979년 3월 미국 스리마일 섬의 원자력 발전소 원자로 내

장치 오작동 원자로 폭발, 2011년 3월 대지진 쓰나미로 인한 일본 후쿠시마 원전 수소폭발 등

이 있으며, 이 사건들 모두 사고 이후 정보 공개 지연과 부정확한 정보 전달로 자국민 및 주변

국가들에게 큰 불안감과 공포를 전달하였다. 과거 몇몇 방사능 및 식품 안전사고 사례들에서

경험했듯이 적절한 시기에 올바른 방법을 통한 리스크 커뮤니케이션은 국민들로 하여금 더 큰

불안감과 혼란이 초래되지 않도록 하는 최선의 방법임을 시사한다. 따라서 이해관계자들과의

소통의 오류를 줄이기 위해서 계층별, 위기 단계별, 실용적인 쌍방향적 리스크 커뮤니케이션

마련이 시급하다.
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제 3 장  연구개발 수행 내용 및 결과

제1절 농식품 중 방사능 신속분석법 개발

1. 농·축·수산물 중 방사능의 정성 및 정량 분석법 확립

가. 실험실 정밀분석 방법 개선 및 신속분석법과의 연계기술 도출

(1) 실험실 정밀분석 방법 개선28)

(가) 동시합성효과 보정기술개발

농․식품 중 방사능 농도 정량분석 시 동시합성 효과를 고려해야 할 필요성이 생긴다. 특히

세슘-134 핵종의 경우 반드시 동시합성 효과를 보정해야 하는데 현재 정밀 분석법에서는 적용

하지 않고 있기 때문에 측정 신뢰도에 문제가 생길 수 있다. 교정선원의 경우 Y-88(이트륨),

Co-60 (코발트) 등이 포함되어 있을 경우 교정선원의 동시합성 효과도 같이 보정해야 하는데

현재 정밀 분석법에서 적용하지 않고 있는 실정이다. 동시합성효과는 크게 두 종류가 있는데

하나는 random 동시합성효과이고 다른 하나는 true 동시합성효과이다. Random 동시합성효과

는 여러 핵종에서 방출된 두 개 또는 그 이상의 에너지가 검출기 분해시간 이내에 동시에 흡

수되어 합해진 에너지에서 측정되는 것으로 주로 count rate에 영향을 받는다.

그림 3.1.1.1. 동시 합성 효과

또 다른 하나는 한 핵종에서 연속적으로 두 개 또는 그 이상의 에너지가 방출될 때 일어나는

것이 true 동시합성효과이다. True 동시합성효과는 count rate와 상관이 없고 검출기와 기하학

적인 절대효율에 매우 민감하고, 특히 well 형태의 검출기에서는 반드시 고려해야 한다. 이런

동시합성으로 인하여 나타나는 현상은 원래의 peak에서 count수가 감소하는 현상뿐만 아니라

summing 효과로 다른 에너지에서 peak가 관찰되는 효과가 있다. 그림 3.1.1.1에서 보면 A신호

와 B 신호가 각각 나와야 하는데 동시에 측정되어 두 신호가 합성되어 A+B의 새로운 신호로

인식하는 것이다. 실제로 어떤 방사능 분석에서 어떻게 나타나는 지는 그림 3.1.1.2에서 보여주

고 있다.
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그림 3.1.1.2. 시료 분석 시 동시합성 효과

그림 3.1.1.2를 보면 Co-60의 경우 1173 keV와 1332.5 keV가 동시에 방출되기 때문에 두 신

호가 합성되어 2505.5 keV에서도 방사선이 나오는 것처럼 보인다. 2505.5 keV에 나온 만큼

1331.5 keV와 1173 keV에서 신호가 줄어들기 때문에 실제로 방사능 농도를 계산할 때 낮게

나오는 문제들이 발생한다. Y-88의 경우도 같은 이유로 방사능이 낮아질 수 있는 문제점들이

노출된다. 보정방법은 합성된만큼을 원래 방출되는 에너지 기여분으로 계산하면 된다. 그림

3.1.1.3에서는 식품공전 규제핵종인 Cs-134에 대한 붕괴도를 개략적으로 보여주고 있다.

Cs-134는 베타붕괴를 하여 Ba-134로 변환되는데 이때 여러 방사선이 방출된다. 이중에서 true

동시 합성에 많은 영향을 주는 것은 604.71 keV와 795.85 keV이다. 이는 검출기 분해능 이내

인 6 ps내에서 동시에 방출되고 방출률도 매우 높기 때문에 두 에너지의 합인 1400.56 keV영

역에서 동시합성 peak가 측정된다. 이때 동시합성효과를 고려하지 않고 604.71 keV와 795.85

keV를 이용한 Cs-134 방사능은 실제 값보다 낮을 수 있다.

그림 3.1.1.3. Cs-134 핵 붕괴도

Cs-134 핵종이외에도 동시합성효과를 고려해야 하는 핵종에는 Ba-133이 있다. 동시합성효과

를 고려하는 방법은 두 에너지의 합에서 나타난 peak가 정규분포를 이루고 충분히 클 때, 동시
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합성 peak 비율만큼 원래의 에너지에서 보상해주는 방법을 이용하였다. 그림 3.1.1.4에서는 포

함된 핵종 중에서 Ba-133, Cs-134에 대해서 동시합성을 고려하지 않았을 경우와 고려했을 경

우를 주어진 값과 비교한 결과를 보여주고 있다. 그림에서 보면 Cs-134 및 Ba-133의 경우는

고려하지 않았을 경우 거의 20 %의 상대차이를 보이고 있다.

0.00

0.20

0.40

0.60

0.80

1.00

1.20

Ba-133 Cs-134

W/O coincidence summing With coincidence summing

그림 3.1.1.4. 동시합성을 보정하지 않았을 경우와 했을 경우 방사능 농도 비

동시합성은 두 에너지뿐만 아니라 세 개 및 네 개 이상의 에너지가 합쳐져서 문제를 야기하

는데 문제를 간단하게 접근하기 위해서 두 에너지가 합성되는 경우를 살펴보면 그림 3.1.1.5로

표현할 수 있다.

   그림 3.1.1.5. 두 개의 에너지가 합성될 경우

그림 3.1.1.5에서 보면 첫 번째 감마에너지(A)가 검출기에 측정되고 두 번째 감마선 에너지(B)

가 검출되어 동시합성효과로 A 감마선이 없어지는 확률은 전체 구면각에서 검출기의 면적에
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비례하게 된다. 즉 검출기 지름이 6 cm, 거리가 10 cm에서 동시합성으로 A가 A+B로 갈 확률

은 4 %가 된다. 여기서 동시합성을 줄이는 하나의 방법은 검출기와 시료의 거리를 멀게 하면

거리 제곱의 역수로 낮아지게 된다는 의미이다. 그러나 그럴 경우 효율이 낮아지기 때문에 불

확도가 커지고 또 현재 시스템에서 거리를 무한정 길게 할 수 없는 문제들이 있다. 그림

3.1.1.5에 보였듯이 A가 동시합성으로 줄어드는(summing out) 양은 감마에너지 B가 총 방출되

어 검출기에서 계수되는 비에 비례하게 된다. 그림 3.1.1.5의 오른쪽 하단에 그 확률을 계산하

였다.

위에서는 A 감마에너지가 동시합성이 없을 때 N'와 동시합성을 일으키는 양은 N'×P로 표시

되고 그 양은 맨 위의 식처럼 표시된다. 따라서 동시합성 효과 때문에 줄어든 방사능 양(N)은

식의 중간처럼 표시된다. 결국 동시합성 보정인자는 맨 아래처럼 표시되고 이것은

peak(P)-to-total(T) ratio로 표시된다. 정리하면 peak-to-total ratio만 구해지면 동시합성 인자

를 보정할 수 있다는 결론을 얻을 수 있다. 먼저 효율교정 시 동시합성 핵종이 포함된 경우에

보정하는 방법은 다음과 같다. 표 3.1.1.1은 주로 효율교정용 선원으로 쓰는 표준 선원들이다.

핵종
감마선 에너지

(keV)

방사능

(Bq)

전체불확도(%)

k=2
반감기

241Am 59.54 1295 4.1 1.5786E5±2.4E2일
109Cd- 88.03 14940 4.0 462.6±0.7일
57Co 122.06 803.1 3.5 271.79±0.09일
139Ce 165.85 775.6 4.4 137.64±0.23일
51Cr 320.08 13180 3.3 27.706±0.007일
113Sn 391.69 1177 3.9 115.009±0.04일
85Sr 514.01 1146 3.8 64.849±0.004일
137Cs 661.66 995.9 3.5 1.102E4±6E1일

60Co
1173.24

1332.50
1252 3.7 1925.5±0.5일

88Y
898.04

1836.06
760.4 3.7 106.63±0.025일

표 3.1.1.1. 효율교정용 표준선원



38

표 3.1.1.1을 보면 Y-88과 Co-60이 동시합성을 일으키는 핵종들이다. 위의 표준선원을 이용할

경우 그림 3.1.1.6과 같이 동시 합성이 일어남을 알 수 있다.

그림 3.1.1.6. 교정선원에 대한 동시합성 효과

위에서 설명한 대로 Peak-to-total ratio를 구해서 보정하면 다음과 같이 교정된 효율을 구할

수 있다.

그림 3.1.1.7. 동시합성 효과 보정 효율곡선

동시합성 효과를 보정하면 600 keV 이상에서 효율이 약간 올라가는 것을 알 수 있다. 표

3.1.1.2를 보면 5∼10 % 정도 올라가는 것을 알 수 있다. 즉 동시합성 효과를 보정하지 않을

경우 600 keV 이상에는 실제 방사능 값이 높게 분석되는 결과를 얻을 수 있다. 이것은 에너지

가 높을수록 실제 값과 분석값이 차이가 남을 알 수 있다. 따라서 효율 교정 시 동시합성 효과

는 반드시 고려해야하는 과정이다.
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표 3.1.1.2. 동시합성 교정 시와 교정하지 않았을 경우 비

측정하고자 하는 시료에서 동시합성 핵종이 포함된 경우는 위에서 설명했듯이 peak-to-total

비를 이용하여 합성된 효과를 고려해 주면 된다. 그럴 경우 그림 3.1.1.4에 나타냈듯이 차이가

약 15 % 이상 차이도 보임을 알 수 있다.

(나) 밀도보정기술개발27)

농․식품 시료의 겉보기 밀도를 살펴보면, 커피가 0.3 g/cm3 근처를 보이고, 소금 1.4 g/cm3

등으로 다양하게 존재한다. 표 3에서 식품시료의 겉보기 밀도를 보여주고 있다. 여기에서 오이,

대구곤, 홍합은 생체를 분쇄한 것이고, 배추, 오징어, 감자는 건조 분쇄한 것이며, 나머지 시료

들은 시중에 일반적으로 판매되는 상태를 분쇄 및 균질화한 것이다.

표 3.1.1.3. 다양한 식품시료(환경시료 포함) 겉보기 밀도 변화

그림 3.1.1.8에서는 다양한 밀도에 따른 에너지별 효율의 변화를 보여주고 있는데, 그림

3.1.1.8(a) 에서는 Cd-109 (88.04keV)의 효율값의 변화를 보여주고 있다. 밀도 0.3 g/cm3에서의

효율과 1.5 g/cm3에서의 효율의 상대차이는 43% 정도였다. 그림 1-8(b)를 보면 특히 일반 환
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경시료에서 관심 핵종인 Cs-137 (661.62 keV)의 경우 효율은 18 %의 차이를 보여 밀도에 대

한 효과가 상당히 컸다. 그림에서는 표시되지 않았지만, Co-60 (1332.51 keV)의 경우에서도 9

% 정도 차이를 보였다. Co-60 (1332.51 keV) 핵종보다 높은 에너지 영역에서는 차이가 적을

것으로 예상되나 대부분 저준위 시료에서 측정되는 저 에너지 영역에서는 그 차이가 크기 때

문에 밀도에 대한 보정은 저준위 환경시료에서 반드시 필요함을 실험으로 확인하였다.

그림 3.1.1.8. 밀도에 따른 효율변화 (a) 좌: Cd-109 의 밀도의 따른 효율교정

변화, (b) Cs-137의 밀도에 따른 효율 변화

그림 3.1.1.9. 밀도에 따른 효율변화

농․식품 시료에서 분석하는 에너지 범위 (50 ∼3 MeV)에서 밀도에 따라 어떤 변화를 보이

는지 확인하기 위해서 표준선원을 이용하여 밀도 0.8 g/cm3, 1.0 g/cm3, 1.3 g/cm3을 제작하여

실험하였다. 그림 3.1.1.9를 보면 약 500 keV 이상에서는 큰 차이가 없지만, 미만에서는 많은

차이를 보이고 있다. 그림 3.1.1.8과 3.1.1.9를 통해서 살펴보면 농․식품 시료는 밀도가 다양한

데, 현재 표준선원은 1 g/cm3만으로 교정하여 사용하기 때문에 측정결과의 신뢰성에 큰 문제
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를 발생하고 있다. 이런 실험실 정밀 분석법의 문제점인 밀도에 따른 효율 변화를 보정하는 방

법을 개발했으며 이를 신속분석법에 적용하기 위한 연계 기술을 확보하였다. 먼저 밀도에 따른

효율을 보정하는 방법은 몬테칼로 방법을 이용하여 이론적으로 보정하여 사용하는 방법이 있

었다.

① 몬테칼로 방법을 이용한 밀도보정기술

확률론적 방법인 몬테칼로 방법을 이용하여 밀도별로 먼저 효율을 구하는데, 그림 3.1.1.10에

서는 MCNP 코드를 이용하여 모사하는 방법을 보여주고 있다.

그림 3.1.1.10. 밀도별 효율변화 전산모사를

위한 검출기와 표준선원 기하학적 구조

그림에서 보면 HPGe 검출기가 내부에 있고, 외부에 마리넬리 1리터짜리 비이커가 외부를

감싸고 있는데, 밀도를 변화시키면서 50 ∼ 3 MeV에서의 효율변화를 계산하였다. 여기에 사용

한 검출기는 30 % 효율(NaI 섬광검출기 대비)를 사용하였고, 표준선원은 균일하게 분포하고

있다고 가정하였다. 밀도의 범위는 0.4에서 8 g/cm3 까지 가정하였다. 계산결과는 그림 3.1.1.11

에서 보여주고 있다.

그림 3.1.1.11. 밀도별 효율변화
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그림 3.1.1.11에서 보면 밀도별로 효율이 변하는 것을 알 수 있으며 이를 이용하면 농․식품

시료의 밀도에 따른 효율 변화를 계산해서 보정할 수 있다. 그러나 위와 같은 방법은 검출기마

다 또 시료 구조에 따라서 복잡한 MCNP 전산모사를 해야 한다는 단점이 있어서 실무 분석에

서 적용하기 매우 힘들었고, 현재 실험실 정밀 분석에서 위와 같은 방법은 잘 사용하고 있지

않다. 따라서 실험실 정밀분석 연계하여 신속분석법에서는 위와 같은 문제를 해결하기 위해 실

용적인 방법을 제시하였다.

② 외부용기를 이용한 밀도보정방법

다양한 시료의 밀도에 대한 효율보정을 위해 표준선원 원액을 이용하여 밀도 1.0 g/cm3의 표

준선원용액을 만들었다. 밀도에 따른 효율변화 효과를 실험적으로 알아보기 위해서 450㎖ 마리

넬리 비커(PE)에 겉보기 밀도 0.3 g/cm3부터 1.5 g/cm3까지의 농․식품시료를 채운 후 그림

3.1.1.12와 같은 구조로 비커를 감싸는 외부용기(acryl)에 방사능을 알고 있는 표준선원용액을

넣고 3시간씩 측정하였다. 외부용기 내에 채워진 표준선원용액의 두께는 5mm, 용액량은 250㎖

였다.

그림 3.1.1.12. 표준용기를 감싸는 외부용기 제작

③ 보정상수 결정

이 방법은 보정상수를 구하는 과정과 그 보정상수를 이용하여 밀도가 고려된 효율값을 구하

는(자체흡수 보정) 과정으로 이루어진다. 보정상수를 구하는 것은 다시 4단계로 이루어진다. 첫

번째 그림 3.1.1.13(a)와 같이 마리넬리 비커에 증류수(  g/cm3)를 이용하여 방사선원이 포함

된 표준선원용액을 만들어 측정한다. 여기서 측정한 효율값은 에너지의 함수이며 다음과 같이

표현된다;

    (1)

여기서 는 방사선표준선원이 마리넬리 비커 내에 존재한다는 의미이다. 두 번째는 그림

3.1.1.13(b)와 같이 마리넬리 비커에 표준선원이 없는 증류수만으로 시료를 제작한다. 마리넬리

비커를 감싸는 외부용기에 밀도(  g/cm3)의 증류수를 이용해 표준선원용액을 채운 후 측정

한다. 효율값은 식(2)와 같이 표현된다;
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    (2)

여기서 o는 마리넬리 비커 외부용기(outside container)에 선원이 있다는 것이다. 식(1)과 식(2)

을 이용하여 비율값을 구하면 아래와 같이 표현된다;

       

   
(3)

세 번째는 그림 3.1.1.13(c)와 같이 밀도(   ≠  g/cm3)인 표준선원용액을 마리넬리 비커에

넣고 측정하여   의 값을 구한다. 마지막으로 그림 3.1.1.13(d)와 같이 마리넬리 비커에

방사선원이 포함되지 않은 밀도(   ≠ g/cm3)의 시료를 넣고, 외부용기에는 밀도(  

g/cm3)인 표준선원용액을 넣고 측정하여    를 구하고 두 값을 이용하여     을

구하면 다음과 같이 표현된다;

         

  
(4)

(a) (b)

(c) (d)

그림 3.1.1.13. 밀도별 보정상수를 구하는 과정

        

  
≃    

  
(5)

여기서 는 0.8, 1.3 g/cm3이다. 식(5)에서 구한 값을 본 논문에서는 보정상수로 정의하였다. 밀
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도가 1.0 g/cm3 인 비율값을 보정상수로 정한 이유는 쉽게 표준시료를 제작할 수 있어서 경제

적이고 간편하기 때문이다.

(2) 교정선원 효율 보정기술개발

효율값 보정은 위에서 구한 보정상수를 이용하여 구할 수 있고 방법은 다음과 같다. 측정하고

자 하는 시료와 밀도가 동일하고 방사능이 없는 바탕(blank)시료를 마리넬리 비커에 넣고, 그

림 3.1.1.13(d)와 같이 밀도 1.0 g/cm3인 증류수를 이용하여 외부용기에 표준선원용액을 제작하

여 효율(   )을 측정한다. 식(5)와 앞에서 구한 효율값을 이용하여 밀도가 보정된 효율

(   )값을 구하면 다음과 같이 표현된다;

   ≃   ×      (6)

여기서 는 자체흡수(self-absorption)를 나타내고 있다. 위의 식(6)에서 보정된 효율값은 보

정상수와 외부용기에 포함된 표준선원용액을 이용하여 측정한 효율값만으로 쉽게 구할 수 있

다. 표 3.1.1.4에서는 밀도에 따른 비율값을 보여주고 있는데, 세 밀도에 대한 비율값들이 거의

일정함을 알 수 있었고, 특히 밀도 0.8 g/cm3와 밀도 1.0 g/cm3의 비율값은 일치하였다. 또한

세 밀도에서 비율값의 최대 오차는 1173.23 keV에서 4.17 %로 최대였다. 이 결과를 이용하여

밀도가 보정된 효율값을 구하는 식(7)에서    값 대신    값을 사용해도 상관없

음을 실험적으로 검증하였고 이 값을 보정상수로 정했다.

표 3.1.1.4. 밀도 보정을 통한 보정 효율

Energy

(keV)

Apparent

density, =0.8

(g/cm3)

Apparent

density, =1.0

(g/cm3)

Apparent

density, =1.3

(g/cm3) error, (%)

             

88.04 5.71 5.71 5.90 3.30

122.07 5.72 5.72 5.67 0.94

391.71 5.51 5.51 5.39 2.36

661.62 4.91 4.91 5.00 1.84

1173.23 4.48 4.48 4.67 4.17

1332.51 4.45 4.45 4.51 1.42

표 3.1.1.4에서는 보정상수를 이용하여 보정된 효율값과 직접 밀도별로 표준시료를 제작하여

측정한 값을 비교하고 있다. 표 3.1.1.3에서 보면 전 에너지 범위의 겉보기 밀도 0.8, 1.0, 1.3

g/cm3에서 보정상수를 이용한 값과 표준시료를 직접 제작하여 구한 값이 거의 일치함을 알 수

있었다. 밀도 1.3 g/cm3에서 두 값의 차이를 보면 보정상수의 오차와 거의 비슷한 경향을 보이

는 것을 알 수 있는데 이는 역시 저에너지에서 검출기가 민감하게 반응하는 것과 동시합성효

과에 의하여 Co-60의 1173.23 keV 에너지에서 오차가 비교적 큰 것으로 판단된다. 또한 위에

서 구한 동시합성 효과와 밀도 보정 효과를 고려해서 효율을 교정할 수 있는 방법론을 제시하

였다. 먼저 peak-to-total 비를 이용하여 동시합성 효과를 보정한 후 이것은 밀도 1이라는 가
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정에서 구한 값이다. 이것을 이용하여 밀도가 1이 아닌 시료의 경우 외부 용기를 이용하여 한

번 더 측정하는 방식으로 보정하면 신속 분석에서도 동시에 적용이 가능할 것으로 판단된다.

그림 3.1.1.14. 동시합성 효과를 고려한 밀도 보정

(2) 신속분석법과의 연계기술 도출

기존 정밀분석법에 대한 문제점과 개선점을 도출하였다. 현재 개발하려는 장비는 신속 및 비

상시 적용해야 하는 점을 고려해야 한다. 신속 분석시 검출 한계치와 불확도가 가장 큰 고려인

자이다. 본 절에서는 검출하한치에 따른 분석 시간 결정과 불확도에 대하여 연구하였고, 이에

따라서 신속분석법에 적용할 수 있는 방법을 도출하였다.

(가) 검출하한치에 따른 분석시간 최적 결정

일반적으로 환경시료에 대한 방사능 분석 시 백그라운드의 통계학적 요동으로 인해 실제로는

방사능이 존재하는 않는데도 존재하는 것으로 오인할 수가 있다. 즉 저준위 환경방사능 검출에

서는 백그라운드 계수의 통계적 요동으로 실제 시료의 방사능이 음수가 나오기도 하고 방사능

이 존재하지 않는 시료가 방사능이 존재하는 것으로 표현되기도 한다. 일반적으로 물리적인 현

상을 고려했을 때 시료의 방사능이 없다고 가정하면 평균 방사능 농도는 제로이기 때문에 음

의 값이 나올 수 없다. 그러나 실제의 현상은 그렇지가 않고 많은 저준위 환경방사능 분석에서

음의 값이 나온다. 그 이유는 백그라운드에서 기인하고 아울러 방사능이 없는 시료가 방사능이

있게 나타나기도 한다. 이런 문제점을 해결하기 위해서 많은 연구가 이루어졌다.

먼저 Currie에 의해 최초로 제기된 방법에 따라 최소검출농도(Minimum Detectable Activity,

MDA)에 대해 설명하기에 앞서 검출한계치(Lower Limits of Detection, LLD)의 개념에 대한

설명이 필요하다. 검출한계치의 경우는 계측 통계학만을 고려하여 정의된 것으로 저준위 환경

방사능 측정에서 방사능 존재여부를 나타내는 개념이다. 여기서 검출한계치는 시료의 양 또는

측정자의 숙련도, 기기의 계통오차 및 다른 우연오차를 포함하지 않는 단지 계측통계학만을 고

려한 개념이다. 여기에 최소검출농도는 실제 저준위 환경방사능 분석 시 기계의 특성, 분석방

법 및 시료의 양 또는 종류에 대한 부분을 포함하여 사용되는 개념으로 보다 포괄적이면서 실

용적인 단위이다. 따라서 대부분의 환경방사능 분석에서 MDA를 많이 사용하고 있는데 여기에
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는 검출한계치에서 사용하는 백그라운드 계측통계오차에 시료크기, 시료측정시간, 효율, 자기흡

수, 전처리 관련 회수율 및 방사능 농도에 영향을 주는 모든 인자가 들어가기 때문에 측정할

때마다 변하는 값으로 검출기의 교체 및 다른 변수가 발생하면 다시 산출해야 한다. 그러나 모

든 최소검출농도는 검출한계치를 기본으로 해서 설정되기 때문에 반드시 검출한계치 산출의

의미를 알아야 하며 그 내용은 Currie가 정립하였다.

검출한계치의 개념은 계측 통계적인 방법에 의해서 정의된다. 그림 3.1.1.15에서 그 개념을 나

타내고 있는데 Currie는 존재판정한계(LC : Critical Level), 검출한계(LD : Detection Limit), 정

량결정한계(LQ : Determination Limit) 등 세 영역으로 나누어 설명하였다.

그림 3.1.1.15. 시료의 측정계수에 따른 검출한계 판단영역

먼저 존재판정한계인 경우는 그 기준선 미만이면 존재를 의심하고 그 이상이면서 검출한계

미만이면 존재하기는 하지만 검출능력이 미약하다고 판단하였다. 검출한계 이상이면서 정량결

정한계 미만인 경우에는 존재는 확신하고 검출도 확신하는 단계로 표시했고, 정량결정한계 이

상인 경우에는 검출 및 정량결정이 확실하다고 판단하였다. 최소검출농도는 존재판정한계, 검

출한계, 정량결정한계를 기준으로 각각 구할 수 있고 여러 기관 및 국가에서 다양하게 사용되

고 있다. 즉 같은 검출기로 똑같이 측정된 값도 어떤 기준을 이용하여 최소검출농도를 구했느

냐에 따라서 다양한 값이 나올 수 있음을 유의해야 한다. 즉 어떤 기관에서는 검출한계를 기준

으로 했고 다른 기관에서는 정량결정한계를 기준으로 구했다면 이는 동일한 계수율을 가지고

도 최소검출농도가 달라진다. 어떤 기준값을 이용하여 최소검출농도를 구해도 상관은 없으며

많은 기관 및 국가에서는 입장에 따라 다양한 방법을 이용하여 최소검출농도를 산출하고 있다.

존재판정한계( : Critical Level), 검출한계( : Detection Limit), 정량결정한계 ( :

Determination Limit)값들을 이용하여 검출한계(LLD)를 설정 할 수 있다. 이렇게 설정할 경우

 ,  , 값 어떤 값을 기준으로 MDA를 구하느냐에 따라서 어떤 기관은 를 기준으로

MDA를 설정하고, 또 다른 분야는  , 또 경우에 따라서는 값을 이용하여 구하기도 한다.

그러나 대부분은 이용하여 구하고 있으며, 특수한 경우에만 다른 경우를 사용하고 있다. 또

한 을 이용하고, 신뢰구간 즉 에러범위를 5%로 이용하여     를 사용할 경우

MDA 설정에서 LLD 값으로 이용된다. 을 이용하여 MDA를 구하면 간단히 다음과 같이 표

현된다.

 ×××


×××

 
(dps) (7)

이때 계수로 이용한 식에 시간을 나눠주면 식(7)로 표현되는데 이때는 백그라운드 시간()
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및 측정시간( )이 같다는 의미이다. 만일 다르다면 식(8)과 같이 표현되어야 하고 신뢰구간 즉

에러 범위를 5 %로 가정 및     을 이용하여 구하면 다음과 같다.

 


 


 

 


 

   ×
  


 (8)

위의 식에서처럼 백그라운드 시간() 및 측정시간( )이 다를 경우는 단순히 식(7)로 표현되

지는 않는다. 따라서 적용 방법에 따라서 에러 선택에 따라서 다양한 종류의 MDA가 산출될

수 있다. 표 3.1.1.5에서는 동일한 측정에서의 어떤 MDA 식을 사용하느냐에 값의 차이를 볼

수 있다. 표에서 보면 고전적인 ortec 방법이 가장 낮고 EDF-france 방법이 가장 높다. 아래

그림에서 보였듯이 똑같은 실험방법에 따라서 측정된 결과에서 MDA는 크게 네 배까지 차이

가 나는 것을 알 수가 있다. MDA는 어떤 식과 어떤 파라미터를 설정하느냐에 따라서 다양한

값을 가질 수 있다. 여기서 고려할 점은 MDA가 낮은 것이 좋고 MDA 높은 것이 검출기의 특

성이 나쁘다고 판단할 수 있는데 이렇게 평가할 때는 같은 MDA를 이용해서 비교해야 하는

점이다. 즉 다른 MDA를 사용해서 비교하는 것은 무의미하며 실제 적용에서 가끔 이를 간과하

는 경우가 있다.

표 3.1.1.5. 감마핵종 분석에서의 MDA 종류에 따른 값의 변화

표 3.1.1.6에서 LLD와 MDA의 차이점을 설명하였다. 표에서 나타냈듯이 LLD는 단지 통계적

요동만을 나타내기 때문에 실제 측정에서 사용할 수 있는 양이 아니다. 따라서 물리적인 의미

를 갖기 위해서는 검출효율, 시료크기, 측정시간, 자기흡수 등을 모두 포함한 MDA가 필요하

다.
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검출한계 최소검출농도

- 통계적인 요동만 고려(계측통계학)

- 백그라운드 요동 및 측정시간(백그라

운드 및 샘플계측시간)

- 계측기 고유의 특성

- 검출한계로부터 유도

- 검출효율, 시료크기, 측정시간, 자기흡

수 등 통계요인에 측정시 실제 필요한

양을 표함

- 계측기 특성+계측과정을 모든 인자

포함

표 3.1.1.6. 검출한계와 최소검출농도의 차이점

저준위 시료를 계측할 경우 백그라운드 준위에 가깝기 때문에 그 계수가 단순히 백그라운드

의 요동에 의한 것인지 백그라운드와 유의한 차이가 있는 것인지를 판별하는 것이 필요하다.

이 판단을 위해서 최소검출농도를 유도하게 된다. 이때 최소검출농도 값을 기반으로 분석시간

에 대한 결정도 가능하게 된다. Currie 식을 이용한 최소검출농도는 백그라운드 및 샘플 측정

시간이 다를 때는 식(9), 같을 때는 식(10)이 된다.

  ×××

 

  




(9)

  ×××

 
(10)

여기서 ts,tb는 샘플 및 백그라운드 측정시간(s), ε는 측정효율, m은 샘플의 무게(kg)를 의미

한다. 여기서 μb는 백그라운드 계수이며 이에 따라서도 다양한 MDA를 가지게 되므로 현장 분

석시 이에 대한 고려도 반드시 필요하다. 현재 상용으로 사용하는 검출기에 대해서 백그라운드

및 샘플 측정시간이 같고 백그라운드 계수율이 0.01 cps, 0.03 cps, 0.1 cps일 경우 MDA를 계

산한 결과는 그림 3.1.1.16과 같다. 여기에서 측정효율은 30 %, 샘플의 무게는 0.5kg으로 가정

하였다. 즉 백그라운드가 낮을수록 목표 MDA에는 도달하는 측정시간이 짧아짐을 확인할 수

있다. 백그라운드와 샘플 측정시간이 다를 경우에는 식(9)를 사용하여야 하며 이에 의한 MDA

변화 추이는 그림 3.1.1.17과 같다. 여기서 백그라운드 측정시간은 24시간, 86400초로 가정하였

으며 백그라운드 계수율은 0.03cps, 측정효율은 30 %, 샘플의 무게는 0.5kg으로 설정하였다. 그

림에서 보듯이 MDA를 0.1 Bq/kg으로 유지하기 위해서는 20000초 이상의 측정 시간이 필요하

다.
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그림 3.1.1.16. 백그라운드 계수율에 따른 MDA 변화

그림 3.1.1.17. 계측시간에 따른 MDA의 변화
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그림 3.1.1.18. 실제 시료에 대한 측정시간에 의한 MDA 변화

앞서 언급하였듯이, 측정시간에 따라 어느 시료에 대한 결과값이 불검출이 될 수도 있고, 검

출값이 될 수도 있다. 이러한 이유 때문에 측정시간을 어떻게 설정해야 하는지 혼란이 있을 수

있는데 감마분석에서는 기본적으로 측정시간을 규제하지는 않으며, 앞에서 MDA를 유도하는

과정에서 확인하였듯이 목표 MDA 기준을 설정하면 그에 따라서 측정시간은 설정이 가능하다.

이러한 기준은 비상시의 경우에도 똑같이 적용하여 짧은 시간 안에 스크리닝이 가능하도록 최

소검출농도를 설정할 필요가 있다. 그림 3.1.1.18은 실제 시료에 대해 측정시간에 따른 MDA

변화를 살펴보았으며 최소검출농도를 4 Bq/kg으로 할 것인지, 1 Bq/kg 혹은 0.1 Bq/kg으로

할 것인지의 기준에 따라 계측시간이 결정된다. 예를 들어 식(1-21)으로부터 기준 MDA를 만

족시킬 수 있는 최소 계측시간은 식(11)과 같다. 여기서 Am은 목표 MDA, rB는 백그라운드 계

수율이다.

 


       (11)

최소검출농도를 낮추기 위해서는 앞에서 확인하였듯이 백그라운드 계수율을 낮추거나, 계측

시간을 늘리거나 계측기 효율이 높아야 한다. 그러나 이러한 모든 요건들은 시간과 사회적 비

용이 발생하므로 무조건 MDA를 낮추는 것이 아니라 기준값을 정하는 것이 필요하다. 원안위

고시 제2012-5호에서 제시하고 있듯이 요오드의 경우 검출하한치가 1 Bq/kg, Cs의 경우 0.1

Bq/kg이다. 그러나 이는 매우 낮은 수치이며 이를 달성하기 위해서는 많은 사회적, 경제적 비

용이 소요된다. 또한 이 값만으로 검출, 불검출을 논함으로써 방사능 농도 분석에 여러 어려움

이 생기게 된다. 따라서 앞서 말하였듯이 기준치의 1/10 정도를 보고기준치를 설정함으로써 이

러한 문제점을 어느 정도 해결할 수 있으며 신속분석의 경우에는 검출하한치의 경우에도 보고

기준치의 1/10정도를 정함으로써 낮은 검출하한치를 달성하기 위해 필요한 시간과 예산을 줄



51

일 수 있다.

(나)정량한계 설정

정량한계(LOQ)는 보통 ‘적절한 불확도 수준으로 결정가능한 분석물의 최저농도’로 정의되고

있다. IUPAC (International Union of Pure and Applied Chemistry)와 ACS(American

Chemical Society)에서 설명하고 있는 LOQ의 개념이란 ‘어느 주어진 분석 절차에 따라서 합리

적인 신뢰성을 가지고 정량 분석할 수 있는 가장 작은 양의 농도나 질량이다.’(The smallest

concentration or the mass which can be qualitatively analysed with reasonably by a given

procedure) 즉, 정량한계가 검출한계와 비교하여 가장 큰 차이점은 정확성과 정밀도가 포함되

어 있는 것이다. 검출한계는 위에서 보듯이 통계적인 개념(α오류와 β오류)을 갖고 있으나 정량

한계(LOQ)는 이런 통계적인 개념보다는 LOD로부터 3배 또는 3.3배라고 인위적으로 정하는 경

우가 많다. 식(1-16)으로부터 정량결정의 상대오차를 10 %라 가정하여 kQ의 값을 10으로 할

경우 LQ의 값은 다음과 같다.

  







   (ts≠tB)

  




 (ts=tB)

즉, 정규성(normality)과 α와 β의 값이 0.05라고 주어지면 LOQ는 검출한계의 3.04배이다. 예를

들어 MDA를 0.1 Bq/kg으로 설정할 경우 정량한계는 약 0.3 Bq/kg이 된다.

(다)불확도요인 산출

불확도는 측정결과와 관련하여 측정량을 합리적으로 추정한 값의 산포특성을 나타내는 파라

미터이다. 불확도는 오차를 포함하는 개념이며 오차는 측정결과에서 측정량의 참값을 뺀 값으

로 정의하는데 일반적으로 측정에는 여러 가지 불완전한 요소가 있으므로 측정결과에는 오차

가 있게 마련이다. 그러나 오차는 하나의 이상적인 개념이며 실제로는 오차를 정확하게 알 수

는 없다. 오차는 우연성분과 계통성분의 두 성분으로 분류되는데 우연오차는 영향량들이 시간

적, 공간적으로 예측할 수 없게 변동하므로 생긴다. 이러한 변동의 영향을 우연효과라 하며, 이

는 측정량을 반복 관측할 때 그 값이 변동하는 원인이 된다. 우연오차를 보정할 수는 없으나,

관측의 횟수를 늘림으로써 줄일 수는 있다. 이 우연오차의 기댓값은 영이다. 계통오차도 우연

오차와 마찬가지로 제거할 수는 없지만 줄일 수는 있다. 만일 계통오차가 알 수 있는 영향량의

효과로부터 생긴다면 그 효과는 정량화될 수 있다. 이 효과가 측정에서 요구되는 정확도에 비

하여 무시할 수 없을 정도의 크기라면, 이를 보상하기 위하여 보정값이나 보정인자를 적용할

수 있다. 보정을 한 후의 계통효과에 의한 오차의 기댓값은 영이라고 본다.

측정결과의 불확도는 측정량의 값을 정확하게 알 수 없다는 사실을 반영하고 있다. 측정결과

는 이미 알고 있는 계통효과를 적절하게 보정하여도 역시 추정값에 불과하다. 왜냐하면 계통효

과에 대한 완전한 보정이 불가능하고 또 우연효과가 있기 때문에 항상 불확도가 존재하기 때

문이다. 그러나 적절한 보정을 한 후의 측정결과는 우연히 측정량의 값에 매우 가까울 수 있으

며 이에 따라 오차는 작아질 수 있다. 그러나 측정결과의 불확도는 매우 클 수도 있기 때문에

불확도와 오차는 구별하여야 한다.
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실제적으로 측정에서는 다음과 같은 불확도의 요인이 존재한다.

1) 측정량에 대한 불완전한 정의

2) 측정량에 정의에 대한 불완전한 실험

3) 대표성이 없는 표본추출

4) 측정 환경의 효과에 대한 지식 부족 및 환경조건에 대한 불완전한 측정

5) 아날로그 기기에서의 개인적인 판독

6) 기기의 분해능과 검출 한계

7) 측정표준과 표준물질의 부정확한 값

8) 외부자료에서 인용하여 데이터 분석에 사용한 상수와 파라미터의 부정확한 값

9) 측정방법과 측정과정에서 사용되는 근삿값과 여러 가지 가정

10) 외관상 같은 조건이지만 반복적인 측정에서 나타나는 변동

측정불확도의 산정방법은 다음과 같다. 수학적으로 표현 가능한 함수식으로 표현되는 측정 모

델링을 세우고 표준불확도를 구한다. 이 때 방사능 측정 시 발생할 수 있는 표준불확도 성분을

모두 구하는데 A형 표준불확도와 B형 표준불확도가 있다. A형 표준불확도는 반복 측정값의

빈도분포에 근거한 확률밀도함수에서 구하는 반면, B형 표준불확도는 기존의 정보 또는 문헌

을 통해 측정값이 가질 수 있는 확률밀도함수를 가정하여 구할 수 있다. 이후 합성불확도를 구

하는데 다음과 같은 불확도 전파원리에 의해서 각각의 표준불확도와 감쇄계수를 구하여 합성

한 값이다.

    



  






 

 

여기서 포함인자 값을 구하기 위해서 유효자유도를 구하는데 보통 유효자유도가 10의 값이

넘어가면 정규분포를 따른다고 가정하고 약 95% 신뢰구간에서 포함인자 k는 2로 가정한다. 마

지막으로 확장불확도를 구하고 최종적으로 측정값±확장불확도(k=2, 약 95% 신뢰구간)로 표현

한다.

위의 절차에 따라 감마핵종분석시 불확도 산정을 어떻게 하는지 살펴보면 다음과 같이 비방

사능 계산식으로터 측정모델링을 설정한다.

 ××× × × × × ×



여기서 N은 전체 카운트, m은 질량(m), ε는 검출기 효율, γ는 감마방출률, ts는 측정시간을

의미한다. 그리고 K1부터 K5는 샘플과 측정사이의 시간 경과에 따른 보정, 측정시간 중 붕괴

보정, 샘플 자체 흡수 보정, 우연동시합성효과 보정(random summing), 동시합성효과 보정(true

summing)을 의미한다. 여기에 불확도 전파원리를 적용하면 식은 다음과 같다.
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
    


   


  


   


  


 


 


 


  


 


 





 





 





 





 







 

즉, 합성불확도는 다음과 같이 표시할 수 있으며 각각의 의미는 다음과 같다.



 
 




  


  


  


  


  







: 측정계수에 의한 불확도




: 무게 측정 등 전처리에 의한 불확도




: 효율 교정등에 의한 불확도




: 방출률에 의한 불확도




: 측정시간에 의한 불확도




: 각종 붕괴 및 자체흡수에 의한 불확도

각 항목에 대한 불확도를 도출한 후 합성표준불확도의 유효자유도를 산출하는데

Welch-Satterthwaite 식으로부터 구할 수 있다. 이 때 유효자유도가 10 이상이면 정규분포로

가정할 수 있다.

 


  









 

(Welch-Satterthwaite formula)

이로부터 포함인자 k의 값을 선택할 수 있으며 보통 약 95%의 신뢰구간으로서 k=2의 값을

선택한다. 이 포함인자를 합성표준불확도에 곱하여 확장불확도 U를 구하고 이를 측정결과 표

기 시 표시한다.

  × 

  ±

실제 예로서 200g의 차가버섯을 450ml 마리넬리 비이커에 넣고 고분해능 게르마늄 반도체 검

출기로 Cs-137을 측정하였을 때 불확도를 평가하였다. 각 불확도의 값들은 예를 든 것이며, 실

제 값들은 계측기별, 시료별, 핵종별 달라진다. 먼저 시료 전처리에 의한 불확도 즉 


는
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다음과 같은 과정을 통해 계산할 수 있다.

① 10회 반복 측정시 불확도(A type)

· 10회 반복측정 표준편차 : 4.7mg

· 표준불확도(평균표준편차) :


 

② 분동교정성적서(B type)

· ±0.019mg, 95%신뢰수준일 경우 k=2이므로




 

③ 합성표준불확도

·    

④ 상대합성불확도

·


 ×   × 

효율교정에 의한 불확도는 다음과 같이 구할 수 있다.

① 상업용 소프트웨어를 이용하여 curve fitting에 의한 보정 불확도(A type) = 1.8%

② 표준용액 제조 불확도(B type) = 1.5%

③ 상대합성불확도

·    

방출률에 의한 불확도는 핵자료 데이터를 이용할 수 있으며 0.2%로 둔다. 붕괴보정에 의한

불확도에 대해서는 대부분의 경우에는 무시 가능하나 Cs-134와 같이 동시합성이 일어하는 핵

종에 대해서는 이에 대한 고려가 필요하다. 동시합성에 의한 불확도는 계측거리, detector의 크

기 등에 의해 조금씩 달라질 수 있으나 약 5%로 가정한다. (참고: “True Coincidence

Summing Correction in Gamma Spectroscopy, Wissam Chehade, 2007) 그러나 Cs-137의 경

우에는 동시합성이 일어나지 않으므로 무시할 수 있다. 측정계수에 의한 불확도 


는

   로부터 구할 수 있다. 여기서 는 net counts, 는 total counts, 는

background counts이다. 는 2023, 는 610 카운트로 가정하였을 경우 다음과 같이 상대합

성불확도를 구할 수 있다.




× 


 

각 불확도 항목에 대한 계산이 끝나면 다음과 같이 합성불확도를 산출한다.



 
×  




  


  


  


  


  


 × 

 ×         ×  
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유효자유도를 고려하여 정규분포로 가정이 가능할 경우, 대부분의 경우 약 95% 신뢰구간으

로 k=2로 하여 확장불확도를 계산하고 그 결과를 포함하여 결과값을 표기하게 된다.

  ×  ×  

 ×××


×××


 

 ±  ±(약 95% 신뢰구간, k=2)

각각의 불확도 인자들을 살펴보면 위에서 언급하였듯이 주로 계측에 의한 불확도가 가장 큰

영향을 미친다. 그러나 Cs-134와 같이 동시합성을 일어나는 핵종의 경우에는 동시합성에 의한

불확도가 가장 큰 영향을 줄 수 있다.

정밀 분석의 경우는 시간을 길게 측정하기 때문에 불확도 요인 중 가장 큰 계측에 불확도를

줄일 수 있다. 비상시는 불확도를 줄이기보다는 가능한 신속하게 분석해야 하기 때문에 계측에

대한 불확도가 커진다. 이것을 동시에 고려해서 신속분석법을 고려해야 한다. 즉 최소검출농도

와 불확도를 동시에 고려해서 신속 분석법에 적용해야 한다.

나. 농·축·수산물 중 방사능의 정성 및 정량 분석법 확립

 농·축·수산물 중 방사능 오염도를 신속 분석하기 위해서는 분석 시간에 따른 최소 검출 방사

능 농도(MDA)변화를 검토해야 한다. 식품공전에서 제시하는 핵종 3개에 대해서 시간에 따른

MDA 변화는 그림 3.1.1.19과 같다. 개발된 NaI 검출기를 이용하여 20분을 측정했을 경우에는

Cs-137에서 MDA가 밀도에 따라서 다른데 밀도가 0.5 g/cm3 일 때 약 18 Bq/kg을 보였다. 밀

도가 1.0 g/cm3일 때는 10 Bq/kg정도를 보였다. 따라서 정성 분석은 NaI의 검출기는 20분 이

내로 측정하여 방사능 유무를 18 Bq/kg 수준에서 측정하고 그 이상의 측정시간을 이용하면 측

정 시간에 따라서 최소검출농도 즉 정량 한계를 낮출 수 있다. 측정시간을 10,000초로 했을 경

우에는 정량한계를 4 Bq/kg으로 낮출 수 있다. Cs-137를 제외한 다른 핵종은 Cs-137보다 낮

기 때문에 Cs-137를 기준으로 판단하면 된다.

개발된 HPGe의 검출기를 이용하여 20분을 측정했을 경우에는 Cs-137에서 MDA가 2.97

Bq/kg을 보였다. 즉 2.97 Bq/kg 이하의 농도는 측정이 어렵다는 의미이다. 측정시간을 10,000

초로 했을 경우에는 1.2 Bq/kg으로 낮아져 보다 정밀하게 측정할 수 있다. 개발된 두 장비

NaI 와 HPGe 검출기를 이용하여 정성 및 정량 분석을 위해서는 다음의 절차를 이용하면 된

다. 우선 방사능 존재여부는 휴대가 간단하고, 운영이 편한 NaI 검출기를 이용하여 현장에서

20분 측정하여 18 Bq/kg 이상의 방사능을 찾아낸다. 보다 낮은 방사능의 존재 유무, 즉 정성

분석을 위해서는 HPGe를 검출기를 이용하여 같은 20분 측정시간 기준 2.97 Bq/kg 방사능 유

무를 신속히 판단할 수 있다. 따라서 두 개발된 검출기를 이용하여 20분 이내에서 방사능 존재

유무, 즉 정성 분석을 수행하고 정량 분석이 필요한 경우에는 측정 시간을 10,000초 또는 더

늘려서 정밀하게 분석하면 된다. 이에 대한 운영 매뉴얼은 부록에 수록하였다.
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그림 3.1.1.19. 시간에 따른 최소방사능 농도(MDA) 변화 (밀도=1g/cm3)

2. 농·축·수산물 신속분석법 확립

□ 농·축·수산물의 신속분석법 확립을 위해 신속 분석 장치가 개발되기 전에는 실험실 정밀

분석 장치(HPGe)를 이용하여 모니터링 하여 오염 실태를 조사하였다. 개발된 이동형 분석

장치와 신속분석법을 표준선원을 이용하여 1차 검증을 하고, 2차로 정밀 분석 시료 중 일

부 높게 검출된 시료와 자연핵종인 K-40을 이용하여 농산물은 4협동(소비자원)에서 정밀

분석과 신속 분석한 결과를 비교하였다. 수산물과 축산물도 주관기관인 한국원자력연구원

과 방사선보건연구원에서 각각 2차 검증을 하였다. 또한 2협동에서 개발한 인증물질을 이

용하여 최종적으로 농·축·수산물 신속분석법을 검증하였다. 식품공전에서는 현재 HPGe 기

반 분석법만을 이용하게 되어 있으나, 일본과 같이 NaI 분석법도 비상시 사용해야 할 것이

다. 따라서 개발된 분석법과 개선된 방법은 국가에 정책제안을 하였다.

(1) 농산물

(가) 시료선정

□ 일본 원전사고 이후 후쿠시마 주변 지역에서 재배되는 농산물 및 식품에서 방사능이 검출

되고 있으며, 일본 후생노동성 자료1)에 따르면 농산물 중에서 주로 버섯, 쌀, 콩, 죽순, 커

피, 차(茶)류 등에서 방사능이 검출되었다. 현재 각 국에서는 일본산 수입 식품에 대한 방

1) 일본 후생노동성 홈페이지(http://www.mhlw.go.jp) 'Information on the Great East Japan Earthquake'
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사능 검사 강화, 수입 금지 등의 조치를 취하고 있다. 우리나라에서도 식품의약품안전처를

중심으로 일본산 수입식품에 대한 방사능 검사가 이루어지고 있으며, 일본 수입 농산물 중

13개현 27개 품목의 수입이 잠정 금지되었고, 수산물의 경우 8개현의 모든 수산물의 수입

이 금지되고 있다.

□ 일본에서 수입되는 식품 중 방사능이 검출되었던 농산물인 쌀을 주원료로 하는 청주와 국

내 수입 맥주 중 가장 높은 시장점유율을 차지하고 있는 일본 맥주에 대한 국민들의 방사

능 오염에 대한 관심이 증가하고 있어 이들 품목에 대한 모니터링을 함께 진행하였다. 또

한, 농산물을 비롯한 천연유래 성분이 다수 포함된 화장품에 대한 소비자들의 불안감도

증가함에 따라 일본산 수입 화장품에 대한 모니터링도 실시하였다.

□ 우리나라 또는 주변국가에서 원전사고가 발생할 경우 국내 농식품 중 가장 소비가 큰 쌀

의 방사능 오염여부에 대한 국민들의 우려가 커질 것이다. 2012년 우리나라 식품군별 일

인당 1일 섭취량(1,435.5g) 중 평균 섭취량이 가장 높은 식품은 백미로, 1일 평균 백미 섭

취량은 전체 섭취량의 11.6%(169.8g)을 차지하고 있다. 따라서 방사능 안전사고가 발생하

게 되면 도정 전 상태인 현미의 안전성 확보가 중요한 문제로 대두될 것이다. 그러므로

국내에서 생산되는 쌀(현미)에 대한 방사능 모니터링과 함께 비상사태 시 신속분석을 위

한 검사 장비 및 시험법이 마련 되어야할 것이다.

□ 성인에 비해 영유아는 방사능에 노출되면 치명적인 영향을 받을 수 있어 영유아 식품의 안

전성 문제는 민감하게 받아들이게 된다. 그 예로 최근 한 분유회사에서 수입·판매한 뉴질랜

드산 산양분유에서 미량의 방사능이 검출되면서 소비자들은 해당제품에 대한 불신이 확산되

었고 불매운동이 일어나는 결과를 초래하였다. 이와 같이 소비자들은 영유아 식품 안전에

대한 관심과 우려가 높기 때문에 이러한 불안감 해소를 위해서 보다 엄격한 관리와 조사가

요구되고 있다.

□ 원전사고 후 몇 년이 지났지만 최근 방사능 오염수가 바다로 유출되고 있다는 일본의 공

식적인 발표 이후, 수산물뿐 만 아니라 천일염과 같이 바다에서 생산되는 모든 식품에 대

한 국민들의 불안감이 증가하였다. 천일염은 체내 삼투압유지 등 중요한 역할을 담당하고

있어 인체 내에 필수적인 것으로 수산물과 더불어 안전성에 대한 지속적인 관리와 감독이

필요하다. 또한, 원전 주변지역 또는 일본 해양 방사능 유출과 관련하여 국내 해안가 주변

논·밭의 토양을 주기적으로 모니터링 하는 것이 필요하며, 실제 원전 사고 발생 시 현장에

서 식품뿐만 아니라 토양 등의 방사능 검사를 실시하여 2차 오염(농수산물, 지하수 등)을

예측, 판단하는 중요한 자료로 활용 가능할 것이다.
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표 3.1.2.1. 방사능 모니터링 시료

과제연도 품목
품목수
(개)

시료수
(개)

구입처 원산지

1차년도

차(茶)류(녹차 등) 10 30 오픈마켓 등 일본

커피,배추,버섯 5 15 대형마트 등 국내,수입

분유 6 18 대형마트 국내,수입

천일염 16 48 생산지 국내

명태내장(알,곤이) 42 42 전통시장 등 수입

원전시설주변 토양 23 69 원전주변 국내

합계 102 222

2차년도

주(酒)류(맥주,청주) 15 45 대형마트 등 일본

현미 20 60 (오픈마켓)생산지 국내

소스류(간장 등) 14 14 대형마트 등 일본

어묵 22 22 마트, 생산지 국내,수입

화장품 10 30 백화점 등 일본

합계 81 171

3차년도

버섯류(송이버섯 등) 21 63 전통시장 등 국내,수입

메밀국수 13 39 오픈마켓 일본

훈제연어 10 10 대형마트 등 수입

화장품 12 12 백화점 등 일본

합계 56 124

총 합계 239 517

(나) 측정 장비 및 기기

① 감마핵종분석기

○ 미국 Ametek Ortec(EG&G) 사에서 제작

○ 고순도 게르마늄 검출기(HPGe) 및 고전압공급기, 증폭기, 다중파고분석기, 컴퓨터, 주

변기기로 구성

○ NaI 검출기에 대한 상대효율이 60 %을 가지는 고순도 게르마늄(HPGe) 검출기 사용

○ 측정된 스펙트럼은 Ametek Ortec 사의 Gamma-Vision 프로그램을 이용하여 분석

② 이동형 감마핵종분석기

○ 1협동 네오시스코리아에서 제작

○ 고순도 게르마늄 검출기(HPGe) 및 NaI 검출기 및 이동형 카트, 컴퓨터, 주변기기로

구성

○ 측정된 스펙트럼은 Canberra 사의 Genie-2000 프로그램을 이용하여 분석
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그림 3.1.2.1. 감마핵종분석기(HPGe-왼쪽)과 이동형감마핵종분석기(NaI-가운데,HPGe-오른쪽)

(다) 에너지 및 효율 보정

시료의 감마핵종 측정에 앞서 감마핵종분석기의 에너지 및 효율 보정을 시행하였다. 한국

표준과학연구원(KRISS)에서 공급하는 241Am (59.54 keV), 109Cd (88.04 keV), 57Co (122.06

keV), 139Ce (165.86 keV), 51Cr (320.07 keV), 113Sn (391.69 keV), 85Sr (514.01 keV), 137Cs

(661.66 keV), 88Y (898.04, 1836.06 keV), 60Co(1173.24, 2332.50 keV) 등의 교정용 혼합용액

표준선원이 채워진 1 L 마리넬리 비이커를 이용하여 감마핵종분석기의 에너지 및 효율을 보

정하였다. 에너지 및 효율 보정에 대한 아래 그림에 나타내었다. 또한, 에너지 분해능

(FWHM)은 60Co 핵종에서 방출되는 1.33 MeV의 감마선 에너지에 대하여 1.80 keV이다. 에

너지 및 효율에 대한 보정 스펙트럼 분석은 Ametek Ortec 사의 Gamma-Vision 또는

Canberra 사의 Genie-2000 프로그램을 이용하였다.

Radionuclide Energy(keV) Radionuclide Energy(keV)

241Am 59.54 85Sr 513.99

109Cd 88.04 137Cs 661.62

57Co 122.07 88Y 898.02

139Ce 165.85 60Co 1173.23

51Cr 320.07 60Co 1332.51

113Sn 397.71 88Y 1836.01

그림 3.1.2.2. 감마핵종분석기의 에너지 및 효율 보정

(라) 시료 준비 및 방사능 측정
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① 방사능 모니터링 진행 계획

○ 시장조사 및 자료수집 → 시료구입 및 채취 → 전처리 → 측정 → 결과분석 및 해석

국내에서 유통되고 있는 국내․외 농산물 및 가공식품과 토양을 구입․채취하여, 기존 실

험실 기반 외산 장비(고순도 게르마늄 검출기)를 이용한 방사능 오염 모니터링을 실시하였

다. 또한, 식품의 방사능 오염 모니터링뿐만 아니라 과제 목표인 수입산 장비와 국산 개발

이동형 장비의 성능 비교를 위해서는 먼저 실험자의 숙련도 검증이 필요하다. 모든 실험은

실험실 조건에서, 기본적인 방사능 측정 절차인 식품공전에 고시된「일반 시험법」의 ‘식품

중 유해물질시험법’ 중 ‘방사능 시험’법에 준하여 진행하였다. 숙련도는 한국표준연구원에서

제작한 기준물질(RM) 및 국외 인증표준물질(CRM) 등을 측정하여 실험자의 측정값과 공인

된 결과 값을 비교하여 검증하였다. 한편, 동일한 전처리과정으로 준비된 동일한 시료의 기

존 수입산 장비와 새로 개발된 이동형 장비의 측정한 값을 비교하여 개발된 이동형 장비의

성능을 평가 가능하고, 이와 더불어 기존 분석법을 기초로 한 비상시 식품 중 방사능 신속분

석법을 확립하고자 하였다.

② 방사능 모니터링 개요

○ 시장조사 및 자료수집

∙ 식약처 등에서 공개하는 수입 식품 목록2)과 일본 후생노동성에서 제공하는 자료3)를

기초로 시중에 유통 중인 일본산 식품 또는 방사능 검출이 빈번했던 품목으로 시료

선정

∙ 국내산 식품 또는 토양 중 방사능 오염과 관련한 연구보고서 및 논문 조사, 수집

○ 시료구입 및 채취

∙ 국내 대형마트, 오픈마켓 또는 현지 등에서 구입

∙ 전국 원자력시설 주변 논, 밭 토양 및 해안지역 토양(모래) 채취

○ 전처리

∙ 분석을 수행하기 전 측정할 시료들을 전처리 과정을 통하여 측정하기 적합한 상태로

만듬

∙ 덩어리로 되어있거나 작은 알갱이로 유통되는 버섯류, (차 茶)류, 소금 등의 경우 시

료를 파쇄한 후 1 L 마리넬리 비이커에 다짐봉으로 잘 충전하였고, 분말형태(예: 커

피, 분유 등)인 경우 분쇄 없이 바로 측정용기에 압축하여 넣고 충전 시료 상면이 수

평이 되도록 고르게 충전한 후 밀봉, 시료 무게 측정

∙ 채소류 등의 식품류(예: 배추)의 경우 식용으로 쓰이지 않는 부분(뿌리, 토사, 고엽

등)을 제거하고 물로 세척할 경우 물기를 제거(가능한 물 사용을 자제)한 후 시료를

잘게 절단 하여 직접법일 경우 분쇄기로 갈아 측정용기에 다져 넣고, 건조법일 경우

무게 보정을 위해 건조 전 무게를 측정하고 상온에서 하루 건조 시킨 후 건조기에

열풍 건조(110 ℃, 24 시간)시켜 다짐봉으로 측정용기에 상면이 수평이 되도록 고르

게 충전한 후 밀봉, 시료 무게 측정(직접법으로 검체 전처리에서 거품이 일어날 경

우 에틸알코올 수방울 첨가)

∙ 토양은 한국원자력안전기술원에서 매년 시행하는 '전국환경방사능 조사'에 보고된

토양 감마핵종 측정 방법을 사용하여, 무게 보정을 위해 건조 전 토양의 무게를 측

2) 식품의약품안전처 홈페이지 일자별 일본산 수입식품에 대한 결과 보고

3) 일본 후생노동성, 원자력규제위원회(NRA, Nuclear Regulation Authority) 일자별 식품 방사능 오염 측정 결과
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정한 후 막자사발로 충분히 분쇄 후 망목 2 mm의 체(sieve)로 토양입자를 선별하고

110 ℃에서 24시간 건조 후 1 L 마리넬리 비이커에 다짐봉으로 상면이 수평이 되게

고르게 충전한 후 밀봉, 시료무게 측정

○ 측정

∙ 고순도 게르마늄 검출기를 사용하여 실험실 조건에서 측정

∙ 식품의 측정시간은 식품 공전에 제시된 10,000초로 측정하였으며, 토양은 한국원자력

안전기술원에서 매년 시행하는 '전국환경방사능 조사'에 보고된 토양 감마핵종 측정

방법을 사용하여, 80,000초 동안 측정

차(茶)류 분쇄 충전1 충전2

차(茶)류 분쇄 충전1

배추 절단 분쇄 충전

배추 건조1 건조2 분쇄 충전

표고버섯 분쇄 충전1 충전2

목이버섯 분쇄 충전1 충전2

분유 충전1 충전2

그림 3.1.2.3. 시료 전처리 방법
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(마) 감마핵종 방사능 측정 결과 및 고찰

① 국내․외 농산물, 수입식품 및 원자력시설 주변 토양 감마핵종 방사능 측정 결과 및 고

찰

○ 국내 유통 되고 있는 농산물 및 수입식품 등 239개 품목 517개 시료에 대하여 감마

핵종의 검출 여부를 측정하였다

○ 일본산 차(茶)류는 10개 품목 중 녹차 1개와 현미녹차 1개 제품에서 미량의 방사성

세슘(134Cs, 137Cs)이 검출되었고, 그 이외의 차(茶)류와 일본에서 제조된 커피, 수입 커

피와 국내산 배추는 MDA(최소검출한계) 이하로 방사성 요오드와 세슘이 불검출 되

었음을 확인하였다. 미량의 방사성 세슘이 검출된 2개 품목의 일본산 차(茶)류는 측정

시간에 따른 MDA 변화를 관찰하기 위해서 추가로 실험을 진행하였다.

○ 일본 원전 사고 이후 후생노동성과 일본 원자력규제위원회에서 발표한 식품의 방사능

오염 측정 결과를 검토해 보면 버섯류에서 식품 기준치를 초과하는 방사성 물질이

검출되었으며, 식약처에서 2002년부터 2008년까지 한국원자력연구원을 주관기관으로

연구 수행한 “식품 중 방사능 오염 실태조사” 보고서 결과에서도 버섯류에서 높은 수

치의 방사능이 검출되었다. 1차년도 모니터링 시료인 중국산 표고버섯에서는 MDA

이하로 방사성 요오드와 세슘이 검출되지 않았으며, 목이버섯에서는 미량의 (1

Bq/kg 이하) 방사성 세슘(137Cs)이 검출되었다. 3차년도 송이버섯 등 21개 품목 버섯

류 모니터링에서는 능이버섯 2개 품목(1.8～25.5 Bq/kg), 석이버섯 1개 품목(23.7～

27.5 Bq/kg), 차가버섯 4개 품목(14.7～36.9 Bq/kg)에서 방사성 세슘(137Cs)이 검출되었

으며, 나머지 품목들은 MDA 이하로 방사성 요오드와 세슘이 검출되지 않았다.

○ 시중에 유통 중인 산양분유, 또는 일반 조제분유 6개 품목 18개 시료에 대한 방사능

측정 결과, 뉴질랜드에서 생산된 두 가지 품목(산양분유 2개 품목)에서 기준치보다 낮

은 미량의 방사성 세슘(137Cs)이 검출(1～3 Bq/kg)되었고, 134Cs과 131I의 경우 MDA이

하로 불검출되었다. 그 밖에 산양분유 1개 품목과 일반조제분유 3개 품목에서는 방사

성 요오드, 세슘(134Cs, 137Cs, 131I) 모두 MDA이하로 불검출되었다.

○ 국내 원전시설 주변 토양에 23개 품목에 대한 감마핵종 검출시험 결과에서는 일부 토

양에서 1～8.3 Bq/kg 정도의 방사성 세슘(137CsI)이 검출되었다. 토양의 경우, 원자력

안전위원회고시 제2012-5호 ‘원자력이용시설 주변의 방사선환경조사 및 방사선환경영

향평가에 관한 규정’ 제 6조에 명시된 환경방사능 분석을 위한 검출하한치는 5

Bq/kg-dry로 이를 넘은 시료는 2개였다.

○ 전라도 지역(영광, 신안군) 국내 천일염(소금), 국내산 현미, 수입산 명태내장(알, 곤

이), 일본산 주류(맥주, 청주) 및 소스류(간장 등)와 메밀국수, 일본 화장품, 국내·수입

산 어묵 및 수입산 훈제연어의 감마핵종 검출시험 결과, 174개 품목 322개 시료 모두

방사성 요오드, 세슘(134Cs, 137Cs, 131I) 값이 MDA이하로 검출되지 않았다.

○ 종합적으로 보면 조사대상 식품 중 일부 품목에서 기준치 이하의 방사능 물질이 검출

되었고, 이들 시료 중 일부는 외산 이동형 장비를 이용한 감마핵종 분석결과와의 비

교분석에 활용하였다.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

차류

녹차 오픈마켓-1 일본 불검출
1.26±0.14
[MDA: 0.49]

3.24±0.26
[MDA: 0.57]

그린티파우더 오픈마켓-2 일본 불검출 불검출 불검출

현미녹차-1 오픈마켓-3 일본 불검출 0.74±0.08
[MDA: 0.33]

1.58±0.16
[MDA: 0.40]

현미녹차-2 오픈마켓-4 일본 불검출 불검출 불검출

현미녹차-3 오픈마켓-2 일본 불검출 불검출 불검출

메밀차 오픈마켓-5 일본 불검출 불검출 불검출

커피-1 오픈마켓-6 일본2) 불검출 불검출 불검출

커피-2 오픈마켓-6 일본2) 불검출 불검출 불검출

커피-3 오픈마켓-6 일본2) 불검출 불검출 불검출

커피-4 오픈마켓-6 일본2) 불검출 불검출 불검출

커피-5 서울마트-1 브라질 불검출 불검출 불검출

커피-6 서울마트-1 브라질, 콜롬비아 불검출 불검출 불검출

채소류 배추 서울재래시장-1 국내 불검출 불검출 불검출

버섯류

표고버섯-1 서울재래시장-2 중국 불검출 불검출 불검출

목이버섯-1 서울재래시장-3 중국 불검출 불검출
0.71±0.11
[MDA: 0.33]

기타
(유류
및
낙농
제품
포함)

산양분유-1 서울대형마트-1 뉴질랜드 불검출 불검출
0.76±0.13
[MDA: 0.40]

산양분유-2 서울대형마트-1 뉴질랜드 불검출 불검출 1.28±0.16
[MDA: 0.41]

산양분유-3 서울대형마트-1 오스트리아, 미국 불검출 불검출 불검출

분유-1 서울대형마트-1 호주 불검출 불검출 불검출

분유-2 서울대형마트-1 수입산, 국산3) 불검출 불검출 불검출

분유-3 서울대형마트-1 수입산, 국산4) 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.

2) 원두 원산지: 브라질, 콜롬비아 등, 원두 볶음국가 : 일본

3) 원재료: 유청분말(수입산), 원유(국산, 1A 등급)

4) 원재료: 탈염유청분말(수입산), 원유(국산, 1A 등급)
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

주류

맥주-1 서울대형마트-2 일본 불검출 불검출 불검출

맥주-2 서울대형마트-3 일본 불검출 불검출 불검출

맥주-3 서울대형마트-2 일본 불검출 불검출 불검출

맥주-4 서울대형마트-2 일본 불검출 불검출 불검출

맥주-5 서울대형마트-2 일본 불검출 불검출 불검출

청주-1 서울대형마트-3 일본 불검출 불검출 불검출

청주-2 서울대형마트-3 일본 불검출 불검출 불검출

청주-3 서울대형마트-3 일본 불검출 불검출 불검출

청주-4 서울대형마트-3 일본 불검출 불검출 불검출

청주-5 서울대형마트-3 일본 불검출 불검출 불검출

청주-6 주류판매점-1 일본 불검출 불검출 불검출

청주-7 주류판매점-1 일본 불검출 불검출 불검출

청주-8 주류판매점-1 일본 불검출 불검출 불검출

청주-9 주류판매점-1 일본 불검출 불검출 불검출

청주-10 주류판매점-1 일본 불검출 불검출 불검출

장류
(간장,
된장 등)

된장-1 서울마트-2 일본 불검출 불검출 불검출

된장-2 서울마트-2 일본 불검출 불검출 불검출

간장-1 서울대형마트-4 일본 불검출 불검출 불검출

간장-2 서울대형마트-4 일본 불검출 불검출 불검출

간장-3 서울대형마트-4 일본 불검출 불검출 불검출

간장-4 서울대형마트-4 일본 불검출 불검출 불검출

간장-5 서울대형마트-4 일본 불검출 불검출 불검출

간장-6 서울대형마트-4 일본 불검출 불검출 불검출

간장-7 서울대형마트-4 일본 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

장류
(간장,
된장 등)

간장-8 서울대형마트-4 일본 불검출 불검출 불검출

간장-9 서울대형마트-4 일본 불검출 불검출 불검출

간장-10 서울대형마트-4 일본 불검출 불검출 불검출

간장-11 서울대형마트-4 일본 불검출 불검출 불검출

간장-12 서울대형마트-4 일본 불검출 불검출 불검출

곡류
(현미)

현미-1 오픈마켓-7 국산(경기안성) 불검출 불검출 불검출

현미-2 오픈마켓-8 국산(경기화성) 불검출 불검출 불검출

현미-3 오픈마켓-9 국산(경기여주) 불검출 불검출 불검출

현미-4 오픈마켓-10 국산(강원양구) 불검출 불검출 불검출

현미-5 오픈마켓-7 국산(강원철원) 불검출 불검출 불검출

현미-6 오픈마켓-11 국산(인천강화) 불검출 불검출 불검출

현미-7 오픈마켓-12 국산(충북진천) 불검출 불검출 불검출

현미-8 오픈마켓-7 국산(충북청원) 불검출 불검출 불검출

현미-9 오픈마켓-11 국산(충남아산) 불검출 불검출 불검출

현미-10 서울대형마트-5 국산(전북김제) 불검출 불검출 불검출

현미-11 오픈마켓-13 국산(전남영안) 불검출 불검출 불검출

현미-12 오픈마켓-11 국산(전남무안) 불검출 불검출 불검출

현미-13 오픈마켓-11 국산(전남보성) 불검출 불검출 불검출

현미-14 오픈마켓-14 국산(전남진도) 불검출 불검출 불검출

현미-15 오픈마켓-11 국산(전남고흥) 불검출 불검출 불검출

현미-16 서울대형마트-5 국산(경북예천) 불검출 불검출 불검출

현미-17 오픈마켓-11 국산(경북상주) 불검출 불검출 불검출

현미-18 오픈마켓-7 국산(경남고성) 불검출 불검출 불검출

현미-19 오픈마켓-11 국산(경남산청) 불검출 불검출 불검출

현미-20 서울대형마트-6 국산 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

버섯류

송이버섯-1 서울재래시장-4 중국 불검출 불검출 불검출

송이버섯-2 서울재래시장-5 중국 불검출 불검출 불검출

능이버섯-1 서울재래시장-6 중국 불검출 불검출
1.84±0.13
[MDA: 0.26]

능이버섯-2 서울재래시장-5 중국 불검출 불검출
19.53±0.74
[MDA: 0.99]

석이버섯-1 서울재래시장-5 국산 불검출 불검출
27.53±0.90
[MDA: 0.77]

차가버섯-1 서울재래시장-7 러시아 불검출 불검출
14.68±0.73
[MDA: 0.79]

차가버섯-2 서울재래시장-8 러시아 불검출 불검출 32.81±1.11
[MDA: 1.42]

차가버섯-3 서울재래시장-9 중국 불검출 불검출
28.40±1.01
[MDA: 1.23]

차가버섯-4 서울재래시장-6 러시아 불검출 불검출 36.87±1.22
[MDA: 1.28]

운지버섯-1 서울재래시장-9 국산 불검출 불검출 불검출

운지버섯-2 서울재래시장-10 국산 불검출 불검출 불검출

상황버섯-1 서울재래시장-11 국산 불검출 불검출 불검출

상황버섯-2 서울재래시장-7 국산 불검출 불검출 불검출

영지버섯-1 서울재래시장-11 국산 불검출 불검출 불검출

영지버섯-2 서울재래시장-8 국산 불검출 불검출 불검출

표고버섯-2 서울재래시장-4 중국 불검출 불검출 불검출

표고버섯-3 서울재래시장-12 중국 불검출 불검출 불검출

목이버섯-2 서울재래시장-4 중국 불검출 불검출 불검출

목이버섯-3 서울재래시장-12 중국 불검출 불검출 불검출

노루궁뎅이
버섯-1

서울재래시장-4 중국 불검출 불검출 불검출

노루궁뎅이
버섯-2

서울재래시장-10 중국 불검출 불검출 불검출

면류
(메밀
국수)

메밀국수-1 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-2 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-3 오픈마켓-15 일본 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

면류
(메밀
국수)

메밀국수-4 오픈마켓-16 일본 불검출 불검출 불검출

메밀국수-5 오픈마켓-16 일본 불검출 불검출 불검출

메밀국수-6 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-7 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-8 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-9 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-10 오픈마켓-14 일본 불검출 불검출 불검출

메밀국수-11 오픈마켓-15 일본 불검출 불검출 불검출

메밀국수-12 오픈마켓-15 일본 불검출 불검출 불검출

메밀국수-13 오픈마켓-15 일본 불검출 불검출 불검출

기타
(소금)

소금-1 신안-1 국내 불검출 불검출 불검출

소금-2 신안-2 국내 불검출 불검출 불검출

소금-3 신안-3 국내 불검출 불검출 불검출

소금-4 신안-4 국내 불검출 불검출 불검출

소금-5 신안-5 국내 불검출 불검출 불검출

소금-6 신안-6 국내 불검출 불검출 불검출

소금-7 신안-7 국내 불검출 불검출 불검출

소금-8 신안-8 국내 불검출 불검출 불검출

소금-9 신안-9 국내 불검출 불검출 불검출

소금-10 신안-10 국내 불검출 불검출 불검출

소금-11 영광-1 국내 불검출 불검출 불검출

소금-12 영광-2 국내 불검출 불검출 불검출

소금-13 영광-3 국내 불검출 불검출 불검출

소금-14 신안-11 국내 불검출 불검출 불검출

소금-15 신안-2 국내 불검출 불검출 불검출

소금-16 신안-11 국내 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

기타
(수산물)

명태내장(알)-1 서울도매시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-2 서울도매시장-2 확인불가 불검출 불검출 불검출

명태내장(알)-3 서울도매시장-3 확인불가 불검출 불검출 불검출

명태내장(알)-4 서울도매시장-4 확인불가 불검출 불검출 불검출

명태내장(알)-5 서울재래시장-13 확인불가 불검출 불검출 불검출

명태내장(알)-6 서울재래시장-14 확인불가 불검출 불검출 불검출

명태내장(알)-7 인천재래시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-8 인천재래시장-2 확인불가 불검출 불검출 불검출

명태내장(알)-9 대전도매시장-1 미국 불검출 불검출 불검출

명태내장(알)-10 대전도매시장-2 미국 불검출 불검출 불검출

명태내장(알)-11 대전재래시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-12 대구도매시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-13 대구도매시장-2 확인불가 불검출 불검출 불검출

명태내장(알)-14 대구재래시장-1 미국 불검출 불검출 불검출

명태내장(알)-15 부산도매시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-16 광주도매시장-1 미국 불검출 불검출 불검출

명태내장(알)-17 광주도매시장-2 미국 불검출 불검출 불검출

명태내장(알)-18 광주재래시장-1 미국 불검출 불검출 불검출

명태내장(알)-19 울산도매시장-1 확인불가 불검출 불검출 불검출

명태내장(알)-20 울산도매시장-2 미국 불검출 불검출 불검출

명태내장(곤이)-1 서울도매시장-1 미국 불검출 불검출 불검출

명태내장(곤이)-2 서울도매시장-2 러시아 불검출 불검출 불검출

명태내장(곤이)-3 서울도매시장-3 미국 불검출 불검출 불검출

명태내장(곤이)-4 서울도매시장-4 확인불가 불검출 불검출 불검출

명태내장(곤이)-5 서울재래시장-13 확인불가 불검출 불검출 불검출

명태내장(곤이)-6 서울재래시장-14 확인불가 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

기타
(수산물)

명태내장(곤이)-7 인천재래시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-8 인천재래시장-2 미국 불검출 불검출 불검출

명태내장(곤이)-9 대전도매시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-10 대전도매시장-2 확인불가 불검출 불검출 불검출

명태내장(곤이)-11 대전재래시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-12 대구도매시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-13 대구도매시장-2 미국 불검출 불검출 불검출

명태내장(곤이)-14 대구재래시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-15 부산도매시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-16 부산도매시장-2 러시아 불검출 불검출 불검출

명태내장(곤이)-17 부산재래시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-18 광주도매시장-1 확인불가 불검출 불검출 불검출

명태내장(곤이)-19 광주도매시장-2 확인불가 불검출 불검출 불검출

명태내장(곤이)-20 광주재래시장-1 미국 불검출 불검출 불검출

명태내장(곤이)-21 울산도매시장-2 미국 불검출 불검출 불검출

명태내장(곤이)-22 울산도매시장-1 확인불가 불검출 불검출 불검출

기타
(수산물
가공품)

어묵-1 서울대형마트-7 수입 불검출 불검출 불검출

어묵-2 청주재래시장-1 수입 불검출 불검출 불검출

어묵-3 부산재래시장-2 수입 불검출 불검출 불검출

어묵-4 서울재래시장-15 국내,수입 불검출 불검출 불검출

어묵-5 서울대형마트-8 수입 불검출 불검출 불검출

어묵-6 부산재래시장-2 수입 불검출 불검출 불검출

어묵-7 서울대형마트-8 국내,수입 불검출 불검출 불검출

어묵-8 서울대형마트-7 수입 불검출 불검출 불검출

어묵-9 서울대형마트-9 수입 불검출 불검출 불검출

어묵-10 부산재래시장-3 국산,수입 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

기타
(수산물
가공품)

어묵-11 서울재래시장-16 수입 불검출 불검출 불검출

어묵-12 서울재래시장-16 수입 불검출 불검출 불검출

어묵-13 서울대형마트-7 수입 불검출 불검출 불검출

어묵-14 청주재래시장-1 국산,수입 불검출 불검출 불검출

어묵-15 서울대형마트-7 수입 불검출 불검출 불검출

어묵-16 서울대형마트-7 수입 불검출 불검출 불검출

어묵-17 서울재래시장-15 수입 불검출 불검출 불검출

어묵-18 부산재래시장-4 수입 불검출 불검출 불검출

어묵-19 서울재래시장-16 국산,수입 불검출 불검출 불검출

어묵-20 부산재래시장-4 수입 불검출 불검출 불검출

어묵-21 서울대형마트-8 수입 불검출 불검출 불검출

어묵-22 서울대형마트-7 베트남 불검출 불검출 불검출

훈제연어-1 오픈마켓-17 칠레 불검출 불검출 불검출

훈제연어-2 서울대형마트-9 칠레 불검출 불검출 불검출

훈제연어-3 서울재래시장-17 칠레 불검출 불검출 불검출

훈제연어-4 서울대형마트-9 노르웨이 불검출 불검출 불검출

훈제연어-5 오픈마켓-18 노르웨이 불검출 불검출 불검출

훈제연어-6 오픈마켓-19 노르웨이 불검출 불검출 불검출

훈제연어-7 오픈마켓-17 노르웨이 불검출 불검출 불검출

훈제연어-8 서울대형마트-10 미국 불검출 불검출 불검출

훈제연어-9 서울대형마트-11 노르웨이 불검출 불검출 불검출

훈제연어-10 오픈마켓-17 칠레 불검출 불검출 불검출

기타
(화장품)

화장품-1 백화점-1 일본 불검출 불검출 불검출

화장품-2 백화점-1 일본 불검출 불검출 불검출

화장품-3 백화점-1 일본 불검출 불검출 불검출

화장품-4 백화점-1 일본 불검출 불검출 불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

기타
(화장품)

화장품-5 백화점-1 일본 불검출 불검출 불검출

화장품-6 백화점-1 일본 불검출 불검출 불검출

화장품-7 백화점-1 일본 불검출 불검출 불검출

화장품-8 백화점-1 일본 불검출 불검출 불검출

화장품-9 드럭스토어-1 일본 불검출 불검출 불검출

화장품-10 드럭스토어-1 일본 불검출 불검출 불검출

화장품-11 백화점-2 일본 불검출 불검출 불검출

화장품-12 백화점-2 일본 불검출 불검출 불검출

화장품-13 백화점-2 일본 불검출 불검출 불검출

화장품-14 백화점-2 일본 불검출 불검출 불검출

화장품-15 백화점-2 일본 불검출 불검출 불검출

화장품-16 백화점-2 일본 불검출 불검출 불검출

화장품-17 백화점-2 일본 불검출 불검출 불검출

화장품-18 백화점-2 일본 불검출 불검출 불검출

화장품-19 오픈마켓-18 일본 불검출 불검출 불검출

화장품-20 오픈마켓-18 일본 불검출 불검출 불검출

화장품-21 드럭스토어-2 일본 불검출 불검출 불검출

화장품-22 드럭스토어-2 일본 불검출 불검출 불검출

기타
(토양)

토양-1 - 전남 영광 불검출
0.31±0.04
[MDA: 0.10]

불검출

토양-2 - 전남 영광 불검출
2.64±0.09
[MDA: 0.14]

불검출

토양-3 - 전남 영광 불검출
0.49±0.05
[MDA: 0.16]

불검출

토양-4 - 전남 영광 불검출 1.14±0.07
[MDA: 0.16]

불검출

토양-5 - 전북 부안 불검출
1.27±0.06
[MDA: 0.15]

불검출

토양-6 - 충남 홍성 불검출
0.60±0.04
[MDA: 0.12]

불검출

토양-7 - 충남 태안 불검출
1.02±0.04
[MDA: 0.09]

불검출

토양-8 - 충남 예산 불검출 2.59±0.11
[MDA: 0.19]

불검출

1) 불검출: MDA(최소검출한계) 이하.
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표 3.1.2.2. 식품 중 감마핵종 방사능 측정 결과(계속)

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

기타
(토양)

토양-9 - 전남 목포 불검출
0.72±0.06
[MDA: 0.14]

불검출

토양-10 - 전남 완도 불검출 0.16±0.03
[MDA: 0.07]

불검출

토양-11 - 전남 완도 불검출
2.47±0.07
[MDA: 0.10]

불검출

토양-12 - 전남 고흥 불검출
1.35±0.07
[MDA: 0.14]

불검출

토양-13 - 전남 여수 불검출 1.22±0.07
[MDA: 0.13]

불검출

토양-14 - 경남 통영 불검출
0.76±0.05
[MDA: 0.11]

불검출

토양-15 - 제주 제주시 불검출
5.14±0.14
[MDA: 0.13]

불검출

토양-16 - 제주 서귀포시 불검출 1.82±0.08
[MDA: 0.13]

불검출

토양-17 - 강원 고성 불검출
0.72±0.06
[MDA: 0.20]

불검출

토양-18 - 강원 양양 불검출
8.26±0.21
[MDA: 0.17]

불검출

토양-19 - 강원 강릉 불검출 0.23±0.05
[MDA: 0.15]

불검출

토양-20 - 강원 동해 불검출
3.49±0.10
[MDA: 0.15]

불검출

토양-21 - 경북 경주 불검출
2.82±0.08
[MDA: 0.12]

불검출

토양-22 - 경북 경주 불검출 1.51±0.07
[MDA: 0.12]

불검출

토양-23 - 울산 울주 불검출
1.52±0.08
[MDA: 0.15]

불검출

1) 불검출: MDA(최소검출한계) 이하.

(2) 축산물

(가) 시료의 채취 및 전처리

종류 채취량 시료구분 핵종분석 방법

소고기/돼지고기
2 kg

이상

시료봉지

에 라벨을

부착한 후

장소, 일

시 및 채

취자 성명

을 기록한

다(공통).

1) 말리넬리 비이커(1 L)와 뚜껑무게를 측정한다.

2) 살코기 부분만 분리하여 분쇄기를 이용하여 미세

하게 분쇄한다.

3) 분쇄된 시료 부패방지를 위해 포르말린을 시료 1

kg 당 30 mL 정도 첨가하고 균일하게 혼합한다.

4) 1 L 말리넬리 비이커 지시선까지 충진하고 중간

뚜껑과 상부뚜껑을 닫아 밀봉한 후 무게를 측정

한다.

5) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

닭/오리고기 3 kg

1) 말리넬리 비이커(1 L)와 뚜껑무게를 측정한다.

2) 식용부분만 취하여 증류수로 깨끗이 씻은 후 10～

15분간 바구니 등에 넣어서 수분을 제거한다.
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3) 수분을 제거한 후 무게를 측정한다.

4) 시료를 분쇄기에 넣어 분쇄한다.

5) 포르말린을 시료 1 kg 당 30 mL 정도 첨가하여

균일하게 혼합한다.

6) 1 L 말리넬리 비이커 지시선까지 충진하고 중간

뚜껑과 상부뚜껑을 닫아 밀봉한 후 무게를 측정

한다.

7) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

소세지 및 치즈
1 kg

이상

1) 말리넬리 비이커(1 L)와 뚜껑 무게를 측정한다.

2) 시료를 분쇄기로 미세하게 분쇄한다.

3) 포르말린을 시료 1 kg 당 30 mL 정도 첨가하여

균일하게 혼합한다.

4) 1 L 말리넬리 비이커 지시선까지 충진하고 중간

뚜껑과 상부뚜껑을 닫아 밀봉한 후 무게를 측정

한다.

5) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

분유 2 kg

1) 말리넬리 비이커(1 L)와 뚜껑무게를 측정한다.

2) 1 L 말리넬리 비이커의 지시선까지 충진(1 kg)하

고 중간뚜껑과 상부뚜껑을 닫아 밀봉한 후 무게

를 측정한다.

3) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

곡류 및 채소류 4 kg

1) 채취한 시료 물기를 제거하고 무게를 측정하여

기록한다.

2) 시료를 전기오븐에 넣고 110 ℃에서 48시간 이상

건조시킨다. 이때, 생체무게와 건조무게 비를 구

하여 건조율을 구한다.

3) 분쇄기로 분말을 만든다.

4) 1 L 말리넬리 비이커와 뚜껑무게를 측정한다.

5) 1 L 말리넬리 비이커에 균일하게 충진(1 kg)한

후 중간 뚜껑과 상부 뚜껑을 닫아 압축한 후 무

게를 측정한다.

6) “HPGe 감마핵종분석기 사용법” 절차에 따라 계

측한다.

임산물 4 kg

1) 시료 무게를 측정하여 기록한다.

2) 110 ℃로 조정된 전기오븐에서 48시간 이상 건조

하여 상온에서 식힌다.

3) 건조한 시료를 분쇄기로 갈아 무게를 측정한다.

이때, 생체무게와 건조무게 비를 구하여 건조율

을 구한다.

4) 1 L 말리넬리 비이커와 뚜껑의 무게를 측정한다.
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5) 1 L 말리넬리 비이커에 균일하게 충진(1 kg)한

후 중간 뚜껑과 상부 뚜껑을 닫아 압축한 후 무

게를 측정한다.

6) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

꿀 2 L

1) 1 L 말리넬리 비이커와 뚜껑무게를 측정한다.

2) 시료를 1 L 말리넬리 비이커에 균일하게 충진(1

kg)한 후 중간 뚜껑과 상부 뚜껑을 닫아 압축한

후 무게를 측정한다.

3) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

어류(생체법)
2 kg

이상

1) 채취한 시료는 빠른 시간 내에 물로 씻는다.

2) 식용 부분만 취하여 증류수로 깨끗이 씻은 후 1

0～15분간 바구니 등에 넣어서 수분을 제거한다.

단, 근내장 등을 제거할 때에는 내장에 상처를

주어 다른 조직을 오염시키거나 체액이 유출되지

않도록 한다.

3) 수분 제거 후 무게를 측정한다.

4) 시료를 분쇄기에 넣어 미세하게 분쇄한다.

5) 분쇄된 시료에 부패방지를 위해 포르말린을 시료

1 kg 당 30 mL 정도 첨가하여 균일하게 혼합한

다.

6) 말리넬리 비이커(1 L)와 뚜껑 무게를 측정한다.

7) 채취한 시료를 균일하게 혼합하고 1 L 마르넬리

비이커 지시선까지 충진(1 kg)한 후 중간뚜껑과

상부뚜껑을 닫아 무게를 측정한다.

8) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

해조류(건조법)
5 kg

이상

1) 해조류에 붙어있는 모래나 동식물 등의 이물질을

제거하고 균일하게 섞은 다음 순수한 생체시료의

무게를 측정하여 기록한다.

2) 110 ℃로 조절한 열풍건조기로 48시간 이상 건조

하여 상온에서 식힌다.

3) 건조한 시료를 분쇄기로 갈아 무게를 측정한다. 이

때, 생체무게와 건조무게의 비로 건조율을 구한다.

4) 1 L 말리넬리 비이커와 뚜껑의 무게를 측정한다.

5) 1 L 말리넬리 비이커에 균일하게 충진(1 kg)한

후 중간 뚜껑과 상부 뚜껑을 닫아 압축한 후 무

게를 측정한다.

6) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

소금 1 kg 1) 1 L 말리넬리 비이커와 뚜껑의 무게를 측정한다.
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(2) 축산물 방사능 분석결과

표 3.1.2.3. 축산물 중 감마핵종 방사능분석 결과

이상

2) 시료를 1 L 말리넬리 비이커에 균일하게 충진한

후 중간 뚜껑과 상부 뚜껑을 닫아 압축한 후 무

게를 측정한다. 채취된 시료는 공기 중 수분 출

입을 방지하기 위해서 가능한 빨리 분석한다.

3) “HPGe 감마핵종분석기 사용법”에 따라 계측한

다.

종류 제품명 구입처 원산지
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1
40K

(Bq/kg-1σ)

육류

소치마살 미국산
-

(MDA:
5.98E+001)

-
(MDA:

1.06E+000)

-
(MDA:

8.93E-001)

-
(MDA:

3.65E+001)

소부채살 미국산
-

(MDA:
5.78E+001)

-
(MDA:

9.96E-001)

-
(MDA:

1.05E+000)

-
(MDA:

3.66E+001)

흑소설도 호주산
-

(MDA:
6.76E+001)

-
(MDA:

1.05E+000)

-
(MDA:

9.99E-001)

-
(MDA:

3.76E+001)

한돈돼지갈비 국산
-

(MDA:
6.57E+001)

-
(MDA:

1.05E+000)

-
(MDA:

1.05E+000)

-
(MDA:

3.89E+001)

한우앞다리
서울대형마트

1
국산

-
(MDA:

8.67E+013)

-
(MDA:

7.94E-001)

-
(MDA:

6.09E-001)

111.04 ± 6.27
(MDA:

9.32E+000)

한우채끝
(암소)

서울대형마트
2

국산
-

(MDA:
7.60E+013)

-
(MDA:

8.47E-001)

-
(MDA:

6.22E-001)

122.17 ± 6.48
(MDA:

8.07E+000)

한우등심
(구이용)

서울대형마트
2

국산
-

(MDA:
7.25E+013)

-
(MDA:

8.90E-001)

-
(MDA:

6.70E-001)

99.06 ± 7.00
(MDA:

1.55E+001)

한우앞다리
다짐육 부채살

서울대형마트
2

국산
-

(MDA:
8.73E+013)

-
(MDA:

8.64E-001)

-
(MDA:

7.05E-001)

100.76 ± 7.32
(MDA:

1.68E+001)

돈육등심
서울대형마트

2
국산

-
(MDA:

5.77E+016)

-
(MDA:

10.19E-001)

-
(MDA:

7.25E-001)

125.16 ± 6.73
(MDA:

8.19E+000)

돈육잡육
(모듬제육)

서울대형마트
2

국산
-

(MDA:
5.50E+016)

-
(MDA:

8.26E-001)

-
(MDA:

6.73E-001)

117.75 ± 6.25
(MDA:

7.81E+000)

돈육앞다리살
서울대형마트

2
국산

-
(MDA:

6.09E+016)

-
(MDA:

8.87E-001)

-
(MDA:

6.62E-001)

133.85 ± 7.15
(MDA:

1.08E+001)

갈매기살다짐육
목심

서울대형마트
2

국산
-

(MDA:
8.64+013)

-
(MDA:

7.84E-001)

-
(MDA:

7.10E-001)

115.19 ± 6.87
(MDA:

1.20E+001)
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안성마춤한우등
심

서울대형마트
3

국산
(안성)

-
(MDA:
2.22E+011)

-
(MDA:

8.15E-001)

-
(MDA:

6.17E-001)

-
(MDA:

4.35E+001)

안성마춤한우설
도

서울대형마트
3

국산
(안성)

-
(MDA:
2.17E+011)

-
(MDA:

9.20E-001)

0.18 ± 0.11
(MDA:

3.67E-001)

113.45 ±
9.98
(MDA:
2.74E+001)

안성마춤한우앞
다리

서울대형마트
3

국산
(안성)

-
(MDA:
2.19E+011)

-
(MDA:

8.50E-001)

-
(MDA:

6.46E-001)

135.55 ± 6.75
(MDA:
2.00E+001)

안성마춤한우양
지

서울대형마트
3

국산
(안성)

-
(MDA:
2.95E+011)

-
(MDA:

8.38E-001)

-
(MDA:

6.21E-001)

-
(MDA:

4.24E+001)

안성마춤한우채
끝

서울대형마트
3

국산
(안성)

-
(MDA:
2.13E+011)

-
(MDA:

8.33E-001)

-
(MDA:

6.74E-001)

118.22 ± 6.20
(MDA:

1.89E+001)

선진돼지삼겹살
서울대형마트

3
국산
(안성)

-
(MDA:

3.71E+012)

-
(MDA:

7.85E-001)

-
(MDA:

5.88E-001)

94.45 ± 6.61
(MDA:

1.44E+001)

선진돼지안심살
서울대형마트

3
국산
(안성)

-
(MDA:

3.70E+012)

-
(MDA:

8.30E-001)

-
(MDA:

6.51E-001)

149.81 ± 7.31
(MDA:

8.25E+000)

선진돼지앞다리
살

서울대형마트
3

국산
(안성)

-
(MDA:

3.94E+012)

-
(MDA:

7.86E-001)

-
(MDA:

6.96E-001)

123.14 ± 7.37
(MDA:

1.44E+001)

선진돼지뒷다리
살

서울대형마트
3

국산
(안성)

-
(MDA:

3.55E+011)

-
(MDA:

7.19E-001)

-
(MDA:

6.62E-001)

72.18 ± 1.14
(MDA:

3.42E+001)

선진돼지목심살
서울대형마트

3
국산
(안성)

-
(MDA:

3.21E+011)

-
(MDA:

7.71E-001)

-
(MDA:

6.83E-001)

101.43 ± 8.77
(MDA:
2.35E+001)

하림닭가슴살
서울대형마트

3
국산
(안성)

-
(MDA:

3.29E+011)

-
(MDA:

1.04E+000)

-
(MDA:

7.12E-001)

-
(MDA:

5.12E+001)

하림닭안심
서울대형마트

3
국산
(안성)

-
(MDA:

3.83E+012)

-
(MDA:

8.25E-001)

-
(MDA:

6.02E-001)

134.10 ± 6.95
(MDA:

9.29E+000)

자연실록닭가슴
살

서울대형마트
5

국산
(익산)

-
(MDA:

3.48E+003)

-
(MDA:

6.45E-001)

-
(MDA:

6.22E-001)

-
(MDA:
2.47E+001)

자연실록닭안심
서울대형마트

5
국산
(익산)

-
(MDA:

3.63E+003)

-
(MDA:

6.36E-001)

-
(MDA:

6.25E-001)

132.43 ± 7.38
(MDA:

1.28E+001)

자연실록닭다리
살

서울대형마트
5

국산
(익산)

-
(MDA:
2.81E-001)

-
(MDA:

3.08E-001)

-
(MDA:

3.43E-001)

64.58 ± 4.19
(MDA:

6.57E+000)

하림훈제조각
서울대형마트

5
국산

-
(MDA:
2.54E-001)

-
(MDA:

3.46E-001)

-
(MDA:

3.27E-001)

50.53 ± 3.35
(MDA:

4.24E+000)
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소앞다리살
서울대형마트

5
수입산
(호주)

-
(MDA:
2.79E-001)

-
(MDA:
2.90E-001)

-
(MDA:

3.50E-001)

69.64 ± 4.29
(MDA:

5.91E+000)

소홍두깨살
서울대형마트

5
수입산
(호주)

-
(MDA:
2.56E-001)

-
(MDA:

3.11E-001)

-
(MDA:

3.53E-001)

86.18 ± 4.93
(MDA:

5.85E+000)

한우설도
서울대형마트

5
국산

-
(MDA:
2.78E-001)

-
(MDA:

3.37E-001)

-
(MDA:

3.39E-001)

74.91 ± 4.44
(MDA:

5.38E+000)

소치마살
서울대형마트

5
수입산
(호주)

-
(MDA:
2.80E-001)

-
(MDA:

3.22E-001)

-
(MDA:

3.58E-001)

83.68 ± 4.65
(MDA:

3.85E+000)

친환경한우등심
서울대형마트

5
국산

-
(MDA:
2.90E-001)

-
(MDA:

3.42E-001)

-
(MDA:

3.36E-001)

74.35 ± 4.42
(MDA:

5.45E+000)

소부채살
서울대형마트

5
수입산
(호주)

-
(MDA:
2.70E-001)

-
(MDA:

3.47E-001)

-
(MDA:

3.43E-001)

70.49 ± 4.13
(MDA:

3.96E+000)

친환경한우채끝
서울대형마트

5
국산

-
(MDA:
2.70E-001)

-
(MDA:

3.28E-001)

-
(MDA:

3.18E-001)

58.80 ± 3.72
(MDA:

4.59E+000)

소척아이롤
서울대형마트

5
수입산
(미국)

-
(MDA:
2.57E-001)

-
(MDA:

3.15E-001)

-
(MDA:

3.25E-001)

62.29 ± 3.87
(MDA:

4.70E+000)

친환경한우양지
서울대형마트

5
국산

-
(MDA:
2.77E-001)

-
(MDA:

3.46E-001)

-
(MDA:

3.45E-001)

73.16 ± 4.30
(MDA:

4.65E+000)

친환경한우앞다
리(부채살)

서울대형마트
5

국산
-

(MDA:
2.95E-001)

-
(MDA:

3.68E-001)

-
(MDA:

3.21E-001)

69.13 ± 4.19
(MDA:

5.18E+000)

소살치살
서울대형마트

5
수입산
(미국)

-
(MDA:
2.86E-001)

-
(MDA:

3.20E-001)

-
(MDA:

3.25E-001)

62.74 ± 3.83
(MDA:

4.13E+000)

소윗등심
서울대형마트

5
수입산
(호주)

-
(MDA:
2.83E-001)

-
(MDA:

3.10E-001)

-
(MDA:

3.14E-001)

78.82 ± 4.53
(MDA:

4.70E+000)

친환경돼지뒷사
태

서울대형마트
5

국산
-

(MDA:
2.79E-001)

-
(MDA:

3.48E-001)

-
(MDA:

3.46E-001)

72.89 ± 4.41
(MDA:

5.86E+000)

친환경돼지뒷다
리

서울대형마트
5

국산
-

(MDA:
2.63E-001)

-
(MDA:

3.69E-001)

-
(MDA:

3.50E-001)

82.55 ± 4.69
(MDA:

4.91E+000)

친환경돼지목심
서울대형마트

5
국산

-
(MDA:
2.87E-001)

-
(MDA:

3.21E-001)

-
(MDA:

3.50E-001)

75.06 ± 4.25
(MDA:

3.03E+000)
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친환경돼지삼겹
살

서울대형마트
5

국산
-

(MDA:
2.64E-001)

-
(MDA:

3.43E-001)

-
(MDA:

3.51E-001)

74.90 ± 4.37
(MDA:

4.66E+000)

친환경돼지등심
서울대형마트

5
국산

-
(MDA:
2.67E-001)

-
(MDA:

3.17E-001)

-
(MDA:

3.36E-001)

83.64 ± 5.12
(MDA:

8.17E+000)

육가공
품

알뜰소시지
(롯데)

서울대형마트
2

돼지고기
(수입산),
연육
(수입산)

-
(MDA:

3.63E+013)

-
(MDA:

7.60E-001)

-
(MDA:

5.64E-001)

24.12 ± 2.67
(MDA:

5.13E+000)

건강생각
라운드햄
(청정원)

서울대형마트
2

돼지고기
(국산)

-
(MDA:

1.23E+013)

-
(MDA:

7.93E-001)

-
(MDA:

6.35E-001)

85.68 ± 6.32
(MDA:

1.41E+001)

살코기햄
(목우촌)

서울대형마트
2

돼지고기
(국산)

-
(MDA:

4.98E+013)

-
(MDA:

8.34E-001)

-
(MDA:

6.32E-001)

93.90 ± 5.37
(MDA:

6.26E+000)

추억의
알찬소시지
(백설햄)

서울대형마트
2

돼지고기
(국산),
연육(수입)

-
(MDA:

4.13E+013)

-
(MDA:

7.55E-001)

-
(MDA:

5.71E-001)

19.83 ± 3.60
(MDA:

1.02E+001)

스모크햄
(델립)

서울대형마트
2

돼지고기
(국산,
수입산),
닭고기
(국산)

-
(MDA:

4.07E+013)

-
(MDA:

7.88E-001)

-
(MDA:

6.15E-001)

76.05 ± 6.55
(MDA:

1.63E+001)

홈 소시지
(진주햄)

서울대형마트
2

돼지고기(
국산),
연육
(국산,
수입산)

-
(MDA:

4.03E+013)

-
(MDA:

7.95E-001)

-
(MDA:

6.48E-001)

19.67 ± 2.75
(MDA:

6.57E+000)

의성 마늘햄
(롯데햄)

서울대형마트
4

돼지고기
(국산)

-
(MDA:

9.09E+013)

-
(MDA:

8.88E-001)

-
(MDA:

6.92E-001)

95.74 ± 6.93
(MDA:

1.51E+001)

요리조리
(롯데햄)

서울대형마트
4

돼지고기
(수입),
닭고기
(국산)

-
(MDA:

6.04E+013)

-
(MDA:

7.64E-001)

-
(MDA:

6.03E-001)

48.65 ± 4.78
(MDA:

1.16E+001)

통그릴부어스트
(본엠)

서울대형마트
4

돼지고기
(국산)

-
(MDA:

5.74E+013)

-
(MDA:

9.36E-001)

-
(MDA:

7.21E-001)

146.26 ± 8.77
(MDA:

1.78E+001)

리챔
(동원)

서울대형마트
4

돼지고기
(수입)

-
(MDA:

5.32E+013)

-
(MDA:

8.28E-001)

-
(MDA:

6.52E-001)

111.30 ± 6.20
(MDA:

8.57E+000)

더 건강한햄 서울대형마트 돼지고기 - - - 142.73 ± 7.19
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(롯데햄) 4 (국산)
(MDA:

7.62E+013)
(MDA:

9.38E-001)
(MDA:

7.28E-001)
(MDA:

7.01E+000)

프랑크소시지
(목우촌)

서울대형마트
4

돼지고기
(국산)

-
(MDA:

5.08E+013)

-
(MDA:

8.53E-001)

-
(MDA:

6.62E-001)

79.43 ± 6.23
(MDA:

1.39E+001)

꼬치구이프랑크
(목우촌)

서울대형마트
4

돼지고기
(국산)

-
(MDA:

1.33E+013)

-
(MDA:

8.70E-001)

-
(MDA:

6.18E-001)

67.64 ± 4.62
(MDA:

7.05E+000)

정말맛있는소시
지

서울대형마트
4

-
(MDA:

6.41E+012)

-
(MDA:

8.08E-001)

-
(MDA:

6.05E-001)

43.72 ± 7.35
(MDA:
2.23E+001)

로스팜치즈(롯
데햄)

서울대형마트
3

-
(MDA:

9.39E+015)

-
(MDA:

8.12E-001)

-
(MDA:

5.66E-001)

63.77 ± 7.55
(MDA:
2.17E+001)

3%날씬한햄(하
림)

서울대형마트
3

-
(MDA:

3.37E+016)

-
(MDA:

8.60E-001)

-
(MDA:

6.74E-001)

96.29 ± 6.15
(MDA:

1.16E+001)

아이사랑
(청정원)

서울대형마트
3

-
(MDA:

4.39E+016)

-
(MDA:

9.01E-001)

-
(MDA:

7.62E-001)

1122.16 ±
7.47
(MDA:

1.41E+001)

안심팜
(사조)

서울대형마트
3

-
(MDA:
2.83E+016)

-
(MDA:

9.35E-001)

-
(MDA:

6.25E-001)

109.37 ± 6.87
(MDA:

1.35E+001)

더건강한햄
서울대형마트

3

-
(MDA:

1.23E+018)

-
(MDA:

8.82E-001)

-
(MDA:

7.06E-001)

73.57 ± 4.85
(MDA:

1.69E+001)

유가공
품

트루맘 분유
(일동)

서울대형마트
4

호주
-

(MDA:
3.83E-001)

-
(MDA:

5.81E-001)

-
(MDA:

4.90E-001)

144.40 ± 7.61
(MDA:

5.07E+000)

그랑노블 분유
(파스퇴르)

서울대형마트
4

호주
-

(MDA:
4.58E-001)

-
(MDA:

6.43E-001)

-
(MDA:

6.15E-001)

141.90 ± 8.00
(MDA:

8.32E+000)

산양유아식(아
이배냇)

서울대형마트
4

뉴질랜드
-

(MDA:
2.21E-001)

-
(MDA:
2.37E-001)

0.26 ± 0.07
(MDA:
2.09E-001)

234.80 ± 9.94
(MDA:

6.50E+000)

아기밀
순유기농
(후디스)

서울대형마트
4

국산/오스
트리아산

-
(MDA:

4.94E-001)

-
(MDA:

6.32E-001)

-
(MDA:

6.86E-001)

94.22 ± 6.18
(MDA:

5.94E+000)

임페리얼드림
엑스오
(남양)

서울대형마트
4

필란드,
아일랜드,
네덜란드,
프랑스,
벨기에

-
(MDA:

6.67E+013)

-
(MDA:

12.71E-001)

-
(MDA:

10.29E-001)

241.76 ±
17.30
(MDA:

4.53E+001)

전지분유
(매일)

서울대형마트
4

국산
-

(MDA:
-

(MDA:
-

(MDA:
261.30 ±
12.50
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(3) 수산물

(가) 배경

2011년 3월 후쿠시마 원자력발전소 사고 발생 이후 국내에서는 각종 식품의 방사성 물질 오

염에 대한 불안감이 야기되었다. 특히, 후쿠시마 사고는 대량의 방사성 물질이 해양으로 누출

됐다는 점에서 주변국들이 수산물에 대한 관리를 강화토록 하는 계기가 되었다. 우리나라는 현

재 후쿠시마 등 8개현의 일본 수산물을 수입금지 하고 있으며, 일본산 수산물을 포함한 일본산

4.44E-001) 5.51E-001) 5.16E-001)
(MDA:

9.57E+000)

모짜렐라치즈
(Messana)

서울대형마트
4

미국
-

(MDA:
1.18E+013)

-
(MDA:

8.18E-001)

-
(MDA:

6.77E-001)

25.70 ± 5.02
(MDA:

1.50E+001)

smoked 치즈
(natural)

서울대형마트
4

네덜란드
-

(MDA:
1.29E+013)

-
(MDA:

8.80E-001)

-
(MDA:

6.46E-001)

32.78 ± 3.73
(MDA:

8.60E+000)

과일치즈
(Lemnos)

서울대형마트
4

호주
-

(MDA:
1.20E+013)

-
(MDA:

7.71E-001)

-
(MDA:

6.42E-001)

95.35 ± 6.46
(MDA:

1.36E+001)

슈레드
모짜렐라치즈

서울대형마트
4

미국
-

(MDA:
1.03E+013)

-
(MDA:

7.79E-001)

-
(MDA:

6.32E-001)

38.00 ± 3.41
(MDA:

6.27E+000)

스모크드치즈디
스크

서울대형마트
3

네덜란드
-

(MDA:
8.56E+012)

-
(MDA:

10.06E-001)

-
(MDA:

8.56E-001)

-
(MDA:

5.29E+001)

Westland
고다치즈

서울대형마트
3

뉴질랜드
-

(MDA:
2.27E+014)

-
(MDA:

12.38E-001)

-
(MDA:

9.28E-001)

598.32 ±
35.32
(MDA:

9.10E+001)

Borden
아메리카 치즈

서울대형마트
3

미국
-

(MDA:
1.60E+014)

-
(MDA:

8.40E-001)

-
(MDA:

6.10E-001)

-
(MDA:

4.12E+001)

스위스조각치즈
서울대형마트

3
스위스

-
(MDA:

1.69E+014)

-
(MDA:

8.68E-001)

0.24 ± 0.10
(MDA:

3.08E-001)

60.46 ± 7.81
(MDA:
2.27E+001)

스위스치즈
서울대형마트

3
스위스

-
(MDA:

7.00E+014)

-
(MDA:

13.17E-001)

-
(MDA:

9.73E-001)

18.72 ± 6.27
(MDA:

1.98E+001)

MILD 체다치즈
서울대형마트

3
영국

-
(MDA:

5.94E+016)

-
(MDA:

15.29-001)

-
(MDA:

11.18E-001)

43.14 ± 6.78
(MDA:

18.45E+000)

콜리오스사카나
키

서울대형마트
3

그리스
-

(MDA:
7.55E+016)

-
(MDA:

12.99E-001)

-
(MDA:

10.91E-001)

28.76 ± 5.38
(MDA:

15.14E+000)

이즈니버터롤
서울대형마트

3
프랑스

-
(MDA:

6.33E+016)

-
(MDA:

11.14E-001)

-
(MDA:

7.45.48E-001)

28.52 ± 4.08
(MDA:

10.29E+000)
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식품 중 방사성 세슘에 대해 좀 더 보수적인 방사능 농도 기준을 설정해서 관리하고 있다(1).

국내에는 1989년도에 식품의약품안전청이 재정한 식품공전 고시 89-19 식품 중의 방사능 농

도 잠정 허용기준이 있으며, 방사성 요오드에 대해서 영·유아용식품 100 Bq/kg, 유 및 유가공

품 100 Bq/kg, 기타식품 300 Bq/kg, 방사성 세슘에 대해서 모든식품 370 Bq/kg을 농도 기준

으로 삼고 있다(1). 또한 후쿠시마 사고 이후에 일본산 수입식품 중 방사성 세슘 대한 임시강

화기준이 재설정되었으며, 사고 이후 일본산 수입식품에는 별도로 100 Bq/kg 의 임시강화기준

을 적용하고 있다. 이러한 기준에 의해 관리되고 있음에도 일본과 해양 인접국이라는 이유로

우리나라 국민들은 국내 수산물에 대해서 역시 불안감을 갖고 있다.

본 연구에서는 현재 국내에서 유통되는 수산물에 대해 신뢰성 있는 방사능 농도를 제시하고

자 2013년부터 3년간 전국의 대형 수산시장의 수산물을 무작위로 채취하여 조사하였으며, 사고

상황에 맞는 신속하고 효율적인 분석 방법을 사용하여 국내 시중 유통 수산물의 후쿠시마 사

고 영향에 대해서 조사하였다.

(나) 시료의 채취 및 전처리

시료 채취지점은 수도권 중 서울, 중부권 중 대전, 대천, 남부권 중 부산의 대형 수산시장을

대상으로 하였으며, 총 60건의 수산물 시료를 2013년부터 2015년까지 채취하였다. 국민건강통

계의 섭취빈도(2)를 참고로 하여 시료의 종류를 결정하였으며, 고등어, 조기, 명태, 멸치, 오징

어, 패류 등 섭취빈도가 높은 품목에, 전복, 갈치, 우럭, 주꾸미, 꽁치, 대구, 전어, 새우, 광어,

삼치, 낙지, 민어, 농어, 도미, 가자미, 병어, 멍게, 노래미, 해삼, 해조류 등 국내에서 많이 유통

되는 품목을 추가하여 시료 선정에 반영하였다.

일반적으로 감마선방출핵종의 방사능 농도를 분석하기 위한 시료의 전처리는 부피를 줄여 더

많은 양을 측정하기 위해서 건조와 회화단계를 거치게 되며, 이 과정에서 며칠간의 전처리 시

간을 소요하게 된다. 하지만 본 연구에서는 신속한 분석을 위해서 전처리 과정 없이 생 시료를

분쇄한 후 직접 측정하였으며, 일반적인 식품분쇄기를 사용하여 측정 용기에 균질하게 들어갈

수 있도록 하였다. 모든 시료에 대해서 뼈, 내장, 껍질을 제외한 살 부위만을 시료로 하였으며,

살 부위만을 시료로 사용할 경우 시료 질량이 반 이상 줄어드는 것은 감안하여 각 시료의 채

취량을 결정하였다. 이미 건조된 수산물 시료의 경우에는 별도의 처리 없이 바로 분쇄하여 측

정하였다. 측정 용기는 직경 142 mm, 홀 직경 86 mm, 높이 98 mm, 용량 1 L의 마리넬리 비

커(Marinelli beaker)로 하였다.
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그림 3.1.2.4. 수산물 시료채취 지점 및 분석과정

(다) 방사능 농도 분석

감마분광분석법을 통해 40K, 137Cs, 134Cs, 131I의 핵종의 방사능 농도를 분석하였다. 40K은 천연

방사성핵종으로 지각뿐만 아니라 사람을 포함한 생명체에 존재하는 핵종이며, 일반 성인의 40K

방사능 농도는 약 70 Bq/kg 정도이다(3). 137Cs, 134Cs, 131I은 인공방사성핵종으로 대표적인 핵

분열 생성물이다. 측정에 사용된 검출기는 고순도 게르마늄 반도체 검출기(HPGe, ORTEC

Advanced Measurement Technology Inc, Oak Ridge, USA)로 상대 효율은 20%, 고압(high

voltage) 2300 V일 때 에너지 분해능(FWHM)은 60Co 1333 keV에서 1.9 keV 이하이다. 두께

10cm 이상의 납 차폐체에 의해 주변으로부터 검출기로 입사하는 백그라운드 감마선이 차단된

다. 사용한 표준선원(100949, Eckert&Ziegler, Atlanta, USA)은 241AM(59.5 keV), 109Cd(88.0

keV), 57Co(122.1, 136.5 keV), 139Ce(165.9 keV), 51Cr(320.1 keV), 113Sn(391.7 keV), 85Sr(514.0

keV), 137Cs(661.7 keV), 88Y(898.0, 1836.1 keV), 60Co(1173.2, 1332.5 keV)을 포함하며, 마리넬리

비커의 기하구조에 대한 에너지 및 효율로 농도를 분석하였다. 방사능 농도는 식 1에 의해 계

산되었다(4,5).

··· ···


(1)

N : 순계수

ε : 효율

m : 시료량

Ir : 감마방출률

ts : 시료측정시간

K1 : 농도 산출일에 대한 붕괴보정인자

K2 : 측정시간 동안의 붕괴보정인자

K3 : 동시합산효과 보정인자

(다) 최소검출가능농도 및 측정시간
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방사능 농도 분석에서 최소검출가능농도는 검출한계치(Lower Limits of Detection, LLD)를

바탕으로 해서 결정된다. 검출한계치는 Currie에 의해 제안되었으며(6), 계측의 통계적인 부분

만을 고려해서 방사능 존재 여부를 나타내는 개념이다. 현재 방사능 분석 분야에서는 검출한계

치 중 검출한계(LD: Detection Limit)에 효율, 시료량, 측정시간 등 방사능 농도에 영향을 주는

모든 인자가 들어가 있는 최소검출가능농도라는 값을 사용하여 방사능의 존재여부를 판단하는

것이 일반적이며, 이는 식 2에 의해 계산되었다.

···

·
(2)

μB : 백그라운드의 불확도

ε : 효율

m : 시료량

Ir : 감마방출률

ts : 시료측정시간

특정 시료에 대해서 같은 검출기로 분석을 할 경우, 최소검출가능농도에 영향을 주는 인자는

백그라운드의 불확도와 측정시간이다. 백그라운드 역시 같다고 가정한다면 측정시간이 길어질

수록 최소검출가능농도가 작아지게 된다(그림 3.1.2.5). 그림 3.1.2.5에서는 137Cs을 예로 들어 측

정시간에 따른 최소검출가능농도를 계산하였으며, 이를 위한 조건은 시료량 1 kg, 해당 에너지

의 백그라운드 계수율 0.01 count/sec 이다. 이는 시료에서 인공방사성핵종이 없고 40K만 존재

하며 그 농도가 약 100 Bq/kg 이라고 가정 했을 때의 값이다. 현재 수산물에 대한 137Cs+134Cs

의 농도 기준은 국내산이 370 Bq/kg, 일본산이 100 Bq/kg이다. 본 연구에서는 일본산 기준의

백분에 일에 해당하는 1 Bq/kg을 최소검출가능농도로 임의 설정하였으며, 이를 만족시키기 위

한 측정시간은 그림 3.1.2.5의 결과를 참고하여 10000 초로 결정하였다.

그림 3.1.2.5. 측정 시간에 따른 137Cs의 MDA 변화



84

(라) 수산물 방사능 분석결과 및 최소검출가능농도 고찰

2013년부터 2015년까지 채취한 수산물 시료의 방사능 분석 결과를 표 3.1.2.4에 나타내었다.

모든 시료에서 40K이 검출되었으며, 나머지 인공방사성핵종 137Cs, 134Cs, 131I은 모두 최소검출가

능농도 이하였다. 건조된 수산물 시료를 제외한 40K 방사능 농도는 21.9~153.8 Bq/kg의 범위를

나타내어 일반적인 수산물의 농도 수준을 나타내었다(7). 다만, 뼈나 내장에 비해 살 부위의
40K의 농도가 상대적으로 높은 것을 고려 할 때(8), 본 연구에서 시료로 사용한 살 부위만의

농도는 전체 부위를 대상으로 했을 때 보다 높은 경향을 나타냈을 것으로 판단된다. 또한, 일

부 건조된 수산물 시료의 40K 방사능 농도는 267∼3610 Bq/kg의 범위를 나타내어 상대적으로

높은 경향을 보인다. 이를 생 시료에 대한 값으로 환산할 경우 일반적인 수산물의 농도 수준을

나타낼 것으로 판단되며, 그 중 해조류의 경우 일반적으로 어·패류 보다 40K의 농도가 높은 것

으로 조사되었다(10). 137Cs, 134Cs, 131I의 인공방사성핵종은 대표적인 핵분열 생성물로써 모든

시료에 대해서 방사능 농도가 최소검출가능농도 이하의 결과를 나타내어, 조사 대상 시료에 대

해서는 후쿠시마 사고의 영향이 없는 것으로 판단할 수 있다.

UNSCEAR(United Nations Scientific Committee on the Effects of Atomic Radiation)가 제

시하는 세계 평균 자연방사선 피폭선량은 2.4 mSv 이다. 이는 라돈흡입, 지각감마선, 우주방사

선 등을 포함한 양이며, 음식물을 통한 방사능 섭취에 따른 내부피폭은 약 14.6% 정도이다. 섭

취에 의한 피폭량은 식사습관에 따라 달라지며 우리나라 국민의 경우 약 12.3% 로 세계 평균

과 비슷한 수준으로 조사되었다(11). 식품군별 평균 섭취량 중 수산물은 약 3%의 비율을 차지

하며(2), 전체 자연방사선 피폭선량 중 수산물에 의한 부분은 극히 일부이다. 따라서, 본 연구

에서 조사한 137Cs, 134Cs, 131I의 인공방사성핵종 핵종에 의한 방사선 피폭 영향은 없다고 볼 수

있다. 또한. 40K의 경우 체내에서 평형상태를 이루므로 UNSCEAR가 평가한 연간 170 μSv를

그대로 적용할 수 있으며, 40K 방사능 농도에 따른 추가적인 피폭 역시 없다고 판단할 수 있

다.

최소검출가능농도의 경우 137Cs 0.140∼1.97, 134Cs 0.0900∼1.89, 131I 0.124∼1.94 Bq/kg의 범위

를 나타내었으며, 대부분의 시료 분석 결과에서 본 연구에서 설정한 최소검출가능농도 1

Bq/kg를 만족시키는 결과를 얻었다(표 3.1.2.4.). 일부 건조된 수산물 시료의 최소검출가능농도

는 1 Bq/kg을 넘었으나, 이는 작은 시료량과 40K에 의한 백그라운드 증가 때문이다. 건조된 수

산물의 경우 1 L의 시료용기에 들어갈 수 있는 시료량이 건조되지 않은 수산물에 비해 두 배

이상 작아 최소검출가능농도가 커진다. 또한, 40K(1460.8 keV) 보다 낮은 에너지에 주 피크가

존재하는 137Cs(661.7), 134Cs(604.7 keV), 131I(364.5 keV)은 40K의 컴프턴 연속에 의해 높아진 백

그라운드의 영향으로 최소검출가능농도가 커진다. 본 연구에서 임의 설정한 1 Bq/kg의 최소검

출가능농도는 수산물 시료 중 40K의 농도가 100 Bq/kg, 측정시간 10000 초 일 때 기대되는 값

이므로 건조된 수산물 시료에 대해서 1 Bq/kg의 최소검출가능농도를 만족시키기 위해서는 측

정시간을 늘려야 할 것으로 판단된다. 하지만 일반적인 수산물 생 시료의 경우에는 본 연구의

실험 조건으로 137Cs, 134Cs, 131I에 대해서 1 Bq/kg 이하의 최소검출가능농도를 만족시키는 분

석이 가능하였으며, 이보다 측정시간을 줄이는 것이 가능할 것으로 판단된다.
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표 3.1.2.4. 수산물 중 방사능 분석 결과

No. Sampling 
(date) Region Fishery product Sample mass 

(kg)
Radioactivity concentration (Bq/kg), k=2

40K 137Cs 134Cs 131I

1 13.08.23 대천 전복 0.916 89.1±10.2 <0.275 <0.385 <0.346
2 오징어 0.928 122±12 <0.252 <0.404 <0.345

3 조기 0.938 50.9±7.9 <0.332 <0.388 <0.239
4 갈치 0.971 77.0±8.4 <0.407 <0.334 <0.246

5 우럭 0.913 123±12 <0.402 <0.325 <0.335
6 13.08.26 부산 주꾸미 0.577 53.1±9.5 <0.574 <0.523 <0.340

7 꽁치 0.807 92.6±10.9 <0.557 <0.432 <0.309
8 명태 0.620 122±15 <0.620 <0.479 <0.336

9 13.10.14 대전 대구 0.881 154±13 <0.500 <0.413 <0.157
10 오징어 0.866 144±13 <0.521 <0.421 <0.401

11 홍합 0.855 27.4±6.5 <0.286 <0.369 <0.428
12 전어 0.928 72.0±8.9 <0.140 <0.289 <0.196

13 고등어 0.924 63.8±8.2 <0.372 <0.373 <0.325
14 14.06.09 대천 건새우 0.379 348±29 <1.07 <0.862 <0.951 

15 건멸치 0.341 267±27 <0.605 <0.799 <0.901 
16 광어 0.973 148±12 <0.377 <0.306 <0.243 

17 우럭 0.961 104±10 <0.473 <0.278 <0.259 
18 바지락 0.973 92.4±9.2 <0.327 <0.193 <0.285 

19 소라 0.764 103±11 <0.358 <0.194 <0.390 
20 14.07.15 대전 전어 0.752 79.2±9.7 <0.394 <0.352 <0.236 

21 꽁치 0.895 68.8±8.3 <0.439 <0.328 <0.529 
22 오징어 0.789 109±13 <0.445 <0.223 <0.466 

23 삼치 0.893 105±10 <0.361 <0.380 <0.350 
24 세발낙지 0.837 66.2±8.5 <0.303 <0.286 <0.312 

25 고등어 0.869 108±11 <0.427 <0.234 <0.324 
26 14.08.06 부산 민어 0.913 131±12 <0.424 <0.250 <0.292 

27 농어 0.854 115±11 <0.302 <0.238 <0.350 
28 참돔 0.991 99.9±9.5 <0.508 <0.289 <0.290 

29 조기 0.838 59.5±8.0 <0.506 <0.329 <0.397 
30 갈치 0.708 88.3±10.6 <0.484 <0.389 <0.348 

31 14.8.11 서울 참가자미 0.800 106±111 <0.244 <0.349 <0.124 
32 대구 0.930 104±10 <0.328 <0.241 <0.375 

33 병어 0.733 90.2±10.5 <0.494 <0.416 <0.179 
34 건다시마 0.454 3050±110 <1.97 <1.75 <1.04 

35 건미역 0.326 2090±90 <1.52 <1.89 <1.94 
36 황태 0.209 385±41 <1.54 <1.19 <1.07 

37 15.6.17 대천 멍게 0.797 75.1±7.5 <0.389 <0.247 <0.281 
38 바지락 1.00 98.7±7.4 <0.191 <0.139 <0.145 

39 우럭 0.852 129±9 <0.292 <0.101 <0.239 
40 농어 0.874 137±9 <0.287 <0.229 <0.179 

41 노래미 0.896 154±10 <0.333 <0.220 <0.271 
42 소라 0.960 120±9 <0.360 <0.169 <0.248 

43 15.6.24 대전 세발낙지 0.909 85.1±7.3 <0.171 <0.168 <0.175 
44 해삼 0.972 21.9±3.9 <0.191 <0.0900 <0.178 

45 조기 0.961 87.1±7.3 <0.317 <0.189 <0.219 
46 고등어 0.969 119±9 <0.339 <0.210 <0.230 

47 오징어 0.980 111±8 <0.295 <0.220 <0.190 
48 삼치 0.934 139±9 <0.361 <0.233 <0.232 

49 15.8.19 서울 건멸치 0.380 204±12 <0.261 <0.299 <0.272 
50 황태 0.289 286±29 <1.12 <1.03 <0.780 

51 　 건다시마 0.761 3610±46  <1.01 <0.668 <0.350 
52 　 연어 0.969 109±10 <0.305 <0.219 <0.185 

53 　 도미 0.945 76.7±5.4 <0.145 <0.121 <0.101 
54 　 　 민어 0.900 78.3±9.1  <0.249 <0.209 <0.244 

55 15.8.19 부산 전어 0.881 77.4±5.0 <0.116 <0.098 <0.128 
56 도다리 0.909 141±9 <0.242 <0.204 <0.207 

57 광어 0.995 152±9 <0.260 <0.193 <0.117 
58 가리비 0.941 50.9±4.1 <0.111 <0.103 <0.082 

59 새우 0.952 78.1±6.6 <0.198 <0.194 <0.202 
60 백합조개 0.919 70.2±9.3 <0.271 <0.135 <0.229 

< less than MDA (Minimum Detectable Activity) level
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나. 특정 시료에 대한 시간별 방사능 측정 결과 및 고찰

□ 방사능의 정밀한 측정을 위해서는 장시간이 소요되고, 현재는 실험실 기반의 장비만이 보

급되어 있는 상황에서 재난상황 발생 시 즉각 대응하기에 미흡한 부분이 있다. 그 예로

일본 원전사고 직후 우리나라는 수입산 장비의 부족과 많은 물량의 식품 방사능 검사관리

ㅊ게 되면 검출되는 핵종의 수가 줄어들고 측정값의 오차가 커진다. 따라서 원전 사고와

같은 비상시에 신뢰도 높은 결과 값을 얻기 위해서 측정시간에 대한 연구가 필요할 것이

다.

(1) 측정시간에 따른 MDA 변화 관찰 시료

○ 일본 현미 인증표준물질(CRM)

∙ 방사성 세슘(134Cs, 137Cs)을 포함하는 현미 CRM : 1개 품목(1개 시료)

- NMIJ(National Metrology Institute of Japan) 제작

- CRM No. 7541-a

- 국내 구매대행 업체를 통하여 구입 (81g × 11ea)

그림 3.1.2.6. 감마핵종 분석용 일본 현미 인증표준물질(CRM. 7541-a)

○ 일본산 차(茶)류 중 방사능 물질 검출 시료

∙ 일본 NMIJ 현미 인증표준물질(CRM) : 1개 품목(1개 시료)

∙ 일본산 차(茶)류 : 2개 품목(2개 시료)

(2) 일본 현미 인증표준물질(CRM)의 시간별 방사능 측정 결과 및 고찰

○ 감마핵종분석을 실시한 시료인 일본 현미 인증표준물질(CRM)과 일본산 차(茶)류 중 미

량의 방사성 세슘이 검출되었던 2개 품목에 대해 측정시간별 MDA변화를 관찰하였다.
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○ 현행 식품 중 방사능 기준값4)으로 방사성 세슘(134Cs+137Cs)은 100 Bq/kg이 적용되고

있으므로 앞서 측정한 일본 현미 인증표준물질에 들어있는 방사성 세슘의 방사능 값

85.4 Bq/kg (134Cs+137Cs에 대한 인증값)은 우리나라 현행 기준치에 근접한 값이다. 기

준치와 비슷한 물질을 측정할 때 그 측정시간에 따른 MDA 값의 변화를 관찰함으로

써 실제로 비상상황이 발생하였을 때 시료의 측정시간을 결정하는 데 중요한 정보로

활용할 수 있을 것으로 기대된다.

○ 일본 현미 인증표준물질(CRM)의 결과와 같이 현행 방사능 기준치에 근접하는 방사능

이 검출되는 시료의 경우 측정 시간을 증가시킴으로써 더 낮은 MDA 값을 얻을 수 있

음을 확인할 수 있었다. 측정시간 변화에 따른 MDA 값의 변화를 살펴본 결과, 방사성

세슘 기준치에 근접한 시료를 측정할 경우 현재 원자력안전위원회고시 제2012-5호 ‘원

자력이용시설 주변의 방사선환경조사 및 방사선환경영향평가에 관한 규정’ 제 6조에

명시된 환경방사능 분석을 위한 검출하한치(0.1 Bq/kg-fresh)를 만족하기 위해서는 분

석하고자 하는 시료 한개 당 259,200초(72시간) 이상을 측정해야한다. 이는 신속하게

식품의 방사능 오염을 분석해야하는 원전 사고와 같은 비상시에는 적용하기 어려울 것

으로 보인다. 따라서, 비상시에는 별도의 방사능 모니터링 기준치를 설정하여 단시간

스크리닝을 통해 방사능 오염여부를 판단하는 별도의 분석 매뉴얼이 요구된다.

(3) 일본산 차(茶)류 시간별 방사능 측정 결과 및 고찰

○ 미량의 방사능이 검출되었을 경우에도(일본산 차(茶)류 134Cs+137Cs 측정값 0.7～3.2 Bq/kg)

측정시간이 증가함에 따라 MDA 값이 감소하는 것을 알 수 있었으며, 미량의 방사능 값에

대한 측정값 신뢰도 향상을 위해 측정시간의 선정에 유용한 정보를 제공할 것이다.

○ 또한, 낮은 수치의 방사능이 검출된 시료는 측정시간을 짧게 설정하였을 때와 긴 측정시간

을 주었을 때는 전혀 다른 결과가 도출되었다. 그 예로 식품공전 상에 제시된 10,000초를 측

정시간으로 하여 녹차, 현미녹차 시료를 측정하였을 때 검출되었던 방사성 세슘이 1,800초

또는 3,600초의 측정시간을 주어 여러 차례 측정 시, 경우에 따라 방사성 세슘의 방사능 값

이 MDA 이하로 불검출되었다(아래 표에 표기된 수치는 동일 시료를 5번 측정한 후 방사성

세슘이 검출되었을 때의 결과값을 표기한 것임). 일본 원전사고 이후 식약처는 일본 수입식

품을 1,800초로 검사하였음을 공개하였다. 기준치 미만의 식품을 선별하기 위해 1,800초로

측정하는 것이 큰 문제는 없는 것으로 보이나, 현재 미량의 방사능이라도 검출되면 다른 핵

종에 대한 증명서도 함께 첨부하도록 하여 원천적으로 방사능 오염 식품을 차단하겠다는 수

입식품 검역취지에서 본다면 1,800초의 측정은 기준치 이하 미량의 방사능 핵종은 판별해

내지 못해 수입 적합 품목으로 판정될 수 있어 이에 대한 검토가 필요하다.

4) 2013.9.26 식품의약품안전처 공고 제2013-188호 “식품의 기준 및 규격 일부개정고시안 행정예고” 기타모든식품에 대한 방사성 세슘

(134Cs+137Cs) 기준치 현행 370 Bq/kg에서 100 Bq/kg로 변경
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표 3.1.2.5. 일본 현미 인증표준물질(CRM)(1개 시료) 및 일본산 차(茶)류(2개 시료) 시간별방사능 측정

종류
품명

(원산지/제조국)
생산/판매처
또는 구입처

측정시간
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

곡류
방사성 세슘
현미 CRM
(일본)

NMIJ2)

/
Wako Pure
Chemical
Ind. Ltd.

1,800 불검출
32.18±1.49
[MDA: 1.81]

50.02±1.91
[MDA: 1.52]

3,600 불검출
32.16±1.04
[MDA: 1.58]

51.07±1.66
[MDA: 0.90]

7,200 불검출
31.48±1.04
[MDA: 1.01]

51.34±1.52
[MDA: 0.63]

10,800 불검출
30.69±0.97
[MDA: 0.94]

50.65±1.45
[MDA: 0.57]

21,600 불검출 31.02±0.82
[MDA: 0.56]

49.63±1.36
[MDA: 0.36]

43,200 불검출 30.01±0.79
[MDA: 0.38]

50.58±1.36
[MDA: 0.24]

86,400 불검출
30.26±0.78
[MDA: 0.28]

50.70±1.35
[MDA: 0.21]

172,800 불검출
30.31±0.77
[MDA: 0.18]

50.48±1.33
[MDA: 0.16]

259,200 불검출
30.23±0.76
[MDA: 0.15]

50.34±1.33
[MDA: 0.12]

음료
및
주류

녹차
(일본)

오픈마켓-1

1,8003) 불검출
1.70±0.22
[MDA: 1.22]

3.85±0.42
[MDA: 1.07]

3,600 불검출 1.69±0.19
[MDA: 0.73]

3.68±0.40
[MDA: 0.94]

10,800 불검출 1.24±0.12
[MDA: 0.48]

3.49±0.24
[MDA: 0.50]

43,200 불검출
1.25±0.07
[MDA: 0.27]

3.10±0.15
[MDA: 0.32]

86,400 불검출
1.18±0.05
[MDA: 0.17]

3.03±0.13
[MDA: 0.17]

172,800 불검출
1.10±0.04
[MDA: 0.12]

2.89±0.10
[MDA: 0.14]

259,200 불검출
1.14±0.04
[MDA: 0.10]

2.93±0.09
[MDA: 0.10]

음료
및
주류

현미녹차-1
(일본)

오픈마켓-3

1,8003) 불검출 1.09±0.19
[MDA: 0.85]

2.43±0.31
[MDA: 0.97]

3,6003) 불검출 1.00±0.11
[MDA: 0.66]

2.18±0.25
[MDA: 0.65]

10,800 불검출
0.69±0.09
[MDA: 0.39]

1.52±0.15
[MDA: 0.39]

43,200 불검출
0.71±0.05
[MDA: 0.17]

1.62±0.10
[MDA: 0.21]

86,400 불검출
0.62±0.04
[MDA: 0.12]

1.46±0.08
[MDA: 0.16]

172,800 불검출
0.63±0.03
[MDA: 0.08]

1.43±0.06
[MDA: 0.11]

259,200 불검출 0.57±0.02
[MDA: 0.07]

1.47±0.06
[MDA: 0.08]

1) 불검출: MDA(최소검출한계) 이하.

2) NMIJ: National Metrology Insutitute of Japan

3) 1,800초 또는 3,600초로 측정 시(5번씩 측정함) 방사성 세슘이 MDA 이하로 불검출 되는 경우가 발생 하거나 peak의 대칭이 정확하지 않음.

위의 결과는 5번 측정에서 방사성 세슘(134Cs, 137Cs)이 모두 검출된 자료만 계산하여 나타냄.
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그림 3.1.2.7. 일본 현미 인증표준물질(CRM. 7541-a) 측정시간에 따른 MDA 변화

그림 3.1.2.8. 일본 차(茶)류-[녹차] 측정시간에 따른 MDA 변화

그림 3.1.2.9. 일본 차(茶)류-[현미녹차-1] 측정시간에 따른 MDA 변화
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다. 국내․외에서 개발된 인증표준물질(CRM) 방사능 측정 결과 및 고찰

○ 일본에서 개발된 방사성 세슘을 포함하고 있는 현미 CRM의 인증 값은 134Cs와 137Cs

의 값이 각각 33.6±2.6 Bq/kg, 51.8±4.6 Bq/kg 이다. 1 L 마리넬리 비이커에 담은 현

미 CRM의 측정결과 이 값의 범위에 속하는 30.6±0.9 Bq/kg, 51.9±1.5 Bq/kg 의 결과

값을 각각 얻었다.

○ 한국표준과학원에서 개발한 쌀CRM 분석 결과, 인증값(3.1 Bq/kg)과 일치하는 값

(3.1±0.2 Bq/kg)을 얻었다.

○ 표준선원 이외에 실험자의 숙련도를 검증할 방법으로 인증표준물질을 이용하여 인증

값과 결과 값을 비교해 본다면 좀 더 신뢰도 있는 결과를 얻을 수 있을 것으로 기대

한다.

표 3.1.2.6. 국외 인증표준물질(CRM) 방사능 측정

구분 품명(제조국)
생산/판매처
또는 구입처

측정시간
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

인증값
방사성 세슘
현미 CRM
(일본)

NMIJ2) /
Wako Pure
Chemical Ind.

Ltd.

불검출 33.6±2.6 51.8±4.6

측정값 10,000 불검출
30.63±0.86
[MDA: 0.84]

51.90±1.51
[MDA: 0.72]

1) 불검출: MDA(최소검출한계) 이하.

2) NMIJ: National Metrology Insutitute of Japan

표 3.1.2.7. 국내 인증표준물질(CRM) 방사능 측정

구분 품명(제조국)
생산/판매처
또는 구입처

측정시간
131I

(Bq/kg-1σ)1)
134Cs

(Bq/kg-1σ)1)
137Cs

(Bq/kg-1σ)1)

인증값
방사성 세슘
쌀 CRM
(대한민국)

한국표준과학
연구원

불검출 불검출 3.1

측정값 10,000 불검출 불검출
3.1±0.2
[MDA: 0.38]

1) 불검출: MDA(최소검출한계) 이하.

라. 개발장비를 이용한 방사능 신속분석

(1) 기준물질(RM)의 측정결과 비교분석

○ 한국표준과학원에서 개발한 기준물질(RM) 9종(농․축․수산물, 저․고준위) 18개 시료

∙ 참여기관별 실험 결과의 신뢰성을 위해 교차분석
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표 3.1.2.8. 교차분석 시료

구분 농산물 축산물 수산물

1차년도
고준위

저준위
현미 소고기 대구

2차년도
고준위

저준위
밀가루 분유 굴

3차년도
고준위

저준위
옥수수 달걀 해초

(2) 실험실 고정형 HPGe, 현장 이동형 NaI/HPGe 감마핵종분석기를 이용한 측정결과 비

교

○ 2협동에서 개발된 농·축·수산물 기준물질(RM)(저준위, 고준위) 6개 시료를 수입 고정

형 장비(HPGe 검출기)와 개발 이동형 장비(NaI 검출기)로 측정(10,000초)하여 그 결

과 값을 비교 분석하였다.

○ 수입 고정 장비(HPGe 검출기)와 개발된 이동형 장비(NaI 검출기)의 137Cs 핵종의 측정

결과값을 비교해 본 결과, 6개 시료 모두 이동형 NaI 장비의 측정값이 수입 고정형

HPGe 장비 측정값보다 낮게 나타나는 결과를 얻을 수 있었다. 반면, MDA 값은 수입

산 HPGe 장비보다 개발 NaI 장비 측정시 더 높게 나타났다.

표 3.1.2.9. 2차년도 개발 기준물질(RM) 측정결과 비교

구분
(수입)HPGe (개발)NaI

241Am 134Cs 137Cs 134Cs 137Cs

농산물

(밀가루)

저준위
54.22±2.65
[MDA: 3.92]

27.57±0.81
[MDA: 0.47]

33.33±0.85
[MDA: 0.42]

21.99±0.76
[MDA: 2.07]

27.09±0.84
[MDA: 2.48]

고준위
178.01±8.71
[MDA: 11.22]

103.26±2.54
[MDA: 1.26]

117.25±2.94
[MDA: 1.02]

88.03±1.78
[MDA: 2.48]

96.50±2.23
[MDA: 2.75]

축산물

(분유)

저준위 59.75±3.20
[MDA: 5.15]

32.28±0.80
[MDA: 0.54]

38.67±0.98
[MDA: 0.44]

23.53±0.77
[MDA: 2.24]

30.04±0.94
[MDA: 2.79]

고준위
229.65±10.94
[MDA: 12.71]

115.60±2.84
[MDA: 1.52]

133.07±3.33
[MDA: 1.09]

105.90±2.16
[MDA: 2.95]

119.34±2.75
[MDA: 3.28]

수산물

(굴)

저준위
34.02±1.76
[MDA: 2.83]

17.07±0.42
[MDA: 0.24]

19.62±0.50
[MDA: 0.22]

- -

고준위 101.34±4.81
[MDA: 6.33]

60.22±1.47
[MDA: 0.54]

67.80±1.71
[MDA: 0.62]

50.28±1.06
[MDA: 1.60]

56.69±1.33
[MDA: 1.79]

* 개발 NaI 장비를 활용한 수산물(굴) 저준위 굴시료의 경우 시료 용기 파손으로 측정하지 못함

○ 3차년도 연구과제 추진 계획에 따라서 이동형 현장 NaI/HPGe 감마핵종 분석기가 개발

되었기 때문에 제 2협동연구기관에서 개발한 표준선원 및 표준물질(옥수수, 미역, 계

란)에 대한 Am-241(표 3.1.2.10.), Cs-134(표 3.1.2.11.), Cs-135(표 3.1.2.12.)을 1,800초

분석하였다(표 24). 아울러, 방보원에 보유하고 있는 HPGe 감마핵종 분석기를 이용하
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여 10,000초 분석하고 이동형 현장 NaI/HPGe 감마핵종 분석기 성능을 최종 확인하였

다.

표 3.1.2.10. 실험실 고정형 HPGe, 현장 이동형 NaI와 HPGe를 이용한 표준시료 241Am

분석

분석시간: 10,000초(방보원 실험실 고정형 HPGe 감마핵종 분석기, CANBERRA, GENIE-2000),

1,800초(현장 이동형 NaI와 HPGe 감마핵종 분석기)

표 3.1.2.11. 실험실 고정형 HPGe, 현장 이동형 NaI와 HPGe를 이용한 표준시료 134Cs 분

석

시료 방사능 준위
감마핵종 분석기

방보원 HPGe 현장 이동형 HPGe

물
표준

교정시료

25.89 ± 0.12

(MDA: 1.220)

30.10 ± 2.09

(MDA: 10.26)

옥수수 고준위
170.50 ± 6.90

(MDA: 3.67)

184.8 ± 7.19

(MDA: 17.54)

옥수수 저준위
51.32 ± 2.17

(MDA: 1.67)

58.64 ± 3.07

(MDA: 11.81)

미역 고준위
169.02 ± 6.82

(MDA: 3.38)

181.6 ± 7.03

(MDA: 16.95)

미역 저준위
54.79 ± 2.29

(MDA: 1.39)

60.26 ± 5.11

(MDA: 11.60)

계란 고준위
205.69 ± 8.24

(MDA: 3.04)

233.8 ± 8.51

(MDA: 17.30)

계란 저준위
64.08 ± 2.66

(MDA: 1.62)

53.20 ± 3.14

(MDA: 13.03)

시료
방사능

준위

감마핵종 분석기

방보원 HPGe 현장 이동형 NaI 현장 이동형 HPGe

물
표준

교정시료

16.25 ± 0.40

(MDA: 0.41)

12.3

(MDA: 8.4)

15.59 ± 2.31

(MDA: 3.62)

옥수수 고준위
111.03 ± 1.85

(MDA: 0.62)

116.5

(MDA: 11.7)

69.75 ± 9.19

(MDA: 4.34)

옥수수 저준위
34.61 ± 0.71

(MDA: 0.41)

35.4

(MDA: 9.7)

32.81 ± 3.46

(MDA: 3.65)

미역 고준위
97.74 ± 1.65

(MDA: 0.48)

105.5

(MDA: 11.3)

86.36 ± 8.11

(MDA: 4.62)

미역 저준위
33.21 ± 0.69

(MDA: 0.42)

30.3

(MDA: 9.57)

27.00 ± 3.13

(MDA: 4.14)

계란 고준위 107.51 ± 1.76 113.2 73.84 ± 9.71
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분석시간: 10,000초(방보원 실험실 고정형 HPGe 감마핵종 분석기, CANBERRA, GENIE-2000),

1,800초(현장 이동형 NaI와 HPGe 감마핵종 분석기)

표 3.1.2.12. 실험실 고정형 HPGe, 현장 이동형 NaI와 HPGe를 이용한 표준시료 137Cs 분석

분석시간: 10,000초(방보원 실험실 고정형 HPGe 감마핵종 분석기, CANBERRA, GENIE-2000),

1,800초(현장 이동형 NaI와 HPGe 감마핵종 분석기)

(3) 농산물 분석시료의 측정결과 비교분석

○ 3차년도 분석 시료 중 방사성 핵종이 검출된 시료(능이버섯, 석이버섯) 각 1개씩을 수

입 고정형 장비(HPGe 검출기)와 개발 이동형 장비(NaI 검출기)로 일본 원전사고 직

후 식약처에서 측정했던 시간과 같이 1800초로 측정하여 그 결과 값을 비교 분석하였

다.

○ 수입산 장비(HPGe 검출기)와 개발된 이동형 장비(HPGe 검출기)의 137Cs 핵종의 측정

결과값을 비교해 본 결과, 석이버섯의 경우 수입산 HPGe 장비 측정값과 개발 HPGe

장비의 측정값이 오차범위 내에서 유사한 값의 결과를 얻을 수 있었으나, 능이버섯의

경우 결과값이 오차범위 밖으로 차이가 나는 것을 볼 수 있었다. 이동형 HPGe 측정

에서 더 낮은 결과 값(11.06 Bq/kg)을 얻었으며, MDA의 경우 두 시료 모두 이동형

HPGe 장비의 값(석이: 5.61 Bq/kg, 능이: 6.87 Bq/kg)이 더 높게 나타났다.

○ 수입산 장비(HPGe 검출기)와 개발된 이동형 장비(NaI 검출기)의 137Cs 핵종의 측정 결

(MDA: 0.57) (MDA: 11.6) (MDA: 4.94)

계란 저준위
33.28 ± 0.70

(MDA: 0.47)

33.3

(MDA: 9.8)

28.57 ± 3.26

(MDA: 3.84)

시료
방사능

준위

감마핵종 분석기

방보원 HPGe 현장 이동형 NaI 현장 이동형 HPGe

물
표준

교정시료

21.81 ± 0.77

(MDA: 0.62)

18.2

(MDA: 9.3)

20.20 ± 1.75

(MDA: 3.96)

옥수수 고준위
150.38 ± 4.38

(MDA: 1.68)

145.8

(MDA: 12.6)

140.5 ± 7.27

(MDA: 4.54)

옥수수 저준위
48.56 ± 1.52

(MDA: 0.80)

45.2

(MDA: 10.8)

43.30 ± 2.79

(MDA: 4.11)

미역 고준위
127.79 ± 3.74

(MDA: 1.48)

122.4

(MDA: 12.1)

121.5 ± 6.40

(MDA: 4.45)

미역 저준위
45.62 ± 1.44

(MDA: 0.831)

37.2

(MDA: 10.5)

43.77 ± 2.80

(MDA: 3.93)

계란 고준위
145.89 ± 4.25

(MDA: 1.48)

152.6

(MDA: 12.4)

146.7 ± 7.59

(MDA: 4.75)

계란 저준위
47.64 ± 1.50

(MDA: 1.01)

43.1

(MDA: 10.9)

42.04 ± 2.77

(MDA: 4.19)
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과값을 보면, 개발 NaI 장비의 경우 MDA가 137Cs 핵종 방사능 값에 근접하여 핵종이

불검출되거나 낮은 측정값을 나타내었다. 이에 대해서는 원인분석 중에 있으며, 제 2협

동에서 개발한 인증 물질을 이용한 교차분석을 통해서 다시 한번 검증하였다.

표 3.1.2.13. 식품 분석시료에 대한 장비 비교분석

구분
HPGe (개발)NaI

131I 134Cs 137Cs 137Cs

석이버섯

수입장비 [MDA: 0.32] [MDA: 0.40]
23.66±0.76
[MDA: 0.51] 7.59

[MDA: 23.80]
개발장비 [MDA: 2.56] [MDA: 1.60]

23.41±2.68
[MDA: 5.61]

능이버섯

수입장비 [MDA: 0.37] [MDA: 0.43]
16.53±0.61
[MDA: 0.63]

[MDA: 22.80]*

개발장비 [MDA: 2.96] [MDA: 1.72]
11.06±1.75
[MDA: 6.87]

* 개발 이동형 장비(NaI 검출기) 측정시 실제 방사성 세슘의 방사능 값(HPGe 측정결과 참고)보다 개발 장비(NaI)의 MDA가 더

높이 나타나 방사능 값이 불검출로 나타남.

(3) 수산물 분석시료의 측정결과 비교분석

○ 방사능 모니터링을 위해서 2013년부터 2015년까지 채취한 수산물 분석 시료의 경우
131I, 134Cs, 137Cs의 방사능 농도 모두 MDA이하의 값을 나타내었다. 그 중 2015년에

채취한 건다시마와 황태에 대해서 수입산 고정형 장비(HPGe 검출기), 개발 이동형 장

비(HPGe 검출기), 개발 이동형 장비(NaI 검출기)로 1800초 측정하여 그 결과 값을 비

교 분석 하였다.

○ 두 시료 모두 인공방사성 핵종이 검출되지 않은 시료이기 때문에 각 장비에 대한

MDA값 비교가 가능하다.

표 3.1.2.14. 수산물 분석시료에 대한 장비 비교분석

구분
Radioactivity(Bq/kg)

131I 134Cs 137Cs

건다시마

수입장비

(HPGe)
<0.700 <1.336 <2.02

개발장비

(HPGe)
<4.05 <4.49 <5.33

개발장비

(NaI)
- - <16.1

황태

수입장비

(HPGe)
<1.56 <2.06 <2.24

개발장비

(HPGe)
<7.61 <9.51 <10.4

개발장비

(NaI)
- - <36.3
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3. 농·축·수산물 중 방사능 실험실 확인검사 연계 현장 신속검사 매뉴얼 개발

기존에 사용하는 실험실 정밀분석과 개발한 NaI와 HPGe 형태의 신속 이동형 분석장비를 연

계하는 방법에 대해서 연구하였다. 실험실 정밀분석의 경우에는 정확하고 낮은 수치의 방사능

을 분석하기 위해서 사용하는데, 비상시에는 대량 분석에 한계가 있다. 따라서 개발된 장비로

대량의 시료를 신속하게 현장에서 분석하고 방사능 오염이 의심되는 식품의 경우는 실험실 정

밀 분석하는 방안을 도출하였다. 식품 공전에서 다루는 핵종 3가지 중 본 연구에서는 Cs-137

를 기준으로 언급하였다. 다른 핵종 I-131과 Cs-134의 경우도 동일한 방식을 따르기 때문에

가장 대표적인 Cs-137에 대해서만 기술하였다.

NaI 검출기를 이용하여 현장에서 300초를 분석하면 방사능의 존재여부를 알 수 있다. NaI 검

출기는 현장에서 신속 분석이 가능하기 때문에 5분이면 비상시 방사능 존재 유무를 즉시 알

수 있다. 방사능 오염이 의심되는 식품은 현장에서 NaI 검출기를 이용하여 최소 검출 농도

(MDA) 10 Bq/kg 기준으로 신속하게 분석할 수 있다. 현장에서 보다 정밀하게 분석하고 싶다

면 HPGe 검출기를 이용하여 30분 측정하여 3 Bq/kg 수준으로 낮은 방사능 오염도를 측정할

수 있다. 3 Bq/kg의 경우는 현재 식품 공전의 기준치 370 Bq/kg에 1 % 미만의 낮은 수치이

다. 현장, 1차(NaI) 및 2차(HPGe) 검출기를 이용하여 스크린하고 이중에 정밀 분석이 필요한

한정된 시료들만 실험실에서 정밀분석하면 된다.

실험실에서 정밀 분석하는 것은 세 가지 경우를 생각할 수 있는데, 먼저 10,000초로 기존 식

품 공전에 측정시간을 고려하고, 보다 정밀한 분석이 필요하면 환경에서 측정하는 기준으로

86400초로 대략 0.2 Bq/kg 정도의 낮은 수치를 정밀 분석할 수 있다. 만일 실험실에서도 대량

을 시료를 분석해야 하는 경우는 30분 측정하여 3.0 Bq/kg 이상의 방사능을 검출할 수 있다.

위에서 설명한 방식을 근거로 하여 실험실 확인검사 연계 현장 신속검사 매뉴얼을 개발하였다.

개발된 매뉴얼의 구성은 정밀분석 매뉴얼로 기존 상용 제품에서 가장 널리 사용되고 국내 식

품업체, 기관에서 모두 이용하고 있는 AMTEK 사의 GammaVison방식과 Canberra사의 Genie

2k 방식의 절차서를 따로 개발하였고, 신속 분석을 위해서 NaI 신속분석 절차서와 HPGe용 절

차서를 별도로 만들었다. 자세한 내용은 부록에 언급하였으며, 아래에는 간단한 목차와 구성방

식을 설명하였다. 아래의 내용을 보면 개념과 전처리는 공통이기 때문에 GammaVision과

Genie 2k에 동시 적용하였고, 분석 방법 및 절차에 대해서는 따로 절차서를 개발하였다.
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가. 정밀분석

(1) 개념 및 전처리
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(2) GammaVision
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(3) Genie 2000
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나. 신속분석

(1) 개발 이동형 HPGe
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(2) 개발 이동형 NaI
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4. 국내 방사능 검사관리 체계 개선

4.1 국내·외 방사능 검사관리 현황 파악

가. 국내 정부부처 및 유관기관 방사능 관리체계 및 기준

(1) 방사능 관리체계

현재 우리나라는 식품의 경우 생산단계에서는 농식품부(농관원), 해수부(수관원), 각 시·도

(농·축·수산물 생산 관련부서)에서 관리하고 있으며, 유통단계에서는 식약처(각 지방식약청 포

함)를 중심으로 각 시·도(식품 위생관련 부서)에서 담당하여 방사능 검사를 실시하고 있으며,

수입단계의 경우 식약처(지방식약청)에서 전담하여 그 결과를 홈페이지 등을 통하여 공개하고

있다. 2003년부터 2008년까지 한국원자력연구원에서 식품의 방사능 분석법 확립과 더불어 시중

에 유통 중인 수입산, 국내산 식품에 대한 방사능 모니터링 결과를 보고한 바 있다. 한국원자

력안전기술원에서는 매년 전국적인 환경 방사능 감시(2001년～2012년), 해양방사능 감시(2005

년～2012년), 원자력이용시설 주변 방사선 환경조사 및 평가(2007년～2012년)등을 진행하고 있

다. 일본 원전사고 이후 여러 기관들 및 단체에서도 수입 및 국내산 식품에 대한 방사능 분석

업무를 진행하고 있으며, 국내 기관별 식품 방사능 오염 감시 현황에 대하여 표로 정리하였다.

표 3.1.4.1. 국내 기관별 식품의 방사능 오염 감시

기관

내용

한국원자력연구소,

원자력안전기술원

수산물

품질관리원

농식품부

(농산물

품질관리원)

광역시, 도

보건환경연구원

식품의약품

안전처
환경부

감시대상

지역 및 국가

국내원자력

시설주변, 해양
국내 국내 국내, 수입 수입, 일본 국내

대상 식품
쌀, 배추, 우유, 계란,

어패류, 해조류등
수산물 농산물

관할지역내

유통식품

농·축·수산물

수입식품
지하수

감시핵종 감마, 베타, 알파 감마 감마 감마 감마

우라늄및라돈,

전베타

전알파

(2) 방사능 관리기준

현재 우리나라는 식품에 대하여 방사성 요오드(131I)의 경우 영아용 조제식, 성장기용

조제식 및 유가공품 등에 대하여 100 Bq/kg, L이며, 기타식품의 경우 300 Bq/kg, L이며,

방사성 세슘(134Cs+137Cs)은 모든 식품에 대하여 370 Bq/kg, L이었으나, 일본 후쿠시마 원

전사고 직후 그리고 최근 후쿠시마 원전 오염수 해양 유출사고 등의 원인으로 2013년 방

사성 세슘에 대하여 기준치를 370 Bq/kg, L에서 100 Bq/kg, L로 강화하였다.
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표 3.1.4.2. 국내 식품 중 방사능 기준

핵종 대상식품 기준(Bq/kg, L)

요오드 131I

영아용 조제식, 성장기용 조제식,

영·유아용 곡류 조제식, 기타 영·유아식,

영·유아용특수조제식품

100

유 및 유가공품 100

기타식품 300

세슘 134Cs+137Cs 모든식품
370 → 100
(*임시강화기준)

(출처: 식품의약품안전처 홈페이지 ‘방사능 안전관리 정보’)

나. 국내 식품업체 방사능 측정 실태조사

국내 식품업체들의 방사능 측정 실태조사를 실시하였으며, 그 중 주요 식품업체들의

실태조사 결과를 아래 표에 정리하였다. 수입산 방사능 측정 장비인 감마핵종분석기

(HPGe 검출기)를 보유하고 있는 식품업체 4곳(농심, 한국야쿠르트, CJ제일제당, 매일유업)

을 방문하여 관리체계를 살펴보고, 실험 숙련도를 측정하기 위한 방법으로 방사성 세슘이

들어있는 기준물질(RM)을 측정하도록 하여 그 결과를 분석하였다.

○ 식품 업체 4곳 모두 비교적 관리가 잘되고 있으나, 식품 중 방사능 오염에 대한 국민들

의 불안과 관심이 줄어들지 않고 더욱 철저한 관리가 요구되기 때문에 몇 가지 보안해

야할 점들을 나열하였다.

○ 현재 식품 방사능 검사를 위한 고가의 방사능 측정 장비는 몇몇 대기업 식품 업체에서

만 운영되고 있으며, 이마저도 1～2대 정도 보유하고 있는 실정으로 많은 양의 원재료

와 완제품을 검사하기에 역부족이고, 중소기업에서는 자체 검사가 불가능 것이 현실이

다. 또한 원전사고 이후 측정 장비의 수요가 급증하여 대부분의 식품 업계에서는 구매

후 장비 입고까지 1년 또는 2년이 넘게 소요되었다. 예기치 못한 비상상황이 발생할 경

우(중국, 북한 등의 주변국에서의 방사능 사고 등), 장비 공급이 원활하게 이루어지지

않아 식품 업계는 원재료와 완제품에 대한 방사능오염 안전성을 확인하는 데에 어려움

이 따르게 될 것으로 예상된다.

○ 또한 대부분의 식품회사 연구실에서는 방사능에 대한 전문지식이 낮은 유사 전공자 또

는 비전공자가 방사능 관련 업무를 수행하고 있었고 담당자도 자주 바뀌고 있어 전문성

이 부족하다는 문제점이 지적되었다. 이는 측정 결과에 대한 신뢰도와 연결되므로 보다

체계적인 식품 방사능 검사체계의 구축을 위해서는 관련 전문 지식을 가지고 있는 연구

자가 실험을 진행해야하고, 방사능에 대한 기본 이론, 분석 관련 정보와 최신 동향에 대

한 주기적이고 전문적인 교육이 진행되어야할 것이다.

□ 향후에도 방사능 측정 유관기관들과 관련 식품업체들에 대한 실태조사를 주기적으로 실시

하여 관리하고, 실태조사 중에 문제로 제기된 점들에 대한 검토와 개선이 필요하다.
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표 3.1.4.3. 국내 식품업체 식품 방사능 측정 실태조사

구분
식품업체

농심(주) 한국야쿠르트 CJ제일제당 매일유업

검출기
GEM60P4-83-SMP

(NaI 대비효율 60%)

GEM60P4-83-SMP

(NaI 대비효율 60%)

GEM60P4-83-SMP

(NaI 대비효율 60%)

GEM60P4-83-SMP

(NaI 대비 효율 60%)

GC-4018

분석프로그램 Gamma-Vision Gamma-Vision Gamma-Vision

Gamma-Vision

Genie-2K

제조사 Ortec Ortec Ortec

Ortec

Canberra

구입년도 2011 2011 2011

2012

2013

분석용도
식품(원재료)

감마핵종 분석

식품(원재료)

감마핵종 분석

식품(원재료)

감마핵종 분석

식품(원재료,완제품)

감마핵종 분석

분석시료
분말 향신료, 복합

시조닝류 등

일본산원재료

(향료,라면분말스프등)

해산물(가츠오부시),첨

가물 등

영유와관련원재료,

일본산원재료(향료) 등

분석시간(sec)

(시료)
> 20,000 > 80,000 > 10,000 10,000～50,000

분석시간(sec)

(표준선원)
10,000 172,8000 10,000 50,000

장비 및

표준선원

관리

년 1회 표준선원

직접 구입, 교정

년 1회 표준선원

직접 구입, 교정

년 2회 영인과학

표준선원 교정,

기기점검

년 2회 영인과학

표준선원 교정,

기기점검

KRISS 쌀

CRM

측정결과1)

(Bq/kg)

137Cs (3.07±0.18) 137Cs (3.39±0.20) 137Cs (3.17±0.22)

137Cs (3.15±0.24)

137Cs (3.16±0.21)

기타 문제점

및 보안점

∙Coincidence summing 으로 인해 결과 상이함에 대한 보정, 관련 교육 필요

∙시간당 처리 가능 시료 한정으로 결과 분석 지연

∙검체 전처리 시 밀도 차이 발생

∙검체 전처리 시 분진 발생으로 실험자 피폭 가능, 관련 교육 및 방호장비 필요

∙고가의 원재료(향료 등) 측정 시 비용 부담

∙방사능 표준인증물질 구입으로 실험자 숙련도 확인 필요

∙방사능 물질(표준선원 등) 구입과 폐기 등에 대한 정보 및 교육 필요

1) KRISS에서 개발한 쌀 CRM (137Cs 인증값 : 3.1 Bq/kg)
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다. 국외 식품 중 방사능 관리체계 및 현황

○ 각 국가별 식품 중 방사능 관리 기준을 아래 표에 정리하였다.

표 3.1.4.4. 제외국 식품 중 방사능 기준 현황(요오드, 세슘)

국가

방사성요오드 131I (Bq/kg) 방사성세슘 134Cs, 137Cs (Bq/kg)

음료수
우유,
유제품

채소류
(뿌리채소
등제외)

기타 음료수
우유,
유제품

채소류 곡류
육류,난류,
어류,기타

일본 - - - - 10 50 100 100 100

미국 170 170 170 170 1,200 1,200 1,200 1,200 1,200

중국 - 33 160

육류,수산물:
470

곡류:190
서류:89

- 330 210 260
육류,수산물
:800
서류:90

Codex 100 100 100 100 1,000 1,000 1,000 1,000 1,000

EU
300 300 2,000 2,000

200 200 500 500 500

영유아용 식품 100

* EU의 경우 일본산 수입제품에 대해서는 일본기준을 적용하고 있음

표 3.1.4.5. 제외국 식품 중 방사능 기준 현황(풀루토늄, 스트론튬)

국가

방사성플루토늄 238Pu (Bq/kg) 방사성스트론튬 90Sr (Bq/kg)

영유아식품,
우유 및 유제품

액체식품 기타식품
영유아식품,
우유 및 유제품

액체식품 기타식품

미국 2 2 2 160 160 160

Codex 1 10 10 100 100 100

EU 1 20 80 75 125 750

* 일본산 수입식품의 경우 요오드 및 세슘이 기준치 이내로 검출되더라도, 수입자에게 ‘플루토늄, 스트론튬 등’ 다른 방사능 핵

종에 오염되지 않았음을 추가로 입증하도록 요구하고 있음

(출처: 식품의약품안전처 홈페이지 ‘방사능 안전관리 정보’)
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4.2 원전사고 지역 방사능 검사관리 현황 파악

(1) 미국

○ 미국의 식품안전관련(방사능 오염) 유관기관을 방문(2014.12.06～2014.12.11)하여 미국의

식품 방사능 모니터링 체계와 관리현황 등에 대하여 알아보았다.

○ 1961년 이후 식품의약품안전청(FDA) 주관으로 미국 내 생산 식품과 원자력 발전소 주

변에서 생산되는 식품에 대한 방사능 오염 모니터링을 하고 있다. 1986년 체르노빌 원전

사고와 2011년 일본 원전사고 이후부터는 수입산 식품에 대해서도 방사능 검사를 실시

하고 있다. 1999～2005년까지 연도별 방사능 측정 결과와 FDA 산하 WEAC(Winchester

Engineering and Analytical Center)에서 2011～2012년 조사한 일본 원전관련 “Japan

Earthquake/ Tsunami Tracking Report(DFS)" 보고서 결과가 공개되고 있다.

○ FDA에는 식품의 샘플을 수집하고 분석하는 900여명의 연구관과 450여명의 분석전문가가

있으며, 동물의 사료를 포함하여 FDA가 관할하는 모든 식품의 수입을 관리 감독하고 있다.

○ 모든 수입식품은 수입단계에서 자동적으로 검사되고 있으며, FDA에서는 연간 31,000

개의 수입식품 샘플 분석과 175,000번이 넘는 실험을 수행하고 있다.

○ FDA에서는 식품내의 방사성 핵종(radionuclide) 수준을 측정하는 방법과 기술을 보유

하고 있으며, 식품 응급 대응 네트워크(FERN; Food Emergency Response Networ

k)5)를 활용하여 식품의 오염정도를 측정하고 있다.

○ 미국 세관 및 국경보호기관(CBP; US. Customs and Border Protection)와의 협력을

통해서는 잠재적 위협이 되는 제품의 선적을 바로 파악하고, 일본에서 수입되는 제품

은 모두 자동적으로 수입 추적 시스템이 적용되도록 관리하고 있다.

○ 특히, “수입경보(Import Alert) #99-336)"을 통해 방사능 오염이 우려되는 지역에서 제

조, 판매되는 제품의 경우, 따로 검사를 하지 않고 이들 지역의 제품 수입을 전면 보

류하도록 하고 있다.

∙ 2014년 기준 제품 수입이 중단된 일본의 14개 지역: 후쿠시마, 아오모리, 치바, 군마, 이바

라키, 이와테, 미야기, 나가노, 니가타, 사이타마, 시즈오카, 도치기, 야마가타, 야마나시

∙ 2014년 기준 수입이 되지 않는 제품군: 육류와 수산물을 포함한 관련 식품군

○ 일본에서 수입되는 FDA 관리감독 제품은 식품과 동물사료, 의료기기와 방사선 방출제품

(radiation emitting products), 화장품, 인체 의약품, 생물학적 약제(biologics), 식이보충제 등이

있으며, 일본산 수입식품은 미국 전체 수입식품 가운데 4% 미만을 차지하고 있다.

∙ 캐나다와 멕시코 수입 식품이 각각 전체 수입 식품의 29%를 차지

∙ 일본에서 수입되는 제품 가운데서는 60%가 식품에 해당하며, 가장 흔하게 수입되는

식품은 수산물, 스낵, 가공 처리된 과일과 채소

5) 식품응급대응네트워크(FERN): 식품의 생물학적, 화학적, 방사능 오염 등과 관련된 긴급 상황에 대응하기 위하여 미국 연방, 주, 지방 정부기

관의 식품 연구소를 하나의 네트워크로 통합하여 만든 식품 안전 연구소 시스템

6) 수입경보(Import Alert) #99-33: 방사능 오염으로 인한 일본산 제품의 물리적 검사 없는 억류(Detention without physical examination of

products from Japan due to radionuclide contamination)
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○ FDA에서는 원전사고 지역 인근에서 생산되는 식품이지만, “수입경보 #99-33”의 적용

을 받지 않는 제품들에 대해서는 시간에 따른 온도변화와 수질오염 등을 포함한 지역

실태 검사를 실시하고, FDA 실험실을 통해 방사성 핵종을 분석할 수 있도록 해당 지

역의 샘플을 채집하고 있다.

○ 원전사고 인근지역 이외의 일본 지역에서 생산되어 수입되는 제품의 경우 방사능 무

선검출기로 스크리닝하고 그 결과값이 백그라운드 값보다 높은 경우 해당 샘플을 수

집하고, 그 외에 방사능 무선검출기 결과값이 0인 경우에도 추가적인 감시를 위해 샘

플을 수집하고 있다.

○ CBP에서는 방사선 탐지 장치를 통해 수입되는 모든 식품과 화물, 여행객들을 조사하

여 잠재적 위험을 사전에 인지하고 해결하며, FDA는 일본산 제품의 선적을 검토하

고, 수입여부 및 실험여부 등을 결정하고 있다.

○ 또한 미국의 생물테러법(Bioterrorism Act; Public Health Security and Bioterrorism

Preparedeness and Response Act of 2002)에서는 모든 식품과 음료를 수입하는 업체

들은 수입 식품의 미국 도착 24시간 전까지 FDA에 식품의 내용을 사전 신고토록 하

고 있어 인체에 위해를 줄 수 있는 식품이 발견되었을 경우 FDA는 해당 식품이 미

국 국경에 도착하지 않도록 조치하고 있다.

○ FDA는 일본 정부의 식품 샘플 검사, 일본과 지리적으로 인접하면서 일본으로부터 많

은 양의 식품을 수입하는 국각의 수입 식품 샘플 검사, 후쿠시마 원전사고와 관련된

국제원자력기구(IAEA)와 같은 국제기구의 검사 등 외국 정부기관들과 국제기구의 정

보와 관련 데이터 등도 면밀하게 주시하고 있다.

○ 후쿠시마 원전사고와 관련하여 식품에 영향을 줄 수 있는 방사성 핵종은 요오드(131I)

와 세슘(134Cs, 137Cs)이며, FDA에서는 필요한 경우 스트론튬(90Sr)과 루테늄(103Ru,
106Ru)도 검사하고 있다.

○ FDA가 2014년 3월까지 후쿠시마 오염과 관련한 모니터링의 일환으로 검사한 수입 및

국내 샘플은 1,345개이며, 이 가운데 225개가 수산물이거나 수산물 가공식품이었다.

∙ 1,345개의 검사 샘플 가운데, 세슘이 검출된 제품은 2개였으나 그 수준은 FDA의 유

도개입준위(DILs; Derived Intervention Levels)*를 훨씬 밑도는 수준이었으며 건강

상 아무런 위해를 나타내지 않는다고 보고

* 미국내 식품에 적용되는 방사성 핵종의 유도개입준위(DILs; Derived Intervention Levels)

Radionuclide Group DIL(Bq/kg)

Strontium-90 160

Iodine-131 170

Cesium-134 + Cesium-137 1200

Plutonium-238 + Plutonium-239 + Americium-241 2

Ruthenium-103 + Ruthenium-106c (C3 / 6800) + (C6 / 450) < 1
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∙ 세슘이 검출된 제품: 생강파우더(2011년 4월 채집), 녹차티백(2013년 8월 채집)

○ FDA는 방사능 안전 문제에 대하여 정부뿐만 아니라, 학계 및 민간 전문가들의 의견

을 구하고, 민간과 공립 연구 기관에서 발표되는 연구 자료들의 최근 동향과 사실 관

계를 파악하여 안전 확립에 노력하고 있다.

○ 미국 국립과학원(PNAS; Proceedings of the National Academy of Science of the

United States of America)에서 2012년에 발표한 논문에서는 2011년 8월 캘리포니아

해변에서 잡힌 참다랑어에서 미량의 세슘이 검출되었다고 보고되었으나, FDA가 논문

에서 발표한 세슘의 농도를 확인한 결과 FDA가 우려하는 수준의 세슘 농도보다 300

배 더 낮은 농도임을 확인하였다.

○ 방사능 물질에 오염된 해수가 수산물 안전에 미치는 영향에 대하여, FDA는 수산물

안전성에 어떠한 위해도 있지 않을 것으로 예상하고 있다.

∙ 그 이유로는 ①방사능에 오염된 인근 지역에서 어획을 하지 않으며, ②물은 방사능에

대하여 스스로 방어하고, 희석제 역할을 하며, ③몇 종의 방사성 핵종은 급속하게 사

라지고, ④FDA는 CBP와 협력하여 일본에서 수입되는 모든 식품을 검사하기 때문임

○ 방사능 오염 인근지역에서 미국 해안가로 와서 포획되는 어종에 대해서도 FDA는 아

무리 조건이 좋아도 해수가 일본에서 미국으로 오기까지는 상당한 시일이 소요되며,

미국 해안가를 떠나 일본 인근에서 어업을 하는 배도 미국으로 다시 돌아오기까지 상

당한 기간이 걸리기 때문에 오는 동안 반감기가 짧은 방사성 핵종의 경우에는 거의

소멸될 것으로 예상하고 있다.

∙ 일본에서는 비교적 수명이 긴 방사성 세슘(137Cs)과 같은 핵종이 몇몇 샘플에서 검출

되었지만, 일본에서 수입되는 수산물에서는 불검출되었음

○ FDA는 방사능 오염물질이 미국까지 오는 어종에 영향을 미칠 확률은 매우 작다고 보

고, 미국 국립해양기상청(NOAA)과 함께 사고 인근지역에서 잡히는 수산물을 시험하

고, 인근 지역에서 수산물을 가공·판매하는 수산물 가공시설도 점검할 계획이다.

∙ FDA의 방사능 오염 수산물 분석 연구소: FDA's Winchester Engineering and

Analytical Center(WEAC), 식품응급대응네트워크(FERN) 실험실

○ 유제품과 관련하여 미국 환경보호청(EPA)이 수행하고 있는 자연 방사선 모니터링 프

로그램(RADNET)에서는 우유에 대한 방사능 오염 여부를 검사하였으며, 그 결과 채

집된 샘플에서 매우 낮은 수준의 요오드와 세슘이 검출되었다.

∙ 검출량은 FDA의 유도개입준위(DILs)보다 매우 낮은 수준이었으며, 심지어 우유를

많이 섭취하는 사람도 건강에 위해를 주는 수준의 방사능 오염에 노출되는 것은 불

가능한 정도임

○ 연방과 주 정부기관에서도 우유 샘플을 검사했을 때 낮은 수준의 요오드가 검출되었으

나, 그 수준은 약간씩 달랐으며, 이처럼 낮은 수준의 방사성 핵종에 의한 위해정도는 성

인뿐만 아니라 태아, 신생아, 어린이에게도 영향을 미치기 힘든 수준으로 판단하고 있다.
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○ 현재 일본에서 수입되는 제품은 전체 수입 식료품의 4% 미만이며, 그 중에서 유제품

은 단 10%를 차지하고 있어 미국 내 유통되는 대부분의 유제품은 미국에서 생산된

제품이라 할 수 있다.

○ 종합적으로 미국은 FDA를 중심으로 일본산으로 표기된 식품들과 일본을 경유하여 들

어오는 식품, 원료에 대해서 검사를 실시하고 있으며, 현재 시점에서 식품의 방사능

오염에 대한 노출로 야기될 수 있는 위협은 미국 내에 없다고 결론을 내렸으며, 미국

에 방사능 오염물질이 퍼질 어떠한 가능성에 대해서도 신중하게 접근하고 있다. 다만

이론상으로도 상당한 양의 방사능이 미국까지 도달하기는 어렵다고 판단하고 있다.

(2) 일본

○ 일본은 후쿠시마 원전사고 이후 종합적인 방사능 모니터링 체계를 구축하였으며, 그

중 일부 아래 표에 정리하였다. 일본 원자력규제위원회(NRA)가 총괄하여 각 기관에

서 소관품목을 관리, 감독하고 있으며, 그 결과를 일본 원자력규제위원회와 후생노동

성 등의 홈페이지를 통해 공개하고 있다.

표 3.1.4.6. 일본 방사능 모니터링 체계

구분

대상
관련(검사) 기관 측정표본 측정지역 측정결과

Foodstuffs

∙후생노동성(MHLW)

∙농림수산부(MAFF)

∙각현(Respective prefecture)

∙수산청(fisheries agency)

∙지방자치단체(Local governments)

∙어업조합(Fishery unions)

∙농, 축, 수산물

∙우유, 유아식

∙야생동물고기

∙먹는물

∙소금등

∙각현별로측정

∙일자별, 주기별로 후생노동성, 농림수산

부, 수산청, 후쿠시마현 홈페이지에 공

개

Water

Water

environment

∙환경부(MOE)

∙후쿠시마현(Fukushima prefecture)

∙Water

∙Bottom soil

(물과함께검사)

∙Rivers, lakes and water

resources(후쿠시마현)

∙Ground water

(후쿠시마현및주변지역)

∙매년 6월～8월 해안가, 호숫가의 해

수욕장

Tap

water

∙후생노동성(MHLW)

∙원자력재해대책본부

∙각현(Respective prefecture)

∙Tap water

∙Drinking water
∙각현에서측정

∙월별 후생노동성 홈페이지에 결과보고

(후쿠시마현결과)

∙일자별결과보고(도쿄도)

∙주기별 원자력규제위원회 홈페이지에

결과보고

Sea-area

∙원자력규제위원회(NRA)

∙수산청(fisheries agency)

∙국토교통성(MLIT)

∙환경부(MOE)

∙해상보안청(Japan coast guard)

∙후쿠시마현(Fukushima prefecture)

∙도쿄전련(TEPCO)

∙지방자치단체(Local governments)

∙어업조합(Fishery unions)

∙해수

∙해저퇴적물

∙해양생물

∙Sea area close to TEPCO's

Fukushima Daiichi NPS

∙Coastal area

∙Off-shore area

∙Outer sea area

∙Tokyo bay

∙주1회NRA홈페이지에결과보고

∙매년 1회 NRA 연차보고서
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○ 일본 후생노동성, 농림수산성, 소비자청 그리고 방사선의학총합연구소를 방문(2013.11.03～

2013.11.08)하여 일본의 식품 방사능 모니터링 체계와 관리현황 그리고 리스크커뮤니케이

션 방안에 대하여 알아보았다. 이를 통해 국내 식품 방사능 모니터링 체계와 소통 방법의

문제점을 파악하고 벤치마킹을 통한 비상시 관리 체계 구축과 리스크커뮤니케이션 방안을

마련할 수 있을 것으로 기대된다.

○ 일본 정부의 방사능 관리체계와 소관부처별 업무분장 내용은 아래 그림에 기술하였

다. 후생노동성은 지방자치단체의 출하제한 등 계획적인 식품 검사를 위해 검사기기

구입 및 유지보수 비용을 보조하고 있으며, 농림수산성은 농축산물·농경지 토양 등의

검사를 위한 장비구입비 및 유지보수 비용을 보조하고 있다. 소비자청에서는 지방자

치단체와 연계하여 검사수요를 파악, 검사기기 대여신청을 접수하여 검사업무에 관한

조언 및 정밀 검사체제 장비 등을 지원하고 있다. 소비자가 직접 의뢰하는 식품과 자

가 재배 작물에 대한 방사능 측정은 소비자청에서 수행하고 있으며, 학교 급식에 대

한 식품의 방사능 검사 업무는 문부과학성에서 담당하고 있다.

그림 3.1.4.1. 일본정부의 방사능 관리체계

○ 일반 식품 중 방사성 세슘 측정시 게르마늄 검출기를 사용하여 검사하는 것으로 공인

시험법에 규정되어 있지만 실제 검사시 현재 NaI 검출기를 사용하여 스크리닝 한 후

기준치(100 Bq/kg)의 1/5인 20 Bq/kg 이하인 경우 시장유통이 적합한 것으로 판단하

고, 20 Bq/kg 이상인 경우 게르마늄(HPGe) 검출기로 정밀 재측정하고 있으며, MDA

(최소검출농도) 또는 검출하한치는 별도로 규정하지 않고 있다.
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그림 3.1.4.2. 방사성 세슘 검사기기(Acrobio Captus 3000A, NaI 검출기)

○ 후생노동성

∙ 후쿠시마 사고 이후 Codex에서 채택한 1 mSv로 연간유효선량을 낮추어 이를 토대

로 식품의 각 품목별 방사능 기준치 설정함

- 음료수 0.1 mSv(연간 물을 통해 10 Bq/kg)와 식품 0.9 mSv를 통하여 섭취된 방

사성 핵종(134Cs와 137Cs, 90Sr, 106Ru, 238Pu)의 연간선량이 1 mSv를 초과하지 않도

록 기준치를 산정하여 규제

- 식품에 의한 연간선량 규제치 0.9 mSv 중 약 12%를 세슘 이외에 방사성 물질에

의한 오염으로 고려

∙ 소비자청과 연계하여 지방공공단체의 검사장비 수요파악 및 구매(정기적인 회의를

개최하고 수시로 정보 공유)

∙ 소비자청, 농림수산성 등과 함께 연계하여 소비자, 생산자, 연구자들과 식품 중 방사

성 물질에 대한 리스크커뮤니케이션 실시함

- 지방자치단체를 위한 교육 세미나 개최(기준치, 모니터링 체계, 검사방법, 리스크커

뮤니케이션)

- 기준치에 대하여 라디오 보도, 신문 광고, 온라인 기사, 인터넷 TV 등을 통해 설명

- 포스터 또는 인쇄물을 공공장소 등에 배포하여 식품 중 방사성 물질에 대한 정보

전달

○ 농림수산성

∙ 방사성 물질 오염 기준은 후생노동성과 동일(연간유효선량 1 mSv에 의해 설정된 기

준치)

∙ 수산물에 대해서는 방사성 세슘 이외 물질이 세슘과 동일하게 존재한다고 가정하여

검사함. 현재까지 수산물 조사에서 방사성 스트론튬(90Sr)은 실효선량 계수를 사용하

여 선량 환산시 방사성 세슘의 약 1/500에서 1/5 정도의 비율

∙ 하부기관인 수산청에서 수산물에 대한 방사성 물질 검사를 실시

- 후쿠시마현 총 검체수: 29,088(2015년 7월말 현재)
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- 후쿠시마현 이외 지역 총 검체수: 35,586(2015년 7월말 현재)

○ 소비자청

∙ 지방공공단체의 방사성 물질 검사기기 수요파악 및 대여(후생노동성, 농림수산성, 문

부과학성과 정기적인 회의 또는 수시로 정보를 공유하면서 기기 대여사업을 기획,

실시)

∙ 사단법인 일본 동위원소협회와 연계하여 연수회 실시(전국, 지방)

∙ 소비자가 의뢰한 식품, 자가재배식품, 학교 급식 등에 대한 방사능 분석

∙ 국민생활센터와 연계하여 검사정보 수집

∙ 후생노동성, 농림수산성 등과 함께 연계하여 소비자, 생산자, 연구자들과 식품 중 방

사성 물질에 대한 리스크커뮤니케이션 업무 수행

- 방사능에 대한 설명회 개최(2012～2013년 총 220회 개최)

- 인터넷 TV를 통해 식품 중 방사성 물질에 대한 동영상 반영

- ‘식품과 방사능 Q&A' 등의 인쇄물을 공공장소 등에 배포하여 식품 중 방사성 물

질에 대한 정보 전달

그림 3.1.4.3. 후생노동성 식품 중 방사성 물질에 관한 리스크 커뮤니케이션
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그림 3.1.4.4. 소비자청 식품 중 방사성 물질에 관한 리스크 커뮤니케이션

4.3 농식품 방사능 검사관리 개선방안 마련

가. 후쿠시마 원전사고 및 방사능 오염에 대한 인식조사

(1) 조사목적

○ 2011년 3월 11일 일본 동북부 지방 앞바다에서 발생한 대규모 지진과 쓰나미로 인해

후쿠시마 현에 위치해 있던 원자력 발전소의 원자로가 폭발하여 다량의 방사능 물질

이 누출되는 사고가 발생하였고, 사고 이후 우리 국민들은 방사능 물질에 직접 노출

되는 것뿐만 아니라 방사능에 오염된 식품을 통한 인체 피폭을 우려하게 되었다.

○ 이에 정부는 방사능 물질에 오염된 식품의 유통을 차단하기 위해 일본산 식품의 수입

을 통제하거나 식품 방사능 검사를 강화하였고, 홈페이지 등을 통해 그 결과를 공개

하고 있다. 하지만 정부의 이러한 조치에도 불구하고 방사능 물질에 오염된 먹거리로

인해 건강을 해칠 수 있다는 국민들의 불안감은 줄어들지 않았고, 일본 원전사고와

관련한 루머들이 인터넷 등을 통해 무분별하게 확산되면서 일본산 식품의 수입을 반

대하거나 소비를 기피하는 현상들이 나타났다.

○ 방사능 오염 식품의 섭취로 인한 내부피폭은 대개 낮은 선량의 방사선 노출로, 건강

에 영향을 끼치는지 여부는 과학적으로 명확하게 결론이 나지 않은 상황이다. 이러한

불확실성은 부정적인 위험 인식의 요인으로 작용하고, 원전사고 및 방사능과 관련하

여 입증되지 않은 정보의 유통과 전달 매체들의 정보 불일치 등을 유발해 과도한 불

안감을 형성시킬 수 있다. 이러한 부정적 인식과 불안감 증가 요인들을 감소시키고

국민들의 인식 변화를 도모하기 위한 방법 중 하나로 리스크커뮤니케이션의 필요성과

중요성이 강조되고 있다. 리스크커뮤니케이션 활성화를 위해서는 다양한 계층을 대상

으로 한 인식조사가 선행되어야하며, 이러한 조사 결과의 면밀한 분석을 통해 국민들

이 쉽게 이해할 수 있는 수준의 정확한 정보를 생산하고 효과적인 창구를 이용해 쌍
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방향으로 소통되어야 할 것이다.

○ 본 인식조사는 일본 후쿠시마 원전사고 이후 원전사고 및 방사능 오염에 방사능에 대

한 기본 지식, 지식수준의 자각정도, 원전사고 영향 정도, 정보 취득 경로 등을 분석

함으로써 우리 국민들의 인식 수준을 파악하고, 일본 원전사고와 방사능에 대한 올바

른 정보 전달과 인식제고를 위한 효과적인 리스크커뮤니케이션 방안의 기초자료를 마

련하고자 하였다.

(2) 조사방법

○ 조사는 2014년 9월 15일부터 9월 30일까지 수도권에 거주하는 만 20세 이상 성인 600

명을 대상으로 1:1 면접설문 방식으로 응답자가 직접 설문지를 작성하도록 하였다.

○ 설문지는 방사선과 방사능에 대한 국민들의 지식수준 및 자각정도, 후쿠시마 원전사

고와 방사능 오염에 대한 인식, 후쿠시마 원전사고와 방사능 관련 정보 수집경로 및

신뢰도, 향후 후쿠시마 원전사고에 대한 정보제공 방향 및 해결과제 등 4개 항목으로

분류한 후 총 14개 문항으로 구성하였다. 완성된 설문지는 원자력 및 방사능 전문가

와 사회과학 전문가에게 의뢰하여 구성과 문항의 타당성을 검토 받았고, 수집된 자료

는 SPSS19.0 통계프로그램을 사용하여 분석하였다.

(3) 조사결과 및 고찰

(가) 조사대상의 일반적 특성

○ 조사대상의 일반적 특성은 아래 표와 같다. 전체 응답자는 600명이며, 남자 295명

(49.2%), 여자 305명(50.8%)이다. 연령별로는 20～29세 109명(18.2%), 30～39세 135명

(22.5%), 40～49세 122명(20.3%), 50～59세 111명(18.5%), 60～69세 66명(11.0%), 70세

이상이 57명(9.5%)이었다.

표 3.1.4.7. 조사대상의 일반적 특성

구분
N

600

%

100

성별
남자 295 49.2

여자 305 50.8

연령

20～29 109 18.2

30～39 135 22.5

40～49 122 20.3

50～59 111 18.5

60～69 66 11.0

70～ 57 9.5
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(나) 방사선과 방사능에 대한 지식수준 및 자각정도

○ 응답자 본인의 지식수준에 대한 자각 정도를 알아보기 위한 ‘방사선과 방사능에 대하

여 알고 있는가’라는 문항에 대해 ‘매우 잘 알고 있다’는 70명(11.7%), ‘알고 있다’는

255명(42.5%), ‘모른다’는 253명(42.2%), ‘전혀 모른다’는 응답자는 22명(3.7%)으로 나

타났다.

○ 방사선과 방사능에 대한 실제 지식 정도를 알아보기 위해 ‘방사선과 방사능은 같은

뜻이다’, ‘방사선은 일종의 에너지원이다’, ‘병원에서 건강검진에 이용하는 X-ray는 방

사선이다’ 등 10개 세부 문항을 제시하여 ‘그렇다’, ‘그렇지 않다’, ‘모른다’로 답하도록

하였다. 각 문항별로 올바른 답변이면 10점, 잘못된 답변 또는 ‘모른다’로 응답한 경우

는 0점으로 처리하여 총 100점으로 환산하여 평가한 결과, 평균 56.7점(SD=19.4)으로

나타나 방사선과 방사능에 대한 지식수준이 높지 않았다. 금번 연구의 질문 문항과는

차이가 있으나 2011년 한국보건환경연구원의 선행연구에서도 우리 국민들의 방사성

물질 관련 지식과 이해도는 전반적으로 낮다는 사실을 확인할 수 있다. 해당 연구에

서는 지식수준과 이해도가 낮은 상황에서 정확하지 않은 정보가 확산될 경우 실제보

다 불안감이 증가될 수 있다고 지적하고 있다.

○ 지식수준을 100점 만점으로 점수화 한 후 상위그룹 71～100점, 중상위그룹 61～70점,

중하위그룹 41～60점, 하위그룹을 0～40점으로 분류해본 결과 상위그룹은 114명

(19.0%), 중상위그룹 94명(15.7%), 중하위그룹 225명(37.5%), 하위그룹 167명(27.8%)으

로 나타났다.

○ 방사능에 대한 지식수준이 높은 상위그룹은 지식수준에 대한 자각 정도는 ‘잘 모른다

(45.6%)’로 답변한 비율이 높아 본인의 지식수준을 실제 보다 낮게 평가하는 경향을

보였고, 중상위그룹의 경우 실제 지식수준과 자기 인식수준이 유사한 경향을 보였다.

반면 중하위그룹과 하위그룹은 ‘잘 알고 있다’라고 답변한 비율이 각각 48.4%, 34.1%

로 실제보다 자기 지식수준을 높게 평가하는 경향을 보였다.

표 3.1.4.8. 방사선과 방사능 지식수준 및 지식자각정도

구분
지식자각정도

계
매우잘안다 알고있다 모른다 전혀모른다

상위그룹
(71～100 점)

N 20 41 52 1 114

% 17.5 36.0 45.6 0.9 19.0

중상위그룹
(61～70 점)

N 13 48 31 2 94

% 13.8 51.1 33.0 2.1 15.7

중하위그룹
(41～60 점)

N 22 109 91 3 225

% 9.8 48.4 40.4 1.3 37.5

하위그룹
(0～40 점)

N 15 57 79 16 167

% 9.0 34.1 47.3 9.6 27.8

계
N 70 255 253 22 600

% 11.7 42.5 42.2 3.7 100.0
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(다) 후쿠시마 원전사고와 방사능 오염에 대한 인식

○ 후쿠시마 원전사고로 인해 본인 및 국내에 미치는 영향에 대한 인식도를 파악하기 위

해 5개 문항을 활용하였다. ‘후쿠시마 원전사고로 인한 방사능 누출이 우리나라에 영

향을 미치고 있다’라는 문항에 대해서는 ‘매우 그렇다’와 ‘그런 편이다’라고 답변한 응

답자가 각각 233명(38.8%), 323명(53.8%)으로 대부분을 차지하였고, ‘그렇지 않은 편이

다’ 또는 ‘전혀 그렇지 않다’는 응답자는 7.3%에 그쳤다. 주로 남성보다는 여성들이,

평균연령이 낮아질수록, 방사능에 대한 지식수준이 높을수록 원전사고 방사능 누출의

영향을 우려하고 있었다.

○ ‘매우 그렇다’와 ‘그런 편이다’라고 답한 응답자 556명(92.6%)을 대상으로 후쿠시마 원

전사고로 인한 방사능 물질 누출로 ‘어떤 부분이 가장 우려되는지’를 질의한 문항에서

는 ‘어패류 등의 수산물 오염’이 52.9%로 가장 높았고, ‘오염된 농수산물 및 식품 수

입’ 18.5%, ‘방사능 비 또는 대기에 의한 직접적 인체 노출’ 17.4% 등의 순으로 나타

났다. 이와 같은 결과는 원전사고 직후, 그리고 최근 태풍의 영향으로 방사능 물질이

바다로 유출되면서 수산물에 대한 방사능 오염의 우려가 높아진 점이 원인으로 보인

다.

○ 식품의 방사능 오염 위험에 대한 인식을 알아보기 위해 ‘후쿠시마 원전사고 이후 우

리나라 국내산 식품이 방사능 오염으로부터 안전하다고 생각하는가?’라는 문항에 ‘전

혀 안전하지 않다’ 또는 ‘안전하지 않은 편이다’고 답한 응답자는 전체의 72.5%, ‘안전

한 편이다’ 또는 ‘매우 안전하다’는 응답자는 27.5%였다. ‘후쿠시마 원전사고 이후 국

내에 수입되는 일본산 식품이 방사능 오염으로부터 안전하다고 생각하는가?’라는 문

항에는 ‘전혀 안전하지 않다’ 또는 ‘안전하지 않은 편이다’라고 답한 응답자는 전체의

93.0%, ‘안전한 편이다’ 또는 ‘매우 안전하다’는 응답자는 7.0%였다. 따라서 일본산 수

입식품의 방사능 오염에 대한 우려도가 더 높았지만, 국내산 식품에 대한 불안감도

여전히 높은 비율을 나타냈다. 국내 영향에 대한 인식도와 마찬가지로 남성보다 여성,

평균연령이 낮을수록, 방사능에 대한 지식수준이 높을수록 국내산 식품과 일본 식품

의 방사능 오염에 대한 불안감이 높았다. 이는 가사와 육아 비중이 높은 여성들이 남

성들에 비해 식품안전 문제에 민감하고, 20～30대 연령대와 지식수준이 높을수록 방

사선 피폭 위험에 대한 지식 습득 기회가 상대적으로 많았을 것이고 이 과정에서 일

부 과장된 정보에 보다 빈번하게 노출된 것이 원인으로 추정된다.

○ ‘후쿠시마 원전사고 이후 본인 및 가족 건강을 위하여 어떠한 조치를 취한 적이 있는

가’라는 문항에 전체의 87.0%가 별도의 조치를 취한 적이 있다고 답변하였다. 구체적

으로 어떤 조치를 취하였는지를 살펴본 결과, ‘일본산 식품의 섭취를 자제한다’ 34.3%,

‘수산물의 섭취를 줄이거나 하지 않는다’ 19.1%, ‘외출 후 손을 씻거나 샤워를 한다’

17.5%, ‘가급적 비를 맞지 않는다’ 14.5% 순으로 나타났다. 원전사고 직후인 2011년 5

월 한국보건사회연구원에서 실시한 조사 결과에서는 본인 및 가족 건강을 위해 비를

맞지 않도록 노력하거나 외출 후 세수 또는 샤워를 한다는 등의 외부피폭을 우려한

예방 조치를 한다는 응답이 많았던 반면, 원전사고 이후 2년이 경과한 금번 조사에서

는 일본산 식품의 섭취를 자제하거나 수산물 섭취를 줄이는 등 식품을 통한 방사능
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물질 노출경로를 차단하는 조치를 주로 취하는 것으로 나타났다.

표 3.1.4.9. 후쿠시마 원전사고의 영향에 대한 인식(%)

전혀
그렇지
않다

그렇지
않다

그렇다 매우
그렇다

M
(4 points)

SD

후쿠시마 원전사고로 인한 방사능 누출이 우
리나라에 영향을 미치고 있다

0.3 7.0 53.8 38.8 3.31 0.61

후쿠시마 원전사고 이후에 우리나라 국내산
식품은 방사능 오염으로부터 안전하다

13.8 58.7 25.2 2.3 2.16 0.68

후쿠시마 원전사고 이후에 국내에 수입되는 일본
산식품은방사능오염으로부터안전하다

37.3 55.7 6.5 0.5 1.70 0.61

표 3.1.4.10. 후쿠시마 원전사고 이후 우려되는 부분

N %

방사능 비 또는 대기에 의한 직접적 인체 노출 97 17.4

수돗물, 식수 오염 30 5.4

토양오염을 통한 농산물 오염 23 4.1

어패류 등의 수산물 오염 294 52.9

오염된 농수산물 및 식품 수입 103 18.5

기타 9 1.6

계 556 100.0

표 3.1.4.11. 후쿠시마 원전사고 이후 본인 및 가족 건강을 위하여 취한 조치

N %

가급적 비를 맞지 않는다 149 14.5

외출시 마스크나 모자 등을 착용한다 45 4.4

외출 후 손을 씻거나 샤워를 한다 180 17.5

방사능 물질 배출에 효과가 있는 의약품 또는 건강보조식품을 복용한다 18 1.8

요오드 함량이 높은 미역 또는 다시마 등을 섭취한다 85 8.3

일본산 식품(농수산물 및 가공식품)의 섭취를 자제한다 353 34.3

수산물(생선, 해산물 등)의 섭취를 줄이거나 하지 않는다 196 19.1

기타 2 0.2

계 1,028 100.0
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(라) 후쿠시마 원전사고와 방사능 오염에 대한 인식

○ 일본 원전사고 및 방사능 관련 정보를 얻는 경로와 신뢰도를 알아보기 위해 5개 문항

을 구성하였다. ‘일본 원전사고 및 방사능 관련 정보가 국민에게 충분히 제공되었다’

라는 문항에 ‘전혀 그렇지 않다’ 또는 ‘그렇지 않은 편이다’는 응답자가 76.1%, ‘그런

편이다’ 또는 ‘매우 그렇다’라고 답한 응답자는 23.9%로 정보제공이 충분하지 않다고

생각하는 비율이 높았다. 원전사고의 영향, 안전 인식도와 마찬가지로 여성과 평균연

령이 낮을수록(20～30대), 지식수준이 높을수록 관련 정보가 부족하다고 생각하고 있

었다.

○ ‘일본 원전사고에 대한 우리 정부의 조치․대응을 알고 있는가’라는 문항에는 ‘전혀 모

른다’ 15.7%, ‘모르는 편이다’ 53.2%, ‘알고 있는 편이다’ 26.2%, ‘매우 잘 알고 있다’

5.0%로 전체의 68.9%가 원전사고에 대한 우리 정부의 조치 및 대응 내용을 모르고

있다고 답변하였다. 이러한 결과는 정부가 취한 일련의 조치에 대해 잘 모른다고 답

변한 비율이 가장 높았던 선행 연구결과(한국보건사회연구원)와 유사한 것으로 나타

났다.

○ ‘원전사고 및 방사능 관련 정보취득 경로’는 ‘TV 또는 케이블 방송’ 49.8%, ‘인터넷’

31.3%, ‘신문 또는 인쇄매체(인터넷 제외)’ 13.0%, ‘주변사람’ 2.2%, ‘정부부처 및 유관

기관 홈페이지’ 1.3%, ‘홍보물’ 1.0%, ‘교육 및 세미나’ 0.5%, ‘관련 전문서적’ 0.5%인

것으로 나타나 우리 국민들은 주로 TV 또는 인터넷을 통해 관련 정보를 취득하고 있

었고, 정부부처 및 유관기관을 통한 정보 취득 비율은 매우 낮았다.

○ 정보원의 신뢰도를 묻는 문항에서는 ‘환경단체 및 소비자단체’가 32.0%로 가장 높았

고, ‘원자력 분야에 종사하는 국내․외 전문가’ 26.0%, ‘정부기관’ 23.0%, ‘원자력 분야

학자’ 9.2%, ‘인터넷 파워블로거’ 5.5%, ‘주변사람’ 2.5% 순으로 나타났다.

○ ‘원전사고 및 방사능 관련 정보를 전달하기 위한 효과적인 방법으로는 ‘뉴스, 신문 등

의 언론매체를 통한 전달’이 53.8%로 가장 높았고, ‘정부부처 및 유관기관 홈페이지를

통한 주기적인 정보 공개’ 16.8%, ‘관련 전문가들을 통한 교육 또는 세미나’ 16.5%,

‘정보 제공을 위한 전용 트위터 및 앱’ 9.3%, ‘홍보물 제작 및 배포’ 2.7% 등의 순이었

다.

○ 효과적인 정보 전달 채널, 정보 취득 방법 및 신뢰도에 대한 3개 문항의 결과를 종합

해 보면, 현재 유관기관 홈페이지, 교육ㆍ세미나, 홍보물을 통해 주로 이루어지고 있

는 방사능 관련 정보 전달 방법의 효과에 의문점을 제기해 볼 수 있으며, 향후에는

정보의 접근 용이성과 정보원의 신뢰성을 고려한 전략적인 정보전달 방안 마련이 시

급함을 알 수 있다.
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표 3.1.4.12. 후쿠시마 원전사고 및 방사능 관련 정보 제공 여부(%)

전혀
그렇지
않다

그렇지
않다

그렇다 매우
그렇다

M
(4 points)

SD

후쿠시마 원전사고 및 방사능 관련 정보가
우리나라 국민들에게 충분히 제공되었다

22.8 53.3 20.2 3.7 2.05 0.70

표 3.1.4.13. 일본 원전사고와 관련하여 우리 정부의 조치·대응방법 인지 여부(%)

전혀
그렇지
않다

그렇지
않다

그렇다
매우
그렇다

M
(4 points)

SD

후쿠시마 원전사고와 관련하여 우리 정부의
조치 및 대응방법에 대해 인지하고 있다

15.7 53.2 26.2 5.0 2.21 0.76

표 3.1.4.14. 후쿠시마 원전사고 및 방사능 관련 정보 취득원

N %

TV 또는 케이블 방송 299 49.8

신문 또는 인쇄매체(인터넷 제외) 78 13.0

인터넷(기사, 블로그, 트위터 등) 188 31.3

홍보물(팜플렛, 리플렛 등) 6 1.0

관련 정부부처 및 유관기관 홈페이지 8 1.3

교육 및 세미나 3 0.5

관련 전문서적 3 0.5

주변사람(가족, 친구, 직장동료 등) 13 2.2

기타 2 0.3

계 600 100.0

표 3.1.4.15. 후쿠시마 원전사고 및 방사능 관련 정보원의 신뢰도

N %

정부기관(식약처, 해양수산부 등) 138 23.0

원자력 분야 학자 55 9.2

원자력 분야에 종사하는 국내외 전문가 156 26.0

환경단체/소비자단체 및 기관 192 32.0

인터넷 파워블로거 33 5.5

주변사람(가족, 친구, 직장동료 등) 15 2.5

기타 11 1.8

계 600 100.0
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표 3.1.4.16. 후쿠시마 원전사고 및 방사능 관련 효과적인 정보 전달 방법

N %

정부부처 및 유관기관 홈페이지를 통한 주기적인 정보 공개 101 16.8

관련 전문가들을 통한 교육 또는 세미나 99 16.5

뉴스, 신문 등의 언론매체를 통한 전달 323 53.8

정보 제공을 위한 전용 트위터 또는 앱(블로그, SNS 등) 56 9.3

홍보물(팜플렛, 리플렛 등) 제작 및 배포 16 2.7

기타 5 0.8

계 600 100.0

(마) 후쿠시마 원전사고 관련 정보제공 방향 및 향후 해결과제

○ ‘후쿠시마 원전사고 및 방사능과 관련하여 가장 필요한 정보가 무엇인지’에 대해서는

‘식품·환경 등의 방사능 오염 정도와 안전성’ 정보가 필요하다고 답변한 응답자가

40.5%로 가장 많았고, ‘방사능 물질이 환경 또는 인체에 미치는 영향’ 21.0%, ‘원전사

고와 관련한 정부의 조치 내용’ 15.5%, ‘방사능에 대한 기본적인 지식 전달’ 10.3%,

‘일본 원전사고의 수습 진행 상황’ 10.2%, ‘원전 사고 시 대처요령’ 2.2%의 순이었다.

○ ‘정부가 후쿠시마 원전사고와 관련하여 가장 먼저 해야 할 일은 무엇인가’라는 문항에

대해서는 ‘국내 원전 점검 및 사고 대응 매뉴얼 관리’ 34.5%, ‘지속적이고 정확한 방사

능 검사 결과 공개’ 26.3%, ‘국내 식품에 대한 방사능 검사 실시’ 17.8%, ‘일본산 식품

수입 금지 확대’ 15.5%, ‘국내 원전 축소 및 건설 예정 원전 재검토’ 5.3%로 나타났다.

○ 이러한 결과는 현재까지는 우리 국민들이 일본 원전사고로 누출된 방사능 물질의 인체

안전성 문제에 가장 관심이 높지만, 이를 계기로 국내 원전의 안전확보, 관리감독 문제

로까지 관심영역이 점차 확대되고 있음을 시사한다.

표 3.1.4.17. 후쿠시마 원전사고 및 방사능 관련 가장 필요한 정보

N %

일본 원전사고의 수습 진행 상황 61 10.2

원전사고와 관련한 정부의 조치 내용 93 15.5

식품, 환경 등의 방사능 오염 정도와 안전성 243 40.5

방사능 물질이 환경 또는 인체에 미치는 영향 126 21.0

방사능에 대한 기본적인 지식 전달 62 10.3

원전 사고시 대처요령 13 2.2

기타 2 0.3

계 600 100.0
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표 3.1.4.18. 원전사고 관련 향후 정부 해결과제

N %

국내 원전에 대한 점검 및 사고 대응 매뉴얼 관리 207 34.5

지속적이고 정확한 방사능 검사 결과 공개 158 26.3

국내식품(농,축,수산물 등)에 대한 방사능 검사 실시 107 17.8

일본산 식품 수입금지품목 확대 93 15.5

국내 원자력 발전소 축소 및 건설 예정 원전 재검토 32 5.3

기타 3 0.5

계 600 100.0

(4) 결론

본 인식조사는 2011년 3월 일본에서 발생한 후쿠시마 원전사고와 방사능에 대한 우리

국민들의 인식도 조사를 통해 정확한 정보제공 방안을 마련하고, 쌍방향 리스크커뮤니케

이션 전략 구축의 기초자료로 활용하기 위한 목적으로 수행되었다. 인식도 확인을 위한

설문조사는 수도권에 거주하고 있는 만 20세 이상의 성인 600명을 대상으로 1:1 면접설문

방식으로 진행되었고, 그 결과는 다음과 같다. 방사선 및 방사능에 대한 지식을 묻는 문항

(10개 세부문항)의 답변결과를 100점 만점으로 환산했을 때, 우리 국민들의 방사선 및 방

사능 관련 기본 지식수준은 평균 56.7점으로 낮은 편이었고, 특히 중하위권 그룹은 실제보

다 자기 지식수준을 높게 평가하는 경향을 보였다. 이러한 결과는 방사선 및 방사능에 대

해 잘못된 정보를 습득한 국민들이 이를 자각하지 못하고 있음을 의미하며, 방사능과 관

련한 기초지식의 폭을 넓힐 수 있는 정확한 정보제공 및 교육 강화가 필요하다는 점을 시

사한다. 대다수 국민들은 후쿠시마 원전사고로 인한 방사능 누출이 여전히 우리나라에 영

향을 미치고 있다(92.6%)고 생각하고 있었고, 특히 어패류 등 수산물의 안전성에 대한 불

안감이 가장 높았다(52.9%). 이러한 결과는 최근 태풍 등의 영향으로 일본 원전인근 방사

능 오염수가 해양으로 유출되는 사건이 발생하면서 수산물의 방사능 오염을 우려한 부정

적 인식의 영향인 것으로 판단된다. 또한 국내산 식품(72.5%)보다는 일본산 수입식품

(93.0%)의 안전성에 더 높은 불안감을 나타내었고, 일본 원전사고 이후 본인 및 가족의

건강을 위해 일본산 식품의 섭취를 자제하거나(34.3%), 수산물의 섭취를 줄이거나 회피하

는(19.1%) 등 식품섭취를 통한 인체 내 방사능 피폭을 최소화할 수 있는 조치를 우선적으

로 취하고 있었다. 관련 정보제공에 대해서는 대다수 국민들이 일본 원전사고와 방사능

오염 정보가 충분히 제공되지 않고 있다(76.1%)고 느끼고 있으며, 일본 원전사고에 대한

우리 정부의 조치 및 대응 내용도 대부분 모르고 있다(68.9%)고 답변하였다. 방사능 관련

정보의 효과적인 전달 방법으로 뉴스 또는 신문 등의 언론 매체를 통한 전달(53.8%)을 꼽

았으며, 정보원에 대한 신뢰도는 환경단체 및 소비자단체(32.0%)가 가장 높았다. 국민들이

실제로 정보를 취득하는 경로는 TV방송(49.8%), 인터넷(31.3%), 신문(13.0%) 등의 순이었

고, 정부부처 및 유관기관 홈페이지를 통한 정보 취득은 1.3%에 불과했다. 현재 식품의약

품안전처 등 정부기관에서는 일본 원전사고 및 방사능 관련 정보를 주로 홈페이지를 통해

전달하고 있으나 실제로 이들 경로를 통한 국민들의 정보 습득 빈도는 미미한 것으로 나
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타나 향후 개선이 필요하다. 한편 일본 원전사고 및 방사능과 관련하여 우리 국민들은 식

품ㆍ환경 등의 방사능 오염수준과 인체 안전성에 대한 정보제공(61.5%)이 가장 중요하다

고 생각하고 있었고, 정부가 해결해야 할 우선 과제로는 국내 원전에 대한 점검 및 사고

대응 매뉴얼 관리(34.5%) 등을 꼽았다. 실제로 우리 국민들이 필요로 하는 정보들 중 일

부는 이미 관련 기관 홈페이지 등을 통해 공개되고 있으나 국민들은 관련 정보가 충분이

제공되지 않고 있다고 생각하고, 정부의 조치 및 대응 내용도 잘 모르고 있는 것으로 나

타났다. 따라서 기존의 홍보방법 및 소통창구에 대한 재평가를 통해 정보전달 방법의 개

선이 필요하다. 금번 연구 결과는 향후 방사능에 대한 국민들의 올바른 인식을 제고하고,

국내 또는 인접국가에서 유사한 사고 발생 시 효과적인 쌍방향 리스크커뮤니케이션 방안

을 마련하는데 유용한 기초자료로 활용될 수 있을 것으로 기대된다.

나. 쌍방향 리스크커뮤니케이션 방안

(1) 리스크커뮤니케이션의 정의와 필요성

○ 방사능 오염 식품의 섭취로 인한 내부피폭은 대개 낮은 선량의 방사선 노출로, 건강

에 영향을 끼치는지 여부는 과학적으로 명확하게 결론이 나지 않은 상황이다. 이러한

불확실성은 부정적인 위험 인식의 요인으로 작용하고, 원전사고 및 방사능과 관련하

여 입증되지 않은 정보의 유통과 전달 매체들의 정보 불일치 등을 유발해 과도한 불

안감을 형성시킬 수 있다. 이러한 부정적 인식과 불안감 증가 요인들을 감소시키고

국민들의 인식 변화를 도모하기 위한 방법으로 리스크커뮤니케이션의 필요성과 중요

성이 강조되고 있다.

○ 리스크커뮤니케이션은 개인, 조직, 다양한 이해관계자들이 정보 및 의견을 상호 교환

하는 전략적 과정을 의미하며, 이러한 과정은 사회적 갈등을 완화하고 불필요한 사회

적 비용을 저감시키는 효과를 가져 올 수 있다. 리스크커뮤니케이션의 활성화를 위해

서는 다양한 계층을 대상으로 한 인식조사가 선행되어야 하며, 이러한 조사결과의 면

밀한 분석을 통해 국민들이 쉽게 이해할 수 있는 수준의 정확한 정보를 생산하고 효

과적인 창구를 이용해 쌍방향으로 소통되어야 할 것이다.

(2) 현행 식품관련 리스크커뮤니케이션 및 문제점

○ 소비자들은 식품안전에 대해 민감하게 반응하고 있으며, 방사능이라는 문제까지 결합

하게 되어 국민들의 두려움과 불안감은 증가하고 이로 인한 혼란이 가중되고 있다.

앞서 실시한 인식조사 결과에서 볼 수 있듯이 현재 국민들은 식품 안전 및 방사능 관

련 정보들을 주로 언론매체(TV 등)를 통해 얻고 있다. 하지만 언론매체들은 주로 사

실에 대한 정확한 판단을 돕는 필요한 정보 제공이 아닌 불안 심리를 자극하는 부정

적이고 과장된 정보를 주로 제공하고, 각각 다른 용어들의 사용으로 불일치하게 보도

함으로써 방사능의 잠재적 위험 인식과 부정적인 태도 형성을 부축이고 있다.

○ 또한, 최근 트위터, 페이스북 등 사람들 사이의 관계망을 구축해 주는 온라인 서비스

인 소셜네트워크서비스(SNS)가 사회적으로 폭발적 성장함에 따라 개인을 통한 신뢰
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성 낮은 식품 안전 및 방사능 관련 정보들이 무분별하게 전파되면서 국민들의 불안감

을 가중시키는 요인으로 작용하고 있다.

○ 한편 관련 부처 등 정부기관들이 제공하는 정보들은 국민들이 이해하기 어려운 전문

용어를 사용하고 있다. 방사능 안전 정보들은 관련 부처의 홈페이지 등을 통해 제공

되고 있지만 국민들이 쉽게 찾아볼 수 없어 접근성 확대가 요구되고 있으며, 제공되

고 있는 정보들 역시 측정 결과 수치 등 정형화된 틀에 맞춰져 있어 정보 제공의 컨

텐츠 확대가 필요한 실정이다.

○ 리스크커뮤니케이션을 방해하는 요소 중 하나로 이해당사자인 국민들의 참여 제한을

꼽을 수 있다. 효과적인 리스크커뮤니케이션을 위해서는 이해관계자 상호간에 쌍방향

소통으로 서로간의 의견의 격차를 줄이기 위한 노력이 필요하다.

○ 방사능 및 식품 안전과 관련된 정보들은 현재 각 관련 부처 및 유관기관의 홈페이지

등을 통해 습득가능 하지만 관련 부처가 다양하고 업무도 나뉘어져 있어 이들을 통합

할 시스템 구축이 필요하다. 리스크커뮤니케이션은 특정 부처가 해결해야할 문제가

아닌 국가 차원 연구 필요성이 요구된다.

그림 3.1.4.5. 현행 방사능 리스크커뮤니케이션의 문제점
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그림 3.1.4.6. 방사능 안전관리 정보(출처: 식품의약품안전처 홈페이지)

그림 3.1.4.7. 방사능 관련 정보 전달 리플렛(출처: 식품의약품안전처 홈페이지)

(3) 식품 방사능 리스크커뮤니케이션 방안

○ 신뢰성 있는 다양한 정보전달 방법 개발 및 관련 기관 간 협업

일본은 후쿠시마 원전사고 이후 관련 부처들과 협력하여 다양한 형태의 정보 전달 방

법을 마련하였다. 국민들이 이해하기 쉽도록 방사능 및 식품안전과 관련한 기본 지식

들을 그림과 도표 등으로 나타내어 설명하도록 하고, 좀 더 자세한 내용들의 경우 동
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영상 등을 제작하여 언론을 통해 방영하거나 정부기관들이 협업하고 이를 주축으로

각 계 전문가들과 국민들이 모여 토론하고 소통하는 장을 마련하였다.

본 연구의 인식조사 결과 우리 국민들은 주로 언론매체를 통해 방사능 및 원전사고

정보들을 습득하고 있었으나 이들 매체들을 통한 정보 전달은 자칫 부정적인 인식을

고착시키는 결과를 초래할 수 있다. 따라서 방사능 관련 정보의 효과적인 전달을 위

해서는 언론매체 이외에도 접근성이 높은 다양한 매체를 활용하고, 환경단체 등 신뢰

성 높은 정보원의 활용하는 방안 등을 고려할 필요가 있다. 또한 관련 기관 또는 단

체는 투명하고 신속하게 정보를 전달함으로써 신뢰도를 향상시키고, 관련 기관들과의

협업을 통한 리스크커뮤니케이션을 활성화할 필요가 있다.

○ 계층별ㆍ성별ㆍ연령별 전달 매체 선정 및 단기·중장기적 방법 수립

방사능과 관련된 안전 정보의 경우 계층별ㆍ성별ㆍ연령별로 위험에 대한 인식이 다르

며, 정보습득 경로 또한 상이하므로 맞춤형 정보전달을 위한 매체 선정이 필요하다.

또한 계층별ㆍ성별ㆍ연령별 맞춤형 매체 선정뿐만 아니라 단계별(기간별) 리스크커뮤

니케이션 전략의 확보 필요성도 강조되고 있다. 식품 방사능 안전에 대한 막연한 불

안감을 불식시키고 부정적 인식 확산을 차단하기 위한 단기적인 접근 방법으로는 예

능 프로그램 등을 활용해 식품 방사능 안전문제를 제고시키는 방안 등을 고려해 볼

수 있고 아울러 사회 전반에 뿌리 깊게 자리 잡고 있는 방사능 오염에 대한 불신을

해소하기 위한 중장기적인 해결 방안도 함께 강구할 필요가 있다.

○ 리스크커뮤니케이션을 위한 거버넌스 구축

일방적인 전달 또는 일반화된 정보제공이 아닌, 정부ㆍ학계ㆍ소비자 등 이해관계자를

망라한 거버넌스를 구축하여 상호간 의견교환 및 정보습득이 이루어질 수 있는 장을

마련하고 이를 관리하고 운영할 수 있는 체계적인 시스템을 구축하여야 한다. 또한

국민들의 관심사항을 지속적으로 파악하고 효과적인 대안 마련을 위한 조사와 연구가

필요하다.

○ 리스크커뮤니케이션 관련 전문가 양성 및 지원 필요

위험요소를 분석하고 대안을 마련하기 위해서는 관련 분야의 전문가 양성 역시 중요

한 과제이다. 소통과정의 설계와 시스템 구축을 위해서는 지식 인프라 구축 등의 다

양한 개선 및 노력이 요구된다.
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그림 3.1.4.8. 방사능 안전 리스크커뮤니케이션 방안

그림 3.1.4.9. 방사능 안전 리스크커뮤니케이션 방안 마련을 위한 전문가회의 및 포럼
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제2절 이동형 방사능 분석 장비 개발

1. 이동형 방사능 분석장비

가. 이동형 방사능 분석장비 연구개발 내용 요약

본 연구에서는 농식품 중 방사능 신속분석에 적합한 NaI(Tl) 및 HPGe 검출기 기반 이동형

분석 장비를 개발하였고, 특히 동일 MCA를 이용하여 NaI(Tl) 및 HPGe 검출기 구동이 가능

한 장비를 개발하였다. 이를 위해 총 3년의 연구개발 기간 동안 1) 현장 이동형 방사능 분석을 위

한 국내외 기존 장비현황 파악, 2) 분리형 차폐체, 이동형 카트, 계측 및 신호처리 장치 및 핵종분

석 프로그램 등의 개발, 3) 분석장비 시제품 제작 및 기존 장비와 성능비교 등을 수행하였다.

구분 연도 연구개발의 목표 연구개발의 내용

1차

년도
2013년

Ÿ 방사능 검사장비 전자부

및 차폐체 설계 및 분석

프로그램 개발

Ÿ 국내외 식품 방사능 현장 검사장비 제작

기술에 대한 자료 조사 및 개념설계

Ÿ NaI(Tl) 검출기 사용 검사장비

- 전자부 및 차폐체 설계

- 정성 및 정량 분석프로그램 개발

Ÿ HPGe 검출기 사용 검사장비

- 전자부 및 차폐체 설계

- 정성 및 정량 분석프로그램 설계

2차

년도
2014년

Ÿ NaI(Tl) 검출기 사용 검

사장비 Prototype 제작

및 성능 검증

Ÿ 방사능 검사장비 분석 프

로그램 설계

Ÿ HPGe 검출기 사용 검사

장비 설계

Ÿ NaI(Tl) 검출기 사용 검사장비

- Prototype 제작

- 차폐체 및 전자부 제작

- 성능검증 및 보완

Ÿ HPGe 검출기 사용 검사장비

- 전자부 및 차폐체 제작

- 분석 알고리즘 설계

3차

년도
2015년

Ÿ HPGe 사용 검사장비

Prototype 제작 및 성능

검증

Ÿ 방사능 검사장비 시제품

제작 및 특허 출원

Ÿ NaI(Tl) 검출기 사용 검사장비

- 시제품 제작

Ÿ HPGe 검출기 사용 검사장비

- Prototype 제작

- 성능검증 및 보완

- 시제품 제작

Ÿ 한국표준과학연구원 연계 성능 시험

Ÿ 방사능 검사장비 특허 출원 및 분석프로

그램 소프트웨어 등록

Ÿ 현장적용 실험

표 3.2.1.1. 이동형 방사능 분석장비 연구개발 목표
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나. 이동형 방사능 분석장비 규격

본 연구를 통해 개발된 농식품 중 방사능 신속분석용 이동형 방사능 분석장비의 주요규격을

표 3.2.1.2에 정리하였다.

구분 NaI(Tl) HPGe

검출기 사양

① 모델 : Canberra 802-3×3

② 규격 : 3*3 inch

③ 분해능 : < 7.5% @ Cs-137

④ 측정범위 : 40 ∼ 3000 keV

① 모델 : Canberra GC3018

② 규격 : Ref. Eff. 30%

③ 분해능 : < 1.8 keV

④ 측정범위 : 40 ∼ 3000 keV

측정시간 20분(1,200초) 30분(1,800초)

최소검출방사능

(MDA)
20 Bq/kg 이하 3 Bq/kg 이하

저온 유지장치 필요 없음
질소 충전방식

(7리터, 2일 연속사용)

무 게 100 kg 이하 130 kg 이하

차폐체

① 규격 : Ø260×375 mm

② NaI(Tl) 및 HPGe 검출기 겸용

③ 1L Marinelli 비이커 사용

④ 40 mm 두께의 납차폐

⑤ 분리 및 이동이 용이한 9단계 분리형

이동형 카트

① 규격 : 745(W)×842(D)×948(H) mm

② NaI(Tl) 및 HPGe 검출기 겸용

③ 일체형 접이식 및 이동용 바퀴 장착

전자부

① 8192 채널 digital signal analyser

② MCA 데이터 저장 기능

③ 고전압 : 0 ∼ 5000 V

④ 전원 :

- 외부전원 : 220 ACV

- 배터리 : 16.8 V/3 A(Li-ion), 약 8시간 운용 가능

⑤ 통신 : TCP/IP, USB

운용프로그램
① 식품분석 DB 프로그램

② 측정 및 핵종분석 한글 프로그램(NeoGMA)

표 3.2.1.2. 본 연구에서 개발한 이동형 방사능 측정장비 규격
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다. 관련 특허 및 국내외 제품 조사

(1) 국내외 특허분석

NaI(Tl) 검출기와 HPGe 검출기를 호환하여 사용할 수 있는 이동형 방사능 측정장비 및 분

리형 차폐체 기술에 대하여 KIPRIS/WIPS 특허 DB에 등록된 특허 중 2013. 9. 30.까지 공개된

4개국(한국, 미국, 일본, 유럽연합) 특허를 분석하였다. 분석 결과, 방사능 측정장비의 경우 주

요 연관 특허는 한국 1건, 미국 17건, 유럽 4건 및 일본 1건으로 조사되었으며, 이 중 유사성이

있다고 판단이 되는 특허는 2건이었다. 또한 분리형 차폐체 기술의 경우 한국 1건, 미국은 1건,

유럽 0건 및 일본 1건으로 조사되었으며, 이 중 유사성이 있다고 판단이 되는 특허는 2건이었

다.

분야
등록번호

(등록일)
발명의 명칭 기술요약 관련성

이동형 방사능

측정장비

10-0372755

(2001.09.15.)

다기능 방사성

감마핵종분석

기 및 측정장

치

한국수력원자

력 주식회사,

한국전력공사

관련없음

10-0925560

(2001.09.15.)

3차원 이동 가

능한 검출기를

구비하는 방사

선 측정 장치

한국수력원자

력 주식회사,

한국원자력연

구원

관련없음

분리형 차폐체

기술

10-0889286

(2009.03.11)

보론 및 납이

함유된 폴리에

틸렌 방사선

차폐제 및 그

제조방법

한국원자력연

구원
관련없음

10-0395886

(2003.08.13)

감마핵종분석

기의 방사선

차폐체

한국수력원자

력 주식회사,

한국전력공사

관련없음

표 3.2.1.3. 관련 특허 분석 결과

국내외 특허분석 결과 방사능 분석 관련 특허는 다수 존재하나 농식품 전용 이동형 방사능

측정장비 관련 특허가 거의 없으며 특히 HPGe 검출기를 이용한 이동형 신속 검사장비는 전

무한 것으로 파악되었다. 또한 본 연구에서 개발하고자 하는 분리형 차폐체 기술 및 검출기 호

환 사용의 경우 기존의 제품보다 성능이 우수할 것으로 판단되었다. 따라서 본 연구를 통해서

개발된 이동형 방사능 분석장비는 검출기를 제외한 전부분의 국산화를 통해 원천기술 확립 및

가격경쟁력 확보 등이 가능하리라 예상된다.

(2) 국내외 관련제품 분석

현재 국제적으로 판매되고 있는 이동형 방사능 식품오염 신속검사장비는 Canberra사의 Foo

dScreen (http://www.canberra.com/products/radiochemistry_lab/pdf/FoodScreen-SS-C39444.p
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df)과 Ortec사의 FoodGurard (http://www.ortec-online.com/Solutions/Food-Water-Environme

ntal-Monitoring.aspx)가 대표적이다. 이들 분석장비는 NaI(Tl) 검출기 기반의 방사능 검사장비

에 이동형 카트를 적용한 것에 불과하며 장비 무게의 대부분을 차지하는 차폐체가 160∼200 k

g 정도의 일체형으로 제작되어 개인의 이동 및 현장분석이 사실상 불가능하다. 국내의 경우 F

oodScreen 및 FoodGurad보다 낮은 수준의 농식품 방사능 분석 장비가 일부 판매 중에 있다.

본 연구에서 개발한 NaI(Tl) 및 HPGe 검출기 겸용 이동형 방사능 분석장비는 농식품 중 방

사능 신속분석을 위한 세계 최초의 제품이다. 또한 식품분석 DB 프로그램과 측정 및 핵종분석

한글 프로그램(NeoGMA)을 통해 국내 실정에 최적화된 분석 장비를 구현하였다.

회사/제품명 주요 특징

(미국) Canberra/FoodScreen

Ÿ 검출기: 2” × 2” NaI detector

Ÿ MDA : 20 Bq/L @ Cs-137 (4분)

Ÿ 측정범위 : 40 ∼ 3000 keV

Ÿ 차폐방식/두께: 납/38∼ 42 mm

Ÿ 전원공급 방식: 배터리 구동방식

Ÿ 무게 : 약 200 kg

Ÿ 가격 : 6,000만원/대

(미국) Ortec/FoodGuard

Ÿ 검출방법: 3” × 3” NaI detector

Ÿ MDA : 15 Bq/L @ Cs-137 (10분)

Ÿ 측정범위 : 40 ∼ 3000 keV

Ÿ 차폐방식/두께: 납/30 mm

Ÿ 전원공급 방식: 배터리 구동방식

Ÿ 무게 : 약 160 kg

Ÿ 가격 : 4,500 만원/대

표 3.2.1.4. 현재 판매중인 이동형 방사능 식품오염 신속검사장비

2. 차폐체 및 이동형 카트

가. 방사선 차폐체

(1) 방사선 차폐체 설계 및 평가

(가) 방사선 차폐체 설계

차폐체 설계를 위해 중요한 필수 요소는 제품의 실용성, 이동의 편의성, 조립 편리성, 제품의

디자인이다. 국외 장비의 경우 차폐부의 설계가 국외용 1리터 마리넬리 비커(D 132 mm × H

155 mm)에 맞춰 차폐부 내경이 150 mm로 제작되어 있다. 하지만 국내에서 주로 사용 중인 1

리터 마리넬리 비커 (D 148 mm × H 144 mm)의 경우 규격이 이와 달라 국외 장비에 직접

사용할 경우 비커의 커버가 벗겨지는 일이 종종 발생하여 검출기 및 차폐부가 오염될 우려가

많다. 또한 시료의 삽입 및 추출에 큰 어려움이 존재한다. 따라서 차폐부 설계 시 국내에서
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CRM 용기로 사용되는 2가지 기준의 비커 형태인 1리터 구 마리넬리 비커 (D 148 mm × H

144 mm)와 일반적으로 사용되는 1리터 뉴 마리넬리 비커 (D 162 mm × H 124 mm)를 현장

에서 모두 편리하게 사용가능하도록 고려하였다.

차폐부의 높이는 이동형 카트와 결합하였을 경우 시료 최상단의 위치가 평균적인 사람의 손

높이인 900 ∼ 1100 mm에 위치하여 시료의 교환 시 분석자가 편리하게 사용하도록 고려하였

다.

국외용 1리터마리넬리비커

(D 132 mm × H 155 mm)

국내용 1리터마리넬리비커

(D 148 mm × H 144 mm)

그림 3.2.2.1. 1리터 마리넬리 비커 크기 비교

차폐체의 재료로는 일반적으로 원자번호가 클수록 유효하나 이 중 차폐체의 재료로 적합한

재료는 납, 철 등이 있다. 감마선의 투과율(그림 3.2.2.2)에서 확인할 수 있듯이 동일한 차폐효

과를 얻기 위해선 철의 경우 납에 비해 약 3배 이상의 두께를 사용해야 차폐율이 동등해진다.

철의 두께에 따라 무게 또한 증가하기 때문에 이동형 측정 장비의 차폐 재료로 철은 부적합하

다. 따라서 최소한의 부피에 최대의 차폐율을 가진 납을 차폐 재료로 사용하였다.
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그림 3.2.2.2. 철의 두께와 납의 두께에 따른 감마선의 투과율

① 프로토타입 설계

프로토타입은 3인치 NaI(Tl) 검출기를 기준으로 3차원 모델링을 통하여 구성을 해 보았다.

총 6가지의 모델을 구성하였으며, 신속 분석에 필요한 실용성, 이동 편의성, 조립 편리성에 부

합되는 타입으로 차폐체 개발의 기준을 삼았다.

여러 가지 개념을 적용하여 총 6가지의 제품 모델을 모델링하였으나, 납 자체가 가진 중량을

효율적으로 가볍게 만들기 위해서는 차폐체 자체를 조각 형태로 나누어 여러 개의 조각을 조

립하는 형태를 취해야만 차폐체를 손쉽게 분해조립 및 이동이 용이한 제품으로 만들 수 있다.

그래서 개념 #5와 같은 조각 형태의 조립식 조각 방식을 최종 설계 방법으로 진행하였다.

그림 3.2.2.3. 프로토타입 개념 #1 (이동형 타입)
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그림 3.2.2.4. 프로토타입 개념 #2 (이동형 소형타입)

그림 3.2.2.5. 프로토타입 개념 #3 (이동형 분해형, 커버 차폐체 분해)

그림 3.2.2.6. 프로토타입 개념 #4 (소형 조각 방식)



138

그림 3.2.2.7. 프로토타입 개념 #5 (차폐체 전체 조각)

그림 3.2.2.8. 프로토타입 개념 #6 (차폐체 조각 탈착식)

② 프로토타입 제작 및 MDA 평가
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Detector NaI(Tl) HPGe

최소검출 방사능

(MDA)
20 Bq/kg 1～3 Bq/kg

검출기 크기 D 83 mm × H 223 m D 79 mm × H 238 mm

시료용기

(최대크기)

1리터 마리넬리 비커

(D 162 mm × H 144 mm)

1리터 마리넬리 비커

(D 162 mm × H 144 mm)

차폐부 높이

(이동형 카트 제외)

500 mm ∼ 700 mm

(저온유지장치 제외)

500 mm ∼ 700 mm

(저온유지장치 포함)

개폐방식 슬라이딩 또는 덮개형 슬라이딩 또는 덮개형

납차폐체 두께 20 mm ∼ 50 mm 20 mm ∼ 50 mm

이동 및 현장설치
4 ∼ 5단 분리형

(개당 15 kg 이내)

4 ∼ 5단 분리형

(개당 15 kg 이내)

저온 유지장치 필요 없음
질소 충전방식 7리터

(D 222 mm × H 343 mm)

무 게 80 kg 이하 100 kg 이하

표 3.2.2.1. 차폐부 설계시 고려사항

설계된 납 차폐체의 신뢰성을 확인하기 위하여 최소검출방사능 농도(minimum detectable

activity; MDA) 평가를 위한 시제품을 제작하였다. 시제품의 납 차폐체 두께는 기존 상용 제

품 차폐체 두께를 참고하여 우선 25 mm와 40 mm 두께의 납 차폐체를 제작하였다. 만일 이들

두께에서 기준에 만족하는 MDA가 산출되지 않는다면, 차폐체의 두께를 줄이거나 늘리는 방법

으로 추가 제작하고자 하였다.

MDA 평가는 NaI(Tl) 검출기 및 HPGe 검출기에 대하여 각각 수행되었다. NaI(Tl) 검출기의

MDA 평가를 위해 Canberra사 802-3x3 NaI(Tl) 검출기와 2007P 프리앰프, DSA-LX 다중채널

분석기로 시험장치를 구성하였다. 또한 HPGe 검출기의 MDA 평가를 위해 2002CSL 프리앰프

가 내장된 GC3018 검출기와 DSA-LX로 구성하였다. 각 시험장치를 테스트용 25 mm 납 차폐

체와 40 mm 납 차폐체에 순차적으로 적용하였다. MDA 평가에 사용된 시료는 북어가루 450

ml 시료와 쌀 1000 ml 시료이며, 각 시료를 NaI(Tl) 검출기에서 20분(1200초), HPGe 검출기에

서 30분(1800초) 측정하여 662 keV(@ Cs-137) 피크에서 MDA를 계산하였다. 산출된 MDA를

표 3.2.2.2에 정리하였으며, 40 mm 납 차폐체를 사용했을 때 NaI(Tl)의 MDA는 8.01 Bq/kg,

HPGe의 MDA는 2.91 Bq/kg으로 모두 목표치에 만족함을 알 수 있었다. 이와 함께 3차원 모

델링 프로그램을 이용하여 40 mm 납 차폐체 설계의 무게를 추정한 결과 약 90 kg으로 산출

되었다. 따라서 납 차폐체의 MDA 값, 추정 무게 등을 고려하여 본 연구에서 개발할 이동형

방사능 분석장비 납 차폐체의 적정 두께를 40 mm로 결정하였다.
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납두께 시료부피 NaI(Tl) 검출기 HPGe 검출기

25T 450 ml 26.3 13.3

40T
450 ml 20.7 12.2

1000 ml 8.01 2.91

표 3.2.2.2. 납 차폐체 두께에 따른 MDA 평가 결과(단위 : Bq/kg)

 

그림 3.2.2.9. 3인치 NaI(Tl) 검출기용, 40mm 대응 차폐부

③ 차폐체 제작

결정된 납 차폐체의 두께가 40 mm로 충분히 두꺼움에도 불구하고 조각 형태 납 차폐체의

가장 큰 문제점은 납이 가진 연성으로 인해 충격시 형태 변형이 발생하는 것이다. 이는 심한

경우 조립이 불가능할 정도로 차폐체에 변형이 일어날 수 있으므로 형태 유지에 중점을 두고

설계를 하였다. 이를 위해 납 차폐체 조각과 조각 간의 접촉면을 찾아 충격과 마찰이 많은 부

분만 알루미늄 재질의 링을 삽입하여 충격으로부터 찌그러짐 현상을 차단하였다. 이동 및 조립

의 간편성을 생각하여 각 조각마다 손잡이를 추가하였고, 무게 감소를 위하여 전자부가 위치한

Body Base 및 Bottom body의 두께를 최소 두께인 15 mm, 12.5 mm로 각각 조정하였다. 납

차폐체를 MDA 기준값에 준하는 두께 40 mm로 할 경우 각 조각 당 무게가 15 kg 이하가 되

도록 총 7조각으로 분할하였다. 각 조각의 손잡이 부분은 스테인리스 재질로서 무게를 지지하

기 위하여 스크류 볼트와 에폭시로 접착하였으며, 알루미늄과 구리부분은 에폭시 처리를 하여

고정하였다. 알루미늄과 구리 부분으로 인하여 납 차폐체 전체에 변형을 최소화 할 수 있는 역

할을 기대할 수 있다.
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(a) 납차폐체 Top 커버 (b) Body

(c) 납차폐체 Body Base (d) Bottom body

(e) NaI(Tl) 검출기용 PE 거치대 (f) 전체 조립형태

그림 3.2.2.10. 40 mm 납 차폐체 세부 및 전체 조립 형태
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(나) 차폐체 구조 개선 및 안전해석

직접 열고 닫는 방식으로 되어있는 본 차폐체는 조각 형태임에도 불구하고 15 kg이라는 무게가

여성 사용자들에겐 여전히 버거울 수 있다는 문제점을 가지고 있다. 그리고 커버를 통째로 들어

서 열고 닫아야 하는 방식에 대한 불편함과 취급 부주의로 인한 안전사고를 방지하고자 차폐체

구조를 개선하였다. 이를 위해 차폐체 Top 커버에 대한 안전성 확보 및 각 조각 부품의 경량을

중점적으로 시도하였다. 차폐체 조각을 들어 올렸을 시 차폐체와 손잡이에 가해지는 하중이 조립

고정된 볼트에만 집중이 된다. 손잡이에만 과도한 스트레스가 계속 발생하게 되는데, 자칫 볼트

손상이나 볼트와 연결된 차폐체 쪽의 볼트 결합 부위의 파손으로 인해 안전사고가 일어날 가능성

이 존재한다. 그리하여 현 차폐체 손잡이 볼트의 크기와 길이를 확장하고, 볼트 내부 나사산 전체

에 접착제 도포를 하여 볼트와 차폐체 전체의 안전성을 강화하였다. 추가로 차폐체 손잡이 부분

에 대한 강도 시뮬레이션 실험도 함께 실시하였다. 또 조각 개별 무게 경량을 위해 7개의 조각으

로 이루어진 차폐체를 9 단계로 나누어 종전에 15 kg이었던 한 조각의 무게를 10 kg이하로 경량

화 하였다.

 

그림 3.2.2.11. 구형 차폐체(좌)와 신형 차폐체(우) 단면도

구형 차폐체와 신형 차폐체를 비교해 보면 높이는 커버 부분에 추가된 1 mm 구리판으로 인

해 전체 크기가 미세하게 증가했고, 하단 NaI(Tl) 전자부 차폐 부분인 Bottom Body(그림

3.2.2.10. (d))의 알루미늄 원통은 두께 15 mm를 유지한 채 상하단에 링을 끼워 넣는 방식으로

보완하였다. 구형 차폐체의 조각 당 무게는 15 kg였으나 신형 차폐체는 무게 기준을 개당 10

kg까지 감소하여 이동, 분해, 조립시의 부담감을 최소화 시켰으며, 전체 무게는 89 kg으로 동

일하다.

① 차폐체 MDA 재평가

구형 차폐체를 보완한 신형 차폐체는 커버 밀폐 방식이 아닌 슬라이드 방식이다. 신형 차폐

체의 신뢰성을 확인하기 위하여 MDA 변화 유무를 평가하였다. 신형 차폐체에 대한 MDA 평

가도 기존방법과 동일하게 수행하였다. MDA 평가에 사용된 시료는 표준과학연구원에서 제작

된 표준시료 Rice Low 시료를 사용하였으며 그 결과를 표 3.2.2.3에 정리하였다. 각 검출기 및

핵종에 대한 신형 차폐체의 MDA 값은 구형 차폐체 값과 매우 유사함을 알 수 있었다. 따라서
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신형 차폐체를 이동형 방사능 분석장비의 납 차폐체로 최종 결정하였다.

Detector Nuclide
MDA (Bq/kg)

비고
Old Sheld New sheld

NaI(Tl)

I-131 7.9 7.3

Cs-137 6.8 6.7

Co-60 14.0 14.0

HPGe

I-131 2.8 2.6

Cs-137 3.2 3.1

Co-60 3.5 3.3

표 3.2.2.3. 납 차폐체에 따른 MDA 재평가(단위 : Bq/kg)

② 차폐체 안전해석

차폐체 특성상 납을 지지하고 있는 손잡이는 안전성을 가장 신경 써야 하는 부분이다. 납 차

폐체에 손잡이를 부착하기 위해 사용된 볼트만으로 대부분의 차폐체 무게를 지지하는 구조이

기 때문에 자칫 잘못하여 연성의 재질인 납의 파손이나 충격으로 손잡이 부분이 떨이지게 되

면 안전사고로 이어질 수 있는 크나큰 문제점이 있다. 따라서 납 차폐체 손잡이 부분에 대한

구조 안전해석을 3차원 구조물 전문시험기관인 VP KOREA에 의뢰하여 수행하였다. 납 차폐

체 손잡이 안전해석 시뮬레이션은 일반적인 대기 중력상에서 손잡이를 사용하여 차폐체를 들

어 올렸을 때 연결된 차폐체 부분과 볼트, 손잡이의 안전성에 대한 검사이다. 평가 기준은 기

본 대기 중력 상에서 손잡이를 붙잡았을 때 차폐체 무게를 손잡이와 고정 볼트가 얼마만큼 버

틸 수 있는지, 그리고 볼트가 결속된 차폐체 부분의 변형이 발생여부이다.

납 차폐체 구조 안전해석 결과, 납은 차폐체 자체 무게값을 기준으로 최대 응력 2.4 MPa, 최

대 인장강도는 21 MPa로 산출되었다. 볼트 부분은 최대 응력 12 MPa, 최대 인장 강도는 505

MPa로 산출되었다. 따라서 차폐체 무게로 인한 변형률은 0%이므로 차폐체 자체는 매우 높은

안전성과 신뢰성을 가짐을 확증할 수 있었다.
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그림 3.2.2.12. 납 차폐체 손잡이 구조 안전해석 결과
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(2) 방사선 차폐체 제작

차폐체 구조 개선 및 안전해석을 통해 이동형 방사선 측정장비용 납 차폐체의 설계 및 평가

를 완료하였다. 이를 바탕으로 최종 납 차폐체를 제작하였다.

 

(a) Top 커버(왼쪽) (b) Top 커버(오른쪽)

(c) Top Body (d) Main Body

(e) Base Body (f) Bottom Body 

그림 3.2.2.13. 이동형 방사능 분석장비용 납 차폐체
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나. 이동형 카트

(1) 이동형 카트 제작 및 평가

(가) 이동형 카트 설계

이동형 카트는 3"x3" NaI(TI) 검출기와 Canberra HPGe 검출기 및 Big MAC 모델을 같이

사용할 수 있도록 설계하였다. 차폐체 거치대는 알루미늄 재질로 만들었으며, 높이는 Big

MAC의 크기를 고려하여 결정했다. 차폐체 무게를 버티기 위해 스틸 사각 파이프를 사용하여

전체 프레임 구성을 하였다. 전체 무게를 유지하고 있는 뼈대 파이프 이외에 나머지 부분들은

알루미늄 재질을 혼합 사용하여 카트 전체 무게를 줄였으며, 상단에는 노트북을 거치할 수 있

는 공간이 있고 그 바로 아래 MCA가 장착하였다. 카트 전체를 받치는 바퀴는 무진동 바퀴로

서 납 차폐체 전체를 장착한 상태에서도 이동 시 충격 완화 목적으로 채택하였다. HPGe 검출

기 및 Big MAC 사용 시에는 즉시 거치가 가능하나, NaI(Tl) 검출기 거치를 위해서는 전용

PE 거치대로 검출기를 고정시켜야 한다.

(a) 이동형 카트 외형 치수 (b) 등각투영도

(c) 측면도 (d) 접었을 때 모습

그림 3.2.2.14. 이동형 카트 설계 개념도

(나) 이동형 카트 제작

이동형 카트 설계에 기초하여 이동성과 차량 적재 용이성, 휴대성 등이 강화된 이동형 방사

능 측정장비용 카트를 제작하였다.
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(a) 이동형 카트 정면 사진 (b) 이동형 카트 측면 사진

(c) 이동형 카트 후면 사진 (d) 접었을 때 사진

그림 3.2.2.15. 제작된 이동형 카트 모습
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(2) 구조 안전해석

이동형 카트의 구조 안전해석 시뮬레이션은 차폐체 거치대 부분에 하중을 주어 최대 파손

시점을 파악하는 형태로 진행되었으며, 카트가 버틸 수 있는 최대 한계점까지 측정하여 실제

차폐체가 실렸을 때 카트 자체가 안전한가, 그리고 카트가 버틸 수 있는 무게 최대치는 얼마인

가를 알아보려 했다.

이동형 접이식 카트 구조해석 결과 최대 하중은 7,850 N (801 kgf)에서 파손이 발생하였고,

최대 응력은 430 Mpa로 파손이 발생하였다. 최대 인장강도는 428 Mpa, 변형률은 차폐체 기준

으로 0.003 %로서 차폐체 무게보다 최대 10배의 무게를 버틸 수 있는 것으로 산출되었다. 따

라서 이동형 카트 구조물 전체에 대한 안정성 및 신뢰성은 매우 높음을 확증하였다.
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그림 3.2.2.16. 이동형 카트 구조 안전해석 결과
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다. 이동형 방사능 측정장비

(1) NaI(Tl) 검출기형 이동형 방사능 분석장비 조립

조립 사진 상세 설명

  

카트 받침 아래 바닥면을 보면 손잡이 볼

트가 두 개 달린 플레이트가 있다. 이는

NaI(Tl) 전용 PE 거치대 브라켓으로 거치

대 거치시 꼭 필요한 부분이다. 손잡이 볼

트 두 개를 한바퀴 정도만 돌리게 되면 플

레이트의 잠금이 풀리면서 앞뒤로 이동이

가능해진다.

  

플레이트가 돌출되면 직경이 작은 거치 공

간이 나오는데, 이 부분이 NaI(Tl) 전용

PE 거치대(좌)가 올라앉는 부분이다.

  

플레이트 고정이 끝나면 거치대 바닥 플레

이트 위로 납 차폐체 Bottom Body를 올리

고, NaI(Tl) 전용 PE 거치대(우)를 넣어준

다.

  

상단 거치대 넓은 홈 부분으로 Base body

(좌)가 올라앉는다. 이후 앰프가 장착된 3

인치 NaI(Tl)검출기를 홀 내부로 밀어 넣는

다.

  

NaI(Tl)이 장착되고 프리앰프 커넥터 쪽 케

이블을 HV, OUT, D-SUB 순으로 연결시

킨다. 연결이 끝나면 납 차폐체 Base Body

(우)을 설치한다. Base Body는 총 4개로

구성되어 있다.
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조립 사진 상세 설명

  

Main Body 장착이 끝나면 최상단에 Top

Body(좌)를 장착 시킨다. 커버 장착은 차폐

체 위가 아닌 카트에 존재하는 두 개의 기

둥에 장착 되게 된다. 기둥위에 있는 금색

의 원형 물체는 베어링으로서 커버 차폐체

에 달린 원뿔형 축을 받쳐주며 축이 움직

일 수 있게 해주는 역할을 한다.

  

오른쪽 Top 커버(우) 차폐체 끝의 스테인

리스 베어링 축을 카트에 세워진 두 개의

축 끝에 있는 금색 베어링 홀에 끼워 넣으

면 된다.

  

왼쪽 Top 커버(좌) 차폐체 설치도 마찬가

지로 좌측 기둥에 설치를 하면 차폐체 조

립이 완료가 된다.
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그림 3.2.2.17. 조립 완료된 NaI(Tl) 검출기형 이동형 방사능 분석장비
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(2) HPGe 검출기형 이동형 방사능 분석장치 조립

조립 사진 상세 설명

  

HPGe & Big MAC을 장착하기 위해서 우

선 전면 바퀴쪽 구조 앞부분의 손잡이 나

사 2개를 돌려 제거 한다. 차폐체 거치대

하판 안쪽부분에 HPGe Big MAC 전용 고

정 브라켓이 달려있는 거치대에서 고정용

뭉치를 제거한다.

  

제거된 고정용 뭉치를 카트 옆면의 삼각

지지대 홀에 장착 한다. 이 부분은 HPGe

& Big MAC 바닥판을 붙잡는 역할을 한

다.

  

고정용 뭉치 조립이 끝나면 HPGe & Big

MAC을 세워서 바닥에 안착 시킨 후 밀어

넣어 고정용 뭉치 안쪽에 걸칠 수 있는 부

분까지 밀어 넣는다.

  

HPGe & Big MAC 장착이 끝나면 제거했

던 전면 바퀴쪽 프레임을 재조립 한다. 재

조립을 할 때 유의점은 프레임 자체에 달

려 있는 바닥판을 거치하는 부분이 아래로

가도록 장착을 하여야 한다.

  

전면 바닥 프레임 조립이 끝나면 뭉치의

걸쇠부분을 돌려 HPGe & Big MAC 바닥

판을 물려 고정시킨다. 반대쪽에도 고정 뭉

치가 있으므로 같이 고정을 시켜준다.

  

장착된 HPGe & Big MAC 검출기 사이로

Bottom Body(우)차폐체를 조립 한다. 조립

할 때 검출기의 손상에 주의하며 조립을

하여야 한다.
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조립 사진 상세 설명

  

Base Body(좌)도 마찬가지로 검출기 손상

에 주의하며 조립한다. 이후 Main Body

(우) 차폐체 4개를 조립한다.

  

Top Body 차폐체(좌), 오른쪽 Top 커버,

왼쪽 Top 커버 순으로 차폐체를 차례대로

조립하게 되면 전체 차폐체 조립이 완료

된다.
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그림 3.2.2.18. 조립 완료된 HPGe 검출기형 이동형 방사능 분석장비
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라. 가방형 방사능 분석장비

가방형 방사능 분석장비는 이동형 카트가 갈 수 없는 상황이 발생하거나, 신속 모니터링이

필요한 상황에서 사람이 들고 이동할 수 있게끔 구조를 보다 더 단순화 하고 가방 형태를 만

들어 즉각적으로 현장 사용이 가능토록 고안하였다.

가방형 분석장비는 차폐체가 올라앉는 부분인 거치대의 전체적인 형태를 단순화 하고 작은

가방 안에 PC를 수납하거나 고정하는 방식을 선택했다. 노트북 또는 산업용 PC를 이용하여

가방 자체에 장착하며, NaI(Tl) 전용 프리앰프 구조를 변경하여 NaI(Tl) 검출기를 분리한 후

수납한다. 차폐체 거치대는 가방 내부에 차폐체 지지가 가능하고 NaI(Tl) 검출기를 장착했을

때 최소한의 공간을 차지하도록 설계되었다. 또한 거치대 상부에는 기본적으로 Body Base 차

폐체가 장착되어 차폐체 전체의 무게를 분산하도록 고려하였다. 이 거치대를 기준으로 외부 구

성을 알루미늄 하드케이스 형태로 제작하였다.

이와 별도로 신속 모니터링을 위해 두께와 무게를 줄인 차폐체는 캐리어 형태의 별도의 보

관 박스에 담아 이동한다.

그림 3.2.2.19. 가방형 방사능 분석장비의 치수 및 등각투영도
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(a) 외형 사진 (b) 커버를 연 모습

(c) NaI(Tl) 검출기 수납 공간 (d) NaI(Tl) 검출기 장착

(e) 납 자폐체 조립 (f) 분석 준비 완료

그림 3.2.2.20. 가방형 방사능 분석장비 외형 및 조립 과정

마. 검출기 및 차폐체 보관 케이스

납 재질의 차폐체가 가지고 있는 취약점 중의 하나인 파손 및 고중량으로 이동이 쉽지 않은
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문제점을 해결하려 가방형태의 보관 케이스를 별도로 제작하였다.

외부 충격으로 인한 제품의 파손을 막고, 캐리어 기능을 추가하여 이동시 안전한 이동을 할

수 있게끔 하였다. 케이스 자체가 가지고 있는 밀폐기능으로 장기 보관 시 제품의 변질 및 산

화를 막을 수 있는 장점을 가지고 있다. 케이스는 차폐체 전체 무게가 90 kg인 점과 이동성

등을 고려하여 두 개의 박스로 구성하였다.

그림 3.2.2.21. 차폐체 전용 하드케이스, CANBERRA Big MAC 케이스

그림 3.2.2.22. 차폐체 전용 하드케이스 내부 구성

3. 계측 및 신호처리

가. 계측 및 신호처리장치 개요

NaI(Tl) 및 HPGe 검출기를 이용한 분석장비를 구현하기 위해서는 신호처리 회로부와 이 출

력을 이용하여 에너지 스펙트럼을 구성하는 데이터 획득 회로부가 필요하다. NaI(Tl) 검출기의
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신호처리 회로부는 Highvoltage Divider 회로, Preamplifier 회로로 구성되며, HPGe 검출기는

Preamplfier 회로로 구성된다. 데이터 획득 회로부 중 Pre Analog Filter부에는 증폭회로

(Amplifier, AMP)와 가변증폭회로(Variable gain amplifier, VGA), 정형증폭회로(Shaping

amplifier, SA)를 거쳐 증폭된 신호에 대한 피크 검출 회로(Peak detector, PD)로 구성된다. 다

중파고 분석기(MCA)의 주장치는 ADC(Analog to Digital Converter)이며, 이는 증폭된 아날로

그 신호를 디지털화하여 채널로 변환시키는 장치이다. 이후 FPGA 기반의 디지털 펄스 처리회

로를 통하여 검출기의 신호에 대해 20 keV 부터 3000 keV 이상의 넓은 측정 범위를 갖는

MCA를 구현하였다. 입력 전원은 220 ACV 상용 전원을 사용하는 +16.8 V 단일 전원의

AC/DC 리튬폴리머 전용 충전기가 사용되었으며, 내부 배터리를 충전과 동시에 MCA에 전원

을 공급한다. 외부 전원이 차단되었을 때는 내부 배터리에 의해 자동으로 전원이 공급되도록

구현하였다. 아래 그림은 NaI(Tl) 및 HPGe 검출기 겸용 이동형 방사능 분석장치를 위한 계측

및 신호처리 개념도이다.

그림 3.2.3.1. NaI(Tl) 및 HPGe 측정 전자회로 개념도

나. 검출기 및 회로 구성

(1) NaI(Tl) 검출기 및 Preamplifier

미량의 탈륨(Tl)을 함유하는 요드화나트륨(NaI)의 결정으로 이루어진 신틸레이션 검출기로

감마선 검출효율이 우수하여 짧은 분해시간 동안 정성분석이 가능하고, 형광량과 흡수에너지의

비례관계로부터 에너지 측정이 가능한 Canberra사의 Model 802-3x3을 사용하였다.
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사양 세부내용 및 구조

Ÿ Canberra 802-3x3,

Ÿ 분해능 : < 7.5% @

Cs-137

NaI(Tl) 검출기를 위한 Highvoltage divider와 Preamplifier는 이동사용의 편의성을 위해 기

존의 분리형을 개선하여 일체형으로 제작하였다.

사양 세부내용 및 구조

Ÿ 일체형 Preamplifier

Ÿ 자체 개발

(2) HPGe 검출기

게르마늄 검출기(High-Purity Germanium Detector)는 게르마늄에 리튬을 확산시켜 만든 검

출기로 게르마늄 반도체에 방사선이 부딪치면 게르마늄 내부의 전자가 Electron-hole을 만들며

주변으로 이동하게 된다. 이 때 튀어나간 전자는 주위의 높은 전압에 의해서 형성된 전기장에

끌리며, 전자가 전기장에 의해 끌리는 정도는 입사 방사선의 에너지 세기에 비례한다. HPGe

검출기에는 검출기의 양극단에 높은 전압을 걸어주는 Bias Supply, 전치증폭기(Preamp), 급작

스런 전압의 상승을 억제하는 필터(High Voltage Filter)와 검출기의 냉각을 유지시키는 냉각

유지장치(Cryostat)가 연결되어 있다.
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사양 세부내용 및 구조

Ÿ Canberra GC3018-DET

Ÿ 분해능 : < 1.8 keV @

Co-60
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(3) 다중파고 분석기(NeoMCA)

그림 3.2.3.2. NeoMCA 케이스 정면

그림 3.2.3.3. NeoMCA 케이스 후면

그림 3.2.3.4. Li-ion 배터리가 장착된 NeoMCA 내부
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(가) 주요 구성 및 특성

그림 3.2.3.5. NeoMCA 내부 및 주요 구성품

① Li-ion 배터리

사양 세부내용 및 구조

Ÿ 16.8 V, 5000 mA

Ÿ 과충방전 보호회로 내장

Ÿ 크기 : 100x55x23 mm

Ÿ 외부 전원이 없을 시 8시

간 이내 구동
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② High voltage

사양 세부내용 및 구조

Ÿ 제조사 : Wismanhv

Ÿ 입력 : +12 V, 200 mA

Ÿ 출력 : HV(0∼5000 V),

0.2 mA @ 5000 V

Ÿ HV 모니터링

그림 3.2.3.6. High voltage 회로도
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③ Digital Pulse Processor

사양 세부내용 및 구조

Ÿ 입력 : 1채널 아날로그

입력

Ÿ 출력1 : DAC, Shaping

Signal

Ÿ 출력2 : TCP/IP

Ÿ FPGA: 1채널 Digital

Pulse Processor 내장

④ 전원부 : DC/DC Converter

사양 세부내용 및 구조

Digital Power

Ÿ 입력 : DC 12 V

Ÿ 출력1 : +3.3 V(10 A)

Ÿ 출력2 : +2.5 V(10 A)

Ÿ 출력3 : +1.8 V(10 A)

Ÿ 출력4 : +1.5 V(6 A)

Ÿ 출력5 : +1.0 V(10 A)

Analog & Preamp Power

Ÿ 입력 : DC 24 V

Ÿ 출력1 : +12 V(100 mA),

Ÿ 출력2 : -12 V(100 mA)

Ÿ 출력3 : +24 V(100 mA)

Ÿ 출력4 : -24 V(100 mA)
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그림 3.2.3.7. DC/DC Converter 회로도

다. 디지털 펄스 프로세서

(1) 디지털 펄스 프로세서(Digital Pulse Processor)
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디지털 펄스 프로세서는 전치증폭기 이후 신호 정형 없이 고속 ADC(80 MHz)를 사용하여

디지털화 한 다음 디지털 필터 방식을 이용하여 신호를 처리하여 MCA 기능을 구현한다. 디지

털 펄스 프로세싱 방식의 신호처리는 Amptek 사의 DP5, XIA LLC사의 microDXP가 대표적이

다. 다음 그림에 디지털 펄스 프로세싱의 개념을 나타내었다.

(2) 주요 규격

(가) 프리앰프 신호 처리부

프리앰프 신호를 입력받아서 Fast ADC에 신호를 전달하기 전 신호의 증폭과 3.2 us의 시정

수를 가진 high pass 필터로 구성된다.

그림 3.2.3.9. 프리앰프 신호 처리부 회로도

(나) 게인 조정

디지털스위치를 이용한 회로를 구성하여 2단으로 구성한다. 소프트웨어에서 스위치 위치를

선택하여 이득을 설정한다. 이득은 스위치의 위치에 따라 다음과 같이 설정된다.(1.21, 4.07,

7.15, 11.11, 13.69, 24.05, 37.37, 42.25, 65.65, 102.01)

그림 3.2.3.8. 디지털 펄스 프로레싱 방식 신호처리 구성도
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그림 3.2.3.10. 게인 조정 회로도

(다) ADC

AD9649BCPZ-80, 14Bit, 80MHz MSPS, Aanlog to Digital Converter

그림 3.2.3.11. ADC 회로도

(라) FPGA

Xilinx Zynq®-7 SoC, XC7Z020-2CLG484I, ARM Cortex-A9 dual Core with FPGA
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그림 3.2.3.12. FPGA 회로도

(마) DAC

DAC: AD9714BCPZ, 125MHz, 14bit, Digatla to Analog Converter

그림 3.2.3.13. DAC 회로도
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(바) 통신 인터페이스(TCP/IP, USB)

그림 3.2.3.14. 통신 인터페이스 회로도
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(3) 디지털 데이터 획득 펌웨어

(가) 주요 기능

FPGA에서 디지털필터와 데이터획득을 하는 펌웨어로써 주요 기능을 다음 그림에 나타내었

다. ADC는 20 MHz, 혹은 80 MHz로 구동되어 프리앰프 신호를 직접 디지털화 한 후 이 신호

에 대해 디지털 필터를 구현한다. 검출기 신호로 판단되는 event에 대해 피크값을 검출한 다음

돗수 분포를 얻는다. 또한 FPGA내에 디지털 프로세서 IP를 구현하여 외부와 통신을 수행하고

명령어에 따른 데이터 획득이 이루어지도록 구성한다. 이러한 모든 기능을 하나의 패키지에 탑

재하여 회로 구성을 간략화 하였다.

그림 3.2.3.15. FPGA 내에서의 디지털 필터 구성

(나) 입력신호 규격

사양 세부내용 및 구조

Polarity Inverse of input

Rise Time
2.5 ns at 0 pF input load with 2SK152 4.5 ns

at 100 pF input load

Output Impedance 10 ohm

Integral Nonlinearity
< 0.03% for 0 to +2 V unloaded <0.006%

for 0 to -2 V unloaded

Decay Time Constant
300 Mohm x Cf = 300 µs, 900 µs, 1.5 ms,

2.1 ms User selectable T=Rf Cf

Positive Clipping Level > +2.8 V

Negative Clipping Level < -4.6 V
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(다) 주요 성능

사양 세부내용 및 구조

AD 피크 결정 펌웨어

Ÿ T/Z 알고리즘 통과 후 shaping 모양과 I/O를

통해 peak 신호를 출력시킨 다음 오실로스코

프 사진 첨부.

Ÿ slow filter, fast filter, peak detection

최적 Trapezoidal Shaping

펌웨어

Ÿ peaking time 조정 : 0.1 ~ 102.4 μs

Ÿ flat top 조정 : 0.05 ~ 51.2 μs

Ÿ test pulse를 사용하여 picking time, flat top에

따른 T/Z shaping 출력 모양을 오실로스코프

그림으로 나타냄

히스토그램 펌웨어 : 8192

채널
입력 펄스 크기에 대응하는 히스토그램 출력

TCP/IP 데이터 통신 로직 통신 점검
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(4) NeoMCA 성능평가

(가) Pulse Generator를 이용한 선형성 시험

펄스 제너레이터(Agilent 33500B)을 이용한 선형성 시험을 위해 입력으로 RAMP 펄스를 20

∼860 mV 까지 100 mV씩 가변하여 선형성을 측정하였다. 특히 낮은 전압영역(20∼100채널)과

높은 전압영역(920∼1000채널)에서는 20mV 간격으로 세분하여 측정하였다.

그림 3.2.3.16. Pulse Generator를 이용한 선형성 시험

측정구간 중 460 mV 입력을 오실로스코프로 확대해 측정한 결과 입력 펄스는 3mV의 진폭

변동이 있었으며, FWHM 폭이 그 결과를 그대로 반영하고 있으므로 디지털 펄스 프로세서 회

로의 전기적 잡음이 아님을 확인하였다.

그림 3.2.3.17. 460 mV 입력 펄스 확대한 파형

최종적으로 디지털 펄스 프로세서 회로의 입력 전압 대비 채널을 비교하였을 때 우수한 선

형성과 안정성을 보임을 확인할 수 있었다.
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그림 3.2.3.18. 입력 전압 대비 출력 채널의 선형성 비교

(나) Preamplifier 입력 전원에 따른 스펙트럼 비교

Preamplifier 신호를 입력받는 AMPTEK사의 DP5 MCA를 이용하여 Preamplifier 입력 전원

에 따른 스펙트럼을 비교 측정하였다. 개발 전원 모듈을 적용했을 때 Cs-137 핵종 기준으로

6.7%의 우수한 에너지 분해능이 산출되었으며(Canberra datasheet 7.5% 이하), 공급 전원을

Linear Power Supply(Agilent E3631A)로 변경했을 때에도 거의 동일한 에너지 분해능이 나타

났다.

그림 3.2.3.19. 개발 전원 모듈과 상용 Linear Power Supply의 비교
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감마 핵종 FWHM Peak 분해능(%)

Cs-137
Linear Power Supply 16.164 240.76 6.71

개발 전원 공급 모듈 15.965 240.71 6.63

Co-60A
Linear Power Supply 19.323 416.76 4.63

개발 전원 공급 모듈 20.818 416.53 4.99

Co-60B
Linear Power Supply 21.215 470.57 4.50

개발 전원 공급 모듈 21.127 470.13 4.49

표 3.2.3.1. Preamplifier 입력 전원에 따른 분해능 비교

(다) 입력 전원에 따른 스펙트럼 비교

입력전원(DC +24 V)의 전압 리플 특성이 3 mV 이하인 Linear Power Supply(Agilent

E3631A)와 리플 특성이 120 mV인 SMPS(Switching Mode Power Supply)로 전원을 공급하였

을 때 스펙트럼을 각각 비교하였다. 그 결과 리플 특성이 낮은 SMPS를 사용해도 스펙트럼에

영향을 주지 않음을 확인하였다.

 

그림 3.2.3.20. 입력전원에 따른 스펙트럼 비교

(라) PMT Base 및 NeoMCA 성능 평가

개발된 일체형 Preamplifier(#1)의 성능을 평가하기 위해 동일한 신호 출력을 발생하는 상용
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제품인 Canberra사 Model 2007(#2), Ortec사 Model 226(#3)을 각각 Amptek사 DP5G MCA에

연결하여 비교측정을 수행하였다. 이를 위해 1 μCi Cs-137 체크선원을 NaI(Tl) 검출기로부터

10 cm 거리에 위치시킨 후, High voltage를 700 V로 고정하였다. 이후 Cs-137(662 keV)의 피

크를 DP5G의 게인을 조정하여 동일한 위치에 나오도록 조정하였다. 이와 함께 개발된 MCA의

성능 평가를 위해 일체형 MCA 상용제품인 Canberra사 Osprey(#4), Ortec 사 DigiBase(#5)를

개발된 일체형 Preamplifier & NeoMCA(#6) 함께 위와 동일한 조건에서 비교측정 하였다.

(a) 일체형 Preamplifier

& DP5G (#1)

(b) Canberra 2007 &

DP5G (#2)

(c) Ortec 226 & DP5G

(#3)

(d) Canberra Osprey (#4) (e) Ortec digiBase (#5)
(f) 일체형 Preamplifier

& NeoMCA (#6)

그림 3.2.3.21. 상용제품과 개발제품의 비교측정 모습

각 제품의 스펙트럼을 비교한 결과, NaI(Tl) 검출기를 이용한 측정에서 모든 스펙트럼은 동

일하게 측정되었음을 알 수 있었다. 따라서 본 연구에서 개발된 일체형 Preamplifier와

NeoMCA는 모든 상용제품과 동일한 성능이 발휘됨을 알 수 있었다.
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그림 3.2.3.22. NaI(Tl) 검출기를 이용한 PMT Base 및 MCA 성능 평가

(마) NeoMCA 분해능 평가

개발된 NeoMCA의 분해능 평가를 위해 Canberra DSA-LX와 비교측정을 수행하였다. 이를

위해 우선 LN2를 이용하여 HPGe 검출기(Canberra GC3018)를 4시간 이상 냉각하였다. 이후 1

μCi Co-60 체크선원을 검출기로부터 25 cm 거리에 위치시키고, Highvoltage를 4,000 V로 설

정한 다음 8,192채널에서 10,000초 동안 각각 측정하였다. 그림 3.2.3.23은 Canberra DSA-LX와

NeoMCA에서 각각 측정된 Co-60 핵종의 스펙트럼이다. NeoMCA의 분해능은 1173.1 keV에서

는 1.07 keV, 1332.5 keV에서는 1.08 keV 정도 낮게 산출되었다.
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그림 3.2.3.23. DSA-LX와 NeoMCA의 분해능 비교

4. 분석용 프로그램

가. 식품분석 DB 프로그램

식품은 다양한 산지로부터 공급되어지고 있다. 일부 식품에서는 방사능 오염이 확인되고

있으나, 방대한 양의 식품 시료에 대한 정보처리 및 오염 분포도 분석에는 어려움이 따른

다. 식품분석 DB 프로그램은 식품 시료의 분류 및 분석을 위하여 식품시료의 접수부터 전

처리, 방사능 검사결과, 그리고 검출기 상태 등 식품방사능 분석에 필요로 하는 방대한 양
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의 DB를 처리할 수 있도록 제작되었다. 그림 3.2.4.1은 식품분석 DB프로그램의 메인화면이

다. 식품분석 DB프로그램은 시료를 사용자가 설정한 조건에 따라 분류하고 방사능 오염을

확인할 수 있다.

그림 3.2.4.1. 식품분석 DB 프로그램 : 메인화면

(1) 로그인

식품 분석 DB 프로그램은 식품분석관련자에 의해 기록 및 관리되어야 한다. 위 프로그램

은 실행시 로그인이 필요로 하다. 사용자 계정은 관리자 모드와 사용자 모드로 구분된다.

관리자 모드는 DB 프로그램에 설정을 관리하고 기록된 식품시료에 대한 분석결과를 열람할

수 있다. 사용자 모드는 식품시료를 접수하고 전처리 정보를 기록하며, 핵종분석을 완료한

시료에 대한 분석결과를 기록할 수 있다.

로그인 화면은 최초 프로그램 실행시 팝업되며, 로그인을 미실시할 경우 DB 프로그램에서

어떠한 기록 혹은 열람 등이 불가하다. 접속한 계정을 로그아웃을 원하는 경우 우측 상단의

Logout을 클릭하여 접속을 종료할 수 있다. 로그아웃 없이 DB 프로그램을 종료한 경우에는

자동으로 계정이 강제적으로 접속이 종료된다.

최초의 DB 프로그램은 사용자의 설정없이 “ID: admin, PW: 4269”의 관리자 계정이 제공

된다. 이 DB 프로그램에 접속할 수 있는 사용자 계정과 관리자 계정들은 관리자에 의하여

DB 프로그램 설정의 ‘사용자 관리’ 메뉴에서 관리가 가능하다.

(2) 시료 정보

식품분석 DB 프로그램의 우측 상단에 위치한 “정보 입력” 메뉴는 시료에 대한 정보를 입

력하는 항목이다. 입력되는 정보는 크게 ‘접수 정보’, ‘시료채취정보’, ‘전처리 정보’로 구분된

다.

접수정보는 새로운 시료 혹은 기존 시료에 대한 접수 절차를 다루는 메뉴로, 접수일자,

접수번호 그리고 의뢰기관을 선택한다. 그림 3.2.4.2 (b)는 식품분석 DB 프로그램 내 시료
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접수 및 채취정보를 입력하는 화면이다. 접수일자는 시료를 처음 입수한 년·월·일 순으로

입력한다. 접수 번호는 시료 접수에 대한 고유번호를 부여하며, 새 시료는 ‘신규 접수 번호’

를 선택하고 기존 시료의 경우에는 접수 번호 목록에서 선택한다. 의뢰기관은 프로그램 설

정에 등록된 기관을 선택하여 입력한다.

시료채취정보는 접수한 시료에 대한 시료 채취정보를 입력한다. 이미지 첨부는 등록할 시

료의 사진을 image 파일로 등록하며, 등록된 시료의 이미지는 시료 입력 창 좌측에 표시된

다. 채취자는 시료를 직접 채취한 인원 혹은 관리자이며, 의뢰기관에 등록된 인원 중 선택

이 가능하다. 채취일자는 시료 채취를 완료한 시점을 입력한다. 채취량은 채취한 시료의 총

질량이며, 단위는 kg, g 등 선택이 가능하다. 시료 종류는 시료의 채취지점 혹은 입수경로,

식품분류 등 다양한 분류에 따른 분류명이며, DB 프로그램에 등록된 대분류, 중분류에 따라

선택이 가능하다. 채취지점은 시료를 채취한 지점에 대한 기록을 입력한다. 전처리법은 식

품 전처리 절차에 대한 상세정보를 입력하는 항목으로, 등록할 시료에 적용할 시료 전처리

법을 선택한다. 마지막으로 감마 분석, 전베타 분석 등 시료를 대상으로 수행할 분석방법을

선택한다.

(3) 시료 전처리

식품시료는 시료의 종류와 분석방법에 따라 다양한 전처리 방법을 요구한다. 전처리 정보

는 시료채취 정보에 입력된 전처리법으로 메뉴를 활성화 할 수 있으며, 활성화된 메뉴에 대

하여 전처리 정보를 입력하여야 한다.

그림 3.2.4.2 (c)는 생체법을 이용한 전처리 정보 입력항이다. 일반적으로 입력되는 정보는

전처리를 시작한 일시와 마무리한 일시(전처리기간), 전처리를 수행한 담당자(전처리 담당),

핵종분석 시 사용할 용기 (계측용기), 전처리에 사용된 시료의 양(전처리량), 전처리 후 측

정에 사용된 양(계측시료량) 등이 있으며, 특이사항은 상세내용에 기록한다. 전처리가 완료

된 시료는 고유한 전처리 번호를 부여하여 관리한다.
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(a) 계정 접속 (b) 시료정보 입력

(c) 전처리 정보 (d) 측정 대기

(e) 측정데이터 입력 (f) 검사기록서 작성

그림 3.2.4.2. 식품분석 DB 프로그램
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(4) 시료 측정 및 결과

전처리가 완료된 시료정보는 메인 메뉴의 ‘대기 중’으로 이동한다. 그림 3.2.4.2 (d)는 측정

을 위해 대기 중인 시료의 목록을 나타낸다. 대기 중인 시료는 시료번호, 전처리번호, 전처

리담당, 전처리방법, 시료 채취자, 분석방법 등을 표시한다. 대기 중 상태의 시료는 1개 이상

입력이 가능하며, 측정이 완료된 시료는 대기 중 목록에서 선택하여 측정데이터를 입력한

다.

측정데이터는 핵종분석 방법에 따른 측정 정보와 시료 분석결과를 입력한다. 측정 정보에

는 측정을 수행한 분석자, 측정 및 분석을 시작한 분석일자 그리고 분석에 사용한 실험장비

를 입력한다. 분석자와 분석장비는 DB 프로그램에 등록되어 있는 담당자 혹은 분석장비 중

선택이 가능하다. 담당자와 분석장비는 메인메뉴 ‘설정’ 내 담당자 설정과 분석장비 설정에

서 추가 및 수정이 가능하다.

분석 결과는 분석핵종, 상세내용 입력, 최종검사기록서 작성, 스펙트럼 첨부 및 리포트 첨

부로 구성된다. 분석핵종은 핵종분석에 대한 결과를 핵종별로 입력하는 항으로 ‘추가’ 및 ‘삭

제’ 버튼으로 원하는 핵종을 입력한 후 방사능(Activity), 최소검출방사능(MDA) 그리고 방

사능오염판별 기준값을 입력한다. 상세내용에는 분석 수행 중 발생된 특이사항 혹은 기록을

요하는 내용을 기록한다. 그림 3.2.4.2 (e)는 분석결과 입력 예시이다.

검사기록서는 분석 결과를 기록하는 공식문서로 작성하는 과정으로, 이 프로그램에서 제

공하는 양식에 맞추어 기록한다. 그림 3.2.4.2 (f)는 프로그램에서 제공하는 검사기록서 양식

이다. 기록 내용은 식품시료 이미지, 접수 정보(접수번호, 접수일자), 분석기간, 시료 정보(시

료명, 식품 유형, 검체사용량, 제조일자), 검사자 및 시험방법 등 접수된 시료 및 분석 정보

를 기입하고, 검사 수행목적, 시험법 근거, 표준물질의 사용내용과 방사능 인공핵종인 I-131

과 Cs-134/137에 대한 방사능 수치 및 판정결과를 입력한다. 시험상세내용에는 의뢰내용,

시료정보, 전처리법, 방사능측정에 관련된 내용에 대한 상세한 수행내용을 기록한다. 기록을

완료하면 저장을 눌러 페이지를 빠져나온다.

검사기록서 외에 핵종분석 장비에서 출력된 스펙트럼 파일과 검사기록서와 별개로 작성

한 리포트 파일을 함께 첨부할 수 있다. 모든 내용을 기입완료한 후 저장버튼을 눌러 식품

시료의 측정결과 기록을 완료한다. 만약 기록한 내용을 지우고 다시 작성을 원하는 경우 초

기화를 수행한 후 다시 기록한다.

(5) DB 열람

검색 메뉴는 DB에 저장되어 있는 측정정보를 검색하는 기능으로, 시료 종류, 분석 방식

등에 따라 다양한 조건으로 검색이 가능하다. 검색 기능은 사용자 계정, 관리자 계정 모두

에서 이용이 가능하나, 관리자 계정에서는 분석정보에 대한 세부내용을 열람할 수 없다. 검

색조건은 시료를 의뢰한 담당자, 지점검색, 분석기간, 시료종류 및 분석방법등 관리자가 원

하는 조건을 설정하여 검색이 가능하다. 예를 들어 의뢰자가 ‘이용주’인 시료 중 2015년도에

접수 및 분석 수행한 결과를 확인하고자 할 경우, 그림 3.2.4.3과 같이 검색 조건을 기입한

후 검색을 수행한다.

검색 결과는 검색조건에 부합한 데이터만을 출력한다. 출력된 정보는 시료번호, 발급번호,

시료종류, 전처리법, 그리고 분석결과 등이 표시되며, 표시된 결과는 우측 클릭을 통하여 시

료 정보 확인 혹은 측정데이터 확인이 가능하다. 시료정보 선택시 정보입력 화면으로 이동
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하여 기록된 정보를 표시하며, 측정데이터 선택시 대기중 화면으로 이동하여 기록한 분석결

과를 열람할 수 있다. 검색된 식품분석 목록은 선택항목 출력을 통하여 프린터로 인쇄가 가

능하다. 만약 파일로 식품분석 목록을 저장하길 원할 경우에는 내보내기를 클릭한다. 내보

내기를 수행하면 검색결과를 선택된 항목들을 엑셀파일로 저장한다.

그림 3.2.4.3. 식품분석 DB 프로그램 : DB 검색결과

(6) 프로그램 설정

프로그램 설정은 사용자 및 분석장비 등에 대한 정보를 기입하고 관리한다. 프로그램 설

정은 사용자 계정으로 열람만 가능하고 관리자 계정에서 직접 관리한다. 프로그램 설정은

사용자 설정, 담당자 설정, 분석핵종 설정, 용기종류 설정, 분석장비 설정, 시료종류 설정으

로 구성된다.

사용자 설정에서는 그림 3.2.4.4의 (a)와 같이 DB 접속 계정을 관리한다. 프로그램에서 계

정 생성은 관리자에 의해서만 가능하다. 등록된 사용자에서는 성명, 아이디, 소속, 휴대폰번

호, 이메일, 권한 등이 표시된다. 위 목록 중 계정을 선택할 경우 하단의 정보창에 상세 내

용이 표시된다. 새로운 계정 생성을 원할 경우 위 내용을 기입한 후 추가를 눌러 계정을 생

성한다.

담당자 설정에서는 그림 3.2.4.4의 (b)와 같이 식품의뢰 및 분석수행 등을 수행하는 담당

자를 등록하는 메뉴이다. 이 담당자는 내부담당자와 외부담당자로 구분되어 관리한다. 내부

담당자는 식품분석을 수행하는 관계자이며, 외부담당자는 식품시료의 분석을 의뢰하는 외부

기관 담당자이다. 등록시 필요한 정보는 기관명, 성명, 이메일, 소재지 등이 있다. 이 메뉴

역시 관리자에 의해서만 수정이 가능하다.

분석핵종설정에서는 그림 3.2.4.4의 (c)와 같이 식품 방사능 모니터링의 기준이 될 핵종

들을 추가하는 메뉴로, 일반적으로 I-131, Cs-134, Cs-137 등이 등록되어 있다. 만약 추가로

핵종 등록을 원할 경우에는 하단의 핵종명칭과 기준값을 기입한 후 추가한다.
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용기종류설정은 그림 3.2.4.4의 (d)와 같이 측정시 사용할 용기의 크기를 등록하는 메뉴로,

다양한 크기의 용기를 등록할 수 있다. 새로운 용기는 용기명칭을 기입한 후 추가한다.

분석장비설정에서는 그림 3.2.4.4의 (e)과 같이 핵종분석 분석장비를 등록하는 메뉴이다.

메뉴에는 분석장비 명칭을 기입하여 등록할 수 있으며, 감마핵종 분석장비에 한하여

Am-241, Co-60에 대한 반칙폭의 상/하한값을 기입한다. 만약 분석장비의 반칙폭이 상/하한

값을 벗어날 경우에 장비에 대한 점검이 필요하다.

시료종류설정에서는 그림 3.2.4.4의 (f)과 같이 식품 분류의 대분류와 중분류를 등록하는

메뉴이다. 시료분류에서 대분류와 소분류를 선택하면 하단 표에 분류별 목록이 표시된다.

대분류에서는 가장 큰 분류 기준을 지정하며, 대분류마다 분류코드를 부여하며, 이 분류코

드는 시료의 고유번호 지정할 때 활용된다. 중분류에는 대분류 아래 단계의 분류를 등록한

다.
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(a) 사용자설정 (b) 담당자설정

(c) 분석핵종설정 (d) 용기종류설정

(e) 분석장비설정 (f) 시료종류설정

그림 3.2.4.4. 식품분석 DB 프로그램 : 사용자 설정
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(7) 분석장비 품질보증

QA 메뉴는 분석장비에 대한 QA(Quality Assuarance)를 관리하는 메뉴로, 설정에서 등록

된 분석장비에 대한 상태를 기록한다. QA 정보를 이용하면 시간별로 변화한 감마핵종 분석

장비의 반칙폭 변화를 감시할 수 있다. QA 정보에는 분석장비와 QA 일자를 선택한 후 QA

입력을 클릭하면 반칙폭 입력 항이 나타난다. 각 해당 핵종에 대한 반칙폭을 입력한 후 저

장하면 DB에 QA 정보가 기록된다. 기록된 QA 정보는 QA 추이그래프 보기를 통하여 시간

별 반칙폭 변화를 확인할 수 있다.

교정파일첨부에서는 각 장비에 대한 교정결과를 기록·관리할 수 있다. 장비선택 후 추가

를 선택하면 교정일자를 선택한 후 견적서, 스펙트럼, 증명서를 첨부할 수 있다. 저장하면

교정 정보가 등록된다.

그림 3.2.4.5. 식품분석 DB 프로그램 : QA
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나. 감마 핵종분석 프로그램(NeoGMA)

(1) 개요

감마 핵종분석 프로그램은 감마선 분석 장비로부터 측정된 스펙트럼 데이터를 대상으로

감마핵종에 대한 방사능 정성적 · 정량적인 분석을 수행한다. 일반적으로 감마 핵종분석프

로그램은 Canberra사, Ortec사 등 방사능 분석 장비를 판매하는 특정기업에서만 개발 판매

되고 있는 실정이다. 이 과제에서는 농식품 분석시스템 개발에 감마선 분석 장비에 대한 핵

종 분석을 수행할 수 있도록 한글화된 감마핵종 분석 프로그램을 개발하였다.

분석프로그램은 TCP/IP 통신방식을 통하여 분석 장비와 연동이 가능하고 연동된 장비를

제어하여 스펙트럼을 실시간으로 수신할 수 있도록 제작하였다. 수신된 스펙트럼은 표준선

원을 이용한 에너지·효율 교정 기능을 적용하여 정량분석이 가능하도록 제작하였다. 그림

3.2.4.6은 개발된 감마 핵종분석 프로그램의 메인화면이다. 장비 제어 메뉴를 손쉽게 확인할

수 있도록 리본메뉴를 이용하였다. 리본 메뉴를 통하여 별도의 창 없이도 감마선 분석 장비

의 상태를 확인할 수 있다. 리본 메뉴는 측정부터 분석까지 절차에 따라 순차적으로 배열하

여 누구나 손쉽게 따라할 수 있도록 제작되었다.

그림 3.2.4.6. 감마 핵종분석프로그램 : 메인화면
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(2) 알고리즘

감마 핵종분석프로그램은 측정된 감마선 스펙트럼을 대상으로 감마선 피크를 선별하고

이 피크에 대한 감마선 여부 판단 및 방사능/MDA를 산출하는 기능을 한다. 아래 절은 프

로그램에 적용된 감마 핵종 분석용 알고리즘을 정리하였다.

(가) 감마선 피크

가우시안 함수는 감마선 피크의 형태를 가장 잘 나타내는 함수이다. 가우시안 함수를 이

용하면 피크의 각종 정보를 얻을 수 있다.

 exp




 (1)

는 감마선의 최고점 높이, 는 감마선 피크의 위치, 는 감마선 피크의 분포를 의미하

며, 이 정보를 이용하여 반칙폭 혹은 피크의 면적(감마선의 총 계수)를 산출할 수 있다.

(나) 에너지 교정 및 효율 교정

에너지 교정곡선은 파고 높이에 따라 분류된 채널을 감마선 에너지로 변환하는 교정식을

의미한다. 교정은 2차 선형 방정식에 의하여 표현되며, 이때, 는 파고의 높이를 나타내는

채널이 입력한다.




(2)

C0, C1 그리고 C2는 각각 2차방정식의 상수, 1차항의 계수 그리고 2차항의 계수에 해당한

다. 는 파고의 높이를 감마선 에너지로 변환한 결과이다.

피크의 폭을 나타내는 반칙폭(FWHM)은 핵종분석에서 피크의 유효범위를 결정하는 데 활

용된다. 반칙폭은 식 (3)과 같이 에너지에 대한 함수로 나타낼 수 있다.






(3)

E는 에너지, C1은 에너지 교정 식에서 “gain” 항, F0 와 F1 은 각각 에너지 교정식에서의

계수이다.

검출효율은 검출기의 물리적 특성에 의하여 결정된다. 일반적인 검출효율 곡선은 저에너지

의 감마선이 검출기보호용 외부 하우징에 의해 차단되는 현상과 고에너지의 감마선이 투과

력에 의해 검출효율이 서서히 감소하는 현상에 의하여 그림 3.2.4.7과 같은 모습을 갖는다.

이 검출효율은 방사능 산출에 주요한 인자이며, 에너지에 따라 영향을 받는다. 검출효율은
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식 (4)와 같이 에너지에 대한 함수로 나타낼 수 있다.

ln ε 
 



·ln  (4)

이 식에서 은 검출효율, 는 감마선 에너지, 는 차수에 따른 계수를 의미한다.
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그림 3.2.4.7. 효율 교정곡선의 예시

(다) 피크검색

감마선 스펙트럼 내에 포함되어 있는 감마선 피크를 식별하는 일은 검출효율, 백그라운드

신호, 노이즈 등에 의하여 복잡하고 어렵다. Mariscotti는 감마선 스펙트럼의 2차 미분 결과

를 이용하여 피크를 식별하였다. 이후 Mariscotti 방법을 보완한 SAMPO 피크검색 알고리

즘이 제안되었다. 이 프로그램에서는 SAMPO 알고리즘을 수정하여 적용하였다.

① 2차 미분 스펙트럼

2차 미분 스펙트럼 :   
 

 

 (5)

2차 미분 스펙트럼오차:  



 

 


  (6)

2차미분 상수:  


 exp

  (7)
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식 (5)와 (6)은 감마선 스펙트럼의 2차 미분 스펙트럼과 스펙트럼 오차이며, 식(7)의 미분

상수에 의해 결정된다. 이 미분 상수는 가우시안 함수를 2차 미분하여 얻은 계수로, 감마선

피크 식별에 유용하다.

② 피크 중심채널

중심채널:  







×
for  (8)

피크 중심채널은 유효값  이하인 범위에 한하여 식(8)을 통하여 산출할 수 있다. 이때,

  이다.

(라) 피크면적

감마선 피크의 면적(총 계수)는 아래 식과 같이 계산된다.

  (9)

는 피크의 높이, 는 측정된 피크 너비로 가우시안 적분을 통하여 총 계수를 산출한다.

하지만 스펙트럼 데이터가 완벽한 가우시안 분포를 띠고 연속적인 분포가 명확할 경우에는

각 채널에 들어가는 계수값을 모두 합하여 피크 면적을 산출할 수 있다.

 
 



 (10)

 : 피크 면적

 : 피크내의 채널 i에서의 계수

 : 피크내의 백그라운드 컨티넘의 채널 i에서의 계수
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그림 3.2.4.8. 효율 교정곡선의 예시.

백그라운드 (B)는 아래 식으로 계산된다.


 









 



 (11)

 : 피크 왼쪽의 n개 채널의 계수값의 합

 : 피크 오른쪽의 n개 채널의 계수값의 합

 : 피크 내의 계수값의 총 합

(마) 방사능 산출

방사능은 검출된 피크 면적에 의하여 식 (12)로 산출할 수 있다.




(12)

이 식에서 는 측정시간, 는 검출효율, 는 감마선 붕괴비, 는 샘플의 질량 (혹은

부피), 는 시료채취부터 측정까지의 방사능붕괴 보정계수이다.

(바) MDA 산출

MDA는 감마선 스펙트럼 내 피크가 검출될 수 있는 최소 검출 방사능 수치를 의미한다.

여기서는 최소 검출 방사능은 식 (13)에 의하여 결정된다.
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


(13)

이 식에서 는 측정시간, 는 검출효율, 는 감마선 붕괴비, 는 샘플의 질량 (혹은

부피), 는 시료채취부터 측정까지의 방사능붕괴 보정계수이다. 이때, 는 최소검출면적

을 의미한다. 이 이상의 면적이 검출되어야만 감마선 피크가 감지되었다고 볼 수 있다. 

는 다양한 산출방법이 존재하나, 이 프로그램에서는 Currie MDA법을 적용하였다. Currie

MDA법에 의한 최소검출면적은 식(14)에 의하여 결정된다.

  


(14)

여기서, 는 검출오차에 의한 신뢰상수이며, 와 는 백그라운드 백그라운드과 그에

대한 오차를 나타낸다.
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(3) 장비 연결

감마 핵종분석프로그램은 감마선 분석 장비와 연결하여 실시간으로 데이터를 송수신할

수 있다. 연결방식은 TCP/IP 통신, USB 통신, Serial 통신 총 3가지 통신방법을 지원하며,

그 중 TCP/IP 통신방법은 소켓을 통한 데이터 송신으로 빠른 데이터 전송이 가능하여

TCP/IP 통신 방식을 사용하는 것을 권장한다.

감마선 검출기는 인가하여야 할 고전압, 출력 신호 등이 검출기 타입에 따라 상이하다.

특히 고전압의 경우에는 HPGe가 3000 V 이상의 고전압을 인가하는 반면, NaI(Tl)검출기는

PMT에서 1000 V 이하의 고전압을 필요로 하기 때문에 잘못 설정될 경우 검출기 손상을

피할 수 없다. 이와 같은 사고를 예방하기 위하여 장비 연결에 앞서 분석 장비에 연결될 검

출기를 선택할 필요가 있다. 상단의 검출기 메뉴를 통하여 검출기 타입을 선택한다.

TCP/IP 통신은 고정 IP를 보유하여 외부 다른 통신장비들이 접속할 수 있는 서버와 서버

에 접속하여 데이터를 송수신하는 클라이언트로 구성된다. 방사능 분석 장비에서 MCA는

서버 기능을 수행하며, S/W는 클라이언트로서 접속하게 된다. 접속시 필요한 정보는 서버

의 IP주소와 Port 번호가 필요로 하다. 위 정보를 기입한 후 하단의 “연결” 버튼을 누르면

장비와 연결을 시도한다. 장비와 연결되면 “연결해제”버튼이 활성화되어 연결됨을 나타낸다.

만약 연결을 해제하고자 할 경우에는 “연결해제” 버튼을 눌러 분석 장비와 통신을 두절할

수 있다. 분석 장비와 연결되면 하단의 “닫기”를 눌러 장비 연결창을 종료한다.

그림 3.2.4.9. 감마 핵종분석프로그램 : MCA 연결
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(a) 설정 메뉴

(b) 화면 메뉴

(c) 측정 메뉴

(d) 교정 메뉴

(e) 분석 메뉴

(f) 도움말 메뉴

그림 3.2.4.10. 감마 핵종분석프로그램 : 리본 메뉴
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(4) MCA 설정

장비가 연결되면 스펙트럼 측정에 앞서 MCA에 대한 설정이 필요로 하다. 그림 3.2.4.10

(a)는 감마 핵종분석프로그램 내 MCA 설정 화면이다. 모든 설정치가 한 눈에 확인될 수 있

도록 제작되었다. MCA 설정은 검출기마다 상이하기 때문에 적절한 설정치를 적용하는 것

이 필요로 하다.

측정시간은 스펙트럼을 측정할 시간을 설정한다. 측정 모드는 실제 시간과 동일한 Real

Time과 신호처리시간을 제외한 순수 측정시간인 Live Time 2가지 모드를 선택이 가능하

다. 측정시간은 1초부터 최대 136년까지 설정이 가능하며, 0초로 설정할 경우 정지 명령입

력 전까지 측정이 가능하다. 현재는 신속분석법 기준인 NaI(Tl)검출기 20분, HPGe검출기

30분간 측정을 기준으로 하고 있다.

방사선 검출기는 전리현상을 이용하기 때문에 고전압 인가가 필요로 하다. HPGe 검출기

는 약 2000 V부터 최대 5000 V까지 고전압을 필요로 하며, NaI(Tl) 검출기는 그보다 낮은

300 V부터 최대 1000 V의 고전압을 필요로 한다. 통신연결에서 설정된 검출기 타입에 따라

고전압 설정이 가능하다. 고전압은 설정치와 현재값이 분리되어 표현하여 실시간으로 현재

값을 확인할 수 있다. HV OFF버튼은 고전압 설정치의 변경 없이 고전압을 켜고 끌 수 있

는 기능이다.

MCA설정은 검출기 신호처리를 위하여 필요한 값들이다. channel은 스펙트럼의 총 채널

수를 설정하고, ULD와 LLD는 이 스펙트럼의 상/하한 채널을 설정한다. LLD와 ULD 범위

를 벗어난 스펙트럼은 제거된다. 증폭비 (coarse gain)와 미세증폭비 (fine gain)은 감마선

신호의 파고 높이를 증폭시키는 역할을 한다. 증폭비는 최대 32배까지 증폭되며, 미세증폭

비는 소수점 5자리까지 미세조정이 가능하다. 문턱값(threshold)은 신호처리 대상을 제외할

신호파고의 최하레벨이며, 노이즈 제거에 유용하게 사용된다. peaking time과 flat top은 검

출기 신호를 디지털신호로 변환할 때 사용되는 인자로, 사다리꼴 모양의 신호의 증가시간과

최고점 유지시간을 결정한다. 설정치를 기입한 후 적용을 하면 분석 장비에 전송되어 설정

치가 변경된다.

검출기마다 설정치가 상이하기 때문에 검출기별로 데이터를 관리할 필요가 있다. 표

3.2.4.1은 검출기별 MCA 기본 설정치이다. 검출기마다 고유한 특성에 의하여 고전압, 증폭

비 등의 적합한 설정치가 필요로 하다. 설정관리 파일에서는 위 설정정보를 저장하거나 불

러올 수 있어 검출기가 변경되더라도 기존의 설정파일을 불러 들여 손쉽게 설정치를 변경

할 수 있다. 분석 장비의 설정치는 NaI용 (NNS파일)과 HPGe용 (NHS파일)으로 분리하여

관리한다.
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분류 NaI(Tl) 분석장비 HPGe 분석장비

고전압 500 ∼ 1000 V 2000 ∼ 4000 V

채널수(channel) 1024 ch 8192 ch

하한채널(LLD) 10 ch 30 ch

상한채널(ULD) 1024 ch 8192 ch

증폭비(Coarse gain) × 2.0

미세증폭비(fine

gain)
0.8 ∼ 1.2

문턱값 (Threshold) 1

Peaking Time 2.8 μs 5.6 μs

Flat Top 0.6 μs 0.8 μs

표 3.2.4.1. 검출기에 따른 MCA의 기본 설정치

(5) 그래프 설정

MCA를 설정을 완료하면 MCA로부터 감마선 스펙트럼을 불러올 수 있다. 스펙트럼은 그

림 3.2.4.6과 같이 메인화면에 그래프로 표현된다. 그래프는 사용목적이나 가시성을 위하여

수정이 가능하도록 제작하였다. 화면 메뉴는 그림 3.2.4.10 (b)에 보이는 바와 같이 그래프에

관련된 메뉴들이 위치하고 있다. 메뉴는 그래프 색상, 스펙트럼 타입, 스케일을 선택할 수

있도록 하였다.

그래프 색상은 배경색상, 스펙트럼 색상, 관심영역 색상으로 구분하여 지정할 수 있다. 배

경색상은 감마선 스펙트럼 뒤에 위치한 배경에 대한 색상으로, 검정색을 기본으로 한다. 스

펙트럼 색상은 감마선 스펙트럼의 색상으로 노랑색을 기본으로 한다. 관심영역은 핵종분석

결과에서 방사능 오염된 피크를 나타내는 영역을 표시하는 것으로 빨강색으로 기본으로 설

정한다. 가시성을 향상시키기 위하여 위 메뉴에서 색상 변경이 가능하다. 그림 3.2.4.11은 기

본으로 설정된 감마선 스펙트럼의 예시이다.

스펙트럼 타입은 스펙트럼의 플롯(plot) 타입을 선택한다. 플롯 타입은 점선, 선, 채우기가

존재하며 기본은 점선으로 설정되어 있다.

스케일은 스펙트럼의 스케일 표현방법을 설정한다. 설정방법은 선형(linear)와 로그(log)가

존재하며, 선형은 비례적으로 증가하는 방식으로 일반적으로 가장 많이 쓰이는 그래프 표현

방식이며, 로그는 지수적으로 (exponentially) 증가하는 방식으로 스케일 차이가 큰 경우 주

로 사용된다. HPGe 스펙트럼은 선형으로, NaI(Tl) 스펙트럼은 로그로 표현하는 것이 유용

하다.

HPGe 감마선 스펙트럼은 8192 ch의 많은 데이터와 좋은 분해능에 의하여 각 피크의 모

양을 육안으로 확인하는 것은 한계가 있어 따로 피크를 확인할 수 있는 기능이 필요로 하
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다. 스케일 조정 기능은 감마선 스펙트럼의 x축 (channel 혹은 에너지) 범위를 조정하여 피

크를 중점적으로 확인할 수 있는 기능이다. 그래프 하단의 미니 그래프의 양단에는 스크롤

이 부착되어 있으며 위 스크롤을 원하는 위치로 이동하면 메인 그래프의 범위가 수정되어

표현된다. 그림 3.2.4.11은 HPGe 감마선 스펙트럼에서 Cs-137이 위치한 범위를 확대한 그래

프이다. 피크의 모양을 보다 상세히 확인할 수 있다.

그림 3.2.4.11. 감마 핵종분석프로그램 : 스케일 조정
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(6) 측정정보 입력

화면 구성을 완료한 후에는 측정에 관련된 사항을 설정하여야 한다. 그림 3.2.4.10 (c)에

관련 메뉴들이 나열되어 있다. 기준값과 시료 정보는 측정 및 분석에 필요한 정보를 제공한

다. 측정 시작, 측정 정지 및 지우기는 MCA의 스펙트럼 측정관련 명령어이다. 윈도우 메뉴

는 감마 핵종분석프로그램을 다수의 창이 제어가 되도록 제작하여 하나의 프로그램에 다수

의 검출기를 연결하거나 다수의 창을 동시에 연결할 수 있도록 한 기능이다.

기준값은 감마선 스펙트럼을 대상으로 분석할 대상핵종을 선택하는 항이다. 기준값을 클

릭하면 그림 3.2.4.12와 같이 기준값 설정창이 실행된다. 핵종 라이브러리를 선택하여 핵종

목록을 불러오면 좌측 하단의 핵종목록에 라이브러리 파일 내 핵종들을 나타낸다. 이 중 하

나의 핵종을 선태하면 우측 창에 핵종명, 반감기 등 핵종 관련 정보와 감마선 정보가 표시

된다. 이때 기준값을 설정하고 하단의 “추가”을 클릭하면 핵종분석 대상으로 선정된다. 선정

된 핵종은 메인화면의 관심핵종에 추가된다. 이 방법을 통하여 식품분석 대상핵종인 I-131,

Cs-134/137을 선택한다. 필요한 경우 Co-60과 같은 다른 핵종도 추가가 가능하다.

시료 정보는 계측에 사용된 핵종 정보를 입력하는 메뉴이다. 시료 정보를 클릭하면 그림

3.2.4.13과 같은 창이 실행된다. 창에는 시료ID(고유번호), 시료명, 분석자, 시료종류, 채취일,

시료량 및 비고를 입력한다. 입력이 완료되면 저장한다. 채취일과 시료량은 방사능 계산에

활용되므로 반드시 기입한다.

측정 메뉴는 MCA의 스펙트럼 동작과 관련된 메뉴이다. ‘측정시작’을 누를 경우 감마선

스펙트럼을 측정하며, 이를 분석프로그램에서는 1초마다 스펙트럼 그래프를 갱신한다. ‘측

정정지’를 누를 경우 계수 중이던 스펙트럼의 동작을 일시적으로 정지한다. 이 상태에서 ‘측

정시작’을 클릭할 경우 기존 스펙트럼에 누적하여 계수를 시작한다. ‘지우기’는 누적된 스펙

트럼을 모두 제거하는 기능을 한다. 만약 측정 중에 ‘지우기’가 입력된 경우에는 ‘지우기’를

입력한 시점부터 재측정을 시작한다. 반면, ‘측정정지’ 상태에서 ‘지우기’를 입력한 경우에는

스펙트럼 초기화가 된다. ‘측정시작’한 이후 설정 메뉴에서 설정한 측정시간이 경과하면 스

펙트럼 측정은 자동으로 정지되며, 이에 대한 스펙트럼이 프로그램에 표시된다.

윈도우 메뉴는 윈도우 전환과 윈도우 정렬 메뉴가 있으며, 윈도우 전환을 클릭할 경우 선

택된 파일 혹은 창이 프로그램 맨 앞에 표시된다. 이 중 하나를 선택하면 그 창이 화면에

활성화되며, 리본 메뉴는 이 창에 해당하는 값을 표시한다. 윈도우 정렬은 현재 켜져 있는

모든 창을 가로, 세로 방식으로 정렬하는 기능이다.
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그림 3.2.4.12. 감마 핵종분석프로그램 : 기준값 설정

그림 3.2.4.13. 감마 핵종분석프로그램 : 시료정보 입력
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(7) DB 연동

시료에 대한 정보는 수기로 입력하는 방법 외에도 식품분석 DB 프로그램에서 분석결과를

불러오는 방법이 있다. 이 방법을 위해서는 반드시 PC에 식품분석 DB 프로그램이 같이 설

치되어 있어야 한다. 그림 3.2.4.14는 식품분석 DB 프로그램을 감마 핵종분석프로그램에 연

결한 상태를 나타낸다. 시료 정보 창 하단에는 DB 위치를 지정이 가능하여 경로를 벗어난

DB를 선택할 수 있다.

시료 ID에 검색하고자 하는 시료의 고유번호를 입력한 후 ‘검색’을 클릭하면 그림 3.2.4.15

와 같이 해당 시료 ID의 검색어와 일부 혹은 전체가 일치하는 전처리 시료 목록이 표현된

다. 전처리 시료 정보는 시료 ID, 시료명, 분석자, 시료종류, 채취일, 시료량을 나타내며, 원

하는 시료를 선택하여 ‘적용’하면 시료 정보 창에 각 입력창에 해당하는 정보가 채워진다.

그림 3.2.4.14. 감마 핵종분석프로그램 : DB 연결.

그림 3.2.4.15. 감마 핵종분석프로그램 : DB 검색 및 정보 입력

(8) 검출기 교정

식품시료의 감마선 측정에 앞서 검출기 교정은 반드시 수행되어야 하는 과정 중 하나이
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다. 검출기 교정은 에너지 교정과 효율 교정이 존재한다. 에너지 교정은 파고의 높이(전압

신호)에 의하여 분류된 채널 데이터를 에너지로 환산하는 교정으로, 이를 통하여 감마선 스

펙트럼을 에너지별 카운트로 표현할 수 있다. 검출 효율은 입사된 감마선에 대한 검출기의

계수 능력을 나타내는 값으로, 저에너지에서 효율이 급격히 증가하다가 약 100 keV를 기준

으로 서서히 감소하는 효율 곡선을 갖는다. 모든 에너지에서 동일한 검출효율을 갖지 않기

때문에 검출 효율에 대한 교정을 수행해야만 올바른 방사능을 산출할 수 있다.

(가) 표준선원 인증

표준선원은 검출기 교정에 사용되는 선원으로, 이 선원들은 선원 내에 포함된 인공핵종

방사능 정보(인증서)를 제공하고 있다. 일반적으로 감마선 방사능 분석장비는 50 keV에서

3000 keV까지 넓은 범위에 대한 감마선을 감지하기 때문에 넓은 범위를 평가할 수 있는 핵

종들이 필요로 하다. 일반적으로 10여종의 방사성 핵종이 포함된 Mixed 선원을 이용하여

교정을 수행한다. 교정 선원에는 표준선원에 대한 방사능 정보를 입력한다. 이 정보들은 검

출 효율 산출에 사용된다.

그림 3.2.4.16. 감마 핵종분석프로그램 : 표준선원 인증정보 입력

(나) 에너지 교정

에너지 교정은 스펙트럼의 채널을 에너지로 변환하는 교정으로, 감마선 스펙트럼에 나타

난 피크들에 대한 에너지 정보가 반드시 필요로 하다. 감마 핵종분석프로그램에는 에너지

교정 방법이 자동과 수동 2가지 방법이 존재한다.

자동으로 에너지 교정하는 방법은 Cs-137선원에 대하여 측정한 데이터가 필요로 하다.

Cs-137 측정스펙트럼은 그림 3.2.4.17과 같이 662 keV에서 단일 피크를 포함한다. 이를 이

용하여 자동을 클릭하면 하나의 피크가 나타나는 지점을 기준으로 에너지 교정을 수행한다.

수동으로 에너지 교정하는 방법은 Mixed source 측정스펙트럼을 사용한다. 이 스펙트럼

에는 총 12 여 개의 감마선 피크가 포함되어 있다. 수동 에너지 교정을 클릭하면 에너지 교

정 창이 실행되며, 자동으로 교정선원 정보에 포함된 감마선 에너지를 목록화 한다. 그림

3.2.4.18과 같이 목록화 된 에너지에는 채널과 FWHM을 기입하여야 한다. 알고 있는 에너지
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의 피크중심을 그래프에서 선택한 후 에너지 교정창의 ‘추가’를 클릭하면 자동으로 채널과

FWHM을 계산한다. 모든 피크에 대하여 입력을 완료하면 채널 대비 에너지 곡선이 완성된

다. 에너지 교정은 2차 선형방정식으로 구해지며, 피크의 모양은 FWHM이 표현하며 에너지

교정 상단의 그래프 선택을 통하여 FWHM을 확인할 수 있다. 그림 3.2.4.19는 교정완료된

채널 대비 FWHM 그래프를 표현한다.

그림 3.2.4.17. 감마 핵종분석프로그램 : 에너지 자동교정(Cs-137 스펙트럼)
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그림 3.2.4.18. 감마 핵종분석프로그램 : 에너지 수동교정(Energy)

그림 3.2.4.19. 감마 핵종분석프로그램 : 에너지 수동교정(FWHM)
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(다) 효율 교정

에너지 교정이 완료되면 스펙트럼 데이터는 채널에 대한 결과가 에너지로 변환된다. 에너

지 교정이 완료된 스펙트럼은 효율 교정이 가능하다. 효율 교정을 실행하면 자동으로 스펙

트럼 내의 피크를 인식하여 효율을 산출한다. 그림 3.2.4.20은 검출 효율 교정을 수행한 결

과를 나타낸다. 하단의 테이블은 각 피크별 검출효율을 나타내며, 각 피크에 대한 측정오차

가 표현되며, 계산된 효율 결과를 바탕으로 효율 곡선이 산출된다. 효율 곡선은 다차항 로

그 선형함수로 구성되며, 검출 효율과 효율곡선 간의 차이는 계산오차로 표현된다. 계산 오

차와 효율곡선간의 차이가 작을수록 정확한 효율 곡선 산출이 가능하다. 정확한 효율 곡선

을 산출하기 위해서는 범위를 벗어나는 데이터는 제거하는 것이 좋다. 하단의 추가, 삭제

버튼은 효율 곡선 산출에 사용될 데이터를 선택할 때 사용된다. ‘삭제’ 선택시 데이터는 비

활성화 되며, 비활성화 된 피크에 한하여 ‘추가’ 선택하여 활성화 할 수 있다. 상단의 곡선차

수는 효율 곡선의 차수를 결정한다.

그림 3.2.4.20. 감마 핵종분석프로그램 : 검출효율 교정
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(라) 교정결과 관리

에너지 교정과 효율 교정이 완료되면 ‘교정곡선’을 통하여 적용된 에너지 교정곡선과 반칙

폭 곡선 그리고 효율 곡선을 확인할 수 있다. 그림 3.2.4.21은 교정 곡선으로 확인한 에너지

교정 곡선과 효율 곡선 결과이다. 그래프를 통하여 교정한 에너지 범위까지의 교정 결과를

표현하며, 각 교정 곡선에 대한 수식은 그래프 하단에 표현된다. 교정 곡선에 대한 정확도

는 R^2를 통하여 표현된다. R^2는 결정계수(coefficient of determination)로 두 데이터의 일

치성을 확인할 수 있다. 1에 가까울수록 곡선접합이 정상적으로 이루어진 것이다.

그림 3.2.4.21. 감마 핵종분석프로그램 : 교정곡선.

검출기 교정이 잘 이루어진 경우에는 교정 결과를 저장하여 이후의 측정 결과에 동일하

게 적용할 필요가 있다. 이를 위하여 감마 핵종분석프로그램에서는 교정 파일에 교정결과를

저장하고 불러올 수 있도록 제작하였다. 교정파일은 스펙트럼 측정이나 분석에서 이용할 수

있다.
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(9) 핵종분석

방사능 분석 장비로 측정한 감마선 스펙트럼에 대하여 관심핵종 포함 여부를 확인하고

방사능/MDA를 산출하여 표현한다. 그림 3.2.4.10 (e)는 핵종 분석에 관련된 메뉴이며, 이 메

뉴들은 스펙트럼을 교정하고, 스펙트럼에서 피크를 걸러 방사능을 산출한다.

(가) 스펙트럼 보정

측정된 스펙트럼은 에너지 교정과 효율 교정을 적용하여야 한다. 교정 파일을 선택한 후

교정 곡선를 통하여 교정 결과를 확인한다. 방사능 측정은 식품에 의한 방사능 스펙트럼으

로만 수행되어야만 한다. 그러나 시료를 위치하고 측정할 경우에는 주변에 위치한 자연 방

사성핵종들로부터 검출되는 신호로 인하여 영향을 받는다. 그러므로 주변에서 측정되는 스

펙트럼을 제거할 필요가 있다. 배경신호는 시료 없이 빈 시료통에 대하여 측정한다.

(나) 피크 검색

피크 검색은 감마선 스펙트럼 내에 포함되어 있는 감마선 전에너지 피크를 자동으로 검

색해 내는 기능이다. 이 분석프로그램에는 SAMPO80의 피크 검색 알고리즘이 일부 수정되

어 적용되었다. 민감도는 피크를 판별하는 수치이며, 수치가 높을수록 보다 정확한 피크가

감지되나, 감지되는 피크의 수는 감소된다. 본 프로그램에서는 민감도를 5로 기본 설정하였

다. 스펙트럼 범위는 피크를 찾을 범위를 설정하기 위한 것으로 HPGe의 경우 30 ∼ 8192

ch, NaI(Tl)의 경우 10 ∼ 1024 ch로 설정하는 것이 좋다.

(다) 피크 면적

피크 검색을 통해 얻어진 피크 목록들을 통하여 피크의 위치를 확인할 수 있다. 피크면적

에서는 피크 위치를 이용하여 감마선 피크의 총 면적을 산출한다. 피크 면적은 반칙폭을 기

준으로 좌·우 2배 영역을 면적으로 설정하나, 상황에 따라 수정이 가능하다.

감마선 피크는 일반적으로 백그라운드 영역 위에 나타나기 때문에 백그라운드 계수를 제

거하여야 한다. 백그라운드 계수는 백그라운드 모드와 범위에 의해 결정된다. 일반적으로

백그라운드 모드는 Step 모드를 사용한다.

피크 검색을 통해서 일부 불안정한 신호나 노이즈가 피크로 인지하여 검색될 가능성이

있다. 95% 신뢰평가를 이용하면 이런 불확실한 피크를 제거할 수 있다. 이 기능은 신뢰할

수 있는 최소한의 면적을 기준으로 피크를 제거한다.

가우시안 접합은 방사선의 피크 모양이 가우시안 모델을 따름을 전제로 한 피크 분석방

법으로 피크 범위 내의 총 계수가 아닌 가우시안 모델로 산출된 면적을 사용하는 방법이다.

불확실한 피크 계수에 사용시 보정된 분석 결과를 얻을 수 있다.

(라) 방사능 및 MDA

최종적으로 얻어진 피크는 관심핵종과 동일한지 판단하여야 한다. 판단 기준은 관심핵종

이 포함한 감마선의 에너지가 기준이 되며, 측정오차를 고려하여 에너지 오차를 설정하여야

한다. 일반적으로 분해능이 좋은 HPGe는 약 2 keV 이하로 설정하고 폭 넓은 피크를 갖는

NaI(Tl)는 10 ∼ 20 keV까지 설정한다. 만약 이 에너지 오차 내에 피크가 존재한다면 해당

핵종이 존재한다고 고려할 수 있다.
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관심핵종에 의한 감마선 피크라고 판단되면 이를 대상으로 방사능과 MDA를 산출한다.

방사능은 효율, 측정시간, 감쇄보정 등을 고려하여 산출된다. 반면, MDA는 피크로 인지되는

영역에 대한 계수율을 바탕으로 MDA를 산출한다. 만약 관심핵종이 검출되지 않는다면 감

마선 스펙트럼에서는 해당 핵종이 MDA 수준 이하로 존재할 수도 있다고 판단한다. 방사능

/MDA 내 분석 버튼을 실행한다.

(마) 분석결과

(라)절에서 수행한 분석이 완료되면 그림 3.2.4.22와 같이 메인화면에 분석결과를 표시한

다. 그래프에서는 검출된 피크를 관심영역 색상에 맞게 표현하며, 최종분석 결과는 메인화

면 우측 하단의 관심핵종 테이블에 방사능과 MDA 그리고 오염여부를 표시한다.

그림 3.2.4.22. 감마 핵종분석프로그램 : 분석완료 화면.

분석결과에 대한 상세 설명을 원하는 경우 분석결과를 클릭하여 확인이 가능하다. 그림

3.2.4.23은 감마선 스펙트럼에 대한 분석결과를 나타낸다. 분석 결과에는 측정정보, 검출기

정보, 교정정보, 피크 검색결과, 피크 면적, 방사능 및 MDA, 최종 결과를 나타낸다. 상단의

메뉴를 이용하여 해당 위치를 간편하게 이동이 가능하고 Text파일로 저장이 가능하다.

만약 분석결과를 보고서 양식에 맞추어 작성을 원할 경우에는 ‘보고서’ 메뉴를 클릭한다.

위 보고서는 엑셀 파일로 저장하거나 인쇄가 가능하다.
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그림 3.2.4.23. 감마 핵종분석프로그램 : 분석 결과
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(10) 도움말

도움말은 프로그램 사용법을 명시하고 있는 매뉴얼과 식품분석 관련자료 링크, 그리고 프

로그램 정보를 나타낸다. 매뉴얼은 자사에서 작성한 프로그램 매뉴얼을 제공한다. 클릭하면

PDF 파일 형식의 파일이 실행된다. 관련 자료에서는 식품분석 관련 정보 및 링크를 제공하

여 사용자가 필요한 정보를 손쉽게 얻을 수 있도록 하였다. 프로그램 정보에는 프로그램 개

발 정보와 회사 연락처가 기재되어 있다.

다. 성능 평가

(1) NaI(Tl) 검출기

제작한 프로그램이 정상적으로 동작하고 실제 분석결과가 상용 프로그램과 동등한 분석

력을 갖는지 확인하기 위하여 동일한 스펙트럼을 대상으로 분석을 수행하였다. 비교 대상으

로는 Canberra Genie2K를 채택하였다.

비교에 앞서 분석에 필요로 한 스펙트럼을 측정하였다. 그림 3.2.4.24는 스펙트럼 측정시

시스템 구축 사진이다. 검출기는 NaI(Tl)검출기, MCA는 Canberra Lynx를 사용하였다. 스

펙트럼은 교정용 선원, 배경신호 , 분석시료에 대하여 측정하였다. 그림 3.2.4.25와 그림

3.2.4.26은 NaI(Tl) 분석장비로부터 얻어진 분석시료의 스펙트럼 결과이다. 스펙트럼은

Canberra Genie2K와 개발한 감마 핵종분석프로그램을 대상으로 에너지 교정 및 효율 교정

을 수행하였으며, 교정결과를 분석시료의 스펙트럼에 적용하여 분석을 수행하였다.

분석대상은 분석시료에 포함되어 있는 Cs-137 (662 keV)핵종으로 하였으며, 이 핵종에

대한 방사능과 MDA를 산출하였다. 표 3.2.4.2는 두 프로그램으로부터 얻어진 NaI(Tl) 분석

장비의 분석결과이다. 두 시료의 방사능은 NEOGMA가 5.60 ± 4.97 Bq/kg, Genie2K가 5.87

± 1.40 Bq/kg으로 오차범위 내에서 일치한 결과를 나타냈다. 단, NEOGMA는 Genie2K보다

다소 높은 방사능의 불확도와 MDA를 나타냈다.

그림 3.2.4.24. 테스트 실험장비: Canberra Lynx with NaI(Tl) detector
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그림 3.2.4.25. NaI(Tl) 측정결과 : 상용프로그램 (Canberra Genie2K)

그림 3.2.4.26. NaI(Tl) 측정결과 : 개발 프로그램 (NeoGMA)

분류
Activity

[Bq/kg]

MDA

[Bq/kg]

NeoGMA 5.60 ± 4.97 7.63

Genie2K 5.87 ± 1.40 6.65

표 3.2.4.2. NaI(Tl) 분석결과 비교
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(2) HPGe 검출기

HPGe에 대한 스펙트럼 분석력을 확인하기 위하여 Canberra Genie2K와 비교평가를 수행

하였다. 분석에 필요로 한 스펙트럼은 HPGe로부터 측정하였다. 그림 3.2.4.27은 스펙트럼 측

정시 시스템 구축 사진이다. 검출기는 HPGe 검출기, MCA는 Canberra Lynx를 사용하였다.

스펙트럼은 교정용 선원, 배경신호 , 분석시료에 대하여 측정하였다. 그림 3.2.4.28과 그림

3.2.4.29는 HPGe 분석장비로부터 얻어진 분석시료의 스펙트럼 결과이다. 스펙트럼은

Canberra Genie2K와 개발한 감마 핵종분석프로그램을 대상으로 에너지 교정 및 효율 교정

을 수행하였으며, 교정결과를 분석시료의 스펙트럼에 적용하여 분석을 수행하였다.

분석대상은 분석시료에 포함되어 있는 Cs-137 (662 keV)핵종으로 하였으며, 이 핵종에

대한 방사능과 MDA를 산출하였다. 표 3.2.4.3은 두 프로그램으로부터 얻어진 HPGe 분석장

비의 분석결과이다. 두 시료의 방사능은 NEOGMA가 8.98 ± 0.97 Bq/kg, Genie2K가 9.03 ±

1.16 Bq/kg으로 오차범위 내에서 일치한 결과를 나타냈다.

그림 3.2.4.27. 테스트 실험장비: Canberra Lynx with HPGe crystal
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그림 3.2.4.28. HPGe 측정결과 : 상용프로그램 (Canberra Genie2K)

그림 3.2.4.29. HPGe 측정결과 : 개발 프로그램 (NEOGMA)

분류
Activity

[Bq/kg]

MDA

[Bq/kg]

NeoGMA 8.98 ± 0.97 3.36

Genie2K 9.03 ± 1.16 3.10

표 3.2.4.3. HPGe 분석결과 비교
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5. 성능평가 및 현장검증

가. 방사능 분석절차

(1) 분석장비 설치 및 연결

① 차폐체 및 이동형 카트에 검출기를 설치한다.

(a) NaI(Tl) 검출기 (b) HPGe 검출기

그림 3.2.5.1. 분석절차 : 검출기 설치

② 검출기 프리앰프 출력단과 MCA 입력단을 연결한다.

(a)NaI(Tl)

타입

(b)HPGe

타입

그림 3.2.5.2. 분석절차 : 검출기 연결

(2) 검출기 교정
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(가) 표준선원 측정

① NeoGMA 프로그램을 실행하고 분석장비를 연결한다.

② 분석장비 고전압을 인가한다.

③ 방사능 분석장비 내에 표준선원을 위치한다.

④ 스펙트럼을 10분간 측정한 후 Gain을 이용하여 Co-60 핵종의 두 번째 피크를

3638 ch(HPGe 기준)에 위치하도록 조정한다(NaI(Tl) : 455 ch).

⑤ 표준선원을 30분간 측정한 후 저장한다.

(나) 에너지 교정

ⓛ 표준선원 정보를 선택한 후 에너지 → 수동을 클릭한다.

② 1836 keV에 근접한 피크를 클릭하여 포인터가 위치하도록 한다.

③ 에너지 교정 창 하단 테이블의 1836 keV 항을 클릭한 후 “추가” 버튼을 클릭하면

채널과 FWHM이 자동 입력된다.

④ 번호 ② ∼ ③을 반복하여 테이블 내 모든 에너지 항을 입력한다.

⑤ “삭제”를 이용하여 부적절한 피크들을 제거한 후 “확인” 버튼을 클릭한다.

그림 3.2.5.3. 분석절차 : 에너지 교정

(다) 효율 교정

① 표준선원 스펙트럼을 불러온다.

② 교정선원에서 표준선원 파일을 선택한 후 효율 교정을 클릭한다.

③ 효율 교정에서 부적절한 피크는 “삭제” 버튼을 이용하여 제거한다.

④ 곡선 차수를 조절하여 계산오차를 최소화 한다.

⑤ “확인”을 클릭한다.

⑥ 교정결과 → “저장” 메뉴를 이용하여 교정 결과를 저장한다.
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그림 3.2.5.4. 분석절차 : 효율 교정

(3) 시료 측정

그림 3.2.5.5. 분석절차 : 시료측정

① 빈 마리넬리 비커와 식품 시료에 대한 스펙트럼을 30분간 측정한다.

② “측정 → 기준값” 메뉴에서 방사능 분석할 핵종을 추가한다.

③ “측정 → 시료 정보” 메뉴에서 식품시료의 무게 및 제작일시를 입력한다.
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그림 3.2.5.6. 분석절차 : 기준값 설정

그림 3.2.5.7. 분석절차 : 시료정보 입력

④ 교정 파일과 배경신호를 선택한 후 분석 조건을 설정한다.

⑤ “분석” 버튼을 눌러 스펙트럼에서 인공핵종 여부를 확인한다.
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그림 3.2.5.8. 분석절차 : 측정 스펙트럼

(4) 결과분석 및 보고서

① “분석 → 분석결과” 메뉴에서 핵종분석 세부 내용을 확인할 수 있다.

그림 3.2.5.9. 분석절차 : 분석 결과
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② “분석 → 보고서” 메뉴에서는 보고서 형식의 분석 결과를 확인할 수 있다.

그림 3.2.5.10. 분석절차 : 분석보고서

나. 기존 제품 비교 (Canberra Lynx MCA)

개발된 방사능 분석장비에 대한 성능을 평가하기 위하여 상용제품과의 비교평가를 수행

하였다. 상용제품은 Canberra사 Lynx 다중파고분석기와 Genie2K 핵종분석 프로그램을 이

용하였다. 본 실험에서는 NaI(Tl) 검출기와 HPGe 검출기를 대상으로 측정한 결과를 각각

비교하였다.

(1) NaI(Tl) 검출기

그림 3.2.5.11은 본 연구에서 개발한 NaI(Tl) 검출기형 방사능 분석 장비이며, 그림

3.2.5.12는 이 방사능 분석장비의 NeoMCA와 NeoGMA 프로그램을 상용제품인 Canberra

Lynx & Genie2K 프로그램으로 대체한 장비이다. 이 두 분석 장비를 이용하여 비교 평가를

수행하였다.
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그림 3.2.5.11. NeoMCA & NeoGMA 프로그램

그림 3.2.5.12. Canberra Lynx & Genie2K 프로그램

(가) 에너지 선형성

에너지 선형성 평가에서는 교정용 Mixed 선원을 이용하여 감마선 에너지에 따라 측정된

피크가 선형적인 관계를 갖는지 확인하였다. 선원은 총 30분씩 3회 측정하여 중심채널의 평

균과 표준편차를 산출하였다. 그림 3.2.5.13은 각 NaI(Tl) 분석 장비에서 측정된 에너지 선형

성 평가 결과이다. 에너지 교정곡선이 모두 1차 선형방정식으로 잘 표현되었다.
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그림 3.2.5.13. NaI(Tl) 성능비교 : 에너지 선형성

(나) 계수율

계수율은 입사된 방사선이 실제 검출기에서 측정되는 검출량으로서 검출기의 효율, 전자

부의 신호처리 그리고 분석프로그램의 면적 계산법 등에 의해 영향을 받는다. 이 실험에서

는 NaI(Tl) 검출기로부터 측정된 스펙트럼을 대상으로 감마선 피크별 순수면적을 산출하였

다. 측정은 30분간 총 3회씩 실시하였으며, 측정결과를 바탕으로 평균 및 표준편차를 그림

3.2.5.14에 표시하였다. 측정한 계수율은 200 keV이하의 저에너지 영역을 제외한 스펙트럼

전 영역에 대하여 거의 일치하였다. 다만 일부 차이나는 부분은 계속 수정 보안할 예정이

다.

Am-241
Cd-109

Co-57
Ce-139

Cr-51
Sn-113

Sr-85
Cs-137

Y-88
Co-60

Co-60
Y-88

0

50000

100000

150000

200000

103%
98%

99%

103%
103%105%103%108%

95%
92%

202%

 
 

 

Ne
tA

re
a 

(c
ou

nt
 p

er
 3

0m
in

s)

 Canberra
 Neosiskorea

126%= Neosis area / Canberra area

그림 3.2.5.14. NaI(Tl) 성능비교 : 계수율

(다) 반칙폭

반칙폭은 감마선의 분해능을 나타내는 주요한 척도이다. 반칙폭은 감마선 피크의 중간높

이에 대한 폭을 나타내며, 반칙폭이 작을수록 스펙트럼 내에서 피크가 명확하게 나타난다.

이 실험에서는 NaI(Tl) 검출기로부터 측정된 스펙트럼을 대상으로 감마선 피크별 반칙폭을

산출하였다. 측정은 30분간 총 3회씩 실시하였으며, 측정결과를 바탕으로 평균 및 표준편차

를 그림 3.2.5.15에 표시하였다. 개발된 분석 장비는 상용 장비에 비해 약 2∼3 keV 정도 높

은 반칙폭이 산출되었으나, 이 반칙폭의 범위에서는 핵종판별에 큰 영향을 주지 않는 것이

확인되었다. 다만 이 부분도 전자회로 부분과 소프트웨어 부분을 보완중에 있다.
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그림 3.2.5.15. NaI(Tl) 성능비교 : 반칙폭

(라) 방사능 분석결과

개발된 방사능 분석장비와 상용제품을 대상으로 Cs-137 선원이 함유되어 있는 RM 시료

를 동일한 조건에서 분석하였다. 그림 3.2.5.16은 각 분석 장비에서 측정된 RM 시료에 대한

스펙트럼으로 모두에서 Cs-137 피크가 확인되었다. 상용제품에서는 Cs-137의 방사능이

64.85 ± 2.05 Bq/kg, 개발 장비에서는 66.62 ± 3.75 Bq/kg이 산출되어 오차범위 내에서 서

로 일치하였다.

(a) Canberra

(b) Neosiskorea

그림 3.2.5.16. NaI(Tl) 성능비교 : Rice High시료의 스펙트럼

(2) HPGe 검출기

그림 3.2.5.17은 본 연구에서 개발한 HPGe 검출기형 방사능 분석 장비이며, 그림 3.2.5.18

은 이 방사능 분석장비의 NeoMCA와 NeoGMA 프로그램을 상용제품인 Canberra Lynx &

Genie2K 프로그램으로 대체한 장비이다. 이 두 분석 장비를 이용하여 비교 평가를 수행하

였다.
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그림 3.2.5.17. NeoMCA & NeoGMA 프로그램

그림 3.2.5.18. Canberra Lynx & Genie2K 프로그램

(가) 에너지 선형성

에너지 선형성 평가에서는 교정용 Mixed 선원을 이용하여 감마선 에너지에 따라 측정된

피크가 선형적인 관계를 갖는지 확인하였다. 선원은 총 30분씩 3회 측정하여 중심채널의 평

균과 표준편차를 산출하였다. 그림 3.2.5.19는 각 HPGe 분석 장비에서 측정된 에너지 선형

성 평가 결과이다. 총 12개의 감마선 피크에 대한 피크 중심은 에너지가 증가됨에 따라 모

두 선형적으로 증가됨이 확인되었다. 에너지 교정곡선도 모두 1차 방정식으로 잘 표현되었

다.
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그림 3.2.5.19. HPGe 성능비교 : 에너지 선형성

(나) 계수율

계수율은 입사된 방사선이 실제 검출기에서 측정되는 검출량으로서 검출기의 효율, 전자

부의 신호처리 그리고 분석프로그램의 면적 계산법 등에 의해 영향을 받는다. 이 실험에서

는 HPGe 검출기로부터 측정된 스펙트럼을 대상으로 감마선 피크별 순수면적을 산출하였다.

측정은 30분간 총 3회씩 실시하였으며, 측정결과를 바탕으로 평균 및 표준편차를 그림

3.2.5.20에 표시하였다. 측정한 계수율은 스펙트럼 전 영역에 대하여 ±5% 범위 내에서 모두

동일한 계수율을 나타냈다.
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그림 3.2.5.20. HPGe 성능비교 : 계수율.

(다) 반칙폭

이 실험에서는 HPGe 검출기로부터 측정된 스펙트럼을 대상으로 감마선 피크별 반칙폭을

산출하였다. 측정은 30분간 총 3회씩 실시하였으며, 측정결과를 바탕으로 평균 및 표준편차

를 그림 3.2.5.21에 표시하였다. 개발된 분석장비는 상용 장비에 비해 약 1 keV 정도 높게

반칙폭이 산출되었으나, 이 반칙폭의 범위에서는 핵종판별에 큰 영향을 주지 않는 것이 확

인되었다. 다만 NaI 검출기와 같은 동일 회로를 사용했기에 약간 높은데, 현재 전자회로 부

분과 소프트웨어 부분을 보완중에 있다.
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그림 3.2.5.21. HPGe 성능비교 : 반칙폭

(라) 분석결과

개발한 방사능 측정 장비와 상용제품을 대상으로 Cs-137 선원이 함유되어 있는 RM 시료

를 동일한 조건에서 분석하였다. 그림 3.2.5.22는 각 분석 장비에서 측정된 RM 시료의 스펙

트럼으로 모두에서 Cs-137 피크가 확인되었다. 상용제품에서는 Cs-137의 방사능이 62.35 ±

2.50 Bq/kg, 개발 장비에서는 60.98 ± 3.76 Bq/kg이 산출되어 오차범위 내에서 서로 일치하

였다.

(a) Canberra

(b) Neosiskorea

그림 3.2.5.22. HPGe 성능비교 : Rice High시료의 스펙트럼

검출기 검출시스템
I-131

(Bq/kg)

Cs-134

(Bq/kg)

Cs-137

(Bq/kg)

NaI(Tl)

Canberra x x 64.85 ± 2.05

Neosiskorea x x 66.62 ± 3.75

HPGe

Canberra x x 62.35 ± 2.50

Neosiskorea x x 60.98 ± 3.76

표 3.2.5.1. 성능비교 : Rice High 시료의 분석결과
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다. RM 시료 분석

(1) 2차년도 RM 시료 분석

한국표준과학연구원에서 제작된 2차년도 RM시료를 이용하여 함유된 인공핵종에 대한 분

석을 수행하였다. RM시료는 그림 3.2.5.23에서 보는 바와 같이 분유, 밀가루, 굴을 대상으로

제작되었다. 특히, 굴의 경우 해산물이기 때문에 부패되지 않도록 주의하며 측정하였다. 핵

종분석은 긴급 상황이 아닌 정밀분석에 중점을 두어 실시하였다. 측정시간은 10,000초와

30,000초로 설정하여 감마핵종 분석의 불확도를 최소화 하였다.

그림 3.2.5.24는 NaI(Tl) 분석장비로부터 측정된 RM 시료의 스펙트럼들이다. 스펙트럼을

통하여 Am-241, Cs-134, Cs-137 핵종이 관찰되었다. 이중 Cs-137에 대하여 방사능핵종 분

석을 수행하였다. 분석결과, 분유와 밀가루의 low 시료에서는 Cs-137의 비방사능이 각각

38.3 ± 1.7 Bq/kg, 32.8 ± 1.4 Bq/kg으로 나타났으며, 굴 시료의 경우에는 이보다 낮은 24.0

± 1.0 Bq/kg으로 나타났다. 반면, high 시료에서는 분유, 밀가루 그리고 굴에 대한 비방사능

은 각각 147.3 ± 5.9 Bq/kg, 135.2 ± 5.5 Bq/kg, 82.3 ± 3.4 Bq/kg으로 계산되었다. 이는

low 시료보다 약 3 ∼4배 높은 값이었다. 분석 결과는 표 3.2.5.2에 정리하였다.

동일한 RM시료를 HPGe 분석 장비를 이용하여 핵종분석을 수행하였다. 측정시간은

NaI(Tl)과 동일한 10,000초, 30,000초로 설정하여 각 분석결과를 서로 비교·평가하였다.

HPGe 검출기는 높은 분해능으로 인해 NaI(Tl) 검출기에서는 중첩되어 나타나던 피크들이

분리되어 나타난다. 이로 인해 보다 정확한 핵종분석이 가능하다. 따라서 Cs-137뿐만 아니

라 Am-241, Cs-134에 대하여 핵종분석을 수행하였다. 그림 3.2.5.25는 HPGe 분석 장비로부

터 측정된 RM시료의 감마 스펙트럼들이며, 이 스펙트럼 모두에서 해당 핵종의 감마선 피크

들이 관찰되었다. 각 핵종에 대한 비방사능을 산출한 결과는 표 3.2.5.2에 정리하였다. 정확

한 교차분석 결과는 제 3협동에서 수행한 숙련도 시험에서 그 내용을 요약하였다.
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(a) 분유 (low) (b) 분유 (high)

(c) 밀가루 (low) (d) 밀가루 (high)

(e) 굴 (low) (f) 굴 (high)

그림 3.2.5.23. 2차년도 RM시료 : 분유, 밀가루, 굴
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(a) 분유

low

(b) 분유

high

(c) 밀가루

low

(d) 밀가루

high

(e) 굴

low

(f) 굴

high

그림 3.2.5.24. 2차년도 RM측정결과 : NaI(Tl) 검출기



228

(a) 분유

low

(b) 분유

high

(c) 밀가루

low

(d) 밀가루

high

(e) 굴

low

(f) 굴

high

그림 3.2.5.25. 2차년도 RM측정결과: HPGe 검출기
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시료명
NaI(Tl) HPGe

Cs-137 Am-241 Cs-134 Cs-137

(a) 분유

low
38.35 ± 1.65 58.30 ± 2.80 33.42 ± 0.57 38.96 ± 1.17

(b) 분유

high
147.26 ± 5.95 237.80 ± 10.89 130.25 ± 2.06 152.45 ± 4.44

(c) 밀가루

low
32.81 ± 1.39 54.52 ± 2.61 30.04 ± 0.51 35.29 ± 1.06

(d) 밀가루

high
135.15 ± 5.49 227.98 ± 10.39 120.51 ± 1.90 141.12 ± 4.09

(e) 굴

low
24.05 ± 1.04 37.09 ± 1.92 23.91 ± 0.39 27.80 ± 0.82

(f) 굴

high
82.28 ± 3.36 130.64 ± 6.00 74.43 ± 1.18 88.69 ± 2.58

표 3.2.5.2. 2차년도 RM 분석결과(단위 : Bq/kg)

(3) 3차년도 RM 시료 분석

한국표준과학연구원에서 제작된 3차년도 RM시료를 이용하여 함유된 인공핵종에 대한 분

석을 수행하였다. RM시료는 그림 3.2.5.26에서 보는바와 같이 계란, 해초, 옥수수를 대상으

로 제작되었다. 위 시료들은 모두 생체이기 때문에 부패되지 않도록 주의하며 측정하였다.

3차년도 RM분석에서는 HPGe와 NaI(Tl) 측정 장비가 모두 개발 완료되었기 때문에 핵종분

석은 신속분석에 중점을 두어 실시하였다. 측정시간은 NaI(Tl) 측정 장비 20분, HPGe 측정

장비 30분으로 설정하여 단시간 내에 분석을 수행하였다.

그림 3.2.5.27은 NaI(Tl) 측정 장비로부터 측정된 RM 시료의 스펙트럼들이다. 스펙트럼을

통하여 Am-241, Cs-134, Cs-137 핵종이 관찰되었다. 이중 Cs-137에 대하여 방사능물질의

정량분석을 수행하였다. 분석결과, 계란과 해초, 옥수수의 low 시료에서는 Cs-137의 비방사

능이 각각 36.29 ± 3.23 Bq/kg, 36.45 ± 3.08 Bq/kg, 39.52 ± 2.88 Bq/kg으로 나타났다. 반

면, high 시료에서는 계란, 해초 그리고 옥수수에 대한 비방사능은 각각 133.20 ± 7.73

Bq/kg, 125.91 ± 7.27 Bq/kg, 139.10 ± 8.09 Bq/kg으로 계산되었다. 이는 low 시료보다 약 3

∼4배 높은 값이었다.

동일한 RM시료를 HPGe에 대하여 감마 핵종분석을 수행하였다. HPGe 검출기는 높은 분

해능으로 인해 NaI(Tl) 검출기에서는 중첩되어 나타나던 피크들이 분리되어 나타난다. 이로

인해 보다 정확한 핵종분석이 가능하다. HPGe는 Cs-137뿐만 아니라 Am-241, Cs-134에 대

하여 핵종분석을 수행하였다. 그림 3.2.5.28은 HPGe 측정 장비로부터 측정된 RM시료의 감

마 스펙트럼들이며, 이 스펙트럼 모두에서 해당 핵종의 감마선 피크들이 관찰되었다. 각 핵

종에 대한 비방사능을 산출한 결과는 표 3.2.5.3에 정리하였다. 정확한 교차분석 결과는 제

3협동에서 수행한 숙련도 시험에서 그 내용을 요약하였다.
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(a) 계란 (low) (b) 계란 (high)

(c) 해초 (low) (d) 해초 (high)

(e) 옥수수 (low) (f) 옥수수 (high)

그림 3.2.5.26. 3차년도 RM시료 : 계란, 해초, 옥수수



231

(a) 계란

low

(b) 계란

high

(c) 해초

low

(d) 해초

high

(e) 옥수수

low

(f) 옥수수

high

그림 3.2.5.27. 3차년도 RM측정결과 : NaI(Tl) 검출기
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(a) 계란

low

(b) 계란

high

(c) 해초

low

(d) 해초

high

(e) 옥수수

low

(f) 옥수수

high

그림 3.2.5.28. 3차년도 RM측정결과: HPGe 검출기
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시료명
NaI(Tl) HPGe

Cs-137 Am-241 Cs-134 Cs-137

(a) 계란

low
49.71 ± 3.23 49.10 ± 2.33 33.43 ± 3.47 46.70 ± 2.88

(b) 계란

high
129.70 ± 11.26 147.00 ± 5.60 117.10 ± 9.23 154.90 ± 7.95

(c) 해초

low
37.38 ± 3.26 61.65 ± 2.81 38.64 ± 3.72 41.51 ± 2.62

(d) 해초

high
133.30 ± 7.72 182.60 ± 6.56 94.55 ± 7.63 120.80 ± 6.32

(e) 옥수수

low
40.79 ± 4.45 54.76 ± 2.80 30.75 ± 3.13 55.41 ± 3.26

(f) 옥수수

high
146.90 ± 10.42 169.00 ± 6.17 119.20 ± 9.39 147.00 ± 7.55

표 3.2.5.3. 3차년도 RM 분석결과(단위 : Bq/kg)

라. 현장검증

개발이 완료된 이동형 방사능 분석장비를 이용하여 외부기관에 방문하여 방사능 오염평

가를 수행하였다. 현장검증은 국립농산물품질관리원 경북지원과 삼성웰스토리 식품연구소 2

곳에서 수행하였다.

(1) 국립농산물품질관리원

첫 번째 현장평가는 국립농산물품질관리원 경북지원에서 수행하였다. 농산물품질관리원에

서 준비한 시료는 그림 3.2.5.29와 같이 대파, 호박 시료였다. 그림 3.2.5.30에서 보는 바와 같

이 HPGe형 이동형 방사능 분석 장비와 NaI(Tl)형 가방형 방사능 분석 장비를 이용하여 측

정하였다.

그림 3.2.5.29. 농산물품질관리원 현장평가용 시료 : 대파, 호박
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그림 3.2.5.30. 농산물품질관리원 현장 측정 모습

각 시료는 신속분석법 기준의 측정시간을 적용하여 HPGe 30분, NaI(Tl) 20분씩 측정하였

다. 그림 3.2.5.31은 HPGe 방사능 측정 장비로부터 얻은 대파 시료에 대한 감마선 스펙트럼

이며, 그림 3.2.5.32는 NaI(Tl) 방사능 측정 장비로부터 얻은 호박 시료에 대한 감마선 스펙

트럼이다.

측정결과에서는 관심핵종을 I-131 및 Cs-134, Cs-137으로 설정하고 방사능 오염여부를

확인하였다. 분석결과에서는 두 시료 모두 방사능 오염이 확인되지 않았으며, MDA만이 산

출되었다. 표 3.2.5.4에 산출된 MDA를 정리하였다.

그림 3.2.5.31. 농산물품질관리원 현장측정 : HPGe 측정결과(대파)
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그림 3.2.5.32. 농산물품질관리원 현장측정 : NaI(Tl) 측정결과(호박)

시료
I-131

(Bq/kg)

Cs-134

(Bq/kg)

Cs-137

(Bq/kg)

대파

[HPGe, 0.88kg]
< 2.45 < 3.50 < 3.43

호박

[NaI(Tl), 0.88kg]
< 10.89 < 9.44 < 10.92

※ < : 감마핵종 미검출 (MDA 표시)

표 3.2.5.4. 농산물품질관리원 현장측정 : 분석결과

(2) 삼성웰스토리

두 번째 현장평가는 삼성웰스토리 식품연구소에서 수행하였다. 삼성웰스토리에서 준비한

시료는 그림 3.2.5.33과 같이 고추, 오이 시료였다. 그림 3.2.5.34에서 보는 바와 같이 HPGe

형 이동형 방사능 분석 장비와 NaI(Tl)형 가방형 방사능 분석 장비를 이용하여 측정하였다.

본 현장실험에서는 농산물품질관리원과 달리 외부전원 연결 없이 배터리만을 사용하여 장

비를 구동하였다.
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그림 3.2.5.33. 삼성웰스토리 현장평가용 시료: 고추, 오이

그림 3.2.5.34. 삼성웰스토리 현장 측정

각 시료는 신속분석법 기준의 측정시간을 적용하여 HPGe 30분, NaI(Tl) 20분씩 측정하였

다. 그림 3.2.5.35는 HPGe 방사능 분석 장비로부터 얻은 고추 시료에 대한 감마선 스펙트럼

이며, 그림 3.2.5.36은 NaI(Tl) 방사능 분석 장비로부터 얻은 오이 시료에 대한 감마선 스펙

트럼이다.

측정결과에서는 관심핵종을 I-131 및 Cs-134, Cs-137으로 설정하고 방사능 오염여부를

확인하였다. 분석결과에서는 두 시료 모두 방사능 오염이 확인되지 않았으며, MDA만이 산

출되었다. 표 3.2.5.5에 산출된 MDA를 정리하였다.
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그림 3.2.5.35. 삼성웰스토리 현장측정 : HPGe(고추) 측정결과

그림 3.2.5.36. 삼성웰스토리 현장측정 : HPGe(오이) 측정결과

시료
I-131

(Bq/kg)

Cs-134

(Bq/kg)

Cs-137

(Bq/kg)
고추

[HPGe, 0.20kg]
< 13.94 < 16.55 < 18.56

오이

[NaI(Tl), 0.20kg]
< 36.70 < 37.55 < 44.70

※ < : 감마핵종 미검출 (MDA 표시)

표 3.2.5.5. 삼성웰스토리 현장측정 : 분석결과
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제3절 농·축·수산물에 대한 표준인증물질 개발

1. 농·축·수산물 기준시료 제작

가. 1차년도

(1) 기준물질 선정

농·축·수산물 대표 품목으로 시중에서 유통되는 농산물(쌀), 수산물(대구), 축산물(소고기)를

선정하여 시료를 구매하였다. 쌀은 우리나라 국민의 주식으로 그 중요성이 인정되어 선정하였

다. 수산물의 대표어종인 대구는 최근 후쿠시마원전 사고이후 식약처에서 수입되는 어종에 대

한 식품방사능측정결과 가장 높은 97 Bq/kg의 Cs-137이 검출된 바가 있어 동일 어종을 선택

하여 기준시료를 준비하였다. 소고기 또한 국내 소비되는 대표적 식육으로 한우 이외 호주나

미국으로부터 수입되어 유통되고 있기에 축산물의 기준시료 제조를 위하여 선정하였다.

그림 3.3.1.1. 기준시료를 위하여 구매한 농산물(쌀), 수산물(대구), 축산물(소고기)

(2) 시료의 전처리

구매한 쌀 시료는 실온에서 보관하였으며, 대구와 소고기시료는 분석 전까지 냉장고에 보관하

였다. 쌀시료는 별도의 전처리 없이 기준시료제조에 바로 이용되었으며, 대구와 소고기는 시중

에서 분쇄기를 구매하여 시료를 분쇄한 후 사용하였다.

(3) 방사성 선원 준비

본 과제를 위하여 시중에서 구매한 농산물(쌀), 수산물(대구), 축산물(소고기)내 Cs-137과

Am-241을 포함한 인공방사성핵종에 대한 측정결과 농도가 감출하한치 (1 Bq/kg)이하임을 확

인하였다 (시료량은 1 kg을 사용하였으며, 측정시간은 30분이 주어졌다). 기준 시료내 측정하

고자 하는 목표핵종은 저에너지에서 Am-241(59.54 keV), 중에너지 부근에서 Cs-137(661.66

keV), 고에너지에서 k-40(1460.82 keV)을 각각 설정하였다. Cs-137과 Am-241은 한국표준과

학연구원에서 인증된 선원을 사용하였으며 K-40은 시료자체에 함유되어 있는 K-40의 방사능

농도를 인증하여 사용하였다. 본 과제를 위하여 사용된 측정용 방사성 핵종은 한국표준과학연

구원에서 방사능 인증표준물질을 제작하는 감마방출핵종을 혼합한 혼합선원을 사용하였으며,

K-40의 경우 KCl 정밀 정량하여 용액에 녹여 사용하였다. 용액의 화학적 구성은 0.5 N HCl이

다. 방사능 농도는 농도 기준 저준위 (1-20 Bq/kg)와 고준위 (50-150 Bq/kg) 두 종류로 준비
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하였다.

그림 3.3.1.2. Cs-137과 Am-241 선원 준비

그림 3.3.1.3. Cs-137과 Am-241 선원의 희석과 분배작업

제작된 인증표준물질은 감마선분광분석방법을 사용하여 방사성핵종분석 및 방사능을 산출하였다.

측정에 사용된 검출장치는 EG&G ORTEC사에서 제작된 상대효율이 90 %인 Ge 고순도반도체 검

출장치이며 측정장비의 교정과 에너지효율측정을 위하여 한국표준과학연구원에서 개발한 혼합감마

인증표준물질(Agar form)을 사용하였다.
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그림 3.3.1.4. 혼합감마인증표준물질를 이용한

감마분광분석기 에너지교정과 효율측정

(4) 기준시료 제조

농산물(쌀), 수산물(대구), 축산물(소고기)에 대한 기분시료를 제조하기 위하여 감마분광분석기

에 사용되는 1 L의 마르넬리비이커를 준비하였다. 각각 준비된 시료를 전체 용기부피의 30%

가량 충진하였다. Spiking용으로 준비된 선원 Cs-137과 Am-241은 방사능농도가 높아 극히

소량을 (100 ㎕ 이하) 시료에 투여해야하기에 전체시료 (약 1 kg)와 균질하게 혼합되지 않을

가능성이 높았다. 이에 대한 보완으로 아세톤 50 ml에 선원을 녹여 희석하여 시료에 골고루

분배하였다.

그림 3.3.1.5. 아세톤에 희석된 선원을 시료에 첨가

(5) 기준시료 균질화

시료내 감마핵종의 방사능은 측정값은 선원-검출기의 거리에 따른 계수효율에 따라 크게 차

이가 나기 때문에 시료내 방사능이 균질하게 분포되어야 이로 인한 불확도를 최소화할 수 있
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다. 본 과제에서는 이를 위하여 시료균질기를 본 연구의 용도에 맞게 설계, 제작하여 사용하였

다. 균질기는 마르넬리 비이커를 균질기 몸체에 고착시킨 후 시계방향과 반시계방향으로 회전

할 수 있도록 하여 시료의 수평혼합을 유도하였으며, 시료내부를 혼합하기 위하여 별도의 장치

를 이용하여 시료의 수직방향으로의 혼합도 유도하였다. 시료의 혼합정도를 파악하기 위하여

일반쌀과 검은쌀(흑미)을 이 장비를 이용하여 혼합시킨 결과 시료가 골고루 혼합됨을 파악할

수 있었다.

그림 3.3.1.6. 시료혼합과 균질화를 위하여 제작된 균질기

그림 3.3.1.7. 시료에 선원첨가 후 시료균질기를 이용하여 대구와 소고기시료를

혼합

충분히 혼합된 시료의 높이를 감마분광분석기에 사용된 기존의 인증표준물질의 높이를 맞추

기 위하여 이 과제를 위하여 특별히 제작된 시료압축기를 사용하여 시료의 높이를 보정하였다.
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그림 3.3.1.8. 시료 압축기를 사용한 시료높이 보정

그림 3.3.1.9. 감마분광분석기

최종적으로 완성된 기준시료의 기준값과 불확도를 결정하기 위하여 감마분광분석기를 사용하

여 Cs-137과 Am-241, K-40의 방사능을 측정하였다. 측정 후, 숙련도시험을 위한 장기보관 필

요성으로 기준시료를 실리콘과 파라필름으로 최대한 밀봉 후 ㈜그린피아에 의뢰하여 기준시

료에 방사선조사(10 kGy) 처리를 하여 멸균하였다.
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나. 2차년도

(1) 기준물질 선정

농·축·수산물 대표 품목으로 시중에서 유통되는 농산물(밀가루), 수산물(굴), 축산물(분유)를

선정하여 시료를 구매하였다. 밀가루는 우리나라 국민의 주식으로 그 중요성이 인정되어 선정

하였다. 수산물은 고착성 수산물로 국민들의 식생에 광범위하게 소비되는 굴을 선택하여 기준

시료를 준비하였다. 분유는 방사성동위원소 피폭에 민감한 영향을 받는 유아들의 주식이며, 최

근 국내에서 유통되는 수입분유에서 미량의 Cs-137이 검출되어 국민적 관심과 더불어 염려를

불러일으켰던 품목이기에 축산물의 기준시료제조를 위하여 선정하였다.

그림 3.3.1.10. 기준시료를 위하여 구매한 농산물(밀가루), 축산물(분유), 수산물(굴)

(2) 시료의 전처리

구매한 밀가루와 분유 시료는 실온에서 보관하였고 굴은 냉장보관 후 별도의 전처리 없이 기

준시료제조에 바로 이용되었다.

(3) 방사성 선원 준비

본 과제를 위하여 시중에서 구매한 농산물(밀가루), 수산물(굴), 축산물(분유)내 Cs-137과

Am-241을 포함한 인공방사성핵종에 대한 측정결과 농도가 감출하한치 (1 Bq/kg)이하임을 확

인하였다 (시료량은 600-1200 g을 사용하였으며, 측정시간은 30분이 주어졌다). 기준시료내 측

정하고자 하는 목표핵종은 저에너지에서 Am-241(59.54 keV), 중에너지 부근에서 Cs-137

(661.66 keV), 고에너지에서 K-40(1460.82 keV)을 각각 설정하였다. Cs-137과 Am-241은 한

국표준과학연구원에서 인증된 선원을 사용하였으며 K-40은 시료자체에 함유되어 있는 K-40의

방사능농도를 인증하여 사용하였다. 본 과제를 위하여 사용된 측정용 방사성 핵종은 한국표준

과학연구원에서 방사능 인증표준물질을 제작하는 감마방출핵종을 혼합한 혼합선원을 사용하였

으며, K-40의 경우 KCl 정밀 정량하여 용액에 녹여 사용하였다. 용액의 화학적 구성은 0.5 N

HCl이다. 방사능 농도는 농도 기준 저준위 (1-20 Bq/kg)와 고준위 (50-150 Bq/kg) 두 종류로

준비하였다.

제작된 인증표준물질은 감마선분광분석방법을 사용하여 방사성핵종분석 및 방사능을 산출하였다.

측정에 사용된 검출장치는 EG&G ORTEC사에서 제작된 상대효율이 90 %인 Ge 고순도반도체 검

출장치이며 측정장비의 교정과 에너지효율측정을 위하여 한국표준과학연구원에서 개발한 혼합감마

인증표준물질(Agar form)을 사용하였다.

(4) 기준시료 제조
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농산물(밀가루), 수산물(굴), 축산물(분유)에 대한 기분시료를 제조하기 위하여 감마분광분석기

에 사용되는 1 L의 마르넬리비이커를 준비하였다. 각각 준비된 시료를 전체 용기부피의 30%

가량 충진하였다. Spiking용으로 준비된 선원 Cs-137과 Am-241은 방사능농도가 높아 극히

소량을 (100 ㎕ 이하) 시료에 투여해야하기에 전체시료 (약 1 kg)와 균질하게 혼합되지 않을

가능성이 높았다. 이에 대한 보완으로 아세톤 50 ml에 선원을 녹여 희석하여 시료에 골고루

분배하였다.

(5) 기준시료 균질화

시료내 감마핵종의 방사능은 측정값은 선원-검출기의 거리에 따른 계수효율에 따라 크게 차

이가 나기 때문에 시료내 방사능이 균질하게 분포되어야 이로 인한 불확도를 최소화할 수 있

다. 본 과제에서는 이를 위하여 시료균질기를 본 연구의 용도에 맞게 설계, 제작하여 사용하였

다. 균질기는 마르넬리 비이커를 균질기 몸체에 고착시킨 후 시계방향과 반시계방향으로 회전

할 수 있도록 하여 시료의 수평혼합을 유도하였으며, 시료내부를 혼합하기 위하여 별도의 장치

를 이용하여 시료의 수직방향으로의 혼합도 유도하였다. 시료의 혼합정도를 파악하기 위하여

일반밀가루과 검은밀가루(흑미)을 이 장비를 이용하여 혼합시킨 결과 시료가 골고루 혼합됨을

파악할 수 있었다.

그림 3.3.1.11. 시료혼합과 균질화를 위하여 제작된 균질기

충분히 혼합된 시료의 높이를 감마분광분석기에 사용된 기존의 인증표준물질의 높이를 맞추

기 위하여 이 과제를 위하여 특별히 제작된 시료압축기를 사용하여 시료의 높이를 보정하였다.

그림 3.3.1.12. 감마분광분석기
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최종적으로 완성된 기준시료의 기준값과 불확도를 결정하기 위하여 감마분광분석기를 사용하

여 Cs-137과 Am-241, K-40의 방사능을 측정하였다. 측정 후, 숙련도시험을 위한 장기보관

필요성으로 기준시료를 실리콘과 파라필름으로 최대한 밀봉 후 ㈜그린피아에 의뢰하여 기준

시료에 방사선조사(10 kGy) 처리를 하여 멸균하였다.

그림 3.3.1.13. 최종 개발된 식품 기준물질

다. 3차년도

(1) 기준물질 선정

농·축·수산물 대표 품목으로 시중에서 유통되는 농산물(옥수수), 수산물(해초), 축산물(계란)

를 선정하여 시료를 구매하였다. 옥수수는 우리나라 국민의 주식으로 그 중요성이 인정되어 선

정하였다. 수산물은 고착성 수산물로 국민들의 식생에 광범위하게 소비되는 해초을 선택하여

기준시료를 준비하였다. 계란은 방사성동위원소 피폭에 민감한 영향을 받는 유아들의 주식이

며, 최근 국내에서 유통되는 수입 계란에서 미량의 Cs-137이 검출되어 국민적 관심과 더불어

염려를 불러일으켰던 품목이기에 축산물의 기준시료제조를 위하여 선정하였다.
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그림 3.3.1.14. 농·축·수산물 기준시료 개

발을 위한 원료물질

(2) 시료의 전처리

구매한 옥수수와 계란 시료는 실온에서 보관하였고 해초는 냉장보관 후 별도의 전처리 없이

기준시료제조에 바로 이용되었다.

(3) 방사성 선원 준비

본 과제를 위하여 시중에서 구매한 농산물(옥수수), 수산물(해초), 축산물(계란)내 Cs-137과

Am-241을 포함한 인공방사성핵종에 대한 측정결과 농도가 검출하한치 (1 Bq/kg)이하임을 확

인하였다 (시료량은 600-1200 g을 사용하였으며, 측정시간은 30분이 주어졌다). 기준시료 내

측정하고자 하는 목표핵종은 저에너지에서 Am-241 (59.54 keV), 중에너지부근에서 Cs-137

(661.66 keV), 고에너지에서 K-40 (1460.82 keV)을 각각 설정하였다. Cs-137과 Am-241은 한

국표준과학연구원에서 인증된 선원을 사용하였으며 K-40은 시료자체에 함유되어 있는 K-40의

방사능농도를 인증하여 사용하였다. 본 과제를 위하여 사용된 측정용 방사성 핵종은 한국표준

과학연구원에서 방사능 인증표준물질을 제작하는 감마방출핵종을 혼합한 혼합선원을 사용하였

으며, K-40의 경우 KCl을 정밀 정량하여 용액에 녹여 사용하였다. 용액의 화학적 구성은 0.5

N HCl이다. 방사능 농도는 농도 기준 저준위 (1-20 Bq/kg)와 고준위 (50-150 Bq/kg) 두 종류

로 준비하였다.
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제작된 인증표준물질은 감마선분광분석방법을 사용하여 방사성핵종분석 및 방사능을 산출하였다.

측정에 사용된 검출장치는 EG&G ORTEC사에서 제작된 상대효율이 90 %인 Ge 고순도반도체 검

출장치이며 측정 장비의 교정과 에너지 효율 측정을 위하여 한국표준과학연구원에서 개발한 혼합

감마인증표준물질 (Agar form)을 사용하였다.

(4) 기준시료 제조

농산물(옥수수), 수산물(해초), 축산물(계란)에 대한 기분시료를 제조하기 위하여 감마분광분

석기에 사용되는 1 L의 마리넬리 비이커를 준비하였다. 각각 준비된 시료를 전체 용기부피의

30 % 가량 충진하였다. Spiking용으로 준비된 선원 Cs-137과 Am-241은 방사능농도가 높아

극히 소량을 (100 ㎕ 이하) 시료에 투여해야 하기 때문에 전체시료 (약 1 kg)와 균질하게 혼합

되지 않을 가능성이 높았다. 이에 대한 보완으로 아세톤 50 ml에 선원을 녹여 희석하여 시료

에 골고루 분배하였다.

그림 3.3.1.15. 농·축·수산물 기준시료 제작을 위한 표준선원

(5) 기준시료 균질화

시료 내 감마핵종의 방사능 측정값은 선원-검출기의 거리에 따른 계수효율에 따라 크게 차

이가 나기 때문에 시료 내 방사능이 균질하게 분포되어야 이로 인한 불확도를 최소화할 수 있

다. 본 과제에서는 이를 위하여 시료균질기를 본 연구의 용도에 맞게 설계, 제작하여 사용하였

다. 균질기는 마리넬리 비이커를 균질기 몸체에 고착시킨 후 시계방향과 반시계방향으로 회전

할 수 있도록 하여 시료의 수평혼합을 유도하였으며, 시료내부를 혼합하기 위하여 별도의 장치

를 이용하여 시료의 수직방향으로의 혼합도 유도하였다. 시료의 혼합정도를 파악하기 위하여

일반 옥수수와 검은 옥수수(흑미)를 이 장비를 이용하여 혼합시킨 결과 시료가 골고루 혼합됨

을 파악할 수 있었다.
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그림 3.3.1.16. 시료혼합과 균질화를 위하여 제작된 균질기

충분히 혼합된 시료의 높이를 감마분광분석기에 사용된 기존의 인증표준물질의 높이를 맞추

기 위하여 이 과제를 위하여 특별히 제작된 시료압축기를 사용하여 시료의 높이를 보정하였다.

그림 3.3.1.17. 감마분광분석기

최종적으로 완성된 기준시료의 기준값과 불확도를 결정하기 위하여 감마분광분석기를 사용

하여 Cs-137과 Am-241, K-40의 방사능을 측정하였다. 측정 후, 숙련도시험을 위한 장기보관

필요성으로 기준시료를 실리콘과 파라필름으로 최대한 밀봉 후 ㈜그린피아에 의뢰하여 기준시

료에 방사선조사 (10 kGy) 처리를 하여 멸균하였다.
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그림 3.3.1.18. 기준시료

2. 인증표준물질개발

가. 밀(flour) 인증표준물질

(1) 배경 및 필요성

그림 3.3.2.1 국민식생에 이용되는 일반 밀

밀은 벼과의 한해살이 풀로 동양에서는 보조식량으로 쓰이지만 서양에서는 주식량이며, 쌀과

함께 세계의 2대 식량 작물이다. 우리나라의 밀 도입량은 연간 약 200~240만t 정도이며, 수입
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산은 미국, 호주, 캐나다로서 각각 60％, 34％, 6％ 정도의 비중을 차지하고 있다. 그리고 수입

산 외에 국산 맥이 연간 4000t 정도 생산되고 있다. 2012년 기준으로 우리나라 국민 1인당 연

간 쌀 소비량는 69.8 kg으로 (2002년 87kg, 2007년 76.9kg) 점점 줄어드는데 비해 밀가루 소비

량은 점점 늘어나 33.6 kg이나 된다. 또한 전세계에서 생산된 쌀은 약 9억만톤인 데 비해 밀은

약 7억톤이나 된다(2012년 기준) 밀은 미국과 캐나다, 호주 등이 주로 수출하고 있으며, 미국이

약 30%를 점유하고 있고 캐나다와 호주가 각각 17%를 차지한다. 밀가루는 밀의 배유 부분을

가루로 만든 것으로 우리가 먹는 하얀색 밀가루 속에는 껍질과 씨눈등이 들어 있지않기 때문

에 단백질이 적게 들어서 쌀에 비해 1/2에 지나지 않는다. 말린 밀에는 수분이 약 11.8%, 탄수

화물이 약 69%, 단백질이 약 12%, 약 2.9%를 포함한다. 밀 단백질의 글루텐은 글리아딘과 글

루테닌의 복합체로서 물과 반죽하면 끈기가 강하기 때문에 빵을 굽거나 과자, 국수를 만든다.

밀의 단백질은 리신, 트리토판, 트레오닌, S-함류 아미노산이 적어서 리신을 강화할 필요가 있

는 데 육류속에는 리신이 많이 들어 있기 때문에 빵을 먹는 서양인들이 고기를 통해 리신을

섭취하느데 비해 쌀이 주식인 동양인들은 그렇지 않다. 밀의 비타민은 약간 많은 편이다. 통계

청이 발표한 양곡 소비량 조사 결과에 따르면 2013년 1인당 쌀 소비량은 67.2㎏으로 전년(69.8

㎏)보다 3.7%(2.6㎏) 감소했다. 사상 최저 수준이다. 소비량이 최고였던 1970년(136.4㎏)과 비교

하면 절반이 안 된다. 이 자리를 파고든 것이 밀이다. 밀가루 소비량은 최근 4~5년 사이 꾸준

히 느는 추세다 (그림 6).우리나라에서 사용하는 밀가루의 97%는 국내에서 가공한 수입 밀가

루다. 국산 밀은 0.8%, 원산지에서 완제품으로 수입한 밀가루가 1.4% 안팎이다. 1983년까지는

전량 미국에서 수입하다가 최근에는 미국에서 50%, 호주에서 45%, 캐나다에서 5%가량씩 수입

한다. 일부 수입업자가 들여오는 프랑스 밀가루는 아직은 통계에 반영되지 않을 정도로 적은

수량이다. 밀가루는 제빵용, 제과용, 제면용 등의 용도별로 구분하지만, 기본적으로는 밀가루

속에 함유된 단백질의 양과 반죽의 힘에 따라 크게 강력분, 중력분, 박력분으로 나눈다. 시중에

서 쉽게 살 수 있는 밀가루는 강력분(빵), 중력분(국수) 박력분(과자, 케이크)으로 나뉜다. 강력

분은 단백질 함량 13% 이상, 중력분은 10~13%, 박력분은 8%이하다. 강력분은 단백질의 함량

이 많으며 그 반죽의 힘이 강하고, 박력분은 단백질의 함량이 적으며 그 반죽의 힘이 약한 특

성을 지닌다. 강력분은 주로 식빵·바케트·피자 등을 만드는 데 사용되며, 중력분은 만두·칼국

수·수제비·부침·라면 등을 만드는 데 사용되고, 박력분은 과자·케이크·스낵류 등을 제조하는 데

사용된다.

그림 3.3.2.2. 국내 1인당 밀가루소비량
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또한 밀가루의 회분 함량 및 색상에 따라 1등급, 2등급, 3등급, 등외 등으로 구별한다. 식품가

공용으로는 대체로 2등급 이상이 많이 사용되며, 3등급은 합판용 등의 공업용 원료 및 사료용

으로, 등외·밀껍질은 사료용 등으로 이용되고 있다. 결과적으로 밀가루는 쌀과 더불어 현재 국

내에서 소비되는 주식으로서 거의 전량 국외에서 수입되는 관계로 방사능 오염관련 식품감시

에 주요항목으로 간주되어 인증표준물질 개발의 주재료로 선정되었다.

(2) 방사능 표준시료 개발절차

방사능 매질표준물질은 현장 측정실험실에서 수행하고 있는 측정결과의 bias 여부를 확인하

는데 사용하며, 실제시료와 병행하여 동일한 방법 및 절차에 따라 측정함으로서 측정절차(방

법) 및 과정의 유효성 확인도구로 이용된다. 이러한 매질표준물질은 측정하고자 하는 시료와

그 매질 조성과 성분 함량이 동일하게 되도록 제조하는 것이 가장 이상적이다. 그러나 다양한

방사능 환경오염 측정 대상 시료 매질과 그 성분 함량을 일치 시키는 것은 현실적으로 불가

능 하다. 대안으로 유사 매질 시료에 측정 대상 성분 용액을 임의로 첨가하여 시료를 제조하기

도 한다. 본 연구에서는 균질화된 분말의 방사능 농도의 균질성을 추구하는 것이며, 국제적으

로 여러 표준기관은 원하는 균질도 수준에서 수율을 늘리되 안전한 방법을 채택하여 운영하

고 있다. 화학 표준물질을 예로들면;

- 유럽 연합의 IRMM (Institute of Reference Materials and Measurement)의 경우 ZrO2

ball-mill로 갈아서 125 μm 이하의 분말을 취한 후 mixing drum이나 turbula mixer로 혼합한

다.

- 미국의 NIST (National Institute of Standards and Technology)의 경우 jet-mill로 갈아서

V-blender로 혼합하고 있다.

- 일본 NMIJ (National Metrology Institute of Japan)의 경우 freeze-pulverization 하고 250

μm 이하의 분말을 취한 후 V-blender로 혼합하고 있다.

- KRISS는 Ti-blade pulverizer로 갈고 50~250 μm 이하의 분말을 취한 후 V-blender로

혼합하고있다.

- 모든 기관은 각 기관의 시설과 경험에 따라 운영하고 있으며 새로운 시도가 비용 면에서나

질적인 면에서 특히 유리하다는 확신이 없는 한 시설과 방법을 바꾸는데 매우 보수적이다.

본 사업으로 수행하는 밀가루 매질 방사능표준물질은 국내에서 처음으로 개발되는 환경 시료

매질 방사능표준물질이다. 특히 숙련도 시험에 요구되는 시료는 균질성(homogeneity)이 확보되

어야한다. 그러므로 밀가루 표준물질 제조 후 균질성에 역점을 두었다. 균질성 평가는 고체 시

료의 경우 전체 batch에서 제조 순, 등 간격 (처음과 마지막 시료 포함)으로 15개 시료를 선택

하며 반복성이 좋은 방법을 사용하여 시료 간 표준편차를 구한다. 이때 표준편차가 시험기관의

측정능력에 비해 무시할 수 있어야 한다. (참고로, 액체시료의 경우 균질성이 좋을 것으로 예

상되며 최소 5개 시료를 평가한다)

(3) 목표 및 내용

밀가루 방사능 표준물질의 제조방법확립 및 개발내용은 다음과 같다.

ú 방사능 표준물질 (숙련도용) 밀가루 Powder 제조
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ú 시료의 선정 및 가공(선별, 건조, 체거름, 혼합, 병입)

- 제조수량: 2종, 1 kg/bottle, 30bottles

- 시료의 주성분: Cs-137

- 균질도 조사

(4) 밀가루 표준물질의 제조 및 균질도 조사

숙련도용 방사능 표준물질에서 밀가루 중의 감마핵종으로 Cs-137을 선택하였다. 일반적 숙

련도용 밀가루 표준시료 제조 과정은 그림과 같으며 다음과 같은 과정을 통해 제조되었다.

그림 3.3.2.4. 시중에서 구입한

원료 시료

시료의 수집

↓

시료 일부분 분취

↓

  대상 방사성핵종 첨가

↓

Mixing 

↓

동결건조

↓

분쇄

↓

체거름

↓

균질화  

↓

소분(bottling)

↓

상온보관

그림 3.3.2.3. 밀가루를 이용한

인증 표준물질개발 절차 
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표준시료의 제조를 위해 그림 3.3.2.4와 같이 시작물질로는 시중에서 시판되고 있는 포장된 밀

가루 20 kg, 2개를 구매하여 사용하였다. 각각 포대는 Batch #1, Batch #2로 나누어

서 제조하였다.

(5) 방사능 핵종 첨가

밀가루 분말에 방사능 표준선원(Cs-137) 1 L와 물 0.5 L를 첨가하여 그림 3.3.2.5의 반죽기

믹서(KENWOOD, KMC570)를 이용하여 반죽하였으며 이때 점도는 약간의 유동성 있게 반죽

(혼합)하였다. 이 과정은 균질성을 좋게 하기 위하여 약 4 시간 동안 진행되었다.

그림 3.3.2.5. 표준선원(Cs-137)과 물, 원료 밀가루 분말 반죽을 위하여 사용된 반죽기 믹서

(6) 동결건조

반죽한 것을 스테인레스 접시 3개에 각각 약 500 g씩을 두께가 약 1.5 cm 정도가 되도록

펴서 냉동고에 보관 후 얼린 상태에서 동결건조 하였다. 동결건조 과정에서는 실험실용 동결건

조기(일신랩, FD8512)를 사용하였다. 동결건조는 영하 87 ℃에서 5 mTorr로 70시간 이상 실시

하였으며 다시 시료를 뒤집어서 100시간 충분히 건조하였다. 건조된 밀가루 시료는

polyethylene bag에 넣어 다음 처리과정인 체거름을 하였다. 동결건조 후 무게는 1.31 Kg 이었

다.
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그림 3.3.2.6. 시료의 건조에 사용된 동결건조기와 내부

(7) 시료의 분쇄

반죽된 밀가루는 손으로도 부서질 정도로 건조되었고, 그림 3.3.2.7의 믹서 겸용 분쇄기(한일

전기, HMF-3100S) 2대를 번갈아 사용하여 분쇄하였다. 분쇄된 밀가루 시료는 100 L 용량의

polyethylene bag에 넣어 다음 처리 과정인 체 거름을 하였다. 동결건조 후의 밀가루 분말시료

는 약 1.31 kg이었으며 분쇄기에서 분쇄한 후에는 약 1.29 kg 이 회수되었다.

그림 3.3.2.7. 동결건조된 밀가루의 분쇄에 사용된 믹서기

(8) 시료의 체 거름

건조 분말로 만들어진 밀가루는 균질한 입자를 얻기 위하여 그림의 체 거름기에 넣고 체 거

름하여 입자크기 mesh 70 이하 시료를 취하였다. 건조된 밀가루 분말 시료 1.29 kg 중 체 거

름을 하여 회수한 시료는 1.28 kg이다. 체 거름에 사용한 모든 sieve cloth의 재질은 나일론이

다.
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그림 3.3.2.8. 분쇄된 시료로부터 균질한 입자의

분말을 얻기 위해 사용된 체 거름기

(8) 체 거름된 분말의 혼합 및 균질화

목표 수량을 계산하여 밀가루 분말 14.7 kg과 방사성 핵종이 첨가된 체거름한 밀가루분말

1.28 kg을 그림 3.3.2.9의 V-blender(대가분체(주)V/Mixer, 내부용량 (60 L)에 넣고 회전 속도

15 rpm에서 5시간 이상 작동하여 시료를 혼합하여 균질화하였다. 최종 시료의 무게는 약 15.5

kg 이다. 시료가 접촉하게 되는 V-blender의 내부는 모두 Teflon coating 처리하여 오염을 방

지하도록 되어있다. 분쇄 및 체 거름, 혼합은 외부로의 방사능 분말시료의 비산방지를 최소화

하기 위하여 Clean booth안에서 작업을 시행하였다.

그림 3.3.2.9. 일정한 범위의 크기로 얻어진 분말 입자를

균질하게 혼합하기 위해 사용된 혼합기
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(9) Batch #2 제조

위 5-8의 과정을 되풀이 하여 추가 인증표준물질 (Batch #2) 15,6 kg을 제조하였다.

(10) 방사능 표준 물질의 병입

건조시료를 소분하여 저장하고 배포하기 위하여 2 kg 용량의 광구병(HDPE Large Neck

bottle, DH.B03117, 2000 mL)을 시료 용기로 사용하였다. 시료와 접촉하는 뚜껑의 내면은

Insert plug cap되어 있다. 용기에는 일련번호를 적은 스티커를 붙였다. 시료의 소분은 방사능

오염의 요인을 최대한 줄이기 위하여 Clean Draft 내에서 모자, 마스크, 장갑 등을 착용하고

실시하였다. batch #1을 시료 병 당 밀가루 분말 1002±1 g을 15개, batch #2을 시료 병 당 밀

가루 분말 1003±1 g을 15개를 일련번호 순서로 담았으며 총 30개 시료가 제조되었다(표 1). 시

료를 병에 넣은 다음 병마개로 밀봉하고 마개 주위의 오염을 막기 위하여 열 수축 튜브로 뚜

껑 주위를 봉하였다(그림 3.3.2.10). 이렇게 처리된 표준시료는 일련번호에 따라 레이블을 붙이

고 상온에서 보관하였다.

그림 3.3.2.10. 최종 개발된 Cs-137측정용 밀가루 인증표준물질

(11) 균질도 평가 방법

밀가루 시료 중 방사능 핵종 표준물질 균질도는 총 30개의 시료 중 임의로 선별된 15병의

측정값의 표준편차로부터 추정할 수 있다. 30개 bottle의 균질도(homogeneity test) 결과값은

표 3.3.2.1에 나타내었다.
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표 3.3.2.1. 균질도 결과값

No. Sample I.D.
Cs-137  (count/kg)

Batch #1 Batch #1
Batch #1

1 14-01-001 1373
2 14-01-003 1524
3 14-01-005 1473
4 14-01-007 1454
5 14-01-009 1395
6 14-01-0011 1473
7 14-01-0013 1331
8 14-01-0015 1348

Batch #2
9 14-01-0017 1503
10 14-01-0019 1350
11 14-01-0021 1507
12 14-01-0023 1508
13 14-01-0025 1460
14 14-01-0027 1504
15 14-01-0029 1518

Mean 1420 1480

Standard deviation 69 60

Relative Standard 
deviation 0.05 0.04

나. 멸치분말(anchovy powder)표준물질

(1) 배경 및 필요성

본 연구용역으로 수행하는 멸치분말 표준시료는 국내에서 처음 개발되는 환경 방사능 시료

매질 표준물질이다. 본 사업에서는 방사능 표준물질을 제조하고, 균질성을 제시하였다. 방사능

인증값 및 불확도는 표준과학연구원이 평가하였다. 표준물질의 제조방법 및 확립을 참고로 하

였으며, 향후 주요 선진국의 환경분야 방사능 표준물질의 개발 현황을 조사 정리하여 이 후 표

준물질 개발 계획수립에 기초자료로 활용하고자 한다.

멸치의 학명은 Engraulis japonius TEMMINCK et SCHLEGEL이다. 몸은 작으나 그 생김

새가 늘씬하며 아래턱이 위턱보다 훨씬 짧다. 몸빛은 등쪽이 암청색이고 배쪽이 은백색이다.

비늘은 크고 엷어 떨어지기 쉽다. 멸치는 연안 회유어(洄游魚)로서 우리나라의 전 연안에 분포

하며 다획성 물고기의 대표적인 존재이다. 또한 삶아서 말린 마른 멸치는 음식 중 칼슘의 대명

사로 대접받는다. 마른 멸치가 칼슘의 보고라는 것은 과학적으로도 증명이 된다. 멸치를 비롯

한 생선뼈는 주로 인산칼슘으로 이루어져 있는데 이 화합물은 비타민 D의 도움을 받아야 흡수

가 잘 된다. 그런데 비타민 D는 생선 내장에 많이 함유되어 있으므로 내장과 뼈를 통째로 먹

을 수 있는 마른 멸치가 칼슘 흡수 면에서 탁월하다. 불안하거나 신경질이 나는 것은 체내 칼
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슘이 부족하기 때문인데 매일 일정량의 칼슘을 섭취하면 건강 뿐 아니라 정신적으로도 매우

좋다. 한편 우리나라 수산물 검사법에 의하면 건조품 중 전장 77mm 이상을 대멸, 46~76mm를

중멸, 31~45mm를 소멸, 16~30mm를 자멸, 15mm 이하를 세멸 이라 부른다. 본 표준물질로 사

용된 멸치는 경산남도 통영산의 대멸치를 선택하였다.

(2) 목표 및 내용

멸치를 이용한 방사능 표준물질의 제조방법확립 및 개발내용은 다음과 같다.

ú 방사능 표준물질 멸치분말 제조

ú 시료의 선정 및 가공(선별, 건조, 체거름, 혼합, 병입, 살균)

- 제조수량: 1종 125 g/병, 100병

- 시료의 주성분: Pu-239, Sr-85, Cs-137

- 균질도 조사

(3) 멸치 표준물질의 제조 및 균질도 조사

숙련도용 방사능 표준물질에서 멸치분말 중의 알파, 베타핵종으로 Pu-238, Pu-239, Sr-90,

그리고 감마핵종으로 Cs-137을 선택하였다. 일반적 멸치분말 표준시료 제조 과정은 그림

3.3.2.11과 같으며 다음과 같은 과정을 통해 제조되었다.



259

시료의 수집

↓

시료 세척 및 이물질 제거

↓

  동결건조

↓

  분쇄

↓

  체거름

↓

대상 핵종 첨가

↓

  Mixing

↓

  재 동결건조

↓

  분쇄

↓

  체거름

↓

  균질화

↓

소분(bottling)

↓

  방사선멸균

↓

  상온보관

그림 3.3.2.11. 멸치를 이용한

표준시료 제조 절차

(가) 원재료 수집 세척

표준시료의 제조를 위해 그림 3.3.2.12와 같이 경상남도 통영시에서 어획한 양식 멸치를 약

21 kg을 구매하여 사용하였다. 구매한 멸치는 수돗물로 세척하여 이물질을 제거하였고 수돗물

세척 후 다시 PVC bag에 넣어 동결건조 전까지 냉동보관 하였다.

그림 3.3.2.12. 수집된 대멸치의 초기 상태
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(나) 동결건조 및 1차 가공

1차 동결 건조를 위해 한국표준과학연구원의 무기분석표준센터 동결건조기(일신 랩)를 사용

하였다(그림 3.3.2.13). 대멸치 시료를 선반에 고르게 펴서 12시간 이상 냉동 후 -37℃ 에서 96

시간 동결건조를 하였다. 약 20 kg 정도를 취하여 세척과정과 동결건조를 거쳐 건조된 무게는

15.1 kg 이었으며, 이때 원 시료량의 75.5 % 이었다.

그림 3.3.2.13. 시료의 건조에 사용된 동결건조기와 건조된 대멸치

(다) 시료의 분쇄

건조된 대멸치는 목표 수량을 계산하여 15.1 kg을 취하여 표준물질제조에 사용하였다. 그림

3.3.3.4의 분쇄기(일신기계)를 사용하여 분쇄하였다. 분쇄된 멸치분말 시료는 100 L 용량의

polyethylene bag에 넣어 다음 처리 과정인 체 거름을 하였다. 동결건조후의 멸치분말 시료는

약 15.1 kg이었으며 분쇄기에서 분쇄한 후에는 약 15.0 kg 이 회수되었다.

그림 3.3.2.14. 동결건조된 멸

치 분쇄에 사용된 분쇄기

(라) 시료의 체 거름

건조 분말로 만들어진 멸치분말은 균질한 입자를 얻기 위하여 그림 3.3.2.15의 체 거름기에
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넣고 체 거름하여 입자크기 mesh 70 이하 시료를 취하였다. 건조된 멸치분말 분말 시료 15.0

kg 중 체 거름을 하여 회수한 시료는 14.6 kg으로서 전체 분말의 97.3%에 해당하였다. 체 거

름에 사용한 모든 sieve cloth의 재질은 나일론이다.

그림 3.3.2.15. 분쇄된 시료로부터 균질한 입자의

분말을 얻기 위해 사용된 체 거름기

(마) 방사능 핵종 첨가

방사능 핵종을 첨가하기 위하여 스테인레스 용기에 멸치분말 중 일부 1.6 kg과 방사능 핵

종 수용액 4 L를 그림 3.3.2.16의 반죽기 믹서(KENWOOD, KMC570)를 이용하여 반죽하였다.

이 과정은 약 6 시간 동안 균질성을 좋게 하기 위한 작업을 하였다.

그림 3.3.2.16. 방사성 핵종 첨가 위해 사용된 반죽기 믹서

(바) 재 동결건조(방사능 핵종첨가된 멸치분말)

반죽한 것을 스테인레스 접시에 두께가 약 1.5 cm 정도가 되도록 펴서 냉동고에 보관 후

얼린 상태에서 재 동결건조 하였다. 재 동결건조 과정에서는 1차 동결건조 때와는 달리 적은

시료양 그리고 방사능 오염의 문제로 인하여 실험실용 동결건조기(일신랩, FD8512)를 사용하

였다.(그림 3.3.2.17) 동결건조는 영하 80 ℃에서 5 mTorr로 120시간 이상 실시하였으며 다시

시료를 뒤집어서 60시간 충분히 건조하였다. 건조된 멸치분말 시료는 polyethylene bag에 넣어
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다음 처리과정인 분쇄와 체거름을 하였다.

그림 3.3.2.17. 시료의 건조에 사용된 동결건조기와 내부

(사) 분쇄와 체거름 (방사능 핵종첨가된 멸치분말)

방사성 핵종이 첨가된 동결 건조된 시료를 그림 3.3.2.18의 믹서 겸용 분쇄기(한일전기,

HMF-3100S) 2대를 번갈아 사용하여 분쇄하였다. 분쇄된 멸치분말 시료는 100 L 용량의

polyethylene bag에 넣어 보관하였다. 그리고 균질성을 좋게 하기 위하여 다음 처리 과정인 체

거름을 하였다. 체거름 과정은 위의 시료의 체거름 과정과 동일하게 실시하였다. 1.6 kg 중 회

수한 시료는 1.55 kg이였다.

그림 3.3.2.18. 동결건조된 멸치분말의 분

쇄에 사용된 믹서기

(아) 체 거름된 분말의 혼합 및 균질화

1차로 체로 거른 멸치분말 분말 14.6 kg중 11.5 Kg을 방사성 핵종이 첨가된 체거름한 멸치

분말 1.55 kg을 그림 3.3.2.19의 V-blender(대가분체(주)V/Mixer, 내부용량 60L)에 넣고 회전

속도 15 rpm에서 12시간 이상 작동하여 시료를 혼합하여 균질화하였다. 최종 시료의 무게는

약 12.8 kg 이며, 최종 회수율을 비례적으로 계산하면 약 61 % 정도이다. 시료가 접촉하게 되

는 V-blender의 내부는 모두 Teflon coating 처리하여 오염을 방지하도록 되어있다. 분쇄 및

체 거름, 혼합은 외부로의 방사능 분말시료의 비산방지를 최소화하기 위하여 Clean booth안에
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서 작업을 시행하였다.

그림 3.3.2.19. 분말 시료를 균질하게 혼합하기 위해 사용된

혼합기

(자) 방사능 표준시료의 병입 및 방사선 조사

건조시료를 소분하여 저장하고 배포하기 위하여 250 mL 용량의 투명 플라스틱을 시료 용

기를 사용하였다. 시료와 접촉하는 뚜껑의 내면은 원터치캔 밀봉기인 캔시머로 밀봉하였다. 용

기에는 일련번호를 적은 스티커를 붙였다. 시료의 소분은 방사능 오염의 요인을 최대한 줄이기

위하여 Clean Draft 내에서 모자, 마스크, 장갑 등을 착용하고 실시하였다. 시료 병 당 멸치분

말 분말 250 ± 0.5 g을 일련번호 순서로 담았으며 총 100개 시료가 제조되었다(표 3.3.2.2). 시

료를 병에 넣은 다음 병마개로 밀봉하였다. 마지막으로 멸균 처리를 함으로써 장기 안정성을

확보하기 위하여 경기도 여주에 있는 그린피아(주)에서 Co-60 감마선을 약 24 kGy 조사하였

다. 이렇게 처리된 표준시료는 일련번호에 따라 레이블을 붙이고 상온에서 보관하였다.

그림 3.3.2.20. 최종 생산된

표준시료
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그림 3.3.2.21. 감마선 조사 인증서

(차) 균질도 평가 방법

멸치분말 시료 중 방사능 핵종 표준물질 균질도는 총 100개의 시료 중 임의로 선별된 10병

의 측정값의 표준편차로부터 추정할 수 있다. 100개 bottle의 weighing 값은 표3.3.2.2 그리고

균질도 결과값은 표3.3.2.3에 나타내었다.
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표 3.3.2.2. bottle의 weighing 값

No. Sample I.D. g No. Sample I.D. g

1 15-01-001 125.0 51 15-01-051 125.0

2 15-01-002 125.0 52 15-01-052 125.0

3 15-01-003 125.0 53 15-01-053 125.0

4 15-01-004 125.0 54 15-01-054 125.0

5 15-01-005 125.0 55 15-01-055 125.0

6 15-01-006 125.0 56 15-01-056 125.0

7 15-01-007 125.0 57 15-01-057 125.0

8 15-01-008 125.0 58 15-01-058 125.1

9 15-01-009 125.0 59 15-01-059 125.1

10 15-01-010 125.0 60 15-01-060 125.1

11 15-01-011 125.0 61 15-01-061 125.0

12 15-01-012 125.0 62 15-01-062 125.0

13 15-01-013 125.1 63 15-01-063 125.1

14 15-01-014 125.0 64 15-01-064 125.0

15 15-01-015 125.1 65 15-01-065 125.1

16 15-01-016 125.0 66 15-01-066 125.1

17 15-01-017 125.0 67 15-01-067 125.0

18 15-01-018 125.1 68 15-01-068 125.0

19 15-01-019 125.0 69 15-01-069 125.0

20 15-01-020 125.1 70 15-01-070 125.1

21 15-01-021 125.0 71 15-01-071 125.0

22 15-01-022 125.0 72 15-01-072 125.1

23 15-01-023 125.0 73 15-01-073 125.0

24 15-01-024 125.0 74 15-01-074 125.0

25 15-01-025 125.0 75 15-01-075 125.0

26 15-01-026 125.0 76 15-01-076 125.1

27 15-01-027 125.0 77 15-01-077 125.0

28 15-01-028 125.0 78 15-01-078 125.1

29 15-01-029 125.1 79 15-01-079 125.0

30 15-01-030 125.0 80 15-01-080 125.1

31 15-01-031 125.1 81 15-01-081 125.0

32 15-01-032 125.1 82 15-01-082 125.1

33 15-01-033 125.1 83 15-01-083 125.1

34 15-01-034 125.0 84 15-01-084 125.1

35 15-01-035 125.1 85 15-01-085 125.0

36 15-01-036 125.0 86 15-01-086 125.0

37 15-01-037 125.1 87 15-01-087 125.0

38 15-01-038 125.0 88 15-01-088 125.0

39 15-01-039 125.0 89 15-01-089 125.1

40 15-01-040 125.0 90 15-01-090 125.0

41 15-01-041 125.0 91 15-01-091 125.0

42 15-01-042 125.0 92 15-01-092 125.0

43 15-01-043 125.0 93 15-01-093 125.0

44 15-01-044 125.1 94 15-01-094 125.1

45 15-01-045 125.0 95 15-01-095 125.0

46 15-01-046 125.0 96 15-01-096 125.0

47 15-01-047 125.0 97 15-01-097 125.0

48 15-01-048 125.0 98 15-01-098 125.1

49 15-01-049 125.0 99 15-01-099 125.0

50 15-01-050 125.0 100 15-01-100 125.0
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표 3.3.2.3. 균질도 결과값

No. Sample I.D. Cs-137(count) Uncertainty

1 15-01-005 9029 342

2 15-01-006 9152 348

3 15-01-014 8937 338

4 15-01-024 9084 345

5 15-01-035 9114 350

6 15-01-054 9026 340

7 15-01-073 8763 333

8 15-01-077 8934 339

9 15-01-080 9181 348

10 15-01-097 8990 348

Mean 9021

Standard deviation 124

Relative Standard
deviation 1.4 %

Uncertainty

* 관련절차서/관련보고서

- 고체상 및 액체상 매질의 유기물 CRM 제조 절차서(한국표준과학연구원 문서번호:

R-108-001-2002)

- 국가 인증표준물질 체계 확립 과제 보고서(한국표준과학연구원 문서번호:

R-108-001-2002), 제2장

- 2008년 검사능력관리를 위한 표준시료 개발 및 기준값 설정 연구, 한국표준과학연구원
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다. 닭가슴살 방사능 인증표준물질 개발

(1) 배경 및 필요성

본 연구용역으로 수행하는 닭가슴살 분말 표준시료는 국내에서 처음 개발되는 환경 방사능

시료 매질 표준물질이다. 본 사업에서는 방사능 표준물질을 제조하고, 균질성을 제시하였다. 방

사능 인증값 및 불확도는 표준과학연구원이 평가하였다. 표준물질의 제조방법 및 확립을 참고

로 하였으며, 향후 주요 선진국의 환경분야 방사능 표준물질의 개발 현황을 조사 정리하여 이

후 표준물질 개발 계획수립에 기초자료로 활용하고자 한다.

닭가슴살은 닭의 날개와 부리 쪽에서 가슴을 뒤덮고 있는 근육이다. 닭고기 부위 중 가장

살코기의 양이 많고 뼈를 포함하지 않는 특징이 있다. 가슴살은 백색근섬유로만 이루어져 있어

육색이 옅은 핑크색 또는 백색을 띤다. 가슴살은 닭고기 부위 중 지방함량이 가장 적은 대신

단백질을 가장 많이 함유하고 있다. 때문에 칼로리가 낮으며 저지방 고단백 식품으로 현대인이

다이어트에 닭가슴살을 많이 이용하고 있다. 닭가슴살의 영양성분은 100 g 당 주요성분으로

탄수화물 0 g, 단백질 23.10 g, 지방 1.2 g, 칼슘 11.0 mg, 나트륨 65 mg을 함유하고 있으며,

메티오닌을 비롯한 필수 아미노산을 소고기보다 풍부하게 포함하고 있다.

(2) 목표 및 내용

닭가슴살 분말을 이용한 방사능 표준물질의 제조방법확립 및 개발내용은 다음과 같다.

ú 방사능 표준물질 닭가슴살분말 제조

ú 시료의 선정 및 가공(선별, 건조, 체거름, 혼합, 병입, 살균)

- 제조수량: 1종 100 g/병, 100병

- 시료의 주성분: Pu-239, Sr-85, Cs-137

- 균질도 조사

(3) 닭가슴살 분말 표준물질의 제조 및 균질도 조사

방사능 표준물질에서 닭가슴살 분말 중의 알파, 베타핵종으로 Pu-238, Pu-239, Sr-90, 그리고

감마핵종으로 Cs-137을 선택하였다. 일반적 닭가슴살 분말 표준시료 제조 과정은 그림 3.3.2.22

와 같으며 다음과 같은 과정을 통해 제조되었다.
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시료의 수집

↓

시료 세척 및 이불질 제거

↓

  동결건조

↓

  분쇄

↓

  체거름

↓

대상 핵종 첨가

↓

  Mixing

↓

  재 동결건조

↓

  분쇄

↓

  체거름

↓

  균질화

↓

소분(bottling)

↓

  방사선멸균

↓

  상온보관

그림 3.3.2.22. 표준시료 제조 절차

(가) 원재료 수집 세척

표준시료의 제조를 위해 닭가슴살은 주요 산지인 충청북도 제천시 신월동에서 사육용으로

길러지고 있는 국내산 생 닭가슴살을 사용하였다. 구입 시 살이 두텁고 윤기가 흐르며 탄력이

있는 것 그리고 살이 너무 흰 것은 오래된 닭이므로 되도록이면 엷은 분홍빛이 나는 포장육을

선택하여 구입하였다. 그림 3.3.2.23과 같이 닭가슴살은 약 50 kg 구매하였다. 이 닭가슴살은

수돗물로 세척하여 이물질을 제거하였고 수돗물 세척 후 다시 PVC bag에 넣어 동결건조 전까

지 냉동보관 하였다.
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그림 3.3.2.23. 수집된 닭가슴살의 초기 상태

(나) 동결건조 및 1차 가공

1차 동결 건조를 위해 한국표준과학연구원의 무기분석표준센터 동결건조기(일신 랩)를 사용

하였다(그림 3.3.2.24). 닭가슴살 분말 시료를 선반에 고르게 펴서 12시간 이상 냉동 후 -37 ℃

에서 100 시간 동결건조를 하였다. 약 50 kg 정도를 취하여 세척과정과 동결건조를 거쳐 건조

된 무게는 12.3 kg 이었으며, 이때 원 시료량의 24.6 % 이었다.

그림 3.3.2.24. 시료의 건조에 사용된 동결건조기와 건조된 닭가슴살

(다) 시료의 분쇄

건조된 닭가슴살은 목표 수량을 계산하여 12.3 kg을 취하여 표준물질제조에 사용하였다. 그

림 3.3.2.25의 분쇄기(일신기계)를 사용하여 분쇄하였다. 분쇄된 닭가슴살분말 시료는 100 L 용

량의 polyethylene bag에 넣어 다음 처리 과정인 체 거름을 하였다. 동결건조후의 닭가슴살 분
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말시료는 약 12.3 kg이었으며 분쇄기에서 분쇄한 후에는 약 12.2 kg 이 회수되었다.

그림 3.3.2.25. 동결건조된 닭가슴살 분쇄에 사용된 분쇄기

(라) 시료의 체 거름

건조 분말로 만들어진 닭가슴살 분말은 균질한 입자를 얻기 위하여 그림 3.3.2.26의 체 거름

기에 넣고 체 거름하여 입자크기 mesh 70 이하 시료를 취하였다. 건조된 닭가슴살 분말시료

12.2 kg 중 체 거름을 하여 회수한 시료는 12.0 kg으로서 전체 분말의 98.3 %에 해당하였다.

체 거름에 사용한 모든 sieve cloth의 재질은 나일론이다.

그림 3.3.2.26. 분쇄된 시료로부터 균질한 입자의 분말을 얻기 위해 사용된 체 거름기

(마) 방사능 핵종 첨가

방사능 핵종을 첨가하기 위하여 스테인레스 용기에 닭가슴살 분말 중 일부 0.7 kg과 방사

능 핵종 수용액 3L를 그림 3.3.2.27의 반죽기 믹서(KENWOOD, KMC570)를 이용하여 반죽하

였다. 이 과정은 약 6시간 동안 균질성을 좋게 하기 위한 작업을 하였다.
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그림 3.3.2.27. 방사성 핵종 첨가 위해 사용된 반죽기 믹서

(바) 재 동결건조(방사능 핵종 첨가된 닭가슴살 분말)

반죽한 것을 스테인레스 접시에 두께가 약 1.5 cm 정도가 되도록 펴서 냉동고에 보관 후

얼린 상태에서 재 동결건조 하였다. 재 동결건조 과정에서는 1차 동결건조 때와는 달리 적은

시료양 그리고 방사능 오염의 문제로 인하여 실험실용 동결건조기(일신랩, FD8512)를 사용하

였다.(그림 3.3.2.28) 동결건조는 영하 80 ℃에서 5 mTorr로 120시간 이상 실시하였으며 다시

시료를 뒤집어서 48시간 충분히 건조하였다. 건조된 닭가슴살 분말 시료는 polyethylene bag에

넣어 다음 처리과정인 분쇄와 체거름을 하였다.

그림 3.3.2.28. 시료의 건조에 사용된 동결건조기와 건조된 닭가슴살

(사) 분쇄와 체거름 (방사능 핵종첨가된 닭가슴살분말)

방사성 핵종이 첨가된 동결 건조된 시료를 그림 3.3.2.29의 믹서 겸용 분쇄기(한일전기,

HMF-3100S) 2대를 번갈아 사용하여 분쇄하였다. 분쇄된 닭가슴살 분말 시료는 100 L 용량의

polyethylene bag에 넣어 보관하였다. 그리고 균질성을 좋게 하기 위하여 다음 처리 과정인 체

거름을 하였다. 체거름 과정은 위의 체거름 과정과 동일하게 실시하였다. 0.7 kg 중 회수한 시

료는 0.65 kg이였다.
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그림 3.3.2.29. 동결건조된 닭가슴살 분말의 분쇄에 사용된 믹서기

(아) 체 거름된 분말의 혼합 및 균질화

1차로 체로 거른 닭가슴살 분말 12 kg 중 9.45 kg과 방사성 핵종이 첨가된 체거름한 닭가

슴살 분말 0.65 kg을 그림 3.3.2.30의 V-blender(대가분체(주)V/Mixer, 내부용량 60L)에 넣고

회전 속도 15 rpm에서 4시간 이상 작동하여 시료를 혼합하여 균질화하였다. 최종 시료의 무게

는 약 10.04 kg 이며, 최종 회수율을 비례적으로 계산하면 약 20.1 % 정도이다. 시료가 접촉하

게 되는 V-blender의 내부는 모두 Teflon coating 처리하여 오염을 방지하도록 되어있다. 분쇄

및 체 거름, 혼합은 외부로의 방사능 분말시료의 비산방지를 최소화하기 위하여 Clean booth안

에서 작업을 시행하였다.

그림 3.3.2.30. 분말 시료를 균질하게 혼합하기 위해 사용된 혼합기

(자) 방사능 표준시료의 병입 및 방사선 조사

건조시료를 소분하여 저장하고 배포하기 위하여 250 mL 용량의 투명 플라스틱을 시료 용

기를 사용하였다. 시료와 접촉하는 뚜껑의 내면은 원터치캔 밀봉기인 캔시머로 밀봉하였다. 용

기에는 일련번호를 적은 스티커를 붙였다. 시료의 소분은 방사능 오염의 요인을 최대한 줄이기

위하여 Clean Draft 내에서 모자, 마스크, 장갑 등을 착용하고 실시하였다. 시료 병 당 닭가슴

살 분말 100±0.5 g을 일련번호 순서로 담았으며 총 100 개 시료가 제조되었다(표 3.3.2.4). 시료

를 병에 넣은 다음 병마개로 밀봉하였다. 마지막으로 멸균 처리를 함으로써 장기 안정성을 확

보하기 위하여 경기도 여주에 있는 그린피아(주)에서 Co-60 감마선을 약 24 kGy 조사하였다.

이렇게 처리된 표준시료는 일련번호에 따라 레이블을 붙이고 상온에서 보관하였다.



273

그림 3.3.2.31. 최종 생산된 표준시료

그림 3.3.2.32. 감마선 조사 인증서

(차) 균질도 평가 방법

닭가슴살 분말 시료 중 방사능 핵종 표준물질 균질도는 총 100개의 시료 중 임의로 선별된

10병의 측정값의 표준편차로부터 추정할 수 있다. 100개 bottle의 weighing 값은 표3.3.2.4. 그

리고 균질도 결과값은 표 3.3.2.5.에 나타내었다.
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표 3.3.2.4. bottle의 weighing 값

No. Sample I.D. g No. Sample I.D. g

1 15-02-001 100.0 51 15-02-051 100.1

2 15-02-002 100.2 52 15-02-052 100.1

3 15-02-003 100.1 53 15-02-053 100.1

4 15-02-004 100.2 54 15-02-054 100.1

5 15-02-005 100.1 55 15-02-055 100.0

6 15-02-006 100.1 56 15-02-056 100.0

7 15-02-007 100.0 57 15-02-057 100.1

8 15-02-008 100.2 58 15-02-058 100.0

9 15-02-009 100.1 59 15-02-059 100.0

10 15-02-010 100.1 60 15-02-060 100.0

11 15-02-011 100.1 61 15-02-061 100.0

12 15-02-012 100.2 62 15-02-062 100.1

13 15-02-013 100.1 63 15-02-063 100.1

14 15-02-014 100.1 64 15-02-064 100.0

15 15-02-015 100.2 65 15-02-065 100.0

16 15-02-016 100.1 66 15-02-066 100.0

17 15-02-017 100.2 67 15-02-067 100.0

18 15-02-018 100.0 68 15-02-068 100.1

19 15-02-019 100.2 69 15-02-069 100.1

20 15-02-020 100.0 70 15-02-070 100.0

21 15-02-021 100.0 71 15-02-071 100.1

22 15-02-022 100.1 72 15-02-072 100.0

23 15-02-023 100.1 73 15-02-073 100.0

24 15-02-024 100.1 74 15-02-074 100.1

25 15-02-025 100.0 75 15-02-075 100.1

26 15-02-026 100.0 76 15-02-076 100.0

27 15-02-027 100.0 77 15-02-077 100.0

28 15-02-028 100.0 78 15-02-078 100.0

29 15-02-029 100.0 79 15-02-079 100.1

30 15-02-030 100.0 80 15-02-080 100.1

31 15-02-031 100.0 81 15-02-081 100.0

32 15-02-032 100.0 82 15-02-082 100.1

33 15-02-033 100.0 83 15-02-083 100.1

34 15-02-034 100.0 84 15-02-084 100.0

35 15-02-035 100.2 85 15-02-085 100.1

36 15-02-036 100.3 86 15-02-086 100.1

37 15-02-037 100.1 87 15-02-087 100.1

38 15-02-038 100.0 88 15-02-088 100.0

39 15-02-039 100.1 89 15-02-089 100.1

40 15-02-040 100.1 90 15-02-090 100.0

41 15-02-041 100.0 91 15-02-091 100.1

42 15-02-042 100.1 92 15-02-092 100.0

43 15-02-043 100.0 93 15-02-093 100.0

44 15-02-044 100.0 94 15-02-094 100.0

45 15-02-045 100.1 95 15-02-095 100.0

46 15-02-046 100.1 96 15-02-096 100.1

47 15-02-047 100.0 97 15-02-097 100.0

48 15-02-048 100.0 98 15-02-098 100.0

49 15-02-049 100.0 99 15-02-099 100.0

50 15-02-050 100.1 100 15-02-100 100.0



275

표 3.3.2.5. 균질도 결과값

No. Sample I.D. Cs-137(count) Uncertainty

1 15-02-072 2630 66

2 15-02-061 2686 68

3 15-02-016 2759 65

4 15-02-021 2733 65

5 15-02-007 2808 68

6 15-02-038 2692 66

7 15-02-044 2750 67

8 15-02-053 2743 64

9 15-02-089 2639 69

10 15-02-096 2700 64

Mean 2714

Standard deviation 55

Relative Standard
deviation 2.0 %

Uncertainty

* 관련절차서/관련보고서

- 고체상 및 액체상 매질의 유기물 CRM 제조 절차서(한국표준과학연구원 문서번호:

R-108-001-2002)

- 국가 인증표준물질 체계 확립 과제 보고서(한국표준과학연구원 문서번호:

R-108-001-2002), 제2장

- 2008년 검사능력관리를 위한 표준시료 개발 및 기준값 설정 연구, 한국표준과학연구원
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3. 숙련도 시험 및 평가

개발된 농축수산물기준물질을 이용하여 본 과제에 참여하고 있는 연구기관들을 대상으로 숙

련도 시험을 수행한다. 이 숙련도 시험은 실제 시료를 개발된 신속분석법 및 이동형 방사능 측

정 장비에 대한 성능, 효율 및 유효성을 평가하는데 이용하였다. 참여기관이 제공한 결과는 한

국표준과학연구원이 설정한 기준값과의 차이(Relative Bias), 참값 (Trueness), 정밀도

(Precision)를 종합적으로 산정하여 만족(In agreement), 주의 (Questionable), 불만족

(Discrepant)등으로 평가하였다.

가. 차이 (Bias Relative, %)

차이 (Bias Relative, %) = 

 ×

ValueRef = 기준값

ValueLab = 참가기관의 결과

참가기관의 차이가 MAB (Maximum Acceptable Bias) 여기서는 만약 15% 이내이면 만

족(Pass), 15% 이상일 경우 불만족(Fail)으로 평가한다.

나. 참값 (Trueness, based on U-test)

평가에 이용된 Trueness 계산식은 다음과 같다.

  ≥
 





Unc2Lab : 참가기관 결과의 불확도

Unc2Ref :　기준값의 불확도

　　　

가 × 
 


보다 작을 경우 만족(Pass)으로

평가한다.

다. 정밀도 Precision (%)

　　Pr







 ×

　 　　Unc2Lab : 참가기관 결과의 불확도

Unc2Ref :　기준값의 불확도
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ValueLab : 참가기관의 결과

　　참가기관의 차이가 만약 LAP (Limit of precision) 여기서는 15 % 보다 작을 경우 만족

(Pass)으로 평가한다. 이상 상기 3 식을 이용, 결과를 종합 평가하는 기준은 다음과 같이 하여

최종 평가하였다.

Bias Relative Trueness Precision Final Evaluation
Pass Pass Pass In agreement

Fail Pass Pass Discrepant
Pass Fail Pass Questionable
Pass Pass Fail Questionable
Fail Fail Pass Discrepant
Fail Pass Fail Discrepant
Fail Fail Fail Discrepant
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그림 3.3.3.1. 1차년도 기준물질을 이용한 방사능 숙련도 시험결과
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그림 3.3.3.2. 2차년도 기준물질을 이용한 방사능 숙련도 시험결과(1)
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그림 3.3.3.3. 2차년도 기준물질을 이용한 방사능 숙련도 시험결과(2)
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그림 3.3.3.4. 2차년도 기준물질을 이용한 방사능 숙련도 시험결과(3)
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그림 3.3.3.5. 수산물(해조류) 기준물질을 이용한 방사능 숙련도 시험결과
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그림 3.3.3.6. 축산물(계란) 기준물질을 이용한 방사능 숙련도 시험결과
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그림 3.3.3.7. 농산물(옥수수) 기준물질을 이용한 방사능 숙련도 시험결과
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제 4 장  목표달성도 및 관련 분야에의 기여도

□ 제1세부

과제별
구분
(연도)

연구개발목표 달성도 기여도

1

세부

과제

(한국

원자력

연구원)

1차년도

(2013)

Ÿ 실험실 정밀 분석법 개

선 및 신속분석법과의

연계기술 도출

100

Ÿ 교정선원 summing effect 효과

보정기술 및 밀도보정기술을 통

해 실험실 정밀 분석법 개선

Ÿ 신속분석법에 적용 가능한 교정

선원 이용한 밀도 및 summing

effect 동시보정기술 개발

Ÿ 수입 장비 현장 신속검

사와 실험실 정밀분석
100

Ÿ 수산물 시료 10개 품목 20개 이

상 시료 방사능 모니터링

Ÿ 자문회의 및 진도점검

회의 개최
100

Ÿ 업계, 학계, 정부, 연구계를 포함

한 자문회의 개최를 통한 과제

점검

Ÿ 진도점검회의를 통한 과제 간 긴

밀한 협조 및 교차분석 수행

Ÿ 방사능분석관련 워크숍 2회 개최

를 통해 방사능 분석법 논의

2차년도

(2014)

Ÿ 방사능검출하한치에 따

른 분석시간 결정과 정

량한계 설정, 불확도

요인 산출

100

Ÿ 정밀분석 및 신속분석법에 적용

할 수 있는 방사능검출하한치

(MDA)에 따른 분석시간 결정

Ÿ 정량한계 설정 및 불확도 요인을

산출함으로써 방사능 분석시 고

려해야 할 요인 제시

Ÿ 직접법을 이용한 전처

리법 절차화 및 RM

이용 교차분석

100

Ÿ 비상시 현장에서 적용가능한 전처

리법절차서제시

Ÿ RM을이용한개발장비비교평가

Ÿ 수산물 시료 방사능 분

석
100

Ÿ 수산물 시료 10개 품목 20개 이

상 시료 방사능 모니터링

Ÿ 기술자문위원회 및 과

제 진도관리
100

Ÿ 년2회 이상 자문회의 개최 및 3

회 이상 과제진도관리를 통한

과제 목표 점검
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과제별
구분
(연도)

연구개발목표 달성도 기여도

1

세부

과제

(한국

원자력

연구원)

3차년도

(2015)

Ÿ 주요 농·축·수산물 중

방사능의 정성 및 정량

분석법 확립

100

Ÿ 현장에서 방사성요오드 및 방사

성 세슘의 규제치 초과여부를 신

속 검사할 수 있는 분석법 확립

Ÿ 평상시 및 비상시 개발장비 운용

방법 확립 및 매뉴얼 제시

Ÿ 농식품 중 방사능 실험

실 확인검사 연계 현장

신속검사 매뉴얼 개발

(시료채취, 분석 및 평

가절차서 포함)

100

Ÿ 실제 현장에서 분석법 적용평가

Ÿ 기준물질 및 실제 농식품 비교

분석

Ÿ 수산물 중 방사능 검사

법 현장적용 및 신뢰성

확인

100

Ÿ 수산물 시료 10개 품목 20개 이

상 시료 방사능 모니터링

Ÿ 수산물에 대한 신속분석법 적용

방법 제시

Ÿ 국내외 농식품 중 방사

능 검사관리 현황 조사

를 통한 개선방안 마련

100
Ÿ 국내외 방사능 검사관리 체계

개선안 제시

Ÿ 자문회의 및 진도점검

회의 개최
100

Ÿ 산업계, 학계, 정부, 연구계를

포함한 자문회의 및 과제진도

점검회의를 통한 과제 진행방

향 점검 및 목표 달성
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□ 제1협동

과제별
구분
(연도)

연구개발목표 달성도 기여도

1

협동

과제

(네오

시스

코리아)

1차년도

(2013)

Ÿ 방사능 분석장비 전자

부 및 차폐체 설계 및

분석프로그램 개발

100

Ÿ 국내외 식품 방사능 현장 분

석장비 자료 조사를 통한 기

술현황 및 특허동향 파악

Ÿ NaI(Tl) 및 HPGe 검출기 겸

용이동형 방사능 분석장비 설

계 기준 마련

Ÿ 식품분석 DB 프로그램 개발

을 통한 정보관리 편의성 및

효율성 제공

2차년도

(2014)

Ÿ NaI(Tl) 검출기형 분석

장비 Prototype 제작 및

성능 검증

100

Ÿ 납차폐체 및 카트의 안전해석

및 MDA 평가 등을 통해 이

동형 방사능 분석장비 관련

납차폐체 및 카트의 기준 제

시

Ÿ 일체형 프리앰프 및 NaI(Tl)

용 MCA 개발을 통해

NaI(Tl) 검출기형 이동형 방

사능 분석장비의 기초 기술

확립 및 신뢰도 검증

Ÿ 방사능 분석장비 분석

프로그램 설계
100

Ÿ 상용 방사능 핵종분석 프로그램

인 Genie2K, GammaVision 등

의 분석을 통해 상용제품의 기

술수준 파악

Ÿ 방사능 핵종분석 프로그램 개념

설계 및 플로우 차트 작성, 핵종

분석 알고리즘 정립, 프로토콜

및 데이터 포맷 정립, 분석보고

서 포맷 정립 등을 통해 농식품

방사능 분석용 핵종분석 프로그

램의 기준안 마련

Ÿ HPGe 검출기형 분석장

비 설계
100

Ÿ 디지털 방식의 NaI(Tl) 및

HPGe 검출기 겸용 MCA 설

계 기술 수립

Ÿ HPGe 검출기형 이동형 방사

능 분석장비의 기초 기술 확

립
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과제별
구분
(연도)

연구개발목표 달성도 기여도

1

협동

과제

(네오

시스

코리아)

3차년도

(2015)

Ÿ HPGe 검출기형 분석

장비 시제품 제작 및

성능 검증

100

Ÿ NaI(Tl) 및 HPGe 검출기 겸

용이 가능하고 내부 배터리를

이용하여 장시간 측정이 가능

한 독립형 MCA 기술 개발

및 상용제품 수준의 신뢰성

검증

Ÿ 장비제어, 측정, 교정, 핵종분

석, 저장, 보고서 출력 등의

모든 기능이 구현된 방사능

핵종분석 한글프로그램의 국

내최초 개발 및 신뢰성 검증

Ÿ 비전문가가 사용가능하도록

한글 프로그램 매뉴얼 및 표

준분석절차서 제공

Ÿ HPGe 검출기형 이동형 방사

능 분석장비의 기초 기술 확

립 및 신뢰도 검증

Ÿ NaI(Tl) 및 HPGe 검출기 겸

용 이동형 방사능 분석장치

시제품 제작 및 한국표준연구

원 식품 RM 시료분석을 통한

신뢰성 검증을 통한 상용제품

수준의 기술 확보

Ÿ 국립농산물품질관리원과 삼성

웰스토리 현장적용 실험을 통

해 이동형 신속분석 장치로써

의 효용성 입증

Ÿ 방사능 검사장비 시제

품 제작 및 특허 출원
100

Ÿ 2건의 특허출원을 통해

NaI(Tl) 및 HPGe 검출기 겸

용 이동형 방사능 분석장치의

원천기술 확보

Ÿ 대한방사선방어학회 2015년 추

계학술대회 전시를 통해 제품화

가능성 확인
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□ 제2협동

과제별
구분
(연도)

연구개발목표 달성도 기여도

2

협동

과제

(한국

표준

과학

연구원)

1차년도

(2013)

Ÿ 농산물(쌀) 기준물질 (고/

저준위 1품목, 총 2종)

Ÿ 축산물(쇠고기) 기준물질

(고/저준위 1품목, 총 2종)

Ÿ 수산물(대구) 기준물질

(고/저준위 1품목, 총 2종)

Ÿ 숙련도시험실시

100

Ÿ 본 과제 참여기관(산·학·

연)을 대상으로 개발된

RM을 사용하여 숙련도시

험을 수행함으로서 각 기

관의 농·축·수산물 방사능

측정 품질관리에 기여

2차년도

(2014)

Ÿ 세슘-137 등 감마핵종을

포함한 농, 수, 축산물 기

준물질제조

Ÿ 농산물(밀가루) 기준물질

(고/저준위 1품목, 총 2종)

Ÿ 축산물(분유)기준물질 (고

/저준위 1품목, 총 2종)

Ÿ 수산물(굴) 기준물질 (고/

저준위 1품목, 총 2종)

Ÿ 숙련도시험실시

100

Ÿ 본 과제 참여기관(산·학·

연)을 대상으로 개발된

RM을 사용하여 숙련도시

험을 수행함으로서 각 기

관의 농·축·수산물 방사능

측정 품질관리에 기여

Ÿ 농산물(밀가루) 인증표준물

질 (CRM) 제조, 1 품

목

100

Ÿ 국내외에서 처음으로 밀가루

를 이용한 방사능측정용 인증

표준물질개발

Ÿ 국내 및 국제비교시험물질로

사용예정

3차년도

(2015)

Ÿ 세슘-137 등 감마핵종을

포함한 농, 수, 축산물 기

준물질제조

Ÿ 농산물(옥수수) 기준물질

(고/저준위 1품목, 총 2종)

Ÿ 축산물(계란)기준물질 (고

/저준위 1품목, 총 2종)

Ÿ 수산물(해초류) 기준물질

(고/저준위 1품목, 총 2종)

Ÿ 숙련도시험실시

100

Ÿ 본 과제 참여기관(산·학·

연)을 대상으로 개발된

RM을 사용하여 숙련도시

험을 수행함으로서 각 기

관의 농·축·수산물 방사능

측정 품질관리에 기여

Ÿ 축산물(닭고기) 인증표준물

질 (CRM) 제조, 1 품

목

100

Ÿ 국내외에서 처음으로 닭고기

를 이용한 방사능측정용 인증

표준물질개발

Ÿ 국내 및 국제비교시험물질로

사용예정
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□ 제3협동

과제별
구분
(연도)

연구개발목표 달성도 기여도

3

협동

과제

(방사선

보건원)

1차년도

(2013)

Ÿ 기존 수입 장비를 이용

한 축산물중 방사능 신

속분석법의 적용성 검

증

100

Ÿ 제 2과제에서 제작한 기준

물질을 이용하여 방보원 보

유 HPGe 감마선 검출기 성

능을 검사하고 이 연구에서

개발할 이동형 NaI/HPGe

감마선 검출기를 이용한 축

산물 방사능 신속 분석법

매뉴얼 작성 기반을 조성함

Ÿ 국내·외 방사능 검사관

리 현황조사
100

Ÿ 일본 농림수산성을 포함한

정부기관의 식품 방사능 관

리 현황을 조사하고 보고서

에 반영함

2차년도

(2014)

Ÿ 축산물 중 방사능 신속

분석법 확립
100

Ÿ 방보원 실험실 고정형

HPGe를 이용하여 축산물

기준물질 방사능을 측정한

후 이 과제를 통하여 개발

한 이동형 NaI 감마선 검출

기로 방사능을 1,800초 측정

한 후 상호 측정효율을 비

교하여 현장 활용성을 검토

함

Ÿ 국내/수입 축산물을 신체 부

위를 종합한 것과 부위를

구분한 것으로 구분하여 방

사능을 측정함으로써 방사

선 사고시 현장에서 검사

효율을 향상 시킬 수 있는

방법론적 기초를 마련함

Ÿ 축산물 기준물질 분석 결과

를 교차분석하고 이 결과를

바탕으로 축산물 신속분석

매뉴얼을 작성함

Ÿ 안정적 핵종분석을 위한 말

리넬리 비이커 보정용기 개

발하여 국내 특허출원하고

분석 기술력을 제고함

Ÿ K-40 농도 변화를 이용한 천

일염 생산년도 추정법을 국내

출원하였고, 환경 방사능 영향

평가를 위한 방법론으로 활용

하려함

Ÿ 원전사고 지역 국가의

방사능검사 관리 현황

조사

100

­ 후쿠시마 사고 후 일본 학술

계의 방사능 검사법 등 변화

를 보고서에 반영함
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과제별
구분
(연도)

연구개발목표 달성도 기여도

3

협동

과제

(방사선

보건원)

3차년도

(2015)

Ÿ 방사능 실험실 확인검

사 연계 현장 신속검사

매뉴얼 검증

100

Ÿ 방보원 실험실 고정형

HPGe를 이용하여 축산물

표준물질 방사능을 측정한

후 이 과제를 통하여 개발

한 이동형 HPGe 감마선 검

출기로 방사능을 1,800초 측

정한 후 상호 측정효율을

비교하여 현장 활용성을 확

인함

Ÿ 국내/수입 축산물을 부위별

로 방사능을 측정함으로써

방사선 사고시 현장에서 검

사 효율을 증가시킬 수 있

게 됨

Ÿ 1~2차년도에서 작성한 시료

채취, 전처리 및 분석방법,

검사기관 간 역할 및 체계,

절차 등을 확인하는 과정을

거쳐 절차서 표준화 완료

Ÿ 안정적 핵종분석을 위한 말

리넬리 비이커와 소형 측정

병 겸용 보정용기 개발하여

국내 및 국제 특허출원하고

분석 기술력을 제고함

Ÿ K-40 농도 변화를 이용한 천

일염 생산년도 추정법을 국제

특허 출원하였으며, 향후 환경

방사능 영향 평가를 위한 기

반적 방법론으로 활용 가능함

Ÿ 방사능 재난사고 대비

농식품 검사기관의 신

속검사 대응 매뉴얼 마

련

100

­ 3년간 연구결과를 정리하여

축산물 방사능 신속 분석 매

뉴얼을 작성하였으며, 축산물

신체 부위별 방사능 측정법

을 국가 방사능 정책에 반영

토록 제안할 예정임
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□ 제4협동

과제별
구분
(연도)

연구개발목표 달성도 기여도

4

협동

과제

(한국

소비자

원)

1차년도

(2013)

Ÿ 기존 실험실 장비를

이용한 농산물 중 방

사능 신속분석법의 검

증 및 이동형 장비를

이용한 농산물 중 방

사능 비교 분석 : 기준

물질 및 인증표준물질

(8종)

100

Ÿ 2협동 과제에서 개발한 농,수,축산물

RM(고준위 및 저준위) 6종 및 국내

외에서 개발된 인증표준물질 2종(쌀

CRM, 현미CRM)에 대한 결과값 비교

분석을 통한 분석 결과 신뢰도 검증

Ÿ 시중 유통 중인 수입 및 국산 농식품

방사능 모니터링 결과, 검출된 제품을

대상으로 결과값 상호 비교분석을 통

한 개발 이동형 장비 성능 평가검증

Ÿ 국내 및 수입 농산물

중 방사능 분석 : 10개

품목 30개 시료

100

Ÿ 수입 및 국내 유통되는 차류 10개 품목

30개 시료 및 국민 다소비 농식품인 커

피, 버섯, 배추, 소금 및 원전주변 토양

시료(92개 품목 192개 시료) 등에 대한

모니터링을 통해 식품 안전성 확보

Ÿ 검출제품을 대상으로 장비, 분석시간별

MDA 비교분석를 통한 신속분석법 개

발의 기초자료 제공

Ÿ 원전사고 지역(국외)의

방사능 검사법, 문제점

및 신속 대응체계 등

조사

100

Ÿ 일본 후생노동성, 소비자청, 방사선의학

총합연구소와 간담회 등을 통한 리스크

커뮤니케이션 방안 벤치마킹

Ÿ 국내 방사능검사 민

간기관의 검사관리

현황조사 및 문제점

파악

100

Ÿ 방사능분석 유관기관에 대한 실태점검

및 인증표준물질 교차분석을 통한 관련

기관 분석 결과 신뢰도 향상 및 문제점

개선

2차년도

(2014)

Ÿ 기존 실험실 장비를

이용한 농산물 중 방

사능 신속분석법의 검

증 및 이동형 장비를

이용한 농산물 중 방

사능 비교 분석 : 기준

물질 및 인증표준물질

(6종)

100

Ÿ 현행 실험실기반 방사능 측정장비와

외산 이동형 장비를 이용한 농산물

중 방사능 측정 결과값 비교분석을

통한 개발 이동형 장비 성능 평가검증

Ÿ 2협동 과제에서 개발한 농,수,축산물

RM(고준위 및 저준위) 6종 및 국내

외에서 개발된 인증표준물질 2종(쌀

CRM, 현미CRM)에 대한 결과값 비교

분석을 통한 분석 결과 신뢰도 검증

Ÿ 국내 및 수입 농산물

중 방사능 분석 : 10개

품목 30개 시료

100

Ÿ 국내 유통 중인 일본 수입 주류(청주)

10개 품목 30개 시료 및 국민다소비농

식품인 현미, 맥주, 소스류, 어묵 및 화장

품시료등(71개품목 141개시료)에 대한

모니터링을통해식품안전성확보

Ÿ 국외(미국)의 방사능 검

사법, 문제점및신속대

응체계등조사

100

Ÿ 미국 방사능 검사법 및 신속대응체계

등의 조사를 통해 국내 방사능 체계

문제점 파악 및 개선점 파악

Ÿ 수도권거주소비자(300

명 이상)를 대상으로

원자력 및 방사능 안전

관련소비자인식조사

100

Ÿ 방사능 안전과 관련한 올바른 정보제공

및 쌍방향 커뮤니케이션 방안제시를

위한 기초자료 수집
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과제별
구분
(연도)

연구개발목표 달성도 기여도

4

협동

과제

(한국

소비자

원)

3차년도

(2015)

Ÿ 수입 장비 및 국내 개

발 장비(NaI, HPGe)를

이용한 농산물 중 방

사능 비교 분석 : 기준

물질 및 인증표준물질

(6종)

100

Ÿ 이동형 방사능측정 외산장비(Food-

screen)와 국내개발 이동형 장비(NaI)를

이용한 농산물 및 2협동 과제에서 개발한

농,수,축산물 RM(고준위 및 저준위) 종에

대한 방사능 측정 결과값 비교분석을

통한 개발 이동형 장비 성능 평가검증

Ÿ 국내 및 수입 농산물

중 방사능 분석 : 10개

품목 30개 시료

100

Ÿ 수입 및 국내 유통되는 농산물 10개

품목 30개 시료 및 국민 다소비 농식

품인 버섯과 수입 식품(메밀국수, 훈제

연어 등) 및 화장품 등의 시료(46개 품

목 94개 시료)에 대한 모니터링을 통한

식품 안전성 확보

Ÿ 검출제품을 대상으로 장비, 분석시간별

MDA 비교분석을 통한 신속분석법 개

발의 기초자료 제공

Ÿ 기준물질 교차분석

수행(2 협동과제 주

관)

100

Ÿ 2협동 과제에서 개발한 농,수,축산물

RM(고준위 및 저준위) 종에 대한 결과값

비교분석을 통한 측정 결과의 신뢰도

향상

Ÿ 방사능분석 유관기관에 대한 실태점검

및 인증표준물질 교차분석을 통한 관련

기관 분석 결과 신뢰도 향상 및 문제점

개선

Ÿ 국내 개발 장비(NaI,

HPGe)를 이용한 농

산물의 방사능 신속분

석법 개발

100
Ÿ 비상시 신속․정확하게 분석 가능한

분석법 개발

Ÿ 방사능 안전과 관련

한 올바른 정보제공

및 쌍방향 커뮤니케

이션 방안 강구

100

Ÿ 2차년도 설문조사 결과를 바탕으로

전문가 자문회의 및 포럼 등 개최하여

리스크커뮤니케이션 방안 강구
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제 5 장  연구개발 성과 및 성과활용 계획

1. 주요 연구성과

□ 정량적

가. 특허

(1) 국내특허

·이동용 조립식 방사능 측정장치 (출원번호 : 10-2015-0170882)

·케이스 내장형 휴대형 조립식 방사능 측정장치 (출원번호 : 10-2015-0170947)

·안정적인 방사성 핵종분석을 위한 신형 말리넬리 비이커 보정용기

(출원번호: 10-2014-0180466)

·K-40 농도를 이용한 천일염 생산연도 감별법 (출원번호: 10-2014-0180465)

·안정적인 방사성 핵종분석을 위한 신형 말리넬리 비이커와 소형 측정병 겸용

보정용기 (출원번호: 10-2015-0102368)

(2) 국제특허

·안정적인 방사성 핵종분석을 위한 신형 말리넬리 비이커 보정용기

(출원번호: PCT/KR2015/008153)

·K-40 농도를 이용한 천일염 생산연도 감별법 (출원번호: PCT/KR2015/008152)

·안정적인 방사성 핵종분석을 위한 신형 말리넬리 비이커와 소형 측정병 겸용

보정용기(출원번호: PCT/KR2015/008154)

나. 소프트웨어

(1) NeoGMA(감마 핵종분석 프로그램) (등록번호 : 제C-2015-032066호)

(2) NeoFRDB(식품방사능 DB 프로그램) (등록번호 : 제C-2015-032067호)

다. 논문

(1) Measurement of 137Cs in the soil in Korea by low-level background

gamma-ray spectrometer, Journal of Radioanalytical and Nuclear Chemistry,

296, 721-725, 2013

(2) Evaluation of three electro-deposition procedures for uranium, plutonium

and americium, Applied Radiation and Isotope, 87, 233-237, 2014

(3) Atmospheric input of 137Cs and 239,240Pu isotopes in Korea after the

Fukushima nuclear power plant accident, Applied Radiation and Isotope, 87,

53-56, 2014

(4) A preliminary study for the development of reference material using oyster
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for determination of 137Cs,90Sr and plutonium isotopes. Applied Radiation

and Isotopes (accepted)

(5) Determinations of the exposure rate using a Na(Tl) detector of the

environmental radiation monitoring, 한국방사성폐기물학회지, 11, 245-251,

2013

(6) Survey study on radioactivity of domestic fishery product, 한국식품과학회

지, 47(6), 1-4, 2015

(7) Dependence Evaluation of the Self-Absorption Correction Factor for p-type

High Purity Germanium Detector Characteristics, 한국방사성폐기물학회지,

2015

(8) Rapid Analysis of Gamma Radionuclides for Foodstuffs, Journal of

Radiation Protection and Research. [submitted]

(9) An Investigation of Awareness on the Fukushima Nuclear Accident and

Radioactive Contamination. Journal of Radiation Protection and Research.

[accepted]

(10) NaI(Tl) 및 HPGe 검출기 겸용 이동형 방사능 분석장비 개발, 대한방사선방

어학회 [submitted]

(11) Differential expression of cancer regulatory DNA repair and damage

pathway related genes in low-dose-rate irradiated ICR and AKR/j mice.

Cancer Control [submitted]

라. 제품화

(1) 이동형 식품방사능 측정장비 (모델명 : NRGS-HN03)

(2) 가방형 식품방사능 측정장비 (모델명 : NRGS-N20M)

(3) 탁상형 식품방사능 측정장비 (모델명 : NRGS-N20L)

마. 정책

(1) ‘농식품 중 방사능 정밀분석 절차서’ 정책제안 (식품의약품안전처)

(2) ‘방사능 안전 리스크커뮤니케이션 방안’ 정책제안 (식품의약품안전처)

바. 교육지도

(1) 2015년 동계 소비자교육 교사연수. 「식품안전의 이해」 (2015. 1. 9, 한국공

정거래조정원 회의실)

(2) 2015년 동계 소비자교육 교사연수. 「식품안전의 이해」 (2015. 1. 16, 농협

대학 회의실)

(3) 2015년 동계 소비자교육 교사연수. 「식품안전의 이해」 (2015. 1. 23, 한국
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공정거래조정원 회의실)

(4) 2015년 소비자행정 및 법령 실무연수. 「식품안전의 이해」 (2015. 3. 26, 한

국소비자원 회의실)

(5) 강원도 지역소비자 전문가 대상 소비자보호 실무연수. 「사례를 중심으로 살

펴보는 식·의약품 안전의 이해」 (2015. 7. 9, 한국소비자원 회의실)

(6) 2015년 하반기 소비자교육 교사연수. 「식품안전과 위해정보」 (2015. 7. 29,

건국대 쿨하우스 연수원 회의실)

(7) 2015년 하반기 소비자교육 교사연수. 「식품안전과 위해정보」 (2015. 8. 5,

한국소비자원 회의실)

(8) 군포의왕교육지원청 초·중·고 영양(교)사 대상 교육.「방사능-식품안전에 대

한 오해」 (2015. 9. 3, 군포의왕교육지원청 회의실)

(9) 식품 방사능 안전과 소비자 리스크커뮤니케이션 방안 마련을 위한 식품안전

포럼 주제발표. 「일본 원전사고 및 방사능 오염 인식조사-식품안전 리스크

커뮤니케이션 전략 수립」(2015. 11. 6, 서울대한상공회의소 회의실)

사. 언론홍보

(1) 일본산 화장품 제품 방사능 오염 여부 모니터링 결과 (2014년 5월호, 소비자

시대)

(2) 식품 방사능 모니터링 및 소비자 인식조사 결과 (2015년 3월호, 소비자시대)

(3) 일본 후쿠시마 원전사고 및 방사능 오염 인식조사 결과 (2015. 1. 26, 언론홍

보)

(4) 식품 방사능 안전과 소비자 리스크커뮤니케이션 방안 마련 식품안전포럼

(2015. 11. 6, 언론홍보)

(5) 대한방사선방어학회 2015년 추계학술대회 (서울, 2015.10.23.)

□ 정성적

가. 농식품 중 방사능 신속분석법 확립 및 국내 방사능 검사관리 체계 개선

Ÿ 실험실 정밀분석법 개선을 위한 교정선원 summing effect 효과 및 밀도보정기

술을 개발하였으며 신속분석법과의 연계를 위해 교정선원 이용 밀도 및

summing effect 효과 동시보정 방법을 제안하였다. 특히 생체 시료와 동일한 표

준인증물질 또는 기준물질을 이용하면 밀도 부분은 쉽게 해결할 수 있다. 또한

농·축·수산물 중 MDA에 따른 분석시간 결정 및 정량한계를 설정하고 불확도

요인을 산출함으로써 농·축·수산물 중 방사능의 정성 및 정량 분석법을 확립하

였다.

Ÿ 비상시 현장에서 적용가능한 전처리법 절차서를 구축하고 개발된 감마선 검출기
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및 분석프로그램에 대한 분석 절차서를 작성하였다. 또한 실제 농·축·수산물 검

역 장소에서 개발 장비 및 분석법의 현장평가 등을 통해 이를 평가하였다.

Ÿ 농·축·수산물에 대해 20개 품목 60개 시료 이상 방사능 모니터링을 수행하였으

며 개발 장비를 이용하여 실제 분석을 수행함으로써 장비에 대한 평가 및 실제

현장에서의 적용성을 평가하였다.

Ÿ 국내·외 방사능 관리체계 및 현황을 조사하고, 각 국가별 방사능분석방법을 비교

검토함으로써 현행 방사능 분석 및 관리체계의 문제점을 파악하고 개선안을 제

시하였다.

Ÿ 방사능 및 식품안전과 관련한 국내외 정보 수집, 인식 조사, 전문가 자문 및 세

미나 등을 통해 올바른 정보제공 및 쌍방향 커뮤니케이션 방안을 제시하였다.

나. 이동형 방사능 분석 장비 개발

Ÿ 농식품 중 방사능 신속분석에 적합한 이동형 방사능 분석장비 두 종류,

NaI(Tl) 및 HPGe 검출기를 개발하였다. 본 장비는 이동이 가능하고, 현장에서

신속하게 분석할 수 있는 장점이 있다. 특히 하나의 다중파고분석기(NeoMCA)

를 이용하여 두 검출기에 동시 적용이 가능하다. 또한 NeoMCA는 디지털 펄스

프로세서(Digital Pulse Processor)를 이용하여 계측 및 신호처리부를 단순화 및

소형화 하였으며, Li-ion 배터리를 내장하여 외부전원 없이 8시간 정도 측정이

가능하다. 이동형 방사능 분석장비의 차폐체는 납으로 제작하였으며, 신속분석에

필요한 실용성, 이동 편의성, 조립 편리성을 고려하여 10 kg 이하의 9조각으로

제작하였다. Cs-137 핵종을 이용하여 평가한 본 차폐체의 최소검출방사능

(MDA)는 NaI(Tl) 검출기에서는 6.65 Bq/kg, HPGe 검출기에서는 3.1 Bq/kg이었

다. 이동형 카트는 이동성, 차량 적재 용이성, 휴대성 등을 고려하여 접이식으로

제작하였다. HPGe 검출기와 결합한 후 Co-60 핵종을 이용하여 NeoMCA의 분

해능을 평가한 결과 1173 keV 피크에서의 FWHM은 2.59 keV, 1332 keV에서의

FWHM은 2.70 keV로 각각 산출되어 신속분석에 적합하였다.

Ÿ 방사능 분석용 농식품 시료에 대한 정보를 종합적으로 관리할 수 있는 식품분석

DB 프로그램 개발하였다. 본 DB 프로그램은 로그인, 시료 정보 입력, 전처리 정

보 입력, 측정 데이터 관리, 검사기록서 출력, DB 검색 및 열람, 측정장비 QA

관리 등의 기능을 갖으며, 대량의 분석자료로부터 농식품 시료의 신속한 방사능

경향 파악 및 다양한 통계처리가 가능하다는 장점이 있다.

Ÿ 이동형 방사능 분석장비로부터 측정된 농식품 시료의 감마선 스펙트럼을 실시간

으로 화면에 표시하며, 측정완료 후에는 시료의 핵종식별 및 방사능, MDA 등의

분석이 가능한 감마핵종분석 프로그램(NeoGMA)을 개발하였다. 본 NeoGMA 프

로그램은 NaI(Tl) 및 HPGe 검출기 각각에 대하여 방사능 측정장비 제어, 감마

선 스펙트럼 표시, 방사능 검출기 교정, 감마 핵종분석, 파일 저장, 보고서 출력
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등이 가능하다. 특히 프로그램의 모든 메뉴를 한글로 작성하고 메뉴 구성을 직

관적으로 표현하여 현장에서 비전문가에 의한 운용이 가능하도록 하였다. 이와

함께 농식품 시료의 방사능 분석 시 시료정보의 빠른 입력과 입력시 오류를 최

소화하기 위하여 식품분석 DB 프로그램과 연동 가능하도록 제작하였다.

Ÿ 본 연구에서 개발한 이동형 방사능 분석장비의 신뢰성 확보를 위해 상용장비

(Canberra Lynx MCA & Genie2k 프로그램)와의 비교측정을 우선 수행하였다.

교정용 인증표준물질(CRM)을 이용하여 NaI(Tl) 및 HPGe 검출기 각각에 대하

여 에너지 선형성, 계수율, FWHM를 비교한 결과 서로 매우 유사함을 알 수 있

었다. 다음으로 한국표준연구원에서 제작한 Rice High RM 시료를 대상으로

Cs-137 핵종의 방사능을 측정한 결과 이동형 방사능 분석장비의 NaI(Tl) 검출

기에서는 66.62 ± 3.75 Bq/kg, HPGe 검출기에서는 60.98 ± 3.76 Bq/kg이 산출되었다.

상용장비에서 측정된 값은 NaI(Tl) 검출기 66.62 ± 3.75 Bq/kg, HPGe 검출기 60.98

± 3.76 Bq/kg로 오차범위 내에서 모든 값이 일치하였다. 이로부터 본 연구에서 개발

된 이동형 방사능 분석장비의 신뢰성을 입증하였다. 이를 바탕으로 이동형 방사능 분

석장비를 이용하여 한국표준과학연구원에서 제작한 RM 시료(분유, 밀가루, 굴, 계

란, 해초, 옥수수)를 측정하였다. NaI(Tl) 및 HPGe 검출기 각각에 대하여 I-131,

Cs-134, Cs-137 핵종에 대한 방사능을 산출하였으며, 각 RM 시료의 방사능 값

은 표준과학연구원의 기준값과 오차범위 내에서 일치함을 확인하였다.

Ÿ 이동형 방사능 분석장비의 현장 적용성을 검증하기 위하여 국립농산물품질관리

원과 삼성웰스토리에서 현장측정을 수행하였다. 보관용 케이스에 담긴 분석장비

를 차량으로 이동한 후 현장에서 외부전원 없이 조립 및 교정, 측정, 핵종분석

등을 수행하였다. 총 4개의 농산물 시료(대파, 호박, 고추, 오이)를 대상으로

NaI(Tl) 및 HPGe 검출기 각각에 대하여 MDA 값을 산출한 결과 모두 목표치

(NaI(Tl) : 20 Bq/kg, HPGe : 3 Bq/kg)와 유사한 값이 산출되었다. 또한 I-131,

Cs-134, Cs-137 핵종에 대한 방사능 분석 결과 모두 MDA 이하로 산출되었다.

따라서 본 연구에서 개발된 이동형 방사능 분석장비는 측정 현장의 환경 및 측

정조건과 무관하게 모두 안정적으로 정상 동작됨을 확인하였다.

다. 농·축·수산물에 대한 표준인증물질 개발

Ÿ 세슘-137 등의 감마핵종을 포함한 농·축·수산물 기준물질을 제조하였으며, 과제

참여기관의 숙련도시험 및 개발된 이동형 장비의 비교평가에 활용됨으로써 방사

능측정의 품질관리에 기여하였다.

Ÿ 국내·외에서 처음으로 농·축·수산물인 밀가루, 멸치, 닭고기를 이용하여 인증표준

물질(CRM)을 개발하였다. 이는 국내 및 국제 비교시험물질로 사용할 예정이며

측정 데이터의 신뢰성 향상에 기여하고자 방사능측정기관에 보급할 예정이다.
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2. 연구성과 활용계획

○ 확립된 신속분석법을 기반으로 현장적용 및 검사체계 개선을 통해 예기치 못한

방사능 사고시 소비자에게 안전한 농식품을 공급하고 사회·경제적 피해를 최소

화한다.

○ 농식품 중 방사능 검사용 국산장비를 개발함으로써 원천기술을 확보하고 수입장비 대

체로 예산을 절감한다.

○ 개발된 기준물질 및 인증표준물질을 활용함으로써 분석결과의 신뢰성을 제고한다.

○ 수집된 자료를 바탕으로 국내 방사능 관련 관리 체계의 문제점을 파악하고 개

선을 위한 정책자료로 활용한다.

○ 국민인식조사 및 쌍방향 리스크 커뮤니케이션 방안을 활용하여 소비자의 불안을

해소한다.

3. 향후 계획

○ 2017년도 사업추진계획 수립 및 과제 기획을 위한 농림축산식품부/농촌진흥청

공동기술수요조사에 개발된 장비를 현장에 적용할 수 있는 과제 제안 예정

(과제 제목: 농축산업 현장 방사능 분석시스템 구축)

○ 개발된 장비 및 분석법을 정책저으로 적용할 수 있도록 농림축산식품부 또는

식약처 등 소관부처에 제안 예정
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<첨부 1>

< 특허, 논문 및 시장분석 〉

1. 본 연구와 관련된 기술의 국내외 수준 비교

기술명
관련기술
최고보유국

현재 기술수준
기술개발
목표수준 비고

우리나라
관련기술수준

연구사업단
보유기술수준

이동형 방사능 분석장비

- 분리형 납차폐체

- 다중파고 분석기

미국 70% 70% 100%

방사능 분석프로그램

- 농식품 DB 프로그램

– 핵종분석 프로그램

미국 70% 70% 100%

1) 기술명은 본 연구사업단과 관련(기보유기술 또는 향후 개발예정기술)된 기술을 기재

2) 현재 기술수준은 세계최고수준을 100%으로 할 때 우리나라 및 신청한 연구사업단의 기술수준 표시

3) 기술개발 목표수준은 연구사업단 종료시의 기술수준을 세계최고수준(100%) 대비 목표로 제시

4) 부가설명이 필요한 경우 비고란에 작성

2. 특허조사 분석

가. 특허조사 분석 범위

대상국가 국내, 국외(미국, 일본, 유럽)

특허DB 특허정보원(www.kipris.or.k), WIPS(www.wipscorp.com) 등

검색기간 1980. 01. 01. ～ 2015. 12. 31.

검색범위 전체

※ 특허조사․분석시 활용하였던 특허정보이용과 관련된 내용을 기재



나. 특허 조사․분석에 따른 본 연구과제와의 관련성

기술명 이동형 방사능 분석장비 방사능 분석프로그램

Keyword

radiation detector,

food screening,

multichannel analyzer,

mobile lead shield

radioactivity,

minimum detectable activity

radionuclide analysis program,

in-situ radioactivity analysis

검색건수 1831 4273

유효특허건수 7 15

핵심특허

및 관련성

특허명
다기능 방사성 감마핵종분석기 및

측정장치

True coincidence summing correction

and total efficiency computation for

radionuclide spectroscopy analysis

보유국 한국 미국

등록년도 2003.02.05. 2012. 10. 10.

관련성(%) 30 30

유사점 NaI(Tl) 및 HPGe 등의 검출기 사용 radionuclide spectroscopy analysis

차이점 식품 방사능 분석 식품 방사능 신속분석

핵심특허

및 관련성

특허명
Autocalibrating multichannel analyzer

and method for use

Methods to enhance nuclear spectroscopy

analysis

보유국 미국 미국

등록년도 1999. 12. 21. 2014. 08. 19.

관련성(%) 30 30%

유사점 multichannel analyzer nuclear spectroscopy analysis

차이점 NaI(Tl) 및 HPGe 검출기 겸용 식품 방사능 분석

핵심특허

및 관련성

특허명 감마핵종분석기의 방사선 차폐체
원전 대형 폐 금속기기의 방사능 측정

유효성 확인방법

보유국 한국 한국

등록년도 2003. 08. 13. 2013. 07. 08.

관련성(%) 30% 20%

유사점 외부 방사선 차폐 minimum detectable activity 측정

차이점 이동형 납차폐체
minimum detectable activity 알고리즘

적용

1) 기술명은 본 연구사업단과 관련(기보유기술 또는 향후 개발예정기술)된 기술을 기재

2) keyword는 검색어를 의미하며, 검색건수는 keyword에 의한 총검색건수를, 유효특허건수는 검색한 특허 중

연구사업단 관련기술과 관련성이 높은 특허를 의미

3) 기존특허는 검색된 특허중 연구사업단 관련기술과의 관련성이 높고 인용도가 높은 상위 3개 특허를 기준으

로 작성



3. 논문분석

가. 논문분석 범위

대상국가 전세계

논문 DB ScienceDirect (www.sciencedirect.com)

검색기간 2010. 01. 01. ～ 2015. 12. 31.

검색범위 제목, 초록 및 키워드

나. 논문분석에 따른 본 연구과제와의 관련성

기술명 이동형 방사능 분석장비 방사능 분석프로그램

Keyword rapid, in-situ, radioactivity, gamma reference material, radioactivity

검색건수 1049 1124

유효논문건수 915 35

핵심논문

및 관련성

논문명

Application of the Monte Carlo

method for the calibration of an

in-situ gamma spectroscopy

Certified reference material for

radionuclides in fish sample

IAEA-414 (mixed fish from the

Irish Sea and North Sea)

학술지명 Applied Radiation and Isotopes Applied Radiation and Isotopes

저 자 F. Tzika et al., Pham et al.,

게재년도 2010 2006

관련성(%) 100 80

유사점
시뮬레이션을 이용한

현장 감마 검출기 교정
기준물질

차이점 MCNP모델 사용 건조시료사용

1) 기술명은 본 연구사업단과 관련(기보유기술 또는 향후 개발예정기술)된 기술을 기재

2) keyword는 검색어를 의미하며, 검색건수는 keyword에 의한 총검색건수를, 유효논문건수는 검색한 논문 중

연구사업단 관련기술과 관련성이 높은 논문을 의미

3) 기존논문은 검색된 논문 중 연구사업단 관련기술과의 관련성이 높고 인용도가 높은 상위 3개 논문을 기준으

로 작성



4. 제품 및 시장 분석 ※ 최근의 자료를 기초로 작성하되, 각 내용별로 반드시 출처 명시

가. 생산 및 시장현황

1) 국내 관련(유사)제품의 생산 및 시장 현황

○ 현재 국내에서 생산하여 판매되고 있는 이동형 방사능 식품오염 신속검사장비는 전무한 상태

이며, ㈜네오시스코리아와 (주)뉴케어 등에서 개발한 일체형 검출장비를 활용한 방사능 식품

오염 검사장비가 있음.

○ 후쿠시마 원전사태 이후 식품과 관련된 방사능 분석 및 방사능 측정 장비에 관한 소비자의

인식이 증대되고 있으므로, 이동형 방사능 식품오염 신속검사장비에 대한 소비자의 수요가

확대될 전망임.

○ 검사장비 기준 국내 시장규모 : 27,300 백만원

- NaI 사용 검사장비 : 식약청 등 80여개 기관 , 7,500 백만원 규모

- HPGe 사용 검사장비 : 대학교 등 130여개 기관, 19,800 백만원 규모

NaI 사용 검사장비 (50백만원/대)

수요처 기관 수 예상 수요량 시장 규모

식약청 등 8 20 1,000백만원

농산물품질관리원 등 10 20 1,000백만원

검역검사본부 34 60 3,000백만원

원전 민간감시기구 5 10 500백만원

지자체 연구기관 23 40 2,000백만원

소 계 80 150 7,500백만원

HPGe 사용 검사장비 (150백만원/대)

수요처 기관 수 예상 수요량 시장 규모

식약청 등 8 10 1,500백만원

농산물품질관리원 등 10 10 1,500백만원

검역검사본부 34 34 5,100백만원

원전 민간감시기구 5 5 750백만원

지자체 연구기관 23 23 3,450백만원

대학교 및 기타 50 50 7,500백만원

소 계 130 132 19,800백만원

2) 국외 관련(유사)제품의 생산 및 시장 현황

○ 국외에서 생산되고 있는 이동형 방사능 식품오염 신속검사장비는 대표적으로 Canberra의

FoodScreen과 Ortec의 FoodGuard가 있음 (출처: Canderra사와 Ortec사의 제품 카탈로그)

○ 현재 해외의 식품 관련 기관 및 기업형 식품 유통사 등에서 사용 중.

○ 일본 후쿠시마 원전 사고이후 방사능 측정 장비 시장이 급속 성장하는 추세임.1)



○ 세계 시장규모 : 2,200백만$ (2012년 기준, 2조4천억원)

○ 2012년 세계시장규모는 2,200백만$이며, 과제 종료시점인 2015년의 예상시장규모는 2,600백만

$ 로 성장하는 시장에 대한 대응이 필요함.

  세계 검사장비 시장규모 및 성장 추세2)

1) http://www.homelandsecuritynewswire.com/radiation-detection-market-see-accelerated-growth

2) Radiation Detection Materials Markets 2011, NanoMarkets, LC

나. 연구사업단 보유(활용)기술의 산업화 계획 및 기대효과

1) 산업화․제품화 계획(제품의 특징, 대상 등)

○ 개발된 이동형 방사능 식품오염 신속검사장비는 국외 제품의 철저한 비교 분석을 통하여 상

대적으로 높은 효율을 가지며, 높은 백그라운드 저감효과를 지닌 차폐체로 구성되어 보다 신

속한 방사능 식품오염 검사가 가능

○ 제품의 사용대상으로는 식품분석을 담당하는 기관과 대형 식료품 생산 및 유통업체가 있음

○ 개발된 이동형 방사능 식품오염 신속검사장비의 국내외 판매를 위한 각종 인증 획득을 추진

할 예정임

2) 산업화를 통한 기대효과

(단위 : 백만원)

산업화 기준
항 목 1차년도 2차년도 3차년도 4차년도 5차년도 계

직접 경제효과 3,300 3,300 3,300 3,300 3,300 16,500

경제적 파급효과 4,200 4,200 4,200 4,200 4,200 21,000

부가가치 창출액 500 500 500 500 500 2,500

합계 8,000 8,000 8,000 8,000 8,005 40,000

※ 직접 경제효과 : 본 연구과제 개발기술의 산업화를 통해 기대되는 제품의 매출액 추정치

※ 경제적 파급효과 : 본 연구과제 개발기술의 산업화를 통한 농가소득효과, 비용절감효과 등 추정치

※ 부가가치 창출액 : 본 연구과제 개발기술의 산업화를통해기대되는수출효과, 브랜드가치등추정치



① 직접 경제효과 : 연간 3,300 백만원

- NaI 사용 검사기기 : 연간 예상수요량 50대 × 30백만원 = 1,500 백만원

- HPGe 사용 검사기기 : 연간 예상수요량 20대 × 90백만원 = 1,800 백만원

② 경제적 파급효과 : 연간 4,200 백만원

- 연구실용검사기기대체효과 : 연구실검사장비(150백만원) - HPGe사용검사기기(90백만원) = 60백만원

- HPGe 사용 검사기기 : 연간 예상 대체 수요량 15대 × 60백만원 = 900 백만원

- 직접 경제효과로 인한 수입 대체효과 : 3,300 백만원

③ 부가가치 창출액 : 연간 500 백만원

- 검사장비 개발 및 홍보 등으로 인한 브랜드가치 등 추정치 : 500백만원

5. 3P(특허,논문,제품)분석결과 및 연구사업단 사업내에서의 활용

가. 특허분석 및 향후 활용(연계 및 추가연구 등)

○ 기존 특허는 방사능 검출기 생산 분야와 방사능 차폐체에 치중되어 있으므로, 본 연구과제에

서는 검출기와 차폐체가 결합된 시스템이 가진 효율에 대한 연구를 추진하여 관련특허 등을

국내 및 국외에 출원하였음.

○ 기존 프로그램은 방사능측정분야에 치중되어 있으므로, 본 연구과제에서는 방사능측정과 시료의

통합관리가 통합된 방향으로 연구를 추진하여 프로그램을 등록하였음.

○ 본 연구에서 개발된 이동형 방사능 분석 장비의 현장 적용 및 방사선사고시 신속분석 등을 위해 개발장

비를 국내 농축산물 원산지 집하장 및 1차 유통지 등에 배치하여 국가 방사능비상안전망 구축 및 먹거리

안전에 기여하는 후속연구를 추진할 계획임

나. 논문분석 및 향후 활용(연계 및 추가연구 등)

○ 본 연구과제를 통해 최초로 개발된 농식품 이동형 방사능 분석장비 및 한글 방사능 핵종분석

프로그램에 관한 논문을 방사선 관련 분야 국제학술지 및 국내학술지에 게재할 계획임.

○ 기존 방사능 기준물질 개발에 관한 논문은 건조시료 분야에 한정되어 있으므로, 본 연구과제에

서 개발된 생체 시료 기준물질, 불확도 등과 관련된 논문을 방사선 관련 분야 국제학술지 및 국

내학술지에 게재할 계획임.

○ 기존 방사능 분석 관련 논문은 MCNP 모델을 이용한 효율 보정 등의 이론적 분야에 집중되어

있으므로, 본 연구과제에서 개발된 실용적이며 식품 생체 시료의 밀도별 비상시 신속분석과 보

정이 가능한 방법론을 국제학술지 및 국내학술지에 게재할 계획임.

다. 제품․시장분석 및 향후 활용(연계 및 추가연구 등)

○ 국내 및 국외시장 분석결과 국외제품인 Canberra의 FoodScreen과 Ortec의 FoodGuard 등의

생산 및 판매가 이루어지고 있음. 하지만 아직 관련 시장이 도입기이므로, 본 연구과제에서 개

발된 기존 제품보다 우수하고 편리한 이동형 방사능 식품오염 신속검사장비 등을 생산하여 국

내 및 국외에 판매할 계획임.



<첨부 2>
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KAERI

식품 중 감마선 방출 핵종 분석 작성일자: 15.11.24

쪽 번 호 : 1/6

개념 및 전처리

1. 적용범위(SCOPE)

본 절차서는 방사능 분석 방법을 표준화함으로써 일관성 있는 시료 분석이 되도록 하

는데 목적이 있으며, 식품 중 감마방출핵종 분석에 적용할 수 있다.

2. 관련 규격

2.1 IEC-61563, “Radiation protection instrumentation-Equipment for measuring 

specific activity of gamma-emitting radionuclides in foodstuffs, 2001

2.2 FDA, WEAC TD Rn-1, “Determiation of Gamma-ray emitting radionuclides in 

foods”, 2000.

3. 응용범위(APPLICATION) 및 원리(PRINCIPLE)

본 절차서는 식품의 감마방출핵종 분석에 적용하며, 50 keV ～ 3000 KeV의 에너지 

범위의 감마방출 핵종의 정성, 정량 분석을 하는데 응용될 수 있다. 전처리한 시료를 

고 분해능 게르마늄 검출기와 다중채널분석기를 사용하여 분석하며, 방사성 핵종 식별

을 위해서 에너지보정이 필요하고 방사능 양을 구하기 위해서 효율을 보정해야 한다. 

4. 실험기구(APPARATUS)

4.1 전처리용 각종 실험기구 (참고: 1.5 시료의 전처리)

4.2 감마핵종분석기(AMETEK ORTEC : 구 EG&G)

․ 고순도게르마늄검출기(HPGe detector)

․ 전치증폭기(Preamplifier),

․ 분광증폭기(Spectroscopy amplifier),

․ 다중파고분석기(Multichannel analyzer),

․ 핵종분석용 소프트웨어가 내장된 컴퓨터(Computer)

- GammaVision or Genie 2000 분석프로그램
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5. 시약(REAGENTS)

5.1 표준방사선원

: 측정시료와 형태, 구조 및 밀도가 같고 측정시료의 에너지 영역을 갖는 혼합 핵종

을 포함한다. NIST, Eckert&Ziegler, Amersham, 한국표준과학연구원 등에서 보정

용 표준방사선원을 구입할 수 있으며 반드시 성적서(certificate)를 통해 보정용 표

준방사선원의 핵종, 에너지, 방사능 값, 제조일자 등을 기록한다.

방사성 핵종 혼합감마선원

형태(Type) 1000 mL Marinelli Beaker Type

일련번호(Serial No.) 05MIX108

기준일(Reference Date) 00h, May, 01, 2005

불순물(Impurity) -

측정방법(Measurement Method) -

예)

              

Radionuclide Energy(keV) Radionuclide Energy(keV)

241Am 59.54 85Sr 513.99

109Cd 88.04 137Cs 661.62

57Co 122.07 88Y 898.02

139Ce 165.85 60Co 1173.23

203Hg 279.17 60Co 1332.51

113Sn 397.71 88Y 1836.01

                   〈보정용 표준방사선원에 주로 포함되는 핵종>

5.2 부식방지용 포름알데히드 (포름알데하이드 30% 이상 용액)
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6. 시료전처리(SAMPLE PREPARATION)

6.1 목    적 

방사능 분석 시료에 대한 전처리 방법을 표준화함으로써 일관성 있는 시료 전처리

가 되도록 한다.

6.2 적용범위

․적용대상 : 모든 식품

6.3 필요한 기구

1.6.3.1 파쇄기

1.6.3.2 분쇄기

1.6.3.3 건조기

1.6.3.4 회화로

1.6.3.5 저울

1.6.3.6 측정용기(마리넬리비이커 등 표준용기 )

6.4  방    법

6.4.1 직접법

․큰 덩어리나 조각으로 구성된 식품 

① 시료를 파쇄한 후 분쇄기로 분쇄하여 측정용기에 다짐봉으로 잘 충진한다.

② 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로

한다.

예) 버섯류, 한약재류, 과자류 등

차가버섯 파쇄 분쇄 충진
   

표고버섯 파쇄 분쇄 충진
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․작은 알갱이나 조각으로 구성된 식품

① 분쇄기를 이용하여 분쇄 한 후 측정 용기에 다짐봉으로 잘 충진한다.

② 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로  

  한다.

예) 견과류, 곡류, 두류 등 

아몬드 분쇄 충진
         

목이버섯 분쇄 충진

․분말이나 액체로 구성된 식품

① 분말인 경우 측정용기에 압축하여 상면이 수평이 되도록 고르게 충진한다.

② 액체(추출물 및 소스류 포함)인 경우 그대로 측정용기에 넣는다. 우유 등의 

원    유인 경우 측정 중 부패로 인한 유정의 분리를 방지할 필요가 있을 경우 

포르    말린(포름알데하이드 약 37% 용액)을 2 ㎖/ℓ 비율로 첨가한다. 

③ 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로  

  한다. 

예) 차류, 분유, 소스류, 주류, 우유, 쥬스류, 쨈류 등

딸기쨈 충진 충진

올리브유    충진 충진
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․비가식부의 제거 등 전처리가 필요한 식품

① 식용으로 쓰이지 않는 부분(채소류 : 뿌리․ 고엽․ 토사 등, 어패류 및 알류:    

뼈․껍질 등)을 제거하고 물로 세척할 경우 물기를 제거한다.

② 시료를 잘게 절단, 분쇄하여 측정용기에 넣는다. 채소류의 경우 분쇄과정 중  

   거품이 생길 수 있으므로 에틸알코올을 수 방울 적하하여 거품을 제거하고, 

측    정 중 부패의 우려가 있는 경우 포르말린(포름알데하이드 37% 용액)을 2

㎖/ℓ    비율로 첨가한다. 

③ 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로  

  한다. 

예) 어패류, 알류, 채소류, 과일류 등

고등어 절단 분쇄 충진
  

계란(+ 껍질) 껍질제거 분쇄 충진

배추 절단 분쇄 충진

        

   
      오렌지          절단            분쇄              충진
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6.4.2 건조법

① 많은 양의 시료가 필요한 경우, 식품을 1～2 일간 바람에 건조시키고 분쇄하  

   기 쉬운 상태가 될 때까지 100 ℃ 정도의 열풍건조기내에서 건조한다.

② 충분히 건조된 검체는 습기가 재흡수되기 전에 분쇄기를 사용하여 분말로 만  

   든다.

③ 균질한 분포가 되도록 압축하여 체적을 최소화시켜 측정용기에 넣는다.

④ 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로  

  한다.

                      김                   건조              분쇄

6.4.3 회화법

① 건조법의 ①～②까지 처리된 시료를 회화로에 넣고 500 ℃를 넘지 않는 온도  

   에서 회화시킨다.

② 막자사발에서 충분히 분쇄 혼합하여 측정용기에 압축하여 넣는다.

    오징어       절단             건조             분쇄           회화
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기기분석(GammaVision) 요약

1. 방사능분석 대상파일 불러오기
▶ File -> Open Datasource -> 분석대상 스펙트럼(Spc 파일) 선택

2. 분석 Library 적용
▶ Analyze -> Setting -> Sample type  -> Nuclide Library

3. 에너지·효율 교정 적용
▶ Analyze -> Setting -> Sample type  -> Calibration

4. 분석옵션 설정(시료정보, 분석기준일, 결과옵션, 백그라운드 등)
▶ Analyze -> Setting -> Sample type  -> System, Decay, Analysis, Correction

5. 분석결과 출력

▶ Analyze -> Entire spectrum in memory.
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1. Library 파일 작성

       방사능분석을 하기 위해서는 목적한 방사성핵종이 포함되어있는 Library 파

일이 있어야 하며, 여기에는 방사성핵종의 에너지, 반감기, 방출 감마선 및 방출

률, 불확도 등의 데이터를 수록할 수 있다.

 1.1. GammaVision Editor 실행

       Library 파일을 작성하기 위해 GammaVision Editor를 실행시킨다

그림 1. GammaVision Editor

그림 2. GammaVision Editor 창

 1.2. Library 핵종 선택

       Library를 만들기 위해서 핵종 정보를 일일이 입력할 수도 있으나, 

GammaVision에서 제공하는 Library 중 핵종을 선택해서 사용할 수 있다.

       제공되는 Library 파일(.Nib)중 추가하고자 하는 핵종이 있는 Library 파일

을 선택하고, 관심 핵종을 선택한 후 더블클릭하거나 “Insert 핵종”을 클릭한다. 

이 과정을 반복하여 관심핵종을 추가한다.

▶ Show Master Library -> Library 선택, 열기 -> 핵종 선택 -> 더블클릭 or Insert 핵종
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그림 3. 핵종 선택을 위한 Show Master Library 창

 1.3. Library 핵종 편집

       GammaVision에서 제공하는 Library는 일부 최신 핵종 데이터와 다를 수 

있기 때문에 각 핵종에 대한 정보를 수정할 수 있음.

  

그림 4. 선택한 핵종에 대한 정보

Ÿ Nuclide Name: 방사성핵종의 이름

Ÿ Half-life: 방사성핵종의 반감기, Nuclide Uncertainty: Half-life의 불확도

Ÿ Nuclide Flags: 자연방사선, 핵분열생성물 등 핵종의 생성기원 등을 규정

Ÿ Energy: 방사성핵종의 방출 에너지

Ÿ Gammas per 100 Disintegrations: 해당 에너지 방출률, Uncertainty: Abundance에 대

한 불확도

Ÿ Key Line: 방출 감마선이 여러개 있을 경우, 방출률이 가장 높은 핵종에 체크

Ÿ Not In Mean: 박스 체크 시 해당 에너지에 대한 방사능분석은 실시되지만, 가중평균방사

능 계산에서는 제외됨.
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 1.4. Library 저장

       핵종 선택 및 편집이 완료되면 적절한 파일이름을 정하여 저장. Library 확

장자는 .Nib

▶ Save Library As

2. Certificate 파일 작성

       검출기의 에너지 교정과 효율 교정을 위해 표준선원에 대한 정보가 담겨있

는 Certificate 파일을 작성한다.

 2.1. GammaVision의 Certificate File Editor 실행

       Certificate 파일을 작성하기 위해 Genie-2000의 Certificate File Editor를 

실행시킨다.

▶ Calibrate -> Calibration Wizard. -> Efficiency Calibration의 Create New

그림 1. GammaVision Efficiency Calibration Wizard

 2.2. 표준선원 정보 입력

       표준선원의 Library 파일을 선택하고 각각의 방사능과 불확도 등의 정보를 

입력해서 Certificate 파일을 만든다.
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▶ Library 선택 -> Certificate File Edit -> Library Group에서 핵종선택 -> Select 

from Lib -> Assay란 입력 -> Add New

그림 2. Genie-2000 Extract Library Nuclides

       표준선원에 대한 정보가 정확하게 입력되었는지 확인하고 추가적인 변경 시, 

변경 후 Update를 선택하여 수정한다. 

그림 3. Certificate file editor 표준선원 정보 입력

 2.3. Certificate 파일 저장 

       작성이 완료되면 적절한 파일이름을 정하여 저장.

▶ File -> Save as 
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3. 에너지교정

       표준선원과 Certificate 파일을 이용하여 채널 대 에너지간의 관계식을 도출

하며, 이를 에너지교정이라고 한다. 

  3.1. 표준선원 계측

       계측오차가 1% 미만일 때까지 계측하고 적정 이름을 부여하여 저장.

▶ File -> Save as

  3.2. Library 파일을 이용한 에너지 교정

       표준선원에 대한 Library 파일을 사용하여 에너지 교정.

▶ Calibrate -> Calibration Wizard -> Energy Calibration의 Create New -> Library

선택 -> 다음

그림 1. 에너지 교정을 위한 Library 파일 불러오기

그림 2. 에너지 교정 후 에너지 대 채널, FWHM 대 에너지 곡선
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       에너지교정 후 추가적인 에너지 교정 가능하다. 스펙트럼에서 피크 선택 후 

Energy란에 에너지를 입력하여 추가하거나, Energy Table에서 에너지 삭제.  

▶ Edit Energy -> 에너지입력 Enter or Energy Table에서 에너지 선택 Delete Energy

그림 3. 에너지 교정 후 Energy Table, Energy Graph 확인 및 수정 창
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4. 효율 교정

       에너지 교정을 위해 계측한 표준선원의 스펙트럼과 Certificate 파일을 이용

하여 에너지 대 효율의 관계식을 도출하며, 이를 효율교정이라 한다.

 4.1. 표준선원 계측

       계측오차가 1% 미만일 때까지 계측하고 적정 이름을 부여하여 저장. 이미 

에너지 교정을 위해서 표준선원을 계측하였으므로 이를 활용한다.

 4.2. Certificate 파일을 이용한 효율 교정

       표준선원에 대한 Certificate 파일을 사용하여 효율 교정.

▶ Calibrate -> Calibration Wizard -> Efficiency Calibration의 Create New -> 

Certificate File 선택 -> 다음

그림 1. 효율 교정을 위한 Certificate 파일 불러오기

그림 2. 효율교정 후 에너지 대 효율 곡선
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       효율교정 후 추가적인 효율 교정 가능하다. 스펙트럼에서 피크 선택 후 

Efficiency란에 효율를 입력하여 추가하거나, Efficiency Table에서 효율 삭제.

▶ Edit Efficiency -> 효율입력 Enter or Efficiency Table에서 효율 선택 Delete Entry

그림 3. 에너지 교정 후 Energy Table, Energy Graph 확인 및 수정 창
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5. 교정 파일 저장 및 불러오기

        교정파일에는 에너지 교정과 효율 교정 정보를 저장할 수 있으며, 저장한 

교정 파일을 분석하고자 하는 시료의 스펙트럼에 불러와서 분석한다.

 5.1. 교정 파일 저장

       에너지 교정, 효율 교정이 완료되면 교정 파일을 저장할 수 있다. 확장자는 

.Clb이며 에너지 교정, 효율 교정 정보가 모두 저장된다. 

▶ Finish Calibration Wizard -> Save Calibration

그림 1. 교정 파일 저장 창
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 5.2. 교정 파일 불러오기

       저장한 교정 파일을 분석하려는 스펙트럼에 불러올 수 있다. Recall Energy 

Calibration, Recall Efficiency Calibration 옵션을 사용해서 에너지 교정, 효율 

교정 결과를 각각 선택해서 불러올 수 있다.

▶ Calibrate -> Recall Calibration

그림 2. 교정 파일 불러오기 창

6. 백그라운드 교정

       방사능 분석을 위해서는 시료 계측 시와 동일한 조건에서 측정한 백그라운

드를 빼주어야 한다.

 6.1. 백그라운드 측정

        시료 용기와 동일한 빈 용기를 시료 측정과 같은 조건에서 충분한 시간동

안 측정한다.

 6.2. 백그라운드 분석 및 백그라운드 파일 만들기

        계측된 백그라운드 파일을 불러온 후 Library, 교정 파일을 적용 하고, 스

펙트럼을 분석한다. 백그라운드의 분석 Library는 백그라운드에 항상 포함되는 

핵종(천연방사성핵종)을 포함시켜 사용할 것을 권장한다. 이때 분석 시 분석 후

에 생성되는 ufo 파일을 이용하여 백그라운드 파일(Pbc)을 만든다.
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        백그라운드 파일(Spc) 분석

▶ File -> Open Datasource -> 백그라운드 스펙트럼(Spc 파일) 선택 -> Analyze -> 

Setting -> Sample Type(Library, 교정파일 설정) -> Analyze -> Display Analysis 

Results

        

        백그라운드 파일(Pbc) 만들기

▶ Analyze -> Setting -> Peak Background Correction -> Edit PBC -> Show 

Backgroud Analysis -> 분석한 백그라운드의 ufo 파일 선택 -> Copy All to PBC

그림 1. Edit PBC 창

 6.3. 백그라운드 저장하기

        백그라운드 파일(Pbc)을 저장하고, 분석 시 적용하여 보정한다.

▶ Save PBC table As

그림 2. PBC 파일 저장 창
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7. 동시합산 보정

        GammaVision의 동시합산 보정을 위해서는 일반 표준선원이 아닌 동시합

산보정용 표준선원을 이용해서 교정 파일을 만들어야 한다. 표준선원과 

Certificate 파일을 이용하여 에너지교정, 효율교정, 동시합산교정을 한다.

 7.1. 표준 선원 계측

       동시합산을 위한 표준선원은 일반적인 교정용 표준선원에서 60Co을 제외하

고 134Cs을 추가하여 제작해야 하며, 계측오차가 1% 미만일 때까지 계측하고 

적정 이름을 부여하여 저장.

 7.2. Library 파일을 이용한 에너지 교정

       동시합산 표준선원에 대한 Library 파일을 사용하여 에너지 교정(3. 에너지

교정 참고).

 7.3. Certificate 파일을 이용한 효율 교정

       동시합산 표준선원에 대한 Certificate 파일을 사용하여 효율 교정을 하고 

동시합산 보정을 위한 옵션을 선택한다.

▶ Calibrate -> Calibration Wizard -> Efficiency Calibration의 Create New, TCC 

Calibration의 Create New -> 다음 -> Certificate File 선택, Single Extended 

Source Method 옵션, Not Present 옵션 선택 -> 다음

그림 1. 효율 교정 시 동시합산 보정을 위한 Certificate 및 옵션 설정
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 7.4. 동시합산 보정 확인, 교정파일 저장 및 적용

       동시합산 보정을 위한 peak to total ratio, peak efficiency를 소프트웨어에

서 계산하며, 교정파일에 에너지 교정, 효율 교정, 동시합산 정보를 저장 할 수 

있다(5. 교정 파일 저장 및 불러오기 참고). 동시합산 보정 적용을 위해서는 8. 

방사능 분석 단계에서 Calibration에 동시합산 정보가 저장된 교정파일 설정 후 True 

Coincidence Correction 옵션 사용을 통해서 가능하다.

▶ Edit Efficiency -> 효율교정 및 동시합산 보정 확인 -> Finish Calibration Wizard -> 

Save Calibration

그림 2. 효율교정 시 동시합산 보정을 위한 Certificate 및 옵션 설정
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8. 방사능 분석

        시료에 대한 교정파일의 에너지, 효율, 시료정보 등을 통해 시료의 스펙트

럼을 분석한다.

 8.1. 분석 옵션 설정

        시료정보, 교정파일, 분석기준일, 결과옵션, 백그라운드 등의 정보를 설정 

할 수 있다.

▶ Analyze -> Setting -> Sample Type -> Sample(Library, 교정파일 설정)

그림 1. Sample Type 설정 창 중 Sample란

Ÿ File: Sample Type 전체 분석 옵션 설정을 Sdf 파일로 저장하고 불러오기 할 수 있다.

Ÿ Description: Sdf 파일에 대한 정보 기입란

Ÿ Presets: 계측 시간 설정

Ÿ Analysis Range: 분석하고자하는 채널구간 설정

Ÿ Random Summing: Random summing 보정인자, 0은 보정하지 않음을 의미

Ÿ Background Type: 피크면적 계산 시 빼주는 백그라운드의 계산에 이용하는 채널 범위

Ÿ Nuclide Library: 분석 시 사용할 Library 파일 설정(1. Library 파일 작성 참고)

Ÿ Calibration: 분석 시 사용할 교정 파일 설정(5. 교정 파일 저장 및 불러오기 참고)
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▶ Analyze -> Setting -> Sample Type -> System

그림 2. Sample Type 설정 창 중 System란

Ÿ Laboratory name, Operator name: 실험실 및 분석자 기입란

Ÿ MDA Type: 여러 유형의 MDA 계산방식 선택 가능. 보통 최소검출농도는 아래의 식을 

이용하여 계산하며, Nureg 4.16 Method가 이에 가장 부합함.

···

·
   

μB: 백그라운드의 불확도, ε: 효율, m: 시료량, Ir: 감마방출률, ts: 시료측정시간

Ÿ Match Width: 핵종 판별 시 Library와의 매칭 정도를 설정. 피크의 FWHM에 입력하는 

값을 곱한 만큼의 Width를 사용.

Ÿ Fraction Limit: 핵종 판별 시 핵종의 방출 감마선 중 피크로 발견된 감마선의 퍼센트에 

따라 핵종의 판별 유무 결정. 100%로 설정 시 Library에 있는 핵종의 모든 방출감마선

을 피크로 발견해야 핵종이 있다고 판별. 0으로 설정 시 기능을 사용하지 않음.

Ÿ File for Suspected Nuclides: 설정한 Nuclide Library 이외에 unknown 피크에 대해서 

본 옵션에서 선택한 Library 파일로 핵종 판별. 따라서 GammaVision에서 제공하는 

Suspect.Lib 파일(많은 핵종이 포함)을 사용.

Ÿ PEAK SEARCH SENSITIVITY: 1~5 사이의 피크 발견 민감도 설정. 1로 갈수록 더 민

감하게 피크를 발견.

Ÿ Unit: 방사능 단위 및 Multiplier, 시료량 및 단위를 입력 가능. mBq을 단위로 할 경우 

Multiplier에 1000 입력
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▶ Analyze -> Setting -> Sample Type -> Decay

그림 3. Sample Type 설정 창 중 Decay란

Ÿ Decay Correction: Collection 옵션을 선택하고, Date를 입력하면 시료채취일 기준으로 

붕괴 보정, During Acquisition 옵션 선택 시 계측시간 동안 붕괴 보정.

Ÿ Sample Collection: Collection 옵션 선택 시 시료채취 기간 동안 붕괴보정. Air filter 

같은 시료채취 기간이 필요한 시료에 대해 적용.

▶ Analyze -> Setting -> Sample Type -> Report

그림 4. Sample Type 설정 창 중 Report란
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Ÿ Reporting options: 결과에 들어갈 분석 결과 항목 선택

Ÿ Uncertainty Reporting: 불확도 단위 및 확장불확도 포함인자, k 설정

Ÿ Output: 출력 옵션. Display Analysis Results 옵션 선택 시 분석 후 결과파일 창 생성. 

결과파일 기본프로그램 Notepad.

▶ Analyze -> Setting -> Sample Type -> Analysis

그림 5. Sample Type 설정 창 중 Analysis란

Ÿ Analysis Method: Program에서 분석 알고리즘 선택. GammaVision 매뉴얼 참고.

Ÿ Additional Error: Systematic error, Random error 입력

Ÿ Peak Stripping: 중첩피크 제거 옵션. Library Based 옵션 선택 시 자동으로 중첩피크 

제거. Manual Based 선택 시 Second Library, Third Library 옵션 활성화 되고 선택한 

Library에 의해서 중첩피크 제거. Library Based 옵션 선택 권장

Ÿ Peak Cutoff: 분석에 사용하는 Nuclide Library 피크와 그 피크의 1-sigma 불확도 간의 

관계가 입력한 Peak Cutoff(%) 값에 미치지 못할 경우 방사능 계산에 이용하지 않음.

Ÿ True Coincidence Correction: 옵션 사용 시 Coincidence Correction 실행 

Ÿ Directed Fit: 옵션 사용 시 음의 방사능 값도 출력.
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▶ Analyze -> Setting -> Sample Type -> Correction

그림 6. Sample Type 설정 창 중 Correction란

Ÿ Peaked Background Correction: On 옵션 사용 시 백그라운드 보정. File에서 Pbc 파일

(6. 백그라운드 교정 참고) 선택
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기기분석(Genie 2000) 요약

1. 방사능분석 대상파일 불러오기
▶ File -> Open Datasource -> 분석대상 스펙트럼(CNF 파일) 선택

2. 에너지 교정 & 효율 적용
▶ Calibrate -> Load -> *. CAL

옵션에서 Energy/Shape, Efficiency 체크  

미리 교정해 둔 시료와 동일한 Geometry의 CAL 파일을 선택

3. Peak Search
▶ Analyze -> Peak Locate -> Unidentified 2nd Diff

4. ROI 설정
▶ Analyze -> Peak Area -> Sum/Non-Linear LSQ fit

5. 백그라운드 보정
▶ Analyze -> Area Correction -> Std. Bkg. Subtract. -> BKG 파일 Select

미리 측정해둔 BKG 파일 (확장자: .CNF) 선택

6. 효율 보정
▶ Analyze -> Efficiency Correction -> Standard -> Dual

7. 방사성핵종 판별
▶ Analyze -> Nuclide Identification -> NID w/interf. Corr.

8. MDA 계산
▶ Analyze -> Detection Limits -> Currie MDA

9. 분석 결과 출력
▶ Analyze -> Reporting -> Standard
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1. Library 파일 작성

       방사능분석을 하기 위해서는 목적한 방사성핵종이 포함되어있는 Library 파

일이 있어야 하며, 여기에는 방사성핵종의 에너지, 반감기, 방출 감마선 및 방출

률, 불확도 등의 데이터를 수록할 수 있다. 

 1.1. Nuclide Library Editor 실행

       Library 파일을 작성하기 위해 Genie 2000의 Nuclide Library Editor를 실

행시킨다.

그림 1. Genie 2000 Library File Editor

그림 2. Genie 2000 Library File Editor 창

 1.2. Library 핵종 선택

       Library를 만들기 위해서 핵종 정보를 일일이 입력할 수도 있으나, Genie 

2000에서 제공하는 Library 중 핵종을 선택해서 사용할 수 있다.

▶ Options -> Extract -> Open
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그림 3. 핵종 선택을 위한 Extract Library Nuclides 창

       제공되는 Library 파일(.NLB)중 추가하고자 하는 핵종이 있는 Library 파일

을 선택하고, 관심 핵종을 선택한 후 “OK"를 클릭한다. 이 과정을 반복하여 관

심핵종을 추가한다.

▶ NLB 파일 선택 -> Select -> 핵종 선택 -> OK

그림 4. Genie 2000에서 제공하는 Library file(.NLB)과 핵종 선택
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 1.3. Library 핵종 편집

       Genie 2000에서 제공하는 Library는 일부 최신 핵종 데이터와 다를 수 있

기 때문에 각 핵종에 대한 정보를 수정할 수 있음.

그림 5. 선택한 핵종에 대한 정보

Ÿ Name: 방사성핵종의 이름

Ÿ Half-life: 방사성핵종의 반감기, Uncertainty: Half-life의 불확도

Ÿ Type: 자연방사선, 핵분열생성물 등 핵종의 생성기원 등을 규정

Ÿ Energy: 방사성핵종의 방출 에너지, Uncertainty: 방사성핵종의 방출에너지의 불확도

Ÿ Abundance: 해당 에너지 방출률, Uncertainty: Abundance에 대한 불확도

Ÿ Key Line: 방출 감마선이 여러개 있을 경우, 방출률이 가장 높은 핵종에 체크

Ÿ No Wt Mean: 박스 체크 시 해당 에너지에 대한 방사능분석은 실시되지만, 가중평균방사

능 계산에서는 제외됨.

Ÿ More: MDA 계산을 원하지 않는 핵종 제거 가능, No MDA 체크

 1.4. Library 저장

       핵종 선택 및 편집이 완료되면 적절한 파일이름을 정하여 저장. Library 확

장자는 .NLB이며, Description에 추가하고자 하는 정보를 기입

▶ File -> Save as 



KAERI

농 식품 중 방사능 정밀 분석 작성일자: 15.11.24

쪽 번 호: 5/25

기기분석(Genie 2000)

2. Certificate 파일 작성

       검출기의 에너지 교정과 효율 교정을 위해 표준선원에 대한 정보가 담겨있

는 Certificate 파일을 작성한다.

 2.1. Genie 2000의 Certificate File Editor 실행

       Certificate 파일을 작성하기 위해 Genie 2000의 Certificate File Editor를 

실행시킨다.

그림 1. Genie 2000 Certificate File Editor

 2.2. 표준선원 정보 입력

       표준선원에 포함되어 있는 핵종을 Library 파일에서 선택하고 각각의 방사

능과 불확도 등의 정보를 입력해서 Certificate 파일을 만든다.

▶ File -> Options -> Library Extract -> NLB 파일 선택 -> 핵종선택 -> Activity, 

Uncertainty 입력 -> Change  -> OK

그림 2. Genie 2000 Extract Library Nuclides
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       표준선원에 대한 정보가 정확하게 입력되었는지 확인하고 추가적인 변경 시, 

변경 후 Change를 선택하여 수정한다. 

그림 3. Certificate file editor 표준선원 정보 입력

 2.3. Certificate 파일 저장 

       작성이 완료되면 적절한 파일이름을 정하여 저장. Certificate 확장자는 

.CTF이며, Description에 추가하고자 하는 정보를 기입

▶ File -> Save as 
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3. 에너지교정

       표준선원과 Certificate 파일을 이용하여 채널 대 에너지간의 관계식을 도출

하며, 이를 에너지교정이라고 한다. 

  3.1. 표준선원 계측

       계측오차가 1% 미만일 때까지 계측하고 적정 이름을 부여하여 저장.

▶ File -> Save as

  3.2. 피크 존재여부 결정

       에너지 교정을 수행하기 전에 스펙트럼에 존재하는 피크를 결정한다. 

▶ File -> Open Datasource -> 계측한 스펙트럼 파일(.CNF) Open

▶ Analyze -> Peak Locate -> Unidentified 2nd Diff

 

그림 1. 스펙트럼의 관심 피크 결정

Ÿ Search Region: MCA에 채널 설정으로 1에서 8192채널내 피크에 대해 적용(채널을 16k

까지 열어 사용할 경우는 Stop channel에 16,384입력)

Ÿ Significance threshold: 피크 존재여부를 결정짓는 파라메터로써, Continuum 위의 피크

가 교정선원 계측과 같이 매우 클 경우 이 값을 올리고(약 20), 

피크 면적을 적은 환경시료 같은 경우는 낮추어(약 3) 많은 피

크를 확보한다. 

Ÿ Significance threshold의 의미

   Net counts > Significance threshold × 1σ(BKG = Continuum)일 경우 피크로 인정. 

만약 어떤 피크의 Continuum이 10,000counts 이고 Significance threshold를 5로 설정

할 경우, 피크의 net counts가 500counts(5×100)이상 되어야 피크로 인정.
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Ÿ Tolerance: Energy Cal은 에너지 교정시 피크의 허용오차 ± 입력값으로 적용되며, 

FWHM 선택시도 허용오차 ± 입력값.

Ÿ Add to Existing Results: 각각의 피크는 피크결과테이블(peak result table)내 피크와 

비교해서, 설정된 Tolerance 보다 peak result table에 가까

울 경우, 이 피크는 이미 peak result table에 있다고 가정해

서 이 피크는 삭제. 반대의 경우는 새로운 피크로 인식해서 

peak result table에 추가. 본 기능을 선택하지 않을 경우에

는, 이번 peak search의 결과로 peak result table이 대체된

다.

Ÿ Generate Report: 이 기능을 선택하고, peak search를 실행하면 리포트 창에 peak 

search 결과가 디스플레이 된다. Reporting 매뉴에서의 report 생성

과는 다르다

  3.3. 피크 면적 결정

       계측된 스펙트럼에 나타나는 피크의 순계수율 계산 방법

▶ Analyze -> Peak Area -> Sum/Non-Linear LSQ fit

그림 2. Sum/Non-Linear LSQ Fit setup

Ÿ Peak Area Region: 피크 면적 계산할 MCA에 채널 설정으로 1에서 8192채널

Ÿ Continuum: 피크 양단에서 continuum의 크기를 설정

Ÿ Continuum function: photopeak 면적 계산시 net count만을 계산하기 위해 피크 밑부분

의 형태를 선택해주어야 됨. 피크 밑부분이 평판하면 “Linear"를 

선택하고, 피크의 오른쪽보다 왼쪽이 높다면 ”Step"을 선택. 

“None"은 알파스펙트럼에 사용. 
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Ÿ 95% Critical level test: Single peak에 대해 Critical level(Lc = Kα×σ0)테스트를 수행

해서(이때 Maximum acceptable confidence level은 

1.645(95%), σ0는 standard deviation of null signal) 기준 즉 

95%신뢰도를 초과하는 피크만을 선택. 체크하지 않을 겨우 크기

에 상관없이 모든 피크를 선택

Ÿ Use fixed FWHM, tail parameter: 중첩 피크 피팅 시 최적의 피팅 함수를 찾아서 피팅

하는 것 대신 선택된 파라메터에 의해 피팅됨.

Ÿ Fit singlet: 일반적으로 Peak Area 작업은 중첩피크에 대해서만 피팅하지만 만약 본 기

능을 선택할 경우 Singlet peak도 피팅

Ÿ Display ROI: 스펙트럼상의 피크 ROI 디스플레이

Ÿ Reject zero area peaks: negative 또는 Zero peak area 피크의 경우 peak result 

table에서 삭제

Ÿ Residual search: Peak Locate 알고리즘에 의해 찾지 못한 피크가 있는지 확인함. 이 과

정은 더 이상 추가할 피크가 없을 때 까지 진행됨. Fixed 

FWHM, Fixed Tail  그리고 Fit Singlet 기능이 선택되었을 때 

적합함.

Ÿ ROI Limits Determination: Sum/Non-Linear LSQ 피크 면적 계산 기능 수행시 본 입력

값에 의해 ROI내에 중첩피크가 있는지 없는지를 구분한다. 

Max.Num. FWHMs between peaks에 입력되는 값내에 피

크가 있으면 중첩피크로 인식. Max. Num. FWHMs for 

Left and Right limit에 입력되는 값에 의해 ROI의 좌우 크

기(boundary)가 결정.

그림 3. 피크 존재 및 면적을 결정한 표준선원의 스펙트럼 파일
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  3.4. Certificate 파일을 이용한 에너지 교정

       표준선원에 대한 Certificate 파일을 사용하여 에너지 교정.

▶ Calibration -> Energy Full -> By cetificate -> 해당 표준선원의 Certificate 파일

(.CTF) Open 

그림 4. 에너지 교정을 위한 Certificate file 불러오기

       보통 HPGe의 경우, 채널은 8192이고 계측 최대에너지는 3000 keV로 설정

해서 사용하므로 채널당 에너지는 약 0.3662 keV이다. 따라서, 채널에 0.3662

를 곱하면 해당 피크의 에너지를 알 수 있다. 

       스펙트럼에서 ROI를 이동시키면서 해당 피크 에너지와 Channel이 일치시키

며 에너지 교정을 하거나, Auto 옵션를 사용하여 에너지 교정을 한다.

▶ ROI 이동시키면서 피크 에너지 대 채널 매칭 -> Cursor -> Accept 

▶ Auto

그림 5. 피크 에너지 대 채널 매칭
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4. 효율 교정

       에너지 교정을 위해 계측한 표준선원의 스펙트럼과 Certificate 파일을 이용

하여 에너지 대 효율의 관계식을 도출하며, 이를 효율 교정이라 한다.

 4.1. 표준선원 계측

       계측오차가 1% 미만일 때까지 계측하고 적정 이름을 부여하여 저장. 이미 

에너지 교정을 위해서 표준선원을 계측하였으므로 이를 활용한다.

 4.2. Certificate 파일을 이용한 효율 교정

       표준선원에 대한 Certificate 파일을 사용하여 효율 교정.

▶ Calibrate -> Efficiency -> By Certificate -> 해당 표준선원의 Certificate 파일

(.CTF) Open 

그림 1. 효율 교정을 위한 Certificate file 불러오기

 4.3. 효율 교정

       Auto 옵션를 사용하여 효율 교정을 수행한 후, Show 옵션을 사용해서 결과

를 검토할 수 있다. 

▶ Auto -> Show
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그림 2. 효율 교정 후 효율교적 곡선 및 관계식

       List Pks 옵션을 사용하여 측정 효율과 계산 효율간의 편차를 확인할 수 있

으며 두 효율 간 차이(Deviation)가 5% 이상일 경우 효율 교정이 적절치 않으

므로 재교정이 요구된다.

▶ List Pks

그림 3. 측정 효율과 계산효율 값 및 편차
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5. 교정 파일 저장 및 불러오기

        교정파일에는 에너지 교정과 효율 교정 정보를 저장할 수 있으며, 저장한 

교정 파일을 분석하고자하는 시료의 스펙트럼에 불러와서 분석한다.

 5.1. 교정 파일 저장

       에너지 교정, 효율 교정이 완료되면 교정 파일을 저장할 수 있다. 확장자는 

.CAL이며 에너지 교정, 효율 교정 정보가 모두 저장된다. Description, EFF. 

Geom. ID에 교정에 대한 정보를 기입할 수 있고, EFF. Geom. ID는 방사능분

석 결과에 출력된다.

▶ Calibrate -> Store

   

그림 4. 교정 파일(.CAL) 저장

 5.2. 교정 파일 불러오기

       저장한 교정 파일을 분석하려는 스펙트럼에 불러올 수 있다. Energy/Shape, 

Efficiency 옵션을 사용해서 에너지 교정, 효율 교정 결과를 각각 선택해서 불

러올 수 있다.

▶ Calibrate -> Load
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그림 5. 교정 파일(.CAL) 불러오기

6. 백그라운드 보정

        방사능 분석을 위해서는 시료 계측 시와 동일한 조건에서 측정한 백그라운

드를 빼주어야 한다.

 6.1. 백그라운드 측정

        시료 용기와 동일한 빈 용기를 시료 측정과 같은 조건에서 충분한 시간동

안 측정한다.

 6.2. 백그라운드 분석 및 백그라운드 파일 만들기

        계측된 백그라운드파일을 불러와서 에너지교정, 피크 존재여부 결정, 피크 

면적 결정, 효율 보정, 핵종판별 단계까지 수행한 후 스펙트럼을 저장한다.

   

        백그라운드파일 불러오기

▶ File -> Open Datasource -> BKG 계측한 스펙트럼 파일(.CNF) Open
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        에너지교정

▶ Calibrate -> Load -> 교정파일 선택 -> Energy/Shape 옵션 체크 -> Load

        피크 존재여부 결정

▶ Analyze -> Peak Locate -> Unidentified 2nd Diff

        피크 면적 결정

▶ Analyze -> Peak Area -> Sum/Non-Linear LSQ fit

        효율 보정

▶ Analyze -> Efficiency Correction -> Standard ->Dual

        핵종 판별

▶ Analyze -> Nuclide Identification -> NID w/Interf. Corr.

그림 1. 핵종판별

Ÿ NID range: 핵종 판별 관심 영역, 통상 MCA 채널 설정으로 50에서 8192채널

Ÿ NID library: 백그라운드에 항상 포함되는 핵종(천연방사성핵종)을 포함시켜 사용.
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Ÿ Use Stored Library: 위에서 선택된 NID Library를 사용하는 것이 아니라 현재 분석 창

에 load된 library로 분석(선택 시 NID Library는 비활성화 됨)

Ÿ Inhibit Acq-Time Decay Correction: 계측시간에 대한 Decay 보정 실시 여부. 기타 시

료채취 등에 대한 Decay 보정은 기본적으로 수행

됨. Genie 2000는 최대 66반감기까지 보정됨.

Ÿ Perform MDA Test: 어떤 한 방사성핵종이 붕괴하여 감마선을 방출할 가능성(branching 

ratio)이 많을 경우, MDA 보다 낮을 것 같은 피크에 대해서는 신

뢰도 테스트 결과에 영향을 미치지 않게 하기 위해 핵종 신뢰도 

계산 시 무시.

Ÿ Tolerance: 스펙트럼상의 에너지 교정결과와 Library 상의 에너지 간 신뢰 범위

Ÿ NID Confidence threshold: 핵종판별을 위한 피크 선택여부 한계 설정. 0(low), 1(high)

Ÿ Cascade correction: 효율 교정 시, 동일 핵종에서 감마선이 cascade로 붕괴할 때, 

summing effect에 의해 실제 방출률 보다 낮게 계수된다. 이에 대

한 보정을 Cascade correction이라 하며, 이 기능은 사전에 해당 

검출기의 Peak-to-total calibration이 되어야만 적용가능하다. 

Ÿ MDA Confidence factor: Peak Area parameter setup시 "95% Critical Level" 선택 

시 기능 작동. 입력 숫자가 작을수록 MDA는 높아짐.

        백그라운드 저장, 분석 완료된 백그라운드를 저장한다.

▶ File -> Save

        백그라운드 보정, 분석 완료된 백그라운드를 불러온다.

▶ Analyze -> Area Correction -> Std. Bkg. Subtract. -> BKG 파일 Select

그림 2. 백그라운드 보정
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7. 동시합산 보정

        Genie 2000의 동시합산 보정을 위해서는 peak to total calibration, 효율

에 대한 동시합산보정, geometry description, 동시합산 보정 적용의 과정을 

거친다.

 7.1. peak to total calibration

         Genie 2000은 동시합산 보정을 위한 peak to total ratio를 구하기 위해 

자체적으로 제공하는 point sources를 이용한다. 1 μCi의 point source 

set(109Cd, 57Co, 113Sn, 137Cs, 54Mn, 65Zn)을 사용하여 peak to total ratio를 

결정한다.

        측정한 point source와 백그라운드 파일을 불러와서 peak to total ratio를 

계산한다. 각 point source의 스펙트럼은 에너지교정, 피크 존재여부 결정, 피

크 면적 결정, 효율 보정, 핵종판별 단계까지 수행한 후 저장해야한다.

▶ Calibrate -> Peak-to-Total -> P/T Files에 측정한 point source 스펙트럼을 불러오

기 -> Background File에 측정한 백그라운드 스펙트럼 불러오기 -> Extrapol. Chan. 

150 설정 -> OK

그림 1. point source 스펙트럼을 불러오기 위한 P/T Calibration 창
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         에너지 대 peak to total ratio 곡선을 그린다. Cross-over를 설정하고, 

곡선을 확인한다. Cross-over 기준으로 양쪽 곡선을 2차식을 사용해서 피팅 

한다.

▶ Cross-over 설정(391 keV) -> Show(2차식으로 피팅) -> OK

그림 2. peak to total ratio 곡선 설정 창

         peak to total calibration이 완료되면 교정 파일을 저장할 수 있다. 에너

지 교정, 효율 교정 정보와 함께 저장 또는 따로 저장 할 수 있다.

▶ Calibrate -> Store

 7.2. 효율에 대한 동시합산 보정

         효율 교정을 위해 사용하는 표준선원에는 60Co, 88Y 등의 핵종이 동시합산

을 일으키며 이를 보정한 효율을 사용할 필요가 있다.

▶ Calibrate -> Efficiency -> By Certificate -> 해당 표준선원의 Certificate 파일

(.CTF) Open  -> Perfrorm Cascade Correction  옵션 선택
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         효율에 대한 동시합산 보정을 위해서는 7.1 peak to total calibration 교

정이 선행되거나, 교정 파일이 불러오기 되어있어야 한다. 또한, 해당 효율의 기

하구조에 대한 Geometry Composer file이 만들어져 있어야 한다. Geometry 

Composer는 Genie 2000 Geometry Composer User's Manual을 참고한다.

▶ Geometry Composer file -> .GIS 선택 -> Auto

       

그림 3. 효율 교정 시 동시합산 보정

 7.3. 동시합산 보정 적용

         동시합산 보정이 된 효율을 사용하고, 스펙트럼 분석 시 핵종 판별 단계에

서 동시합산 보정을 실시한다. 

▶ Analyze -> Nuclide Identification -> NID w/Interf. Corr. -> Perform cascade 

correction 옵션 사용 -> Geometry composer file 선택

그림 3. 효율 교정 시 동시합산 보정
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8. MDA 계산

        최소검출농도(Minimum Detectable Activity, MDA)는 아래의 식을 이용하

여 계산한다.

 ···

·

μB: 백그라운드의 불확도, ε: 효율, m: 시료량, Ir: 감마방출률, ts: 시료측정시간

▶ Analyze -> Detection Limits -> Currie MDA

그림 1. Currie MDA Setup

Ÿ Confidence factor: Confidence level을 95%로 설정하고자 할 경우 여기에 5.0% 입력. 

Confidence factor는 0.1%(high) ∼ 40%(low) 사이 값 사용. 이 값

은 Nuclide Identification에서와 연동된다. Confidence factor가 

0.1%일 경우 Confidence level은 99.9%, 40%일  경우 confidence 

level은 60%.

Ÿ Perform Variable ROI Width: MDA 계산시 ROI의 즉 Photopeak의 좌우 범위를 설정. 

만약 설정치 않을 경우, Currie MDA의 경우는 4.0FWHM, KTA의 

경우 1.25FWHM이 디폴트 값. 

Ÿ ROI Width: Unidentified peak에 대한 MDA 계산시 적용되는 ROI 범위 설정. 0.8 

FWHM이 최소 설정치.
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Ÿ Use Variable MDA Constants: MDA 계산에 사용되는 수식의 상수(Constant)와 곱의 

수(Multiplier)를 사용자가 직집 입력. 입력하지 않을 경

우, Currie의 MDA 계산시 Detection Limit(LD)= k2 + 

2kσ0 = C0 + C1σ0 , 여기서 confidence level을 95%, 

k=2를 선택할 경우 C0(add constant) = 2.71,  

C1(multiplier) = 4.65.

Ÿ Cascade correction: Summing effect correction이 NID 단계에서 이루어졌다면, 

Coincidence library 파일이름이 디스플레이되고 Perform Cascade 

Correction 선택하면 summing effect 보정.

9. 분석 결과 출력

        방사능 분석 결과를 파일로 출력할 수 있다.

 9.1. 결과 형식 및 항목 선택

        분석 완료된 스펙트럼의 결과에 포함시킬 항목을 선택할 수 있다. 그림 2의 

Section Name(Header, AreaCorrect, NID_Intf, MDA)의 각 선택 단계에서, 

Execute 옵션을 선택하여 각각의 결과를 출력할 수 있다.

        분석이 끝난 파일을 저장하면 자동으로 .RPT 파일이 생성되어 

C:\GENIE2K\REPFILES\name.RPT로 저장된다. 

▶ Analyze -> Reporting -> Standard

그림 1. 결과 양식 선택

▶ Template Name 선택 -> Section Name 선택 -> Execute
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그림 2. 결과 양식 선택 창 및 옵션

Ÿ Template Name: 결과 출력에 대한 10개의 양식이 있음. 보통 ANALYSIS.TPL 사용

Ÿ Directory: 결과 파일 저장 경로

Ÿ Section Name: 각 단계(section name) 선택 후 “Execute" click해서 결과 생성시킴.  

방사능분석에 이용되는 모든 절차(피크 분석, 에너지 및 효율 교정, 핵

종판별, 면적 계산 및 보정, MDA 계산, Gain 조절 등)가 선택가능하

고, 이 모든 정보를 보고자 할 경우 “All"선택. 사용자가 필요한 정보만

을 원할 때는 각각 선택 가능. Header를 선택하고 New File로 선택하

지 않을 경우, 새로운 분석파일이 생성되지 않고 현재 창의 분석 결과

의 마지막부분에 실행한 Section Name 결과가 이어짐. 따라서, 새로운 

시료 분석 시 ‘New File’ 선택.

Ÿ Error multiplier: 확장불확도 포함인자, k

Ÿ Start On: Page One은 선택된 Section이 새로운 페이지에서 시작. New Page는 현재 

결과 다음페이지에 이어서. New file은 새로운 파일(*.RPT)로 저장.

Ÿ Output to: Screen은 스펙트럼 화면 밑에 결과 창에 결과가 보이고, Printer는 컴퓨터에 

연결된 프린트로 출력

Ÿ Activity Units: 단위 선택
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9.2. 자동 결과 출력 절차 만들기(Execute sequence)

        결과 출력 시 절차를 만들어 사용할 수 있다.

▶ Edit -> Analysis Sequence -> Step Selection -> Insert Step

      

그림 3. Analysis Sequence 실행 

Ÿ Step selection: 결과 출력 절차에 포함하고자 하는 명령어(step)을 선택할 수 있음. 시료 

계측, 피크 분석, 효율적용 및 결과 작성까지. 

Ÿ Edit Step: Current Steps에 삽입, 지우기, 알고리즘 선택 및 설정

Ÿ Current Steps: 자동 결과 생성을 위한 명령어(step)으로 구성

Ÿ Load: 기존에 만들어진 Sequence 파일 불러오기

Ÿ Store: Sequence 저장.

Ÿ Execute: Load된 Sequence 실행

 9.3. Sequence 저장

       방사능분석 결과 작성을 위한 Sequence를 저장.

▶ Store -> File name 작성, Seq. Description 작성 -> OK

그림 4. Reporting Sequence 저장 
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 9.4. Sequence 실행

        방사능분석 결과 작성을 위한 Sequence를 실행

▶ Analyze -> Execute Sequence -> 저장한 Sequence 선택

그림 5. Reporting Sequence 실행

10. Display 설정

        스펙트럼 창의 디스플레이 방법을 설정할 수 있다.

그림1. 스펙트럼 디스플레이
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 10.1. Preference 설정

        분석자의 기호에 따라 에너지 스펙트럼의 디스플레이를 설정할 수 있다.

▶ Display -> Preference

그림2. Display preference

Ÿ Spectrum Background: 에너지 스펙트럼의 배경색(Red, Green, Blue로 조절)

Ÿ Reference spectrum: 분석 대상 스펙트럼의 색(Red, Green, Blue로 조절)

Ÿ Compare spectra: 비교 스펙트럼의 색(Red, Green, Blue로 조절)

Ÿ ROI type: ROI type 선택

Ÿ Peak Labelling: Peak 정보 디스플레이(peak 핵종 등 디스플레이)

Ÿ Energy Units: 에너지 단위 설정 “keV” 

10.2. 방사능단위 및 Library 설정

        방사능 분석결과 에너지스펙트럼 창에 디스플레이 되는 방사능 단위 및 

Library 선택

▶ Interactive NID

 

그림3. 방사능 단위 및 Library 선택

Ÿ Activity units: 분석대상 방사능의 세기에 따라 달리 선택가능 “Bq" 기본 
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1. 시료 전처리

  식품분석에 사용할 시료는 비가식부를 제거하고 밀도를 고르게 분포하도록 전처리를 수행

한다. 분석하고자 하는 시료를 측정용기에 충진하는 과정으로 아래 절차에 따라 준비한다.

2-1. 필요기구

  1) 파쇄기(Hammer & Chaffcutter)

  2) 분쇄기(GFJ-3070G) 

  3) 건조기(Electric chamber type furnace & Electrically heated ceramic             

       chamber or Fisher(ISOTEM, Oven Model 177))

  4) 회화로(Electric Muffle Furnace, #C-MF)

  5) 저울(Top loading balance : 0.4～2,100 g)

  6) 측정용기(1L 마리넬리비커)

2-2. 전처리 방법

① 준비한 식품 시료에서 비가식부를 모두 제거한다.

② 시료를 파쇄한 후 분쇄기로 분쇄하여 측정용기(1L 마리넬리비커)에 다짐봉으로 

잘 충진한다.

③ 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로 

사용한다(HPGe 방식과 동일).
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2. 에너지 및 효율 교정

  검출기 측정신호는 에너지 교정을 통하여 검출기에서 측정되는 파고 높이를 핵종 에너지

에 맞게 조정하고, 효율 교정을 통하여 검출 계수율을 방사능으로 변환한다. 에너지 교정과 

효율 교정은 방사선핵종 정보를 알고 있는 표준선원의 스펙트럼을 이용하여 수행합니다.

3-1. 표준선원 측정

① MCA 장비를 설치한 후 “설정 → 연결”메뉴를 이용하여 프로그램과 연결한다.

② HPGe 검출기에 고전압 +600 V를 인가한다.

③ 방사능 측정장비 내에 표준선원을 위치한다.

④ “시작”버튼을 눌러 스펙트럼을 약 10분간 측정한 후 Gain을 조정하여 Co-60의 두 번

째 피크(1332 keV)가 455 ch에 위치하도록 한다.

⑤ 표준선원에 대한 스펙트럼을 30분간 측정한다.
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3-2. 표준선원 정보입력

① 교정 탭 선원정보를 클릭한다.

② 선원 정보 내 선원명, 기준일, 시료량을 입력한다. 

③ 핵종 라이브러리에서 "CRM.lib" 파일을 선택한 후 하단의 핵종목록의 교정에 사용할 핵

종을 선택한다.

④ 선택한 핵종은 “>>” 버튼을 눌러 핵종 정보에 추가한다.

⑤ 표준선원 인증서를 참고하여 추가된 핵종의 방사능과 불확도를 입력한 후 “저장”을 클릭

한다.
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3-3. 에너지 교정

① 표준선원 스펙트럼을 불러온다.

② 교정선원에서 표준선원 파일을 선택한 후 에너지 교정 → 수동을 클릭한다.

③ 1836 keV에 근접한 피크를 클릭하여 포인터가 위치하도록 한다.

④ 에너지 교정 창 하단 테이블의 1836 keV 항을 클릭한 후 “추가” 버튼을 클릭

하면 채널과 FWHM이 자동 입력된다.

⑤ 번호③ ~ ④을 반복하여 테이블 내 모든 에너지 항을 입력한다.

⑥ “삭제”를 이용하여 부적절한 피크들을 제거한 후 “확인” 버튼을 클릭한다.
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3-4. 효율 교정

① 표준선원 스펙트럼을 불러온다.

② 교정선원에서 표준선원 파일을 선택한 후 효율 교정을 클릭한다.

③ 효율 교정에서 부적절한 피크는 “삭제” 버튼을 이용하여 제거한다.

④ 곡선 차수를 조절하여 계산오차를 최소화 한다.

⑤ “확인”을 클릭한다.

⑥ 교정결과 → “저장” 메뉴를 이용하여 교정 결과를 저장한다.
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3. 분석 방법

  식품 시료와 백그라운드 신호의 스펙트럼을 측정하고, 식품 시료의 스펙트럼 분석을 통하

여 인체에 유해한 I-131, Cs-134 그리고 Cs-137 핵종이 식품 시료에 존재여부를 확인한

다.

 

① 빈 마리넬리 비커와 식품 시료에 대한 스펙트럼을 30분간 측정한다. 

② “측정 → 기준값”메뉴에서 방사능 분석할 핵종을 추가한다.

③ “측정 → 시료 정보”메뉴에서 식품시료의 무게 및 제작일시를 입력한다.

   

④ 교정 파일과 배경신호를 선택한 후 분석 조건을 설정한다.

⑤ “분석” 버튼을 눌러 스펙트럼에서 인공핵종 여부를 확인한다.
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4. 결과 해석

  식품 시료에서 검출된 I-131, Cs-134 그리고 Cs-137 핵종에 대한 정량적 분석결과를 

확인하고 분석 보고서를 저장 및 출력한다.  

① “분석 → 분석결과”메뉴에서 핵종분석 세부내용을 확인할 수 있다.

② “분석 → 보고서”메뉴에서는 보고서 형식의 분석 결과를 확인할 수 있다.



KAERI

농 식품 중 방사능 신속분석 절차서 작성일자: 15.11.24

쪽 번 호: 8/9

NaI 검출기 이용

부록 1. 방사능 측정장비 특징

1. 방사능 측정장비

 가방형 식품방사능 측정장비는 식품 내에 포함된 방사선 핵종을 검출하는 장비로, 차량이

나 카트로 이동이 불가한 현장에 즉시 투입이 가능한 장점이 있다. 이 장비는 이동에 적합

하도록 최적의 납 차폐체 두께와 고효율의 NaI(Tl)검출기, 내장배터리를 사용하여 어떠한 

환경에서도 방사능 분석이 가능합니다. 

< 장비 특성 >
- 식품분석용 방사능 측정장비 

- 두터운 납 차폐로 MDA 최소화 

- 분할 차폐체로 이동용이 

- 3” × 3” NaI(Tl) 검출기 사용 

- 표준 마리넬리비커 사용

- 최대 8시간의 배터리 운용시간 

- MCA 데이터 저장기능

- 감마핵종 분석 프로그램 제공 

 < 장비 제원 >

검출기  3” × 3” NaI(Tl) scintillator 측정범위  40 keV ∼ 3 MeV

MCA
· Digital signal Analyzer

· Channel: 256 ~ 8192 ch
통신방식  TCP/IP, USB

고전압 + 0 ~ 5000 V MDA  20 Bq/kg 이하 (1200초 기준)

전원
· AC/DC Li-ion (16.8V/3A)

· 배터리 운용시간 : 최대 8hr
프로그램  NeoGMA 한글프로그램

외형

· 가방형 카트: 

   460(W)×410(D)×270(H)

· 납차폐체 : 

   Ф240×163 [단위: mm]

중량 · 전체: 70 kg (차폐체 포함)

동작온도

/습도
 -20 ~ 80℃ / 10 ~ 95% 옵션 무선 키보드 및 마우스



KAERI

농 식품 중 방사능 신속분석 절차서 작성일자: 15.11.24

쪽 번 호: 9/9

NaI 검출기 이용

부록 2. 측정 시간에 따른 최소검출 방사능 농도(MDA)

  NaI 기반 신속 분석 절차서를 국내최초로 개발했으며, 식품 중 방사능 오염도를 신속 분

석하기 위해서는 분석 시간에 따른 최소 검출 방사능 농도(MDA)변화를 검토해야 한다. 식

품공전에서 제시하는 핵종 3개에 대해서 시간에 따른 MDA 변화는 그림 1과 같다. 20분을 

측정했을 경우에는 Cs-137에서 MDA가 밀도에 따라서 다른데 밀도가 0.5 g/cm3 일 때 약 

18 Bq/kg을 보였다. 밀도가 1.0 g/cm3일 때는 10  Bq/kg정도를 보였다. Cs-137를 제외한 

다른 핵종은 Cs-137보다 낮기 때문에 Cs-137를 기준으로 판단하면 된다. 측정시간을 

10,000초로 했을 경우에는 4 Bq/kg으로 낮아져 보다 정밀하게 측정할 수 있지만, 비상시 

신속 분석이 요구될 때는 분석하기 어려운 단점이 있다. 개발 장비를 이용해서 10분 측정했

을 경우에는 Cs-137 MDA가 10 Bq/kg으로 10,000초 측정한 값보다 2.5 배정도 높지만, 

시료를 17배 빨리 분석할 수 있는 장점이 있다. 따라서 상황에 따라서 적절하게 적용하면 

본 장비는 신속하게 다량의 시료를 분석할 있는 장점이 있다.

그림 1. 간에 따른 최소방사능 농도(MDA) 변화 (밀도=1g/cm3) 
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1. 시료 전처리

  식품분석에 사용할 시료는 비가식부를 제거하고 밀도를 고르게 분포하도록 전처리를 수행

한다. 분석하고자 하는 시료를 측정용기에 충진하는 과정으로 아래 절차에 따라 준비한다.

1-1. 필요기구

  1) 파쇄기(Hammer & Chaffcutter)

  2) 분쇄기(GFJ-3070G) 

  3) 건조기(Electric chamber type furnace & Electrically heated ceramic             

       chamber or Fisher(ISOTEM, Oven Model 177))

  4) 회화로(Electric Muffle Furnace, #C-MF)

  5) 저울(Top loading balance : 0.4～2,100 g)

  6) 측정용기(1L 마리넬리비커)

1-2. 전처리 방법

① 준비한 식품 시료에서 비가식부를 모두 제거한다.

② 시료를 파쇄한 후 분쇄기로 분쇄하여 측정용기(1L 마리넬리비커)에 다짐봉으로 

잘 충진한다.

③ 시료의 중량(측정용기의 중량 제외)을 정밀히 측정하여 밀봉한 후 측정시료로 

사용한다.

시료 종류 시료 원형 파쇄 분쇄 충진

고형 시료

분말/액체 시료

비가식부포함 

시료
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2. 에너지 및 효율 교정

  검출기 측정신호는 에너지 교정을 통하여 검출기에서 측정되는 파고 높이를 핵종 에너지

에 맞게 조정하고, 효율 교정을 통하여 검출 계수율을 방사능으로 변환한다. 에너지 교정과 

효율 교정은 방사선핵종 정보를 알고 있는 표준선원의 스펙트럼을 이용하여 수행합니다.

3-1. 표준선원 측정

① MCA 장비를 설치한 후 “설정 → 연결”메뉴를 이용하여 프로그램과 연결한다.

② HPGe 검출기에 고전압 +3500 V를 인가한다.

③ 방사능 측정장비 내에 표준선원을 위치한다.

④ “시작”버튼을 눌러 스펙트럼을 약 10분간 측정한 후 Gain을 조정하여 Co-60의 두 번

째 피크(1332 keV)가 3638 ch에 위치하도록 한다.
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⑤ 표준선원에 대한 스펙트럼을 30분간 측정한다.
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2-2. 표준선원 정보입력

① 교정 탭 선원정보를 클릭한다.

② 선원 정보 내 선원명, 기준일, 시료량을 입력한다. 

③ 핵종 라이브러리에서 "CRM.lib" 파일을 선택한 후 하단의 핵종목록의 교정에 사용할 핵

종을 선택한다.

④ 선택한 핵종은 “>>” 버튼을 눌러 핵종 정보에 추가한다.

⑤ 표준선원 인증서를 참고하여 추가된 핵종의 방사능과 불확도를 입력한 후 “저장”을 클릭

한다.
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2-3. 에너지 교정

① 표준선원 스펙트럼을 불러온다.

② 교정선원에서 표준선원 파일을 선택한 후 에너지 교정 → 수동을 클릭한다.

③ 1836 keV에 근접한 피크를 클릭하여 포인터가 위치하도록 한다.

④ 에너지 교정 창 하단 테이블의 1836 keV 항을 클릭한 후 “추가” 버튼을 클릭

하면 채널과 FWHM이 자동 입력된다.

⑤ 번호③ ~ ④을 반복하여 테이블 내 모든 에너지 항을 입력한다.

⑥ “삭제”를 이용하여 부적절한 피크들을 제거한 후 “확인” 버튼을 클릭한다.



KAERI

농 식품 중 방사능 신속분석 절차서 작성일자: 15.11.24

쪽 번 호: 6/10

HPGe 검출기 이용

2-4. 효율 교정

① 표준선원 스펙트럼을 불러온다.

② 교정선원에서 표준선원 파일을 선택한 후 효율 교정을 클릭한다.

③ 효율 교정에서 부적절한 피크는 “삭제” 버튼을 이용하여 제거한다.

④ 곡선 차수를 조절하여 계산오차를 최소화 한다.

⑤ “확인”을 클릭한다.

⑥ 교정결과 → “저장” 메뉴를 이용하여 교정 결과를 저장한다.
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3. 분석 방법

  식품 시료와 백그라운드 신호의 스펙트럼을 측정하고, 식품 시료의 스펙트럼 분석을 통하

여 인체에 유해한 I-131, Cs-134 그리고 Cs-137 핵종이 식품 시료에 존재여부를 확인한

다.

 

① 빈 마리넬리 비커와 식품 시료에 대한 스펙트럼을 30분간 측정한다. 

② “측정 → 기준값”메뉴에서 방사능 분석할 핵종을 추가한다.

③ “측정 → 시료 정보”메뉴에서 식품시료의 무게 및 제작일시를 입력한다.

   

④ 교정 파일과 배경신호를 선택한 후 분석 조건을 설정한다.

⑤ “분석” 버튼을 눌러 스펙트럼에서 인공핵종 여부를 확인한다.
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4. 결과 해석

  식품 시료에서 검출된 I-131, Cs-134 그리고 Cs-137 핵종에 대한 정량적 분석결과를 

확인하고 분석 보고서를 저장 및 출력한다.  

① “분석 → 분석결과”메뉴에서 핵종분석 세부내용을 확인할 수 있다.

② “분석 → 보고서”메뉴에서는 보고서 형식의 분석 결과를 확인할 수 있다.
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부록 1. 방사능 측정장비 특징

 이동형 식품방사능 측정장비는 식품 내에 포함된 방사성 핵종을 검출하는 장비로, 이동이 

용이하며, 이 장비는 기존의 다중파고분석기(MCA)와 달리 배터리 충전방식을 통하여 별도

의 전원없이 최대 8시간까지 방사능 측정이 가능하다.

 

< 장비 특성 >
- 식품분석용 방사능 측정장비 

- 두터운 납 차폐로 MDA 최소화 

- 분할 차폐체로 이동용이 

- 고분해능의 HPGe 검출기 사용 

- 표준 마리넬리비커 사용

- 최대 8시간의 배터리 운용시간 

- MCA 데이터 저장기능

- 감마핵종 분석 프로그램 제공 

 < 장비 제원 >

검출기
 HPGe Crystal 

 (Rel. eff.: 30%)
측정범위  40 keV ∼ 3 MeV

MCA
· Digital signal Analyzer

· Channel: 256 ~ 8192 ch
통신방식  TCP/IP, USB

고전압 + 0 ~ 5000 V MDA  3 Bq/kg 이하 (1800초 기준)

전원
· AC/DC Li-ion (16.8V/3A)

· 배터리 운용시간 : 최대 8hr
프로그램  NeoGMA 한글프로그램

외형

· 이동형 카트: 

   745(W)×842 (D)×948(H)

· 납차폐체 : 

   Ф260×375 [단위: mm]

중량
· 전체: 127 kg (차폐체 포함)

· 납차폐체: 88 kg

동작온도

/습도
 -20 ~ 80℃ / 10 ~ 95% 옵션  측정용 노트북
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부록 2. 측정 시간에 따른 최소검출 방사능 농도(MDA)

  식품 중 방사능 오염도를 신속 분석하기 위해서는 분석 시간에 따른 최소 검출 방사능 농

도(MDA)변화를 검토해야 한다. 식품공전에서 제시하는 핵종 3개에 대해서 시간에 따른 

MDA 변화는 그림 1과 같다. 20분을 측정했을 경우에는 Cs-137에서 MDA가 2.97 Bq/kg

을 보였다. 즉 2.97 Bq/kg 이하의 농도는 측정이 어렵다는 의미이다. 측정시간을 10,000초

로 했을 경우에는 1.2 Bq/kg으로 낮아져 보다 정밀하게 측정할 수 있지만, 비상시 신속 분

석이 요구될 때는 분석하기 어려운 단점이 있다. 개발 장비를 이용해서 10분 측정했을 경우

에는 Cs-137 MDA가 5.56 Bq/kg으로 10,000초 측정한 값보다 5배정도 높지만, 시료를 

17배 빨리 분석할 수 있는 장점이 있다. 따라서 상황에 따라서 적절하게 적용하면 본 장비

는 신속하게 다량의 시료를 분석할 있는 장점이 있다.

 

그림 1. 시간에 따른 최소방사능 농도(MDA) 변화 (밀도=1g/cm3) 
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